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Getting started with Ektron

Ektron manages the life cycle of content, from creation to approval and publication. It
helps your organization set up a process for overseeing changes to a website,
indicate the status of content within that life cycle, and inform the next approver that
it is their turn to review the content.

Business users, such as marketing or public relations professionals, can author,
manage and publish Web content, build and deploy Web forms, and collect and

leverage visitor information. The editor supports the industry’s best in-context

editing environment, ensuring user adoption and project success.

People interact with your Ektron website in different ways. Some people operate in
different roles, and sometimes different roles overlap in activity. For example, a
developer uses PageBuilder to create page structures, while content authors use
PageBuilder to build a page in those structures. Similarly, some administrators and
developers may perform installation and set-up actions.

The major roles for people interacting with your website are as follows:

» CMS User (Content Author). creates content for your website and may edit
the content in context on the Web page or in the Workarea. Content authors can
have specialized roles and permissions, such as a discussion board
administrator.

o Ektron's marketing suite on page 1033
® Creating personalized Web experiences with personas on page 1047

® Connecting visitors with targeted content on page 1063
® Measuring Web experiences with multivariate testing on page 1087
® Managing landing pages on page 1107
® Managing calls to action on page 1099
® Managing a blog platform on page 1141
® Fktron's marketing suite on page 1033
® Analyzing websites on page 483
® Targeting content with GeolP information on page 1079
o Editing in Ektron on page 553
o Creating PageBuilder pages on page 993
o Editing content on a PageBuilder page on page 997
°o Managing content on page 591
o Working with Ektron content on page 622
o Working with assets in the Document Management System on page 649
o Working with files in the library on page 673
o Working with collections on page 740
o Managing user communities on page 1505
o Working with discussion boards on page 933
o Working with forums on page 945
o Assigning and managing tasks on page 1339
o Working with calendars on page 913
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Getting started with Ektron

» Marketer. marketing campaign managers, lead generation managers, digital
marketers, and content marketing managers.
» Ektron's marketing suite on page 1033

» Creating personalized Web experiences with personas on page 1047
» Connecting visitors with targeted content on page 1063

» Measuring Web experiences with multivariate testing on page 1087
» Managing calls to action on page 1099

» Managing landing pages on page 1107

e Managing a blog platform on page 1141

» Analyzing websites on page 483

» Personalizing a Web page on page 1327

« CMS Administrator. manages the website including access to all content,
taxonomies, users, rules, and settings.
o Setting up your CMS folder structure on page 141

°o Managing content on page 591

o Working with Ektron content on page 622

o Approving content for publication on page 689

o QOrganizing content with taxonomies on page 1253

o Creating a mobile-driven Web experience on page 457
o Synchronizing servers using eSync on page 1787

o Developing wireframe templates on page 1007

o Using responsive frameworks with PageBuilder on page 1001
o Applying adaptive image resizing on page 472

o Personalizing a Web page on page 1327

o Creating and using widgets on page 1171

o Creating menus for your website on page 1235

o Creating user-friendly URLs with aliasing on page 1293
o Navigating a website with breadcrumbs on page 1321
o Working with multi-language content on page 1393

o Analyzing websites on page 483

o Defining roles on page 1464

o Creating business rules for your website on page 1361
o Working with Smart Forms on page 815

o Viewing network server diagnostics on page 1903

° Managing users and user groups on page 1439

o Sending notifications to a community on page 1543

o Sending Web Alert emails to subscribers on page 1369

« Web Administrator. installs, upgrades, or migrates sites to Ektron and gets
Ektron ready for use.
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Getting started with Ektron

Ektron release notes

Ektron system requirements

Installing Ektron on page 9

Upgrading to on page 35

Securing Ektron on page 53

Setting up Ektron on page 67

Setting up search for your website on page 181

Ektron Digital Experience Hub release notes on page 453
Distributing resources with 3-tier architecture on page 167
Using LDAP with Ektron on page 1498

» Developer. writes API code, modifies ASPX pages, creates wireframe templates
with PageBuilder, and create widgets to customize your website.

o

o

o

o

[}

e}

e}

o

Framework API

Framework UI

Templated server controls

Server controls

Strategies

Constants

Ektron Markup Language

Creating and using widgets on page 1171

For information about developing a Web strategy, see Creating a mobile-driven Web
experience on page 457.
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Installing Ektron

For information about system requirements for the current release, see System
Requirements. If your system does not conform to them, you should upgrade before
installing or upgrading Ektron.

IMPORTANT: Each deployment has unique requirements. Ektron recommends
that you engage with a Certified Ektron Partner when making decisions about the
needs of your production environment.

License keys

IMPORTANT: Read the Ektron Perpetual License Agreement before installing
Ektron software.

Ektron controls the usage through a license key, a unique code assigned to your
domain. Your license key is included in the email that is sent when you request or
purchase Ektron.

When you login to a website that contains Ektron, it checks the license key(s) against
the domain.

If the URL of a valid license key matches the URL of the site being accessed, the
Workarea appears.

If no valid license key is found for the URL of the site being accessed, Ektron is
disabled and you must log in the with Builtin account to change the License Key.

If you have a broken license key or a license key with an incorrect base URL, an error
message appears in the Ektron Login window. The message states, “Error: A license
violation has occurred and the application is presently locked. Please see your
administrator.” If this message appears, login with the Builtin account and reenter
your license key. If the message continues to appear and you are sure you have a
valid key, contact Ektron Support.

Domains in which you can use a license key

The license key is assigned to a base URL, typically your domain name. For example,
if your domain name is www.mycompany . com, the license key follows this pattern:
WwWw .mycompany.com (expdate) (Modifiers) ?1234567890.

Each domain requires its own license key. For example, to support the domains,
WWW.mycompany.com, sales.mycompany.com and Support.mycompany.com, YOu need
3 license keys.

When you purchase a license key, be sure to register a domain name, not an IP
address. Although Ektron supports IP addresses, the domain that you license
becomes the required URL in the browser address. For example, if you register
192.168.0.1, you would need to access the site as
http://192.168.0.1/somedirectory/myloginpage.aspx. Because users would
typically not identify a Web page by its IP address, register a domain name instead.

Using Ektron without a license key
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Inserting the license key

For evaluation purposes, when you install Ektron, you do not need a license key.
During the installation process, leave the License Key field blank and click Next on
the License screen. This lets you use Ektron as localhost.

Inserting the license key

You are prompted to enter a license key during installation. If you do not, enter it by
choosing Workarea > Settings > Setup > Edit and completing the License Key
(s) field.

When cutting and pasting license keys, keep the full license key intact without adding
or deleting characters. License keys that are changed in any way render Ektron
inoperable.

Upgrading a license key

If you upgrade Ektron and want to replace the old license key with a new one, choose
Workarea > Settings > Setup > Edit. Next, add the license key to the License
Key(s) field. If you want to add new keys in addition to old keys, create a comma-
delimited list of keys in the License Key(s) field.

Installing Ektron

By default, the installation places files in 2 server locations:
e C:\Program Files (x86)\Ektron\CMS400vxX.sample and minimal databases,
documentation, utilities, setup files for creating additional sites.

e C:\Inetpub\wwwroot\site root. bin folder, Web services, scripts, supporting
files, uploaded files and images, graphics used in Ektron, CustomAPI, and so on.

NOTE: The bin folder stores Ektron’s binary executable files. .NET
automatically searches this folder for .dll files.

During installation, the ASPNET or IIS_WPG and IUSR users are given permission to
create folders in these directories:
e C:\Inetpub\wwwroot\site root\uploadedfiles

e C:\Inetpub\wwwroot\site root\uploadedimages

Before you install

1. Create a folder for the site. Make sure the drive and folder to which you install
your Ektron website have sufficient space. Anticipate future needs, since the site
is likely to grow over time.

2. Make sure that Internet Information Server (IIS) is installed on your server. See
Creating multiple websites on a single server on page 90.

3. Install the Application Server role on your server. For more information, see
https://technet.microsoft.com/en-us/library/cc754684.aspx.

Ektron Reference I 11


https://technet.microsoft.com/en-us/library/cc754684.aspx

Installing Ektron

4. Create an IIS site. See also: How to set up your first IIS Web site.
a. OpenIIS.

b. In the left panel, right click the Sites folder and choose Add Web Site.

c. Inthe Add Web Site dialog, insert sitename, hostname, and physical path
for the new site.

IMPORTANT: Ektron does not support the installation of nested sites,
each having its own web.config file. Nested sites can disrupt features,
such as Aliasing, Menus, and eSync.

Also, do not install the site under another application’s folder within Web
root, nor to an IIS Application under another site.

@-id |7 |8
- &5 Start Page
=93 HOTSPARE! (HOTSPARELAdir
-} Application Poals

= @ | Sites
=143 Default Web Site
- | gsprebclient
L et
+-€D hobsparets
P Test
- | F |8

o *d:il Stark Page
=183 HOTSPAREL (HOTSPAREL}Admit
- o Application Paals
- & Sites
-3 Default web Site
- f-hetsparela
@ Correct

5. If you are setting up one website that uses multiple Ektron servers and points to
a single database server, make sure both servers connect to the same database.
This configuration ensures that membership user registrations, forum/blog
posts, statistics, and so on, are the same on both servers. For more information,
see Setting up Ektron on page 67.

6. Decide which search provider you will use. See also: Search providers on
page 182.

If you will use any Microsoft search provider, install it. See also: Working with
Microsoft FAST search on page 423; Setting Up Microsoft Search Server 2010 on
page 302; Using Solr search on page 204
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Installing the Ektron base

7. Enable IIS 6 metabase compatibility and ASP.NET. To do that:

a. From the Windows Control Panel, choose Programs and Features.
b. From the left panel, choose Turn Windows Features On or Off.

@vaj » Contral Panel » Programs and Features - ‘ ¢f| Sea

Tasks i
= Uninstall or change a program

View installed updates
To uninstall 2 program, select it from the list and then click "Uni

(3et new programs online at
Windows Marketplace

: Organize » 1= Views .
View purchased software
o

{digital lacker) Marne Publishe
IS Turn Windows features on or | BN T EE N dE Pty Adobe &

off B2 2dobe Reader 8,10 Adobe §
Eadobe® Photoshop® Album Starter Edition 3.2 http: e
Lo ALPS Touch Pad Driver

.Eraadcam Managernent Programs Broadco
o e B e

c. Click to open Internet Information Services > Web Management
Tools > IIS 6 Management Compatibility.

d. Check IIS Metabase and IIS 6 configuration compatibility.

e. Click to open Internet Information Services > World Wide Web
Services > Application Development Features.

f. Check ASP.NET.
g. Click OK.

8. Obtain a license key from Ektron. Send email to license@ektron.com.

Installing the Ektron base

1.

Contact your Ektron account manager to obtain a link to download Ektron.
Double click the downloaded CMS400Basevreleasenumber.exe file.

Ektron verifies that your server has all required components. You must install
any missing ones before you can continue.
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Installing Ektron

Ektron ChA5400

E ktron CM 5400 Prerequisites Checkhst

4 Check if curent user iz an administratar

4 Check if server iz NTFS

4 Check if system is Win2008 sp2 or greater

4 Check if 15 is installed
4 Check if MET 4.5 iz installed

4 Check if 85P.MET iz installed

4. A screen displays Ektron’s License Agreement. Read it and click I Accept. If you
do not accept, the setup ends.

Licenze Agreement
Fl ad the |

y
ektron

“ READ THIS BEFORE LOADING SOFTWARE™

OUR RIGHT TO USE THE PRODUCT DELIVERED 15 SUBJECT TO THE TERMS AND
CONDITIOMS SET OUT IM THIS LICENSE AGREEMENT. USIMNG THIS PRODUCT
SIGHIFIES vOUR AGREEMENT TO THESE TERMS. IFvOU DO NOT AGREE TO THIS
SOFTWARE LICENSE AGREEMENT, DO NOT DOWMLOAD.

CUSTOMER should carefully read the following terms and conditions befare uzing the
zoftware program(z] contained herein [the "Software"). Downloading and/ar uzsing the
Saftware or copying the Software onto CUSTOMER'S cormputer hard drive indicates
CUSTOMER S acceptance of these terms and conditions. If CUSTOMER does not agree
with the terms of this agreement. CUSTOMER should not download.

Ektron, Ihe. ["Ektron''] grants, and the CUSTOMER accepts, a nontransferable and
nonexcluzive License to uze the Software on the following terms and conditions:

1. Licenze: Licensor hereby grants to Licensee a worldwide, fully paid. royalty free,
imrevocable not-excluzive licenze [the "'License’"] to uze the following Software:

CHSA00.MET [specify Professional with number of LUIRLz and seats, or Enterprise Package
with Lnlimited Usgers and Unlimited URLs on a single server]

Q0 | do not

Lnistaf| field [ < Back H et > ‘ I Cancel J

5. Select Complete to install all components. Or, select Custom to choose which
components to install. You can also choose where to install them.
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Installing the Ektron base

up type.

d. [Fequires the mao

want installed. Recommended for advanced

’ < Back ” Mewt » ] Cancel

6. When you click Next, the install checks for SQL or SQL Express on the server. If
SQL is not installed, a dialog prompts you to install SQL Express.

7. If you will use a remote SQL server, click Continue. If you plan to use SQL
Server on this computer, click the link on the message to install SQL Server
Express 2008 R2 RTM. If you do, the Ektron installation terminates. After

installing SQL Server Express, restart the Ektron installation.
)
Mo SOL Server wasdetected onthis system. SOLServer 20055P2 or gieateris required. 1fyou planonusing

aremote SQL Server. click 'Continue’ to proceed. Adownload link for SQL ServerExpress 2008 B2 RTM is
provided below. Clickingthe SOL Express download ink willclose the Ektion CMSAM0NET mstall

Microsoft SOL Server Express 2008 B2 RTM: http:go. microzoft com/frlink. PLinkld=18E6733

| tomtinue |

4

8. The Ready to Install the Program screen appears. Click Install. The
installation program copies files to the c: \Program Files folder.
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Installing Ektron

Heady to Install the Program

The wizard iz ready to begin installation.

kiron

Instalahiel [ < Back H Fnstall | ] Cancel

IMPORTANT: After completing the installation, further configure your
permissions based on your network security model before using Ektron.

9. Click Yes to check for updates. This verifies that you have the latest version of
Ektron.

Question

.

I I would waou like the inskall ta check For updates?

. r

10. You might be prompted to restart your server. If so, you should restart now.
Otherwise, the installation begins.

IMPORTANT: If this dialog appears, do not run the site setup until the
system reboots.
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Installing a site

InztallShield Wizard Complete

A reboot of your spetem in now required to continue setup of CS400.

| <Back || Finsh | [ Concel |

After you install Ektron, the web.config file is updated as follows.

o ek_sitePath. webroot/siteroot

o ek_buildNumber. Current build number of Ektron

» ek_cmsversion. Current version of Ektron

» Connection String. Information about the database's connection to Ektron
See also: Managing web.config on page 74

Installing a site

NOTE: Continue with these steps after completing Installing the Ektron base on
page 13.

The installation copies the following folders from C:\Program Files
(x86) \Ektron\CMS400vxx to the Web root folder you specify:

« BIN

» workarea

» documentation

» uploaded files and uploaded images

» alogin page

« the Visual Studio solution file

1. You can create a new site manually by clicking the cms400sitesetup.exe file
located in C:\Program Files (x86) \Ektron\CMS400vxx\Utilities\SiteSetup
or by choosing Start > Programs > Ektron > CMS400vXX Utilities >
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Installing Ektron

CMS400 Site Setup. The Setup Type screen appears.

If you're using Windows 8 or 2012, press the Windows key (ﬂ)/Q then enter
CMS400 Site Setup. Right click and choose Run as Administrator.

2. Choose an option and click Next.
+ CMS400 Full Installation. For setting up a new site installation.

« CMS400 Upgrade. For upgrading existing site's database and site files.

« CMS400 Database Setup. For setting up a new site database. Site files,
such as .aspx pages, are not included in this setup.

3. Inthe License Key field, enter your primary license key for Ektron. License keys
are typically emailed to your organization when you request a copy of the
application. When cutting and pasting a license key, keep it intact without adding
or deleting characters. If you do not have license keys now, you can insert them
later.

License Key

Iristalatield l < Back ” Mest » ] Cancel

4. Select a site to install. This screen does not appear the first time you run the site
setup for a starter site. If you run it again and have multiple sites, this dialog
appears.
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Installing a site

Please select demo site: E

Ektron Site Selection

ktron

ChS 400 Minsit ontainz the minimum components needed bo run a site.

Tiystal| el ’ Back l ’ Mewut l Cancel

5. Select from the drop-down list the site to which you want to install Ektron. You
created the site when preparing for the Ektron installation, as documented in
Step 4 of Before you install on page 11.

Webzite and Host zelection

kiron

Hast: localhost =

M Enter Host Marually

e tics:

LCancel

Tetallo el Back ] [
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Installing Ektron

6. Enter the destination folder for the site. If your website resides in a folder other

than the default, click Browse and go to that folder. The default reflects your
selection in the previous dialog.

WARNING! Do not install under another application’s folder within the Web
root.

IMPORTANT: Ektron does not support the installation of nested sites, each
having its own web.config file. Nested sites can disrupt Ektron features, such
as Aliasing, Menus, and eSync.

Site Path Directory

zelect another

Cancel

7. Enter the path of the Secure Asset Location. The Site Options screen appears.

IMPORTANT: If you plan to load balance several servers, make sure this
path is the same for all servers in the cluster. See also: Balancing the load on
your servers on page 94.

NOTE: Be sure the drive to which you install the asset library has sufficient
storage space plus room for growth.
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Installing a site

Secure Asset Storage Location

nation Faolder

e |

Cancel

8. You may see the following dialog.

Question

™% FEktron requires IP Restrictions to be set on several folders for
'e' security purposes, This requires the Microsoft IIS Feature to be
= enabled on this server, Waouold waou like For the installation ko enable
this and restrick access ko these specific site Folders? Select “es' to

conkinue or 'Mo’ to cancel the installation and configure this
rnanially,

Click Yes if you want the installation to

a. Enable IIS's IP Address and Domain Restrictions role.

b. Restrict access to the /workarea/webservices and /workarea/services
folders and the /workarea/ServerControlWs.asmx file, so they are only
accessible from localhost.

If you click No, the site installation is terminated.

For more information, see https://portal.ektron.com/kb/10234/.

If you click Yes and complete the installation, you may have to grant permission
to other servers that need to access the restricted folders and file. To do this:

a. GotolIs.
b. Choose the /workarea/webservices folder.
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Installing Ektron

c. Choose IP Address and Domain Restrictions.
Click Add Allow Entry from the right panel

e. Add IP addresses for each server that will access this server's
/workarea/webservices folder.

f. Repeat Steps a through e for the /workarea/services folder and the
/workarea/ServerControlWS.asmx file.
9. On the Search Provider screen, choose the search provider you will use with
Ektron.

Ektron ChAS400.MET

Search Provider

kiron

o Micr

& Micr

ion that iz free to

’ < Back ” Mext > l Cancel

See also: Working with Microsoft FAST search on page 423; Setting Up Microsoft
Search Server 2010 on page 302; Using Solr search on page 204.

10. On the Site Options screen, check each option you want to install.

NOTE: You should generate a security certificate because it lets the Ektron
Windows Service register Ektron sites with Search. Certificates also allow
content scheduling and are required for eSync.

See also:

» Viewing network server diagnostics on page 1903.
e Managing eSync security certificates on page 1838
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Setting up a database

InstallShield Wizard “

Site Options If pou

& eSync Security Certificates

kf ron Bl Diagnostic Utilty

Description:

eSync Secunty:  The eSync feature requires secunty certificates to ensure secure communication
between servers. A tool to generate the certificates will launch after the Site
Setup is finished winning.
You can run this tool later if desired but it must be run prior to using eSync.

Diagnostic Utility: - Provides information about servers in pour Ektron network. (CMS400.MET
server, connected database servers, and other servers with which your web
site has an eSync or Load Balance relationship.)

NOTE: eSync is only available if the eSync modifier is in your license key.

11. After choosing, click Install. The Moving Files dialog appears, and the following
things happen.
« files are copied to the site

» permissions are set for the site’s directories

o ASPNET, IIS_WPG, or Network Service user and IUSR are given permissions
to the directories

» the site is set up to use .NET 4.5
» web.config settings are configured
» IIS is configured

Setting up a database

If you are using a separate database server, you need the following information:

» Database server host name or IP address.

» If the database server is on the same domain as the application server, it
supports NT or SQL authentication.

» If the database server is on a separate domain from the Ektron server, it
supports SQL authentication.

* You have database administrator or database creator privileges .

NOTE: Continue with these steps after completing Installing a site on page 17.
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Installing Ektron

Your database contains information such as users and content blocks. The database
setup program:

» checks for SQL or SQL Express server. If either is installed on your server, an
appropriate database is set up.

» loads database tables

» updates the web.config file with information about your database connection,
based on your responses

1. You are prompted to set up a database. Click Yes.
rQuestiDn )

@ Would you like to run the database setup at this time?
- i

Mote: You must be able to connect to Microsoft SQL Server 200572008,
SQLExpress 2008 R2 RTM, SQL Server 2012 or a SQL Azure Database to
run this setup.

2. Enter a name for the database.

Database Name

Enter the database name pou would like setup to create.

kiron

l < Back ” MHest » ] Cancel

3. Enter the Ektron administrator user's password. It cannot be admin. You may
also change the user's username if you wish.
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Setting up a database

Ektron CMS400.MET

Admin User

ktron

Usert amne:

[ < Back ” Mext > l Cancel

After completing the installation, Ektron administrators may edit these values in
the Ektron Workarea > Settings > Users screen.

The Ektron administrator user is a member of the Administrators group. Group
members have access to all Ektron Workarea screens.

4. Enter the builtin user’s password. For information about the builtin user, see
Editing the builtin username and password on page 110.
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Builtin User

ktron

U serName:

Iniscallhield l < Back H Mext > l Caticel

5. Click Next. The SQL Server DB Setup screen appears and prompts for database
connection information.

SAL Server DB Setup

Tystal| Shield < Back n Mext > Cancel

» Server. List the database server on this system. To setup the database on
this server, accept the default. Otherwise, enter a SQL or SQL Express
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Setting up a database

server that already exists. For SQL, this would typically be (local) if it's
installed on the local server. Otherwise, enter the Server’s name. For SQL
Express, enter (local) \SQLEXPRESS.

+ Username. Enter the username you will use to access the database.
» Password. Enter the password you will use to access the database.

NOTE: If you want to use NT authentication, leave the username and
password blank. This will set up a trusted connection.

After you complete the screen, the setup verifies the database connection
information. If the database name already exists, you are asked to assign a
different name. When a connection is made and the name is available, the
installation program creates a database using the provided information.

6. If you did not leave the Username and Password fields blank on the previous
screen, the following screen appears.

7. The setup verifies the database connection information. If the database name
already exists, you are asked to assign a different name. If the name does not
already exist and a connection is made, the installation program creates a
database using the provided information.

8. Click Install to begin the installation. The Setup Status screen appears.

Setup Status

The InzstallShield *+izard is installing CRMS400MET SDE

ktron

ions.elntranetibinsD e

[ Cancel

9. When the SDK install is finished, the following screen appears. Click Finish. The
site and database setup portion of the install is complete.
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InstallShield Wizard Complete

kiron

i ]

| i

10. The following screen appears, providing information about setting up a search
provider. The message varies according to the chosen search provider.

Search Configuration: Apache Solr

Iﬁl YWou have selected Spache Solr as the search provider for your Ektron

W site. If wou have installed the Ektron Solr Search components on your

~ search server, ywou can register ywour site with the Ektron Solr
Administration console,

Please see the Ektron Reference for information on how to install the
Ektron search components and register your site,

Ok

11. If you checked the eSync box in Step 9 of Installing a site on page 17, the
following dialog appears.

28 | Ektron 9.50




2 Ektron eSync Security Configurator

Troubleshooting installation issues

— Certifizate Generator

— Generate Certificates

Site Narme: [l

Site Path: FCinetpubh AT rek,

Web SItE |D HHEHEHEHE RS
= Local Server Hame: SMACDOMALDT

HMHHEHNMHME RN RS

Databaze Server:

REEREHERREE RN RN

D atabaze Mame:

Digeard Exizting Feys r

—&pply Bemate Server Certificates

i HE”:"?'tE Jerver C:hlozal secunty certificate
Certificate Folder

tanage Certz | Help

Status Al sites are now configured for eSyne.

Generate

To learn about eSync security certificates, see Part 2: Generate and copy

security certificates on page 1798.

Troubleshooting installation issues

Error: Failed to Create Directory

CMS400 - InstallShield Wizard

Q Error: Failed to create directory ciiinetpublwswrootCM34003ample as YWeb Application

in [15, Please perform this manually.

o

The possible cause and solutions are as follows:

» User does not have permission to create objects. Grant user permission to create
objects. For information on how to, read IIS Security help topic “Setting NTFS

Permissions for a Directory or File.”

http://localhost/iishelp/iis/htm/core/iidfpsc.htm

» Host is not localhost. Install Ektron on localhost machine only.

Error: Configuration error
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Server Error in '/' Application.

Configuration Error

Description: An srror oocurred during the processing of & configuration fie requined 1o service fhis regquest. Pleass review the specific smar detais below and mosity your configuration file sppropsiatey
Parser Error Message: Urvecoanized sttribute targetFramework’. Note that stirioute names sre case-sensitve

Source Error:

Line BO8: debugging ASP.NET files.

Line BO9: -

Line 810: ccompilation debug="false" targetFramework="4.0">

<buildProvi derss
cadd extensiol

Line 811
Line 813: n='", htm" types"System.Web,Compilation. PageBui 1dProvider” /3

Source File: Clinetpub\sited bweb config  Line: 510

¥ersion Information: Microsoft NET Framework Version:2 0 50727 4206, ASP.NET Yersion 2.0.507278

If Ektron requires .NET 4.0, but you server has a previous version of the Microsoft
.NET framework, Install the .NET 4.0 framework.

Installing Ektron on several servers

Perform these steps on the development server.

1. Complete all steps in Before you install on page 11.
2. Download and run the Ektron installation file, cMS400Basevversionnumber. exe.

3. In Windows Explorer, create a folder to be used for development (for example,
c:/cmsdev).

a. Atthe Setup Type page, select CMS 400 (Complete).

b. On the Site Setup screen, at the Select Site drop-down, select the site you
created in Step 3, dev.example.com. At Select Host, select the host you
entered for dev.example.com.

c. On the Site Path Directory screen, browse to the ¢: \cmsdev folder.

d. Onthe Host screen, enter http://dev.example.com or an IP address. A
window prompts you to define the Asset Storage Location. Enter
C:\assetlibrary\cmsdev and C:\assetcatalog\cmsdev. The Database
Setup utility begins. (See Setting up a database on page 23.)

4. Run the Site Setup utility by choosing Start > Programs > Ektron > Utilities
> CMS400 Site Setup. This installs the site on the development server. (See
Installing a site on page 17.)

If you're using Windows 8 or 2012, press the Windows key (ﬂ)/Q then enter
CMS400 Site Setup. Right click and choose Run as Administrator.

a. Enter your database name, cmsdev to continue the example. (Do not leave
it as localhost.)

b. Enter your database server information, then the host, user and password.
The database is created. The site is ready for use.

c. Open Internet Explorerand goto http://yvour web site/login.aspx to
test the site.

d. Log in to make sure the database is working.
Using the steps, install sites to your staging and production servers.
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Uninstalling Ektron

Uninstalling Ektron

Uninstalling removes all Ektron files from your server. You might want to do this if
you installed Ektron, experimented with it, and now want to remove that version and
install a clean, new version.

IMPORTANT: Do not use the Windows Add/Remove programs utility to uninstall
Ektron. Use the uninstall utility instead.

To uninstall Ektron:

1.

2
3.
4

Close all programs that are using your Ektron website. Close all Ektron files.

. GotoC:\Program Files (x86)\Ektron\CMS400vxx\Utilities.

Copy the CMS uninstaller folder to your desktop.

. From that folder, run CMSUninstaller.exe. You can uninstall specific websites,

the Ektron application directory, or all Ektron files.

(B cMS Uninstaller (el e S |

CLOSE VISUAL STUDIO BEFORE CLICKING UNINSTALL!
Choose the site you want to uninstall

AinetpubwwwrootOn Trek * || Remove Website

Site Version: 9.0.0.181
Database Name: OnTrek

| Remove Websites Database
Remove Eltron Application directory (ncludes CeH)

Remowve Ektron Solr Files and Services

Remove All Sites and Application Directory {includes CheH)

| Uninstall |

Effect of removing a website

When you uninstall a website, the following happens.

i

The IIS and Indexing Service stops.
The website's database is deleted.
The website folder's files are deleted.
The IIS and Indexing Service starts.

Effect of removing a website's database

If you check the Remove Websites Database box, the site database is removed.
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Effect of removing the Ektron application directory

If you check the Remove Ektron Application directory box, the following items
are removed.
» All Ektron services

» These Program Files (x86)\Ektron directories (if they exist)
°© CMS400v76

o CMS400v75
o CMS400v70
o Dms400
o EktronWindowsService40
o EktronWindowsService30
o EktronWindowsService20
o EktronWindowsService
o EktronCmsFileHelperService
o EktronNotificationServices
° Plugins
°© CMS400SDK

» Various system directory files

» These registry entries
o Everything under Software\Ektron

o All StarterSite keys
o SDK install key
» The base installer key

Removing search server files and services

If you check the Remove Ektron Search Server Files and Services box, the
services and files that Ektron uses for Microsoft Search Server are removed. (This
action does not remove Microsoft Search Server 2010).

Removing all sites and application directory

If you check the Remove All Sites and Application Directory box, all Ektron files
are removed.

NOTE: After you complete the uninstall, you may need to manually remove the
AssetLibrary, EktronSearchData directories.

Removing third-party programs

To remove all third-party applications required to run Ektron, go to Windows Control
Panel > Uninstall a Program and remove these programs.
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» Your search provider (for example, Microsoft Search Server 2010)
» SQL 2008 R2 Reporting Services Sharepoint 2010 Addin

e Microsoft Sync Framework 2.1 SDK

» Microsoft Visual C++ 2010 x64 Redistributable

» Microsoft Filter Pack 2.0

» Microsoft Visual C++ 2008 Redistributable

e MSXML 4.0 SP2 Parser and SDK

» Microsoft Visual C++ 2005 Redistributable (x64)

» Microsoft Server Speech Recognition Language = Tele (enUS)
» Adobe PDF iFilter for 64bit platforms

» Microsoft Chart Controls for Microsoft .NET Framework 3.5

» Microsoft Server Speech Platform Runtime (x64)

» Microsoft ASP.NET 2.0 AJAX Extensions 1.0

» Microsoft .NET Framework 4 Extended

» Microsoft .NET Framework 4 Client Profile

» Microsoft Sync Services for ADO.NET v2.0 (x64)

« Microsoft Report Viewer Redistributable 2008 SP1

» Microsoft Office 2003 Web Components

NOTE: Some applications may have been installed before you installed Ektron.

Installing help files on a local server

Beginning with Ektron Version 8.5, Ektron online help files reside in an Ektron-hosted
Web server instead of a folder on your Web server. If you block your users'
workstation access to the Internet, help files are not available, and users see an error
when they click the help button. To remedy this issue, either change the firewall to
allow access to the internet, or install help files locally.

PREREQUISITE

* You can download files to the Ektron server.
» You can edit files in your website's siteroot folder.

Step 1: Download and install the help folder on your

Web server

1. Click the following link:
http://documentation.ektron.com/cms400/v9.30/Reference/Zip/EktronReferen

ce.zip.
2. Download the .zip file to your Ektron server.

3. Create a folder called help in the Workarea folder, typically
inetpub/wwwroot/your-website/Workarea/.
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4. Unzip the file to your Ektron help folder, typically inetpub/wwwroot/your-
website/Workarea/help. (You can install help to any website folder.)

NOTE: If you installed help to another folder, replace the web.config default
value with the complete URL to that folder. For example: <add key="ek
helpDomainPrefix" value="http://www.example.com/help" />

Step 2: Change your website's web.config file

1. Edit your siteroot/web.config file.

2. Find ek helpDomainPrefix.

3. If you installed the help folder to this website's Workarea folder, remove the path
value. For example:

<add key="ek helpDomainPrefix" value=""/>

If you installed help to another folder, replace the default value with the
complete URL to that folder.
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The upgrade procedure copies Ektron’s latest features to your Web server. Ektron is
installed to its own folder, C:\Program Files (x86)\Ektron\. This means Ektron
can coexist with previous versions on the same machine—the template directories
are independent.

If you are upgrading from version 8.00 or higher, follow the instructions in this
section. If you are upgrading from an Ektron version prior to 8.00 and need
assistance, please contact Ektron technical support.

For information about the current release's system requirements, see System
Requirements. If necessary, upgrade your infrastructure before beginning the Ektron
upgrade.

Consider the following information before upgrading:

 Warning! During the upgrade procedure, your website’s Bin, Workarea and
Documentation folders are removed. Any customized files in these folders will be
lost. Only store custom files in these folders when absolutely necessary. Even
then, keep a backup file in another folder.

 Important! You cannot upgrade Ektron sample or starter sites because they are
designed to demonstrate the product's latest features, so each version is
uniquely created to support a release.

« Important! Each deployment has unique requirements. Ektron recommends
that you engage with a Certified Ektron Partner when making decisions about the
needs of your production environment.

The Site Setup utility uses files in the cMS400v9x base folder to create and upgrade
Ektron sites. The base folder contains these subfolders.
» AssetManagement. Folders and files for the Document Management Functionality
e Bin. Required .NET assemblies
» CMSServiceUpdate. Files to update your services

» CommonFiles. Application Global Resources, Web References and Starter
Application files

* Documentation. Documentation. The site setup procedure copies this directory
to the workarea directory when setting up a site.

* EktronAsyncProcessor Service. Files needed to add Asynchronous Processor
for Web Alerts

» StarterSites. Files for starter sites that have been added
e StudioHelp. Files for adding API help to Visual Studio
» SyncUpdate. Files to update eSync

e Utilities. Utilities for
° database upgrade

o database application strings update
o email encrypt password tool
o a setup SharePoint Portal
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Backing up databases

o Document Management Registration tool
° Load Balancing service files
» Workarea. Scripts used for the Workarea

NOTE: The contents of this folder are later copied to a website folder,
typically in the Web server’s Web root. The sample provides a good way to
learn how to work with an Ektron site.

Backing up databases

To protect your database, back it up before upgrading. During the upgrade, Ektron
attempts to back up your database. If that fails, use the following MSDN link for
instructions on backing up and restoring your database via SQL Server.

* Backup SQL Server

NOTE: On that web page, links for restoring a backed-up database are at the
bottom of MSDN resources.

Before restoring a SQL database, either stop the Ektron Windows service or force all
connections closed. You need to do this because the Ektron Windows Service
accesses the database. To view and update the status of the service, go to
Computer Management > Services and Applications > Services. For more
information, see Handling background processing functions with the Ektron Windows
Service on page 128.

Upgrade overview

The upgrade procedure performs these tasks.

1. Installs new files to new directories. See also: Installing the Ektron base on
page 13.
2. Removes the following folders (and their subfolders) from and copies new
folders to your site directory.
» bin
» workarea
 Documentation

WARNING! Any customized files in these folders will be lost. So, only store
custom files in these folders when absolutely necessary. Even then, keep a
backup of customized files in another folder.

3. Updates the web.configfile.
4. Updates your databases using the upgrade and language update utilities.

NOTE: The upgrade automatically starts the IIS and Search services.

Performing the upgrade
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Upgrading to

If you have not done so already, install a Search provider. You must use an
external search provider if you want to use search with Ektron. See also: Setting
up search for your website on page 181.

. Copy the Assets folder.

NOTE: This step is only relevant if you are using Microsoft Search Server
2010 on a server that is different from your Ektron server.

For Microsoft Search Server 2010 to index your Ektron assets, they must be
copied from the Web server to the Search Server. This process is handled in the
background once your site is up and running. However, if your site has a large
number of assets, the initial copy may get clogged. To avoid this problem,
inspect the size of your Ektron site's Assets folder. If it exceeds 1 gigabyte,
follow these steps. Failure to do so may result in errors.

a. Create a folder on your search server to hold the assets. The folder's path
must match the path to your Ektron site's Assets folder and include
EktronSearchData between C:\ and the beginning of the path.

For example, if your site's Assets folder is
C:\inetpub\wwwroot\OnTrek85\Assets, create a folder on your Search
Server named
C:\EktronSearchData\inetpub\wwwroot\OnTrek85\Assets.

b. Copy the Assets folder from your Ektron site folder to the Search Server
folder you created in Step a.

. Follow the steps of the installation procedure, Installing the Ektron base on

page 13, which instruct you to install Ektron and restart your server. Continue to
the next step when the Site Setup Selection appears.

. The Setup wizard appears. (If this screen does not appear, launch it by following

this path from the Windows Start menu: Start > Programs > Ektron >
CMS400vxx > Utilities > Site Setup. If you're using Windows 8 or 2012,

press the Windows key (E)/Q then enter CMS400 Site Setup.)

38 | Ektron 9.50



Performing the upgrade

CMS5400 Setup Wizard

1zard will allo I_J|:|Q[E||:|Ef_. ar reinsia

2 your heeds.

etup tupe vou would like tause from the follawing:

6. Choose an application directory. If you are not sure, use the default
(C:\Program Files (x86) \Ektron\CMS400vxx). This directory stores Ektron
components and utilities.
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NOTE: This dialog appears only if Setup cannot detect the location of the
site’s application directory.

CM5 400 Application Directory

7. If your server operating system accommodates multiple websites, select the site
to which you want to upgrade Ektron. Otherwise, accept the default.

Please select which site and host you would like to use B

Website and Host selection

kiron

=
. localhost A

Erter Host:

LCancel

TstAE Tl Back ] [
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. Select the path of the website you are upgrading. Note that the upgrade only
updates the web.config file, Ektron assembly files, and Web services/Workarea
components. It does not update your templates nor other files not mentioned
above.

Site Path Directory

Please select the directory where your CMS400 site is located. This uparade will only update
kfron Ektron CMS files. &ll user added templates, files and folders will remain untouched.

estination Folder
c:hinetpub\wwwroot

9. The following message appears. Click Yes to back up your site.

WARNING! Ektron strongly recommends backing up your site before
continuing the upgrade. If you choose No and the upgrade fails, you cannot
revert the files to their original state.

@ Wiould wou like the inskall to backup vour site? IF nok, it is

recommended vwou back it up now before continuing.

10. If you choose to back up your site, a dialog asks where to store the backup, and

provides a suggested folder.
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Ektron CMS400.NET
Site Backup

Browze...

11. If you chose to back up your site, you may see the following dialog.

Question

| security purposes. This requires the Microsoft 115 Feature ko be
== enabled on this server. Would vou like for the installation to enable
this and restrick access ko these specific site Folders? Select "es' to

'0 Ekkron requires IP Restrictions to be set on several Folders For

conkinue or "No' ko cancel the installation and configure this
manually.

Click Yes if you want the installation to

a. Enable IIS's IP Address and Domain Restrictions role.

b. Restrict access to the /workarea/webservices and /workarea/services
folders and the /workarea/ServerControlWs.asmx file, so they are only
accessible from localhost.

If you click No, the site installation is terminated.

For more information, see https://portal.ektron.com/kb/10234/.

If you click Yes and complete the installation, you may have to grant permission
to other servers that need to access the restricted folders and file. To do this:

a. GotolIs.
b. Choose the /workarea/webservices folder.
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c. Choose IP Address and Domain Restrictions.
Click Add Allow Entry from the right panel
e. Add IP addresses for each server that will access this server's
/workarea/webservices folder.
f. Repeat Steps a through e for the /workarea/services folder and the
/workarea/ServerControlWsS.asnx file.
12. On the Search Provider screen, determine which search provider you will use
with Ektron.
Ektron CMS400.MET

Search Provider

that iz free to

’ < Back ” Mext > l Cancel

See also: Setting up search for your website on page 181.

13. The Site Options screen appears. Check the box next to each option you want to
install. Boxes are grayed out if an option is not available for your site. See also:
» Viewing network server diagnostics on page 1903

» an eSync security certificate. See also: Managing eSync security certificates
on page 1838.

» Using Ektron’s Developer SDK
14. After choosing, click Install.

NOTE:
eSync is only available if you have the eSync modifier in your license key.
SDK is only available if Visual Studio 2010 is installed on your server.
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InstallShield Wizard
Site Dptions

ktron

:, and templates

PCI Compliance:

Tt Efield I < Back U Irstall ] Cancel

15. You are asked if you want to update your siteroot/widgets directory. Click Yes
to install the latest widgets. Before doing so, rename any customized widgets in
that folder; otherwise, they will be overwritten.

16. You are notified that files are moving to the starter site directory. The Choose
Destination Location screen appears.

17. Enter the path to your AssetManagement Directory.

NOTE: This dialog appears only if the upgrade cannot find the
AssetManagement directory.
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CM5400 - InstallShield Wizard

Choose Destination Location

Select folder where setup will install files. I E T~

Fleaze enter the the path bo wour current &zzeth anagerment Directan).

C: M netpubbissnaroothCh S 400E s ampletd zzethd anagemen

Browse. ..

< Back " Mest = ][ Cancel

18. If you chose to do so, your site is backed up. Next, the bin, Workarea and other

19.

20.

files are updated. Any missing permissions or Index catalogs are added.

WARNING! The previous version’s bin and Workarea folders are removed
from your website. Any customized files within these folders are lost. Do not
store custom files in them unless absolutely necessary. Even then, always
keep a backup file in another folder.

Your web.config file is updated with information needed to run Ektron. If other
applications use the web.config file, their sections are unaffected.

A dialog asks if you want to upgrade the database. Select Yes to upgrade. If you
select No, the site will not work properly until the database upgrade has been
run. To upgrade the database at a later time, run the Site Setup and select
Database Upgrade. The site setup is located in Start > Programs > Ektron
> CMS400vxX > Utilities > CMS400 Site Setup. If you're using Windows 8

or 2012, press the Windows key (E)/Q then enter CMS400 Site Setup.
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21. If you selected yes, the Database Upgrade Wizard appears. Click Install.

CM5400 Database Upgrade

will allow: pou to upgrade your C

22. This screen prompts for database connection information.

Ektron CMS400.MET
S0L Server DB Setup

Lnistalletied < Back H Mewt > Cancel
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Server. List the database server on this system. To set up the database on this
server, accept the default. Otherwise, enter a SQL or SQL Express server that
already exists. For SQL, this would typically be (local) if it's installed on the local
server. Otherwise, enter the Server’s name. For SQL Express, enter
(local)\SQLEXPRESS.

NOTE: This dialog appears if you are using SQL Authentication. If you are
using Windows Authentication, skip to the next step.

23. A dialog appears asking you to back up your database. See also: Backing up
databases on page 37

............. e e e L

24. If you clicked Yes, select the location of your database backup. If this path does
not exist on your database machine, the backup will fail. Otherwise, skip to the
next step.

Database Backup Directory

culd like to backup your databaze. This path must ale
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IMPORTANT: If the backup fails, the following message appears: Warning!
The install could not backup your database. Please manually back it
up now before continuing. You should manually back up your database
before clicking OK.

25. If your license key was not generated for the 9.x Release, you are prompted to
enter a 9.x license key. If you do not have an 9.x license key:
o Complete the upgrade.

» Obtain a 9.x license key from Ektron (send email to license@ektron.com).

» Login as builtin user. See also: Editing the builtin username and password
on page 110.

» Insert the key into the Settings > Configuration > Setup screen's >
General tab >License Key(s) field.

26. If you selected Microsoft Search Server as a search provider, the following
screen appears.

worn S ==

v The Microsoft Search Server needs to be upgraded for your search to

I hawve the latest updates. Please run the C:\Program Files

(x86)\Ektront CMS4000vE5S Litilities\ SearchServer EktronSearch Configurat
ien.exe on your Microsoft Search Server, If this has already been done
then click yes to re-register your website,

» If you have already upgraded the search server to use the Search
components, click Yes. (This would typically be the case when an Ektron
site on the server is already using search).

» If you have not set up a search provider, or the Ektron search components
have not yet been installed or upgraded to , click No.

After completing the Ektron CMS installation, install the search provider and
the search components.

If you chose Solr, the following dialog appears. Click OK.
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Search Configuration: Apache Salr @

e . You have selected Apache Solr as the search provider for your Ektron
' site, If wou have installed the Ektron Solr Search cormponents onyour
~ search server, you can registeryour site with the Ektron Solr
Sdministration console,

Please see the Ektron Reference for information an how to install the
Ektron search components and register your site,

To complete the search setup, log on to the search server, click the Windows
Start menu > All Programs > Ektron > CMS400Vxx > Utilities > Search

Configuration. If you're using Windows 8 or 2012, press the Windows key (ﬂ
)/ Q then enter Search Configuration.

The Connection Information screen appears. See also:

o Installing Solr on a single on-premises (local) server on page 216
o Setting up Microsoft Search Server 2010 Express on page 295
o Setting Up Microsoft Search Server 2010 on page 302
o Working with Microsoft FAST search on page 423
After upgrading your site and rebuilding the solution, you are ready to use Ektron.

If you did not run the database upgrade or language update during the installation,
you need to do it manually. The next sections explain how to do that.

Troubleshooting upgrade problems

Problem 1: After upgrade, Ektron does not load properly. Also, an error icon
appears next to your templates when you open the project in Visual Studio.NET. The
problem is that your .NET references need to be updated.
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Solution 1: To verify the problem, open the Ektron solution file in Visual Studio.NET
(webroot\siteroot\cms400sitename.sln; for example, cms400Intranet.sln) and
look at the template files. If your references are broken (as shown in the sample
screen on the left), delete all Ektron references. Then, add new references with the
same name from the webroot\siteroot\bin folder.

Problem 2: When viewing a page containing Ektron server controls or API calls, the
page returns a fatal error Compiler failed with Error Code 2000. Detailed
compiler output may say Fatal error BC2000: compiler initialization failed
unexpectedly: The filename, directory name, or volume label syntax is
incorrect. This error message might appear after an upgrade.

Solution 2: To remove the error message, open up your site's .sIn file in Visual
Studio. Then, rebuild the solution using the Build > Rebuild solution menu option.

In this case, the error can be resolved by correcting the database settings in
web.config.

NOTE: To use SQL Authentication with Microsoft SQL server (as opposed to
Windows Authentication), you must have the database 'Security' properties set to
allow "Windows and SQL Authentication." After changing this setting, you must
restart SQL Server for it to take effect.

Problem 3: After upgrading from Ektron version 4.8 or earlier, Metadata is no longer
applied or required when adding or editing content.
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Solution 3: In Ektron version 4.8 or earlier, Metadata is applied globally. In later
versions, metadata is applied to each folder individually. Child folders can inherit the
metadata from a parent folder or they can have their own metadata settings. To set
the metadata settings back to global:

1. Inthe Workarea, click the site root folder.
Next, choose View > Folder Properties.
Click Edit Properties.
Click the Metadata tab.

Check the all of the appropriate check boxes for Assigned and Required
Metadata.

6. Click Save.

If you have not broken inheritance on any of the folders, your metadata settings are
applied globally.

A

UTC datetime storage in the database

If you upgrade from an older version of Ektron, the UTC Converter is automatically
run after the database upgrade is complete.

Dates in the CMS are stored in UTC rather than in the server time zone, and display in
the local user’s selected time zone. The dates default back to the server time zone if
the user is not logged in.

UTC Converter

In order to complete your upgrade, all dates in the database must be converted to LITC.

Site Information

Site:

Connection: |server={local),database=52 tcOnTrek

Time fone

(@ Web Server and Database Server are in the same time zone.

() Web Server and Database Server are in different time zones. | wart to select:

Run Close

1. Choose one of the Ektron sites from a provided list.
2. Choose the time zone from which to convert data.
3. Click Run. The conversion occurs and UTC automatically closes.

NOTE: If UTC Converter is opened while running an upgrade, you are not
permitted to change the "Site."
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After installation, you can find the UTC converter at C: \Program Files
(x86) \Ektron\CMS400v93\Utilities\UTCConversion\UTCConverter,
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WARNING! Securing your Ektron site is critical to you and to anyone using your
site. Failure to implement security measures can make your site vulnerable to
cyber-attacks and other security threats. You should complete the actions in this
section to make Ektron as secure as possible.

Security updates are available for Ektron versions 8.02, 8.5, 8.6, 8.6.1, 8.7, 9.00,
9.10, and 9.20, including all service packs from 8.02 to 9.10 SP2. For information,

see Security Update 3.

» Change the password for the Admin and Builtin users.
o Do not use easy-to-guess passwords (because thieves use automatic

programs to test for easy passwords).
° Do not use passwords that you use for other systems (because if thieves
gain access to passwords on one system, they will try them on others).
» Update browsers to take advantage of advances in technology (including
security).
» Apply available service packs and updates for CMS, .NET, and Windows.

Changing the admin password

NOTE: If you changed the admin password during site setup, you do not need to
change it again.

IMPORTANT: You should create your own Administrator user and delete the
Admin user. Also, delete unnecessary users from Ektron.

In the Workarea, choose Settings > Users.

Click the Admin user.

Click Edit Users.

Enter the new password in the Password and Confirm Password fields.

Click Save.

uaua A W N =

Changing the builtin password

NOTE: If you changed the builtin user password during the site setup, you do not
need to change it again. See Editing the builtin username and password on

page 110 for additional information. Also, the “builtin” user does not appear in the
Users list. This user appears on the application setup screen.

Workarea > Settings > Configurations > Setup.

Click Edit.

Find the Built In User field.

Enter the new password in the Password and Confirm Password fields.

Click Update.

NOTE: If you cannot sign in to Ektron because the builtin user password was
changed and you do not know the new password, use the

a p W N B
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Changing the everyone group permissions

BuiltinAccountReset.exe utility. This resets your Ektron user / password to
Builtin / Builtin. This utility is located in C:\Program Files
(x86) \Ektron\CMS400versionnumber\Utilities.

Changing the everyone group permissions

By default, the root folder in Workarea provides the Everyone Group with all
permissions except Overwrite Library. You should review the permission needs of the
Everyone Group when you add a folder. See also: Managing folder and content
permissions on page 160.

1. Go to Workarea > Folders > Folders. The View Contents for Folder "Root"
appears.

2. Choose View > Properties.

3. Choose View Permissions (.fﬁ’). The View Permissions for Folder "Root"
appears.

4. Click on the Everyone group. The Edit Permissions for Folder "Root" appears.

5 & Folders & || upoaTe @
=] MainSite

= Con s
e Campaigns

=i Clients

Client Quotes 82 C1S user grou
Client Testimonials
® Community
@ ) Company Everyone i 7 Fi 7 Fl 7 Ei 7 i

My Accoun it Enable All Disable All

5. Check the permissions that you want and click Update.

Removing sample users and sample
membership users

Ektron includes sample CMS users and membership users for evaluation and
demonstration purposes. Remove these users when they are no longer needed.

» CMS users have access to the Workarea and can be content authors,
administrators or developers. These users count towards the number of users in
your license.
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» Membership users are typically people who only interact with your website but
have limited privileges to Ektron. They cannot use the Workarea and do not
count towards the number of users in your license.

NOTE: Some users in the following lists might not appear in your user list. Also,
you might have sample users that appear in your users lists. This depends on your
Ektron version.

Ektron users. See also: Managing users and user groups on page 1439
o jedit
° tbrown
° jsmith
° Vs
Membership users. See also: Membership users and groups on page 1507

° jmember

° member@example.com
° north

° supermember

° west

Removing Ektron users

1. Inthe Workarea, choose Settings > Users.

2. Check the box next to each user that you want to remove.
3. Click Delete (J%).
4,

Click OK.

Removing membership users

1. Inthe Workarea, choose Settings > Community Management >
Memberships > Users.

2. Check the box next to each user that you want to remove.
3. Click Delete (.%).

4. Click OK.

Disallowing group user accounts

A group account is an account used by more than one person to log in to Ektron using
the same username and password. This is a serious security issue because it
prevents you from tracking user activities in your Workarea. Group accounts violate
Ektron's license agreement.

Securing services
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IMPORTANT: Typically, the \workarea\services\path is used in 3-tier
implementations. Review your site architecture and configure access to support
accordingly.

You need to restrict services to specific IP addresses in IIS 7.

1. From the Windows Start menu, choose Run, then type INETMGR. If you're using

Windows 8 or 2012, press the Windows key (E) /Q then enter INETMGR. IIS
Manager appears.

2. Go to your website > Workarea > services.
3. Double click IP Address and Domain Restrictions.

™E Internet Information Services (IIS) Manager -0l x|

@... ] [ 1 v WIN-7SUK92QASAV b Sites » gitel » Workarea P services b IED |E:.E:Zlv

File View Help

@ Workarea/services Home

Open Feature

; ilter: | Go - \g v ; J Exph
FrameworkU Filter: Go - lgiShow Al |Groupby:  _ 4 Explore

| images @ r\?\ i=M \QJ ] Ed?t Permissions. ..
| ImageTool 4= e B - Manage Folder £
ASP Authentication Authorization Compression
Rules Browse Folder

N - [@] Browse site1 on *:80 (http)
-0 @ E,[glls ﬂ He.\p

Default Directory Error Pages Failed Request
Document Browsing Tracng Rules

| Moss
| MyWarkspace
“| Notifications

Online Help

~| Packaging B o
_| PageBuilder Q?i1 '_q\;
- Fesandtzation Handler HTTP Redirect

PrivateData Mappings

@ = A
Logging MIME Types Modules Output
Bundmanager Caching

1550

subscriptions S% s
| sync = =
7| TargetedContent E‘T&“&St S5L Settings
| template 9
| threadeddisc
| ToDo Management

Tree
| UrlAliasing D
| UserProfile

wamenu b Configuration
| WebCalendar Editor |
| webservices =

Widgets
rmd
4]

Ready

5

€

4. Inthe Action pane, click Add Allow Entry. The Add Allow Restriction Rule dialog
box appears.

5. Select Specific IP Address, enter the IP address of the Web server, and click
OK.
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Add Allow Restriction Rule d |

Allow access for the following IP address or domain name:

¥ Specfic IP address:

|111.22.3.4{

™ IP address range:

QK I Cancel

6. In action pane, click Edit Feature Settings. The Edit IP and Domain

Restrictions Settings dialog box appears.
7. Choose Deny from the drop-down and click OK.
Access for unspedfied dients:
Allow j
Allow

Securing WebServices

You need to restrict Web services to specific IP addresses in IIS 7.

1. From the Windows Start menu, choose Run, then type INETMGR. If you're using
Windows 8 or 2012, press the Windows key (ﬂ) /Q then enter INETMGR. IIS

Manager appears.
2. Goto your website > Workarea > webservices.
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3. Double click on IP Address and Domain Restrictions.

File  view Help

- Workarea/webservices Home
y il |5=’ .| 2 Explore
| MyWorkspace = » . == Edit Permissions. ..
| Notifications Filter: - Go - g Show All | Groupby: Area SR
| Packaging ASP.NET = Manage Folder &
| PageBuilder - Browse Folder
| Personalization =0 ‘m’ li;i [y [ 9,,, rg] Browse smacdonald1 on
| PrivateData L] z L= 192.188.14,23:80 (http)
| resources NET NET .NET Error NET {NET Profile  .NET Trust ®
B search Authorizati,..  Compilation Pages Globalization Levels &) Help
= - Online Help
7 sE0 - = al
| services IiE ab! gﬁf L_j' & L“ ol
d = = =]
| seundmanager Application Connection  Machine Key  Pages and  Session State  SMTP E-mail
1 550 Settings Strings Controls
| subscriptions
1 sync
| TargetedContent s
template -
1 = X &
| threadeddisc @ g\_,? . =0 E ‘g| ;
ToDo = E = - a9
= T ASP Authentication Authorization CGI Compression Default
| Tree
- Rules Document
| UrlAliasing
[ | UserProfile T :ll = L Emh —
= 7 ne z
-] wamenu EE,;,-' Iji ﬂ@ <,‘:_1 _GE_ <‘FE
Directory Error Pages Falled Request  Handler HTTP Redirect HTTP
Browsing Tracing Rules Mappings Respo...
®-[ Widgets L = : iy e %
5 ¥ed i = j &l i =
-] Xt IF Address Logging MIME Types Modules Output Regquest
-7 XmlFiles 1 and Dom... Caching Filtering
B QA L
[ | temp -
Ready €.

4. Inthe Action pane, click Add Allow Entry. The Add Allow Restriction Rule dialog
box appears.

5. Select Specific IP Address, enter the IP address of the Web server, then click
OK.

Add Allow Restriction Rule d |

Allow access for the following IP address or domain name:

¥ Spedfic IP address:

|111.22.3.4{

™ 1P address range:

o

al}
7]
-~
[=]

QK I Cancel

6. In action pane, click Edit Feature Settings. The Edit IP and Domain
Restrictions Settings dialog box appears.
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Choose Deny from the drop-down and click OK.

Access for unspedfied dients:

Allow j

Allow
QK I Cancel |

Securing ServerControlWS.asmx

1.

w

From the Windows Start menu, choose Run, then type INETMGR. If you're using

Windows 8 or 2012, press the Windows key (E) /Q then enter INETMGR. IIS
Manager appears.

Go to your website > Workarea.
Click Content View at the bottom of the window.
Right click ServerControlWS.asmx and choose Switch to Features View.

File  view Help

Adions
FEEIEY | Workarea Content g ServercontroWS.asm
minsite = T
OrTrek Filter: =+ [Go - lShow Al | Group by: Mo Grouping v ASP.NET Web Service
" App_Browsers Mame I Type il =/| Switch to Features View
- App_Code ] reterror.aspx.cs Visual C# Source file —=
+- | App_Data | Roles.aspx ASP.NET Server Page 8| Browse
-] App_GlobaResources ] Roles. aspx.cs Visual C# Source file Edit Permissions. ..
:_ App_WebReferences ] Seesmic.asm ASP.NET Web Service Last Modified: 3/25/2013 1:46:34
| AssetManagement 5] selectereatecontent.aspx ASP.MET Server Page PM
| assets ‘ﬁ selectcreatecontent.aspx.cs Visual C# Source file Size: 0.06 KB
- bn =] selectFolder.aspx ASP.NET Server Page B rereh
- 1:::”&”13 ] selectFolder.aspx.cs Visual C# Source file =
i =] selectusergroup.aspx ASP.NET Server Page ® Helb
o] .CS Visual C# Source file Online Help
QZSE : - Switch to Features View Page
% logs #] setcookie.aspx.cs &l Browse = file
PrivateAssets =] settings.aspx Page
. : profie 2] Settings.aspx.cs Edit Permissions. .. e S J
~_| uploadedfiles 72| share.aspx G Refresh Page
+ uploadedimages ‘ﬁ share.aspx.cs _ —————————=file
idgets, _j showcontent. aspx '@‘ Help Page
<] showcontent. aspx.cs Online Help e file
- js\gnamre.aspx SFCT Server Page _ILI
| - -
- il | B
- wwwroot hd . -
Ready Gfl.:i
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5. Double click IP Address and Domain Restrictions.

File  view Help
@ - e m] ServerControlWS.asmx Home
' |21 |8 Manage Folder -
PrivateData - -
S resources Filter: « (fllco - Fhshowal |Groupby: Area e Browse Folder
= == Browse smacdonaldlon
. ppiication onnection achine Key Bges an: ESSI0n -mai )
=1 Z:‘:;m Settings Strings Controls - 192.168. 14.23:80 (http)
[H-[] services ﬂ Help
[~ "] soundmanager s Online Help
-7 sso _
(-] subscriptions Qi !\MJ . =l E z:‘éj ]
| syne = B B = (/]
TargetedContent Asp Authentication Authorization CGI Compression Default
| template Rules Document
B[] threadeddisc - 5 o 1 T ==t
= ] P W =y
- TeDo E:/,_ /| |ﬂ: ﬁ@ 4= 9a C:E
& TFIEEI. . Directory Error Pages Failed Request  Handler HTTP Redirect HTTP
B-[] UrlAliasing Browsing Tracing Rules  Mappings Respo...
-] UserProfile
-] wamenu = =% i G="
J = = L. =
[#-[ ] webCalendar EL_ Jj'\ <'F::>n g “l o=
| webservices 1P Address Logging MIME Types Modules Output Request
| Widgets and Dom... Caching Filtering
Xsd o
- =
-] Xt @E 3
- #] ServerControlWs.asmx =i
8- XmiFiles S5 Settings  WebDAV
B3 QA Authori...
I — -
B temp [~ |
B[P wawroot -
‘ [ Content Ve
Ready €.

box appears.
Select Specific IP Address.

Add Allow Restriction Rule

Allow access for the following IF address or domain name;

{* Spedfic IP address:

|111.22.3.4{

™ IP address range:

o

s}
%]
)
[=]

o |

Cancel

In the Action pane, click Add Allow Entry. The Add Allow Restriction Rule dialog

Enter the IP address of the Web server and then click OK.

2

9.
Restrictions Settings dialog box appears.

In action pane, click Edit Feature Settings. The Edit IP and Domain
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10. Choose Deny from the drop-down and click OK.

Access for unspedfied dients:

Allow j

Allow
QK I Cancel |

Securing assets and user folders

As of version 8.50, user data is no longer indexed directly under the Assets folder.
The /users/ folder may expose user data, such as your users email addresses, when
browsing to this folder. Prevention was made within the Ektron handlers to address
this issue in version 8.00, but you should review and remove the following folder
[site root]\Assets\users if you have version 8.50 or later. If the users folder
exits, you should delete it.

Defining the default file types for assets

Enable only file types that your website needs to support.

1. Go to Workarea > Settings > Configuration > Asset Server Setup.
2. Click Edit File Types (1£).

3. Add or remove file types that your website needs.

4. Click Save (&),

Enabling firewall use

» Only open port 80 for standard websites. If you enable SSL, open port 443 also.

» If you need FTP, open port 21, but restrict access to IP addresses that need to
FTP access to your server. The same applies for SFTP, FTPES, SSH for their
respective ports.

» Do not open remote desktop ports, SQL ports, SMTP ports, or any other port
unless absolutely necessary. Instead, use a VPN tunnel through the firewall for
access to these services. Even FTP can be made accessible through a VPN tunnel.

Setting up SSL

Ektron strongly recommends configuring a secure socket layer (SSL), especially if
you are using Active Directory integration. SSL encrypts user names and passwords
during transmissions to the Ektron server that are otherwise sent as clear text. See
Updating web.config to use SSL on page 73.
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If your Web server does not have an SSL certificate, install one. If you set up an SSL
certificate and configure Ektron to use it, the login page is launched in a Secure
Socket Layer.

After completing this procedure, the Ektron Workarea and your website require the
https protocol—URLs beginning with http no longer work.

To set up SSL for Ektron:

PREREQUISITE

Your server has an SSL certificate. See http://technet.microsoft.com/en-
us/library/cc731977%28v=ws.10%?29.aspx.

1.
2.
3.

7.

Open the siteroot\web.config file.
Set the value of ek UseSsSL to true.

Set the value of ek_SSL Port to the server port that you want to use for SSL
communications.

Set the value of ek_ecom ComplianceMode to true.

. Save siteroot\web.config.

Configure IIS so that your site uses SSL only. To do this:
a. Open IIS Manager.

b. Select your Ektron website.
From the right panel, select Bindings.
Click Add.
In the Type drop-down, choose https.
In the SSL certificate drop-down, choose your server's SSL certificate.
Click OK.
From the IIS Manager's center panel, click SSL settings.
i. Check Require SSL.
See also: How to Set Up SSL on a Server.

o0 4 0 A o

If you are using a self-signed certificate, follow these additional steps.

Open IIS Manager.

Select your Ektron website.

From the right panel, select Bindings.

Select https and click Edit.

On the Edit Site Binding screen, click View....

® oo T O
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Securing Ektron

f. On the General tab, copy the value next to Issued by.

Certificate

General | petails | Certification Path |

5; Certificate Information

This certificate is intended for the following purpose(s):

* Ensures the identity of a remote computer
+ Al issuance policies

Issued to:

Essued by: ahc-serverﬂ

valid from &/ 21} 2011 to & 15 2021

[.r’ You have a private key that corresponds to this certificate.

g. Open your Windows host file.
h. Insert the URL copied in Step 7f.

Additional security measures

The following measures are also recommended.

» Encrypt cookies in web.config.

<add key="ek EnableCookieEncryption" value="true" />

NOTE: After making this change, you must reset IIS.

« Enable Captcha for new user signup and other membership features. Captcha
prevents automated tools from creating unwanted data and traffic on your site.
Set the Membership server control's EnableCaptcha property to true. See
Membership Properties.

« Enable IP filtering on all FTP sites, and WWW sites as needed. Use Ipsec filters to
accomplish this. See How to configure TCP/IP filtering in Windows 2000.
» Install needed services only (for example, FTP, www, SMTP, NNTP).

» If you make a backup of web.config, do not use another extension. The
.config extension is secured, but another extension may make the backup file
readable. (For example, web.BAK.config is secured, but web.config.BAK iS
not!)

» Remove test scripts you may have left on your site.
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Additional security measures

If you zip up databases and code, do not leave . zip files on your site.
Do not use IIS on a domain controller.

Never use virtual directories across servers.

Never install websites on the system drive.

Remove NTFS write permissions wherever possible. See How IT Works: NTFS
Permissions.

Configure a default website with extremely secure settings (for example, require
SSL, Integrated Windows authentication only, accessible from only one IP, NTFS
permissions to none on an empty home directory, and so on), then stop the site.
This results in a broken default website that 80% of hackers will blindly attack
instead of your real website.

Configure websites so that the host header matches the site's DNS name. Do
this for both HTTP and HTTPS. Do not configure the default website with
host header. This should prevent 90% of automated hacking tools from
working by sending them to your crippled default website. To do this:

1. Open IIS Manager.

Right-click your website icon.

On the Web Site tab, click Advanced.

Click the IP Address then Edit.

Enter the host header in the Host Header field.
6. Click OK to save.

Enable IIS auditing.

Enable W3 extended logging. Verify that the logged information is appropriate.
Consider enabling the following items:
o Date and time

o IP address of client
o IP address of server
o Server port
o Username
o HTTP method used to access your site
o URI Stern
° URI Query
o Status of request
See Extended Log File Format and W3C Extended Log File Format (IIS 6.0).

v AN

Set permission for IIS logs to system and local administrators only.

Remove write permissions to hklm\software for non-admin accounts.
o Administrators & System: Full

o Everyone: Read/Execute

Restrict NTFS permissions to all executable files on the system.
o Administrators & System: Full

o Users: Read/Execute
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IUSR account: execute permissions sparingly

See How IT works: NTFS Permissions.

» Restrict NTFS permissions to any script interpreters, such as Perl.

e}

[e]

o

Administrators & System: Full
Everyone: Read/Execute
IUSR account: execute permissions sparingly

» Ensure that the Everyone group has read-only permissions for these directories.

e}

e}

[e]

o

Web root

%systemroot%

%systemroot%\system32
%systemroot%\system32\inetsrv
%systemroot%\system32\inetsrv\asp
%systemroot%\program files\common files\
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Setting up development and staging
environments

You can set up your Ektron website in the following ways. You decide which
configuration is the best fit for your particular situation.

Virtual staging

Use Ektron’s approval process and scheduled publishing of content to manage when
content goes live.

Case 1: Virtual
Staging

gy =

Staging is accomplished through
Ektron CMS workflow process.

» Best choice when changes to templates and library files are infrequent
* No special implementation guidelines; just an installation on one server

» When upgrading this type of site, make a temporary copy of the site (both
display layer and database) on a separate server to test the upgrade

Same server, same database

» Production and development/staging sites use separate copies of Ektron but
reside on same server and point to same database

» Ektron’s settings, managed content, and library files are identical between sites
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Same server, different databases

Case 3: Same
Server, Same DB

- T
—

|

Copy DB 1o I

I tast upgrade |
-

e

To set up this configuration:

» To maintain file paths between sites:

o Create separate websites in IIS.

o Assign different ports to the production and development/staging sites. For
example, the production site is http://www.example.com, and the
development/staging site is http://www.example.com:8080.

» Both sites must use the same pathing relative to the Web root. For example,
www.example.com\Workarea\applicationAPI.asp and
dev.example.com\WorkarealapplicationAPI.asp.

» Because both sites use the same database, editing and publishing content on
one site affects the other site. As a result, the development/staging server
always has the freshest content.

» Make the Ektron uploadedimages/ and uploadedfiles/ folders IIS virtual
directories that point to the same physical directory.

» Template changes must be copied between sites. The best way to copy site
templates and other assets is eSync. This is described in Synchronizing servers
using eSync on page 1787.

o If eSync was not implemented and changes to these items are infrequent,
you can manually copy them.

To test and QA an upgrade, make a temporary copy of the site’s display layer on a
separate server connected to the development/staging database.

If the development/staging database is the master, back it up before upgrading.

Same server, different databases

» Production and development/staging sites use separate copies of Ektron’s
display layer, reside on same server, but point to different databases

» Changes to content, configuration, or library files made in one site must be
copied to other site
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Case 2: Same

Server, Different DBs

Production
Sita DB

of Content

500 Regplication

To set up this configuration:

» To maintain file paths between sites:

Create separate websites in IIS.

Assign different ports to the production and development/staging sites. For
example, the production site is http://www.example.com, and the
development/staging site is http://www.example.com:8080.

Separate the databases for isolation.

One database is the master, and the other is a copy

Only edit content in the site connected to the master database

Remove the Ektron login page from the site connected to the copy database

» To copy the Ektron database, your best choice is Ektron’s eSync feature. This is
described in Synchronizing servers using eSync on page 1787.

« If you have not implemented eSync, copy site content using a replication tool for
the database.

SQL Server 2008 SDK Replication: See SQL Server Replication.

» Library files. Make sure the Ektron uploadedimages/ and uploadedfiles/
folders IIS virtual directories point to the same physical directory.

» Templates and other file system assets—The best way to move these is eSync. If
that was not implemented and changes to these items are infrequent, you can
manually copy them. For automated replication, use a product such as Microsoft
Application Center.

» Upgrading Ektron. To test an upgrade, make a temporary copy of the site’s
display layer on a separate server connected to the development/staging
database. If the development/staging database is the master, back it up before
upgrading.

Separate servers, same database

» Production and development/staging sites reside on separate servers, which
point to the same database.
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Separate servers, separate databases

» Ektron settings, content, and library files are identical between sites.
» Changes to templates must be copied between servers.

Case 4. Separate
Servers, Same
Database

B

l‘

O

CMS
Replicates
Library Contanl

To set up this configuration:

» Configure Ektron’s Load Balancing feature to copy uploaded images and files
between the servers.

» The best way to move site templates and other assets is eSync. This is described
in Synchronizing servers using eSync on page 1787.

» If that was not implemented and changes to these items are infrequent, you
can manually copy them. For automated replication, use a product like
Microsoft Application Center.

» When upgrading Ektron:

Back up the file system of the development/staging server.
Make a temporary copy of the production server database.
Switch the development/staging site to use the copy.

Test and QA the upgrade on the development/staging server.

R

Separate servers, separate databases

» Production and development/staging sites are installed to separate servers and
point to different databases

» Changes to content, configuration, or files must be copied between sites.
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To set up this configuration:

Both sites must have the same pathing relative to the Web root, for example,
www.example.com\Workarea\applicationAPI.asp and
dev.example.com\WorkarealapplicationAPI.asp.

Separate the databases for isolation.
» One database is the master, and the other is a copy

« Only edit content in the site connected to the master database

» Remove the Ektron login page from the site connected to the copied

database
The best way to copy site templates and library files is eSync. This is described in
Synchronizing servers using eSync on page 1787.

» If that was not implemented and changes to these items are infrequent, you
can manually copy them. For automated replication, use a product like
Microsoft Application Center.

To copy the Ektron database (containing HTML and XML content), your best
choice is Ektron’s eSync feature.

» If you have not implemented eSync, copy site content using a replication
tool for the database, such as SQL Server 2008 SDK Replication. See
SQL Server Replication.

Make sure the Ektronuploadedimages/ and uploadedfiles/ folders IIS virtual
directories point to the same physical directory.

When upgrading Ektron:

Back up the file system of the development/staging server

Make a temporary copy of the production server database
Switch the development/staging site to use the copy
Test and QA the upgrade on the development/staging server

e
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Copying the site and database to other servers

Copying the site and database to other servers

When your project is ready to be tested in house, move the site to a staging server.
When the project is ready to go live, move the site to a production (live) server. You
can use the same database for all environments. Back up that database often to keep
it safe. Alternatively, create a separate database for each server.

To create new environments:

1.

6.

On the same server or a separate server, create new folders for Ektron:
C:/cmsstage and/or C: /cmsproduct.

. InIIS, create a new domain for each server. http://stage.example.com points

to c:/cmsstage and http://www.example.com points to c¢: /cmsproduct.

. If all environments are on the same server, you do not need to copy other

folders. But, if you are using a separate server for each environment, copy the
c:/assetcatalogand c:/assetlibrary folders to the other servers.

. For the database, access the SQL manager and make a backup of the

development database. Then, create new databases for staging and production.
Finally, restore the backup of the development database to the staging and
production databases.

. In the staging and production environments, open web.config. Then, update

the database connection information so that it points to the new databases.
Test the staging and production environments.

Setting up the certificate for IS 7

See Configuring Internet Server Certificates (IIS 7).

Updating web.config to use SSL

1.
2.

Open the siteroot/web.config file.

Find these settings.

<add key="ek UseSSL" value="false" />
<add key="ek SSL Port" value="443" />

. Setek UsessL to true.

WARNING! If ek UsessL is true, but you did not install the certificate to the
Web Server, you cannot log into Ektron.

. Setthe ek SsSL Port to 443 (unless you specified another SSL port).
. Find the following line: <add key="WSPath" value="http://server

name/site name/Workarea/ServerControlWS.asmx" />

. Change http to https.
. Edit the <wsHttpBinding>/<security> element so it looks like this:
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<security mode="Transport">
<transport clientCredentialType="None"
proxyCredentialType="None" realm="">
</transport>
</security>

8. Save and close the file.

Managing web.config

Ektron’s web.config file lets you control many key functions of your content
management system. When you install Ektron, web.config is placed into
webroot/siteroot.

If your server is currently running another .NET application, you must merge that
web.config file with this one. To distinguish Ektron’s tags, they begin with ek and
reside within the <appSettings> tags of the web.configfile.

The following sections show the settings in the web.config file.
Analytics

» See Running Google Analytics on page 510.
Connection strings

For SQL Server, use this connection string to define an SQL server.

e name. ektron.DbConnection
» providerName. System.Data.SglClient

» connectionString. this part of the connection string contains the following
element.

» server. the name of the database server to which Ektron is installed. If installed
locally, the value is localhost. This value is set during installation, at the Host
screen.

« database. use the name of the database.
» Integrated Security. use True or False. True. use integrated security.

» user. If required, specify the username used to connect to the DSN. This user
account must have at least read and write permissions to the database.

NOTE: This value can be blank if you are using Windows authentication.

« pwd. If required, specify the password for the username given. It should match
your database name.

NOTE: This value can be blank if you are using Windows authentication.

IMPORTANT: After changing any database settings, you must stop and
restart the Ektron Windows Service. See also: Handling background
processing functions with the Ektron Windows Service on page 128.

appSettings
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ek_AdvancedWorkflowEnabled. Enables or disables advanced workflow;
when set to false the original (basic) approval functionality is available.

ek_appName. The name of the application, CMS400. You typically would not
change this value.

ek_appPath. This element is prefixed by the ek_sitePath value and describes
the location of the Workarea folder. This file stores external applications (such as
eWebDiff), templates, and the images folder.

ek_appImagePath. The folder that stores Ektron images, such as toolbar
icons. Only change this value if you need to move the images folder to another
location. This value is prefixed by the value in the ek _appPath variable. By
default, ek appPath is set to webroot/siteroot/workarea/. So, by default, this
folderis set to webroot/siteroot/workarea/images/application/.

ek_appXSLTPath. The folder that stores XSLTs. Only change this value if you
need to move the XSLT folder to another location. This value is prefixed by the
value set in the ek _appPath variable. By default, ek appPath is set to
webroot/siteroot/workarea/. S0, by default, this folder is set to
webroot/siteroot/workarea/Xslt.

ek_buildNumber. Value set by the installation program. You typically would
not change it.

ek_cmsversion. Value set by the installation program. You typically would not
change it.

ek_enableLegacyBlogFields. Determines whether the Summary tab displays
the 9.00 fields for Tags, Traceback URL and Pingback URL when you create a
blog post. In 9.10, the defaultis false. Setting it to true uses the functionality
from 9.00 and earlier versions. (Blog subjects will display but will not allow
changes to be saved without setting the value to true.)

ek_LDAPMembershipUser. Integrate membership users with LDAP or Active
Directory. Set the value to True for Membership Users to be authenticated using
LDAP/AD.

ek_RedirectFromLoginKeyName. Provides a mechanism to return from the

login page to the previous page, specify the query string key-name. By default

the value is RedirectUrl. Currently, the redirect works in 2 instances.

1. When a user tries to use a forum but is not logged in, it sends them to a

login page and returns them. The value in this key used in conjunction with
the ek RedirectToLoginURL key sends the user from a forum page to a
login page and back to the previous page.
For example, a user tries to reply to a forum post but is not logged in. The
user is sent to the login page, then returned to the original page.

2. A user sends a private message to another user or group administrator from
the SocialBar server control. In this case, once the message is sent, the user
is returned to the page from which he/she clicked private message.

For example, you visit a community group’s page and click Private
Message Admin. You are directed to the private message screen. When
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you click post, you return to the community group’s page. For additional
information, see ActiveTopics.

ek_RedirectorInstalled. Turns the redirector on or off. Turning the redirector
on alloes you to alias your website's URL. The default is False.
° True. Aliasing turned on.

o False. Aliasing turned off.
See also: Creating user-friendly URLs with aliasing on page 1293.

ek_RedirectorManualExt. Set a comma-delimited list of Web page extensions
for which you will create aliased pages. For example, .aspx, .htm, .html. By
default, the list contains.aspx. See also: Creating user-friendly URLs with
aliasing on page 1293.

NOTE: You can enter several extensions. Each extension must begin with a
period, and the last extension must be followed by a comma (,).

ek_RedirectToLoginURL. The URL of a login page to which to redirect a site
visitor who is not logged.
ek_sitePath. The location of Ektron relative to the Web root. This value is set
during installation at the Site Path Directory screen. If you move Ektron to
another folder, you must update this value.
ek_TreeModel. Choose whether or not to use Ajax for the folder tree in the
Workarea.

° 0. use the legacy folder tree in the Workarea.

o 1. use Ajax for the folder tree in the Workarea.

NOTE: This key has been removed from the web.config file. However,
you can still use this key by adding it between the <appsettings> tags.
For example, <add key="ek TreeModel” value="0">changes the
Workarea folder tree to legacy.

ek_workareaDateFormat. Choose how to display dates in some areas of the
Workarea.

° long. example: Tuesday May 21, 2014

o short. example: 5/21/2014
ek_xmlPath. The location of the xmlfiles directory. The ek sitePath path is

prefixed to this location. Only change this value if you want to move the location
of the xml files relative to the Web root.

GoogleMap. Enter connection information for using Google Maps with the
Mapping feature in Ektron. See also: Map.

VirtualEarthMap. Enter connection information for using Bing Maps for
Enterprise with the Mapping feature in Ektron. See also: Map.

Images

These images appear before a user logs in, so cannot be stored in the database.
Update as needed. Their location is set in the ek appImagePath variable. See also:
ek _appImagePath.
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 ek_Image_1. close button

» ek_Image_2. small login button

» ek_Image_3. big login button
SMTP server configuration

See Enabling email notification on page 98.

+ ek_SMTPPass. The password set up to send and receive email
» ek_SMTPPort. The port your system uses to retrieve email
» ek_SMTPServer. The server that processes email
» ek_SMTPUser. The username set up to send and receive email
Mail format
+ ek_MailFormat. The format of the email created in Ektron.HTML generates
email in HTML format, while Text generates plain text email.
SSL support

See Updating web.config to use SSL on page 73.

» ek_SSL_Port. SSL port used by Web server.
» ek_UseSSL. Determines if server uses SSL for security.
Active Directory Server Configuration

See Using Active Directory with Ektron on page 1472.

 ek_ADAdvancedConfig. Enable Active Directory advanced configuration.
» ek_ADEnabled. Whether Ektron uses Active Directory support.

» ek_ADPassword. Password for the Active Directory server.
 ek_ADUsername. User name for the Active Directory server.

 ek_AUTH_Protocol. The directory access protocol used with the Active
Directory feature. The default value is LDAP. Other protocols are GC (global
catalog) and WINNT.

Menu settings

 ek_MenuDisplayType. Determines the appearance of the content menu that
appears within every content block after the user logs in.

NOTE: This setting only works if ek UserMenuType is set to zero (0).

» 0. Horizontal—menu icons are arranged horizontally
» 1. Vertical—menu icons are arranged vertically and include the tooltip text

+ ek_UserMenuType. Determines the appearance of the content menu that
appears within every content block after the user logs in.
° 0. New dynamic menu—only appears when user moves cursor over content
block

o 1. Old classic menu—always appears

o 2. Menu without borders—a silver pin head appears above content that has
a menu available. Hovering over this pin produces a menu.
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Multilingual settings

+ ek_DefaultContentLanguage. Sets the 4 digit, decimal representation of the

default content language. For example, American English is 1033. See also:
Setting the default language on page 1398.

ek_EnableMultilingual. Enable or disable multilingual content support.
o 1. enable

o 0. disable

See also: Enabling/disabling support for multiple language content on
page 1395.

ek_ServerURL. Mainly used in Web services to determine a remote server
location. For example, in a Web farm environment, the content server can reside
in @ remote location. In this case, the developer’s content is replaced with this
value, so all <img src=""../>and <href... references point to server named
here instead of the local one.

Machine translation

Lets you enter the path to the Google Translation Service API key. See also: Enabling
machine translation on page 1418.

Miscellaneous settings

ek_assetPath. The folder that stores assets. Only change this value if you need
to move the Assets folder to another location. Note that this value is prefixed by
the ex appPath value. By default, ek appPath is set to webroot/CMS400Min. So,
by default, this folder is set to webroot/CMS400Min/assets.

ek_BatchSize. The number of files that can be uploaded at one time. The
default is 4, but it can be any non-negative number.

NOTE: Users can upload any amount of files. The system handles them 4 at a
time.

ek_CacheControls. Enable or disable caching for Ektron server controls. See
also: Caching with Server Controls.
° 0. Disable

o 1. Enable

ek_EditControlMac. Defines the editor used by a Macintosh operating system
user. See also: Changing the default editor on page 582.

ek_EditControlWin. Defines the editor used by a Microsoft Windows operating
system user. See also: Changing the default editor on page 582.

ek_EnableMessageBoardEmail. Set to True to enable e-mail notification
when a user posts a message to a user or community group’s message board. If
true and a user posts to another user’s message board, the board's owner is
notified. If true and a user posts a message to a community group’s message
board, all group members are notified. This setting does not affect content
messages. See also: Sending notifications to a community on page 1543.
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ek_helpDomainPrefix. The path to the help files. By default, help files are
located on an external server and the path is

http://documentation.ektron.com/cms400/v[ek cmsversion]/webhelp

Change this path if you install help files on a local server. See also: Installing
help files on a local server on page 33.

ek_InvitationFromEmail. The "From” email address used when a user sends
an Invitation. Invitations are emails that are sent to non-system users asking
them to join your site. See also: Invite server control.

ek_LinkManagement. This setting determines if Ektron uses linkit.aspx when
inserting a quicklink. By default, it is set to false. If set to true, when a user
inserts a quicklink, Ektron inserts a special link instead of a quicklink. A special
link determines the correct quicklink to use when a site visitor clicks it. For
example, a user adds a content block to folder A. A quicklink to that content is
a.aspx?1id=10. Later, if an administrator changes the folder’s template but
doesn’t update the quicklink within the content block, the quicklink is broken. To
avoid this problem, enable link management.

ek_LogFileName. Path to the log file name for the message queue

ek_loginAttempts. Ektron has a login security feature that, by default, locks
out a user after 5 unsuccessful attempts to log in. See also: Restricting login
attempts on page 108.

ek_LoginScreenWidth. The width of the login screen in pixels. You may need
to widen the screen if you are using Active Directory and database names are
long.

ek_PageSize. This setting determines the maximum number of items that can
appear on a page before it “breaks.” When a page breaks, additional entries
appear on another screen, and the following appears near the bottom of the list:
Page 1 of 2

[First Page] [Previous Page] [Next Page] [Last Page]

NOTE: The above text changes depending on the page you are viewing.

ek_QueueName. Path to the message queue.

ek_ShowWorkareaRetErrorReferrer. Choose whether to enable referrer
debug information on the RetError.aspx page.
° True. enable

o False. disable

ek_ToolBarFormatTag. This setting only applies after a user logs in to your
site. Change this setting if the colored border that surrounds content looks
wrong. (The border color indicates the content’s status.) By default, <table>
tags create the border. If the border looks wrong or inappropriate, change
setting to div. If you do, <div> tags are used to draw the border instead of
<table> tags. This change typically solves the problem.

ek_WorkarealLibSearchResultMode. Sets the Workarea Library search-
results mode.
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o text. returns a text only version of the library search results.
o mixed. returns text and images associated with library search results.
o graphical. returns a images associated with library search results.

» ek_XliffVersion. Define the XLIFF version to use when exporting files. See
also: Exporting content to XLIFF on page 1418.

« WSPath. Determines the location of the Web services page used by the server
controls at design time.

system.diagnostics

» LoglLevel. Enter a numeric value that determines the level of message logging.
By default, diagnostic messages are logged in the Event Log. Choices are:

1—Error: log errors.

2—Warning: log errors and warnings.

3—Information: log errors, warnings and informationals.
4—\Verbose: Everything is logged.

ektronCommerce

IMPORTANT: Ektron has discontinued new development on its eCommerce
module. If you have a license to eCommerce, you will continue to receive support,
but if you need to upgrade, contact your account manager for options.

See Conducting eCommerce on page 1605.

 ek_ecom_ComplianceMode. When set to true, your site is Security
Compliant. This means the Workarea is encrypted in an SSL session and Logging
is started.

 ek_ecom_DefaultCurrencyld. Select the default currency and enter its
Numeric ISO code. This should be done before creating your product catalog.
See also: The default currency on page 1638.

WARNING! Do not change the default currency or measurement system
after your eCommerce site is live.

» ek_ecom_TestMode. When set to true, payments are sent to a test gateway
instead of the actual one.

» ek_MeasurementSystem. Select whether to use English or Metric
measurements for your packages. See also: Configuring packages on
page 1662.

mediaSettings
See also: Managing multimedia assets on page 657.

- application/x-shockwave-flash. Define the relationship between the
Shockwave Flash mime type and the Flash player.

» audio/mpeg. Define the relationship between the MPEG audio mime type and
the Windows Media Player.
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+ audio/x-ms-wma. Define the relationship between the MS-WMA mime type
and the Windows Media Player.

« audio/x-realaudio. Define the relationship between the realaudio mime type
and the Real player.

» audio/x-wav. Define the relationship between the WAV mime type and the
Windows Media, Quicktime and Real players.

» audio/x-wav-default. Define the relationship between the WAV default mime
type and the Windows Media Player.

» Flash-CLSID. The class ID for the Flash player.

+ Flash-Codebase. Location of the code base plug-in for Flash player.

* Quicktime-CLSID. The class ID for the Quicktime player.

» Quicktime-Codebase. Location of the code base plug-in for Quicktime player.
» Realplayer-CLSID. The class ID for the Real player.

» Realplayer-Codebase. Location of the code base plug-in for Real player.

» video/mpeg. Define the relationship between the MPEG video mime type and
the Windows Media Player.

» video/quicktime. Define the relationship between the Quicktime mime type
and the Quicktime player.

» video/x-avi. Define the relationship between the AVI mime type and the
Windows Media, Quicktime and Real players.

» video/x-avi-default. Define the relationship between the AVI default mime
type and the Quicktime player.

» video/x-msvideo. Define the relationship between the msvideo mime type and
the Windows Media, Quicktime players.

» video/x-msvideo-default. Define the relationship between the msvideo
default mime type and the Windows Media Player.

» video/x-ms-wmv. Define the relationship between the MS-WMV mime type
and the Windows Media Player.

» video/x-realvideo. Define the relationship between the realvideo mime type
and the Real player.

« WindowsMedia-Codebase. Location of the code base plug-in for Windows
Media Player.

 WindowsMedia-CLSID. The class ID for the Windows Media Player.
Miscellaneous
« HttpHandlers. This section sets how the URL Aliasing feature handles URLs with
certain extensions. If you have any extension you do not want aliased, add it

below the following line using the same syntax.

add verb="*" path="*.png" type="URLRewrite.StaticFileHandler,
Ektron.Cms.URLRewriter" />

« maxRequestLength. This setting determines the maximum size of files that
can be uploaded to your server. The default setting is 204,800 kilobytes, or 200
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MB. Enter the desired value in kilobytes. To convert megabytes to kilobytes, go
to OnlineConversion.com.

» session state. Mode—determines the storage option for session data. Ektron
supports all session-state modes listed in this article: Session-State Modes.

Migrating your site to Ektron

This section explains how to migrate your website to Ektron, as follows.

» What to copy to your website
» Setting up and deploying templates

Before you migrate

» Ektron requires a physical installation of the product. If you do not have physical
access to the machine, someone with access to the machine must run the install.
For more information, see Installing Ektron on page 11.

» After you install Ektron, verify that it is properly installed by using the starter
site. By default, the sample website is located at the following address on the
machine to which Ektron is installed.
http://localhost/siteroot/default.aspx

If you can browse the starter site and it works properly, Ektron is properly
installed.

BEST PRACTICE

Keep a working version of the starter site to help you debug
problems. For example, if you encounter errors on your site, try to
reproduce on the starter site. If you can, that may indicate a problem
with the installation. If you cannot, the installation is probably OK and
an external factor is causing the problem.

Setting up a new site

NOTE: You can use the Site Setup utility to perform these tasks by choosing Start
> Programs > Ektron > CMS400 > Utilities > Site Setup. See Installing a
Site on page 17.

If you're using Windows 8 or 2012, press the Windows key (E)/Q then enter
CMS400 Site Setup. Right click and choose Run as Administrator.

1. Copy application core files. Copy these files from the siteroot/workarea folder
into your site folder. These files operate the Workarea, library, and content
functions.

2. Set up the database. Content is stored in a database. To learn how to set one up,
see Setting up a database on page 23.

3. Modify application parameters. Modify the web.config file installed to the Ektron
site root directory. In that file, update the <ConnectionString> tags to point to
your server, database, user, and pwd.
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NOTE: If you are using SSL, web.config settings are explained in Setting up
SSL on page 62.

. Create a Login Page. You can either copy the one from the starter site or create
your own. See also: Log-in server control.
. LogIn
a. Browse to the login page you created and click Login. A login dialog box

opens asking for a username and password.

b. Enter the admin username and password and click Login. (You selected

these while installing Ektron.) You are logged into Ektron.

. Modify configuration settings. Click Workarea to modify these settings.

» Set up Active Directory. If plan to use Active Directory, configure this now.
The settings for Active Directory can be found in the Settings >
Configuration folder. Refer to Using Active Directory with Ektron on

page 1472.

Modify the Setup screen. The Ektron setup section is located under the
Settings > Configuration folder. The setup section lets you configure
items such as your license key, style sheet support, and default language.
See Modifying setup information on page 121.

Set up Metadata. Ektron includes extensive metadata support. Settings for
metadata definitions can be found under the Settings > Configuration
folder in the Workarea. You can have as many metadata definitions as
needed. See also: Working with Metadata on page 755.

Set up Smart Forms. You can also set up your Smart Forms. You create XML
files externally or via the Data Designer. Next, a Smart Form is assigned to
content blocks and folders. See also: Working with Smart Forms on

page 815.

. Create Ektron users. If you are not using Active Directory support, add users
manually. The maximum number of users is determined by your license key. For
instance, if you purchase a 10-user license, you can enter 10 users. If you
exceed the licensed number of users, you may get locked out of Ektron. Every
user must belong to a group. When you first add a user, the user is automatically
added to the Everyone group. You can create more user groups and add users to
them as desired. See also: Managing users and user groups on page 1439.

. Configure content and forms folders. Create folders to organize content blocks
and forms. Create as many folders as you want. Each folder level can go as deep
as you want. See also: Planning your CMS folder structure on page 142.

. As you create folders, you can assign a default template and style sheet. The
default template is used when a new content block is created and Ektron creates
a Quicklink that points to the new content block. If you do not provide a default
template, it is inherited from the parent folder.

After creating the folders, assign permissions and workflow to them. Permissions
can be assigned to a user or a user group. The same is true for workflow.

BEST PRACTICE
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Limit permissions for the "Everyone” group, as this gives every user
permissions to content. Similarly, limit the “Everyone” group’s
inclusion in the workflow to restrict which users can publish content.

10. Create templates. Templates determine the look and feel of the site. Masthead,
navigation, and footer graphics are all part of the template. Use server controls
to insert Ektron content into a template. For a list of server controls, see Server
Controls.

BEST PRACTICE

Because dynamic templates include URL parameters, make each
main landing page and other important pages static tags. This makes
it easier for you to remember if you need to provide that link to
someone.

For instance, each main landing page from your home page could use
the static tag. Then, as you go deeper into that section, subsequent
pages use a dynamic tag.

11. Migrate or create content. You can create or migrate your content. If you are
migrating content from an existing site, add a new content block, and cut and
paste the content into the Ektron editor.

NOTE: All images and files must be uploaded and inserted into the content
separately.

12. Deploy the content. Deployment from development to production is as simple as
moving the files over. To properly deploy your new Ektron website:
a. Copy all assets (templates, images, files, and so on) from your development
box to your production machine.
b. Move the database. You have 2 choices
» point your data source on the production machine to the database you
were using.
» copy the database, move it to your production server, and point a data
source to that.
13. Optionally, for email notification to work in Ektron, make sure the SMTP service
is setup and running in IIS, and that it points to a valid mail server. See Enabling
email notification on page 98.

Setting up an additional site

After installing Ektron, it is easy to create another site. While creating the new site,
you can create a sample or minimal site and database. To create a site for your
content, you typically install a minimal site and database, then create your Web page
templates. Later, add users and content.
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Setting up an additional site

1. Set up New Site.
a. Create a new folder in the Web root folder to contain the site files.

b. From the Windows Start menu, choose Start > Programs > Ektron >
CMS400 > Utilities > SiteSetup.

If you're using Windows 8 or 2012, press the Windows key (E)/Q then
enter CMS400 Site Setup. Right click and choose Run as Administrator.

c. Follow the steps for creating a new site, as described in Installing a site on
page 17. When prompted to select a folder to which you want to install the
files, choose the folder you created in Step 1.

2. Set up New Database. After installing an Ektron site, it is easy to create a new
database. You can create either a sample or minimal database. When creating a
database for your content, you typically install a minimal database.

a. From the Windows Start menu, choose Start > Programs > Ektron >
CMS400 > Utilities > SiteSetup .

If you're using Windows 8 or 2012, press the Windows key (E)/Q then
enter CMS400 Site Setup. Right click and choose Run as Administrator.

b. On the Setup Type screen, choose CMS400 Database Setup.

Setup Type

Select the setup tupe that be

ch zetup twpe pou would like to uze from the following;

O ChSA00 Full Inztallation

® CMS400 Data

Instal Ehield i T e e e BT el v e
it Ll J 1 |

c. Follow the steps for creating a new database, as described in Setting up a
database on page 23.

3. Create Project in Visual Studio.NET. To work with the new site in Visual
Studio.NET, you must create a new project for it. To do that:
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a. Go to the folder that contains the new site.

b. Double click Ektron’s solution file. If you are using the minimal database, the
file is cMS400Min.sln.
At this point, you can build the project and log in. If you cannot log in

because you have not set up the license key, use the builtin account: by
default, the username is builtin and password is builtin.

IMPORTANT: You should only use the builtin account temporarily. As
soon as possible, you should insert the license key and log in under a
user name assigned in Ektron.

To learn about creating templates and using server controls, see Ektron
Server Controls.

Supporting multi-site configurations

Ektron’s multi-site support lets you set up and manage several websites under one
CMS. (The multi-site support feature does not support multiple databases.) You
manage content in the additional sites the same way you work with content in the
root site. You log into a root site then begin editing content in an additional site.
Regardless of which site you are using, you can use the library to insert common
hyperlinks, images, files, and quicklinks.

IMPORTANT: Place any file (such as an XSLT file) that needs to be shared among
sites in a multi-site environment in a virtual folder. Also, you cannot create a
quicklink within content, a collection, menu, and so on to a form that resides in
another site.

PREREQUISITES

o All sites reside on the same server.

» Each site has a multi-site license key. To purchase additional licenses,
contact Ektron sales.

Advantages of multi-site configurations:

e The URL can indicate the nature of the site to visitors
° www.example.com

° support.example.com
o forums.example.com

» All sites can share a single database
°o common content, but appear within their own site and templates

° ashared library of images and files. These files can be stored once; authors
can insert them into content from any site.

In the Workarea, sites appear in Ektron’s folder structure with a globe icon.
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Best practices for working in a multi-site

A folder to which a production domain is assigned is a domain folder. Links to content
in a domain folder are activated via 1inkit.aspx, which redirects to the appropriate
domain name using the appropriate template for the folder or content.

Best practices for working in a multi-site environment

BEST PRACTICES

IMPORTANT: Do not remove your root site!

» Log into the root site before working with the root site or any secondary site.
o Exception: If you are a content author, log into the site for which you are
authoring content.
« Do not log into a secondary site then add files to a different secondary site.
There are 2 ways to install multi-site support. (The automatic setup is easy to use
and minimizes issues.)

» Automatic multi-site setup below
» Setting up Ektron on page 67

Automatic multi-site setup

IMPORTANT: Before creating a multi-site configuration, you must have installed
an Ektron website. All installed folders must remain in that site. The original site
cannot have virtual folders. Also, you cannot nest a multi-site under another IIS
site.

1. Create each new site in IIS. See http://www.iis.net/learn/manage/creating-
websites.
2. Run the Multi-Site Setup Wizard.

a. Double click c:\Program Files
(x86) \Ektron\CMS400vxx\Utilities\MultiSiteInstall\Multisite.exe

b. Use the pulldown to select the site you created in Step 1.
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c. Select your host.
Please select which site and host fer your multisite X

e W

Ektron CM5400 Site Setup %

Fleaze zelect the site you would like to install to.

Select Site: Default 'web Site v]

Drefault web Site

ektronhelp

SharePaint \Web Services

SharePoint Central Administration 4
Selact Haozt: ShareFaint - 80

[ Ember Host b anually

d. Enter a path to the new site.

MultisiteSetup - InstallShield Wizard S|

Site Path Directory
. e

Toinstall to this folder, click Mest. Toinzstall to a different folder, chck Browse and select
anather folder.

Setup will ingtall the zite files into the fallowing folder.

D estination Folder

C:hinetpubhssaroothSite Browsze. . |

| I Carcel I

e. Identify your main website; that is, the site to which this multi-site is being
added.
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MultisiteSetup - InstallShield _ |

Site Path Directory - .QM

Fleaze chooze the main website

Destination Faolder

C:hinetpubhwsnroothOnT rek

.............

f. When prompted to add a multi-site key, click Yes.

g. Enter alicense key for the new site. This step copies the new site's license
keys to the database.

h. Enter information about the new site's database.
i. Follow the remaining screens in the wizard.

3. Assign multi-site capabilities in Ektron.
a. Loginthe Workarea.

b. Click Content.
c. Click the site root folder.

NOTE: Site folders must reside within the site root folder.

d. On the View Contents of Folder screen, create a new top-level site folder for
each site by choosing New > Site.

e. Assign site folder properties as you did for the root folder. The Multi-site
Configuration fields appear on the lower section of the screen.
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Add a Subfolder to folder "Root”

€| ADDFOLDER (2]

Taxonomy Templates Flagging Metadata Web Alerts Smart Forms

Site Name:

Description:

Style Sheet: o Trak/

TO Tl

Staging Domain: bttp:f

roduction Domain: -y

Office Documents: PR

Prrtrretre
Please Hote: POF generation must also be enabled in the configuration file of the Ektron windows Service

* [existing documents are not converted undil re-published)
ContentSearchable: Inherit parent configuration

Mantant Saarchahkla

f. In the Staging Domain field, insert your staging domain.

IMPORTANT: Production and staging URLs must be unique across
multi-sites. In other words, in a multi-site configuration, one site's
production or staging URL cannot be the same as another site's
production or staging URL.

g. Inthe Production Domain field, insert your production domain.
h. Click Add Folder. Within Ektron, new sites are indicated by a globe icon.

Creating multiple websites on a single server

NOTE: This text is adapted from Microsoft’s IIS help.

IIS lets you create multiple websites on a single server.

Before adding a website

Adding a website to a server requires careful preparation before running the Website
Creation Wizard. Consider these recommendations.

» Review the methods of hosting multiple websites, and determine which one is
appropriate for your environment.
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Multiple websites can use the same IP address. But if you decide to use a unique
IP address for the new website, obtain a static IP address from your organization
or ISP. Then, configure the server’s TCP/IP settings.

If you use a host header name to identify the new website, select a unique
name. On a private network, the host header can be an intranet site name. But
on the Internet, the host header must be a publicly available Domain Name
System (DNS) name, such as support.microsoft.com. Register a public DNS
name with an authorized Internet name authority.

Update your name resolution system (typically DNS) with a new record that
contains the new IP address and site name. For more information, see Domain
Name Resolution in IIS help.

Standard Internet services use TCP port 80 by default. It is not recommended to
use any other port for HTTP services.

If you use a non-standard TCP port number to identify a new website for special
situations (such as a private website for development/testing), select a TCP port
number above 1023. In this way, the number does not conflict with well-known
port numbers assigned by the Internet Assigned Numbers Authority. (For more
information about IANA and port assignments, see List of TCP and UDP port
numbers.)

Use Windows Explorer to create a home directory for the content. Create
subdirectories to store HTML pages, image files, and other content as needed.

To organize home directories for multiple websites on one server, create a top-
level directory for all home directories, then subdirectories for each site.
You can create a home directory

° on the local server
° as a uniform naming convention (UNC) path on a network share
° as a URL that redirects clients to a different Web server

You can also create virtual directories that map to physical directories. For more
information, see “Setting Home Directories” and “Using Virtual Directories” in
IIS help.

Determine whether to generate the website’s identification number
incrementally or from the website name.

Create a home page that clearly identifies the new site.

Adding a website

IIS provides 2 methods for adding a new website.

The Website Creation Wizard
The iisweb.vbs command-line script

IMPORTANT: You must be a member of the Administrators group on the local
computer to perform the following procedure (or procedures), or you must have
been delegated the appropriate authority. As a security best practice, log on to
your computer using an account that is not in the Administrators group, and then
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use the Run as command to run IIS Manager as an administrator. From the
command prompt, type runas /user:administrative_accountname "mmc

%systemroot%\system32\inetsrv\iis.msc".

Using IIS 7's website creation wizard

1.
click Add Web Site.

*E Internet Information Services (115

@ « | % » swacoona: »

File  Wiew  Help
e-H|7 |8

-5 Start Page
E‘HE] SMACDOMALDT (SMACDONALD1 A
= L=} Application Paols

=
& Gwebsts>

&3 Refresh

kel k-

-E-E-E-E- e

2. Click Next. The following dialog appears.

In IIS Manager, expand the local computer, right-click the Sites directory, and

Add Web Site EE3 |

Site name; Application poal;
|| IDeFault.ﬁ.ppPDDI Select.., |
—i_onkent Direckory
Physical path:
Pass-through authentication
Conneck as... | Test Setbings. ..
— Binding
Twpe: IP address: Port:
Ihttp j IP.II Unassigned j IEI:I
Host narnme:
Exarmple: wany, conkoso,cam ar marketing, conkasa,com

¥ Start web site imrnediately

= |

Cancel
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o Site Name. Enter the website name.

» Application Pool. Click Select if you want to select a different application
pool than the one listed in the Application Pool box. If you do, the Select
Application Pool dialog box appears. Select an application pool from the list
and then click OK.

» Physical path. Enter the physical path to the website's folder. Or, click the
browse button (...) to go the file system and find the folder.If the physical
path that you enter is to a remote share, click Connect as... to specify
credentials that have permission to access the path. If you do not use
specific credentials, select the Application user (pass-thru authentication)
option in the Connect As dialog.

» Type. Select the protocol for the website from the Type list.

o IP Address. The default value in the IP address box is All Unassigned. If
you must specify a static IP address for the website, type the IP address in
the IP address box. All Unassigned refers to IP addresses assigned to a
computer but not a specific site. The default website uses all IP addresses
not assigned to other sites. Only one site can be set to use unassigned IP
addresses for a given port number. For more information on how sites are
identified, see Creating Multiple FTP Sites in IIS help.

» Port. Enter a port number. The TCP port is assigned to port 80 by default.
To use a nonstandard port number to create a unique identity for a private
website, enter a new port number above 1023.

 Host name. Optionally, enter a host header name for the website.If you
are adding additional sites to a single IP address by using host headers, you
must assign a host header name containing the full name of the site, for
example, world.optimizely.com/ektron/.

» Start website immediately. Check this box if you do not have to make
any changes to the site and want it to be immediately available.

Adding a website with a command line script in lIS 7
To add a site, use the following syntax:

appcmd add site /name: string /id: uint /physicalPath:
string /bindings: string

The variable namestring is the name, and the variable iduint is the unsigned integer
that you want to assign to the site. The variables namestring and iduint are the only
variables that are required when you add a site in Appcmd.exe.

NOTE: If you add a site without specifying values for the bindings and
physicalPath attributes, the site will not be able to start.

The variable physicalPathstring is the path of the site content in the file system.

The variable bindingsstring contains information that is used to access the site, and
it should be in the form of protocol/IP address:port:host header. For example,
a website binding is the combination of protocol, IP address, port, and host header. A
binding of http/*:85: enables a website to listen for HTTP requests on port 85 for all
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IP addresses and domain names (also known as host headers or host names). On the
other hand, a binding of http/*:85:marketing.contoso.com enables a website to
listen for HTTP requests on port 85 for all IP addresses and the domain name
marketing.contoso.com.

To add a website named contoso with an ID of 2 that has contentin c:\contoso, and
that listens for HTTP requests on port 85 for all IP addresses and a domain name of
marketing.contoso.com, type the following at the command prompt, and then press
Enter.

appcmd add site /name: contoso /id:2 /physicalPath: c:\contoso /bindings:http/*:85:
marketing.contoso.com

See also: Appcmd.exe (IIS 7).

Balancing the load on your servers

Load Balancing has 2 purposes:
» Provides redundancy for your website—if one server fails, a second can handle
requests
» Balances requests—distributes requests across multiple servers
To enable load balancing, set up several servers that include the same files.

IMPORTANT: The physical path to the Ektron website must be the same on all
load balanced servers. Also, sticky sessions must be enabled.

Purchase load balancing equipment to evenly distribute content requests among
servers. Then, whenever an image or file is uploaded, regardless of the Web server
the user is working on, the asset is replicated on all servers.

The client browser is unaware that more than one server is involved. All URLs point to
a single website. The load balance software resolves them.

Ektron provides different strategies for load balancing library images and files and
DMS assets. See also: eSync in a load-balanced environment on page 1878.

Load-balancing library images and files

Library load balancing is important when your configuration consists of 2 or more
websites that share one database. When uploaded, library files are saved to the site
root folders uploadedfiles and uploadedimages.

To support load balancing, library files on all servers must be identical. To maintain
this state, whenever a user uploads a library item, it is copied to the corresponding
folder on other servers in the configuration.

1. Openthefile c:\Program Files
(x86) \Ektron\EktronWindowsServiced0\Ektron.ASM.EktronServices40.ex

e.config using a word processor such as Notepad.
2. Setthe value of the LibraryLoadBalanced property to 1.
3. Setthe value of the AssetslLoadBalanced property to 1.
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Load-balancing assets

4. Set the value of the LoadBalServerCount property to the number of servers in
your load balance cluster.

5. Save the config file.
6. Restart the Ektron Windows Service.

Mame - Descripticn Status Startup Type Lg ~
. Ektron Asset Transfer Server This service ... Running  Automatic Lc
. Ektron CMS5 File HelperService Used for file.. Running  Automatic Lc
. Ektron Motification Service This service ... Running  Automatic Lc
4 Ektron Windows Services 4.0 This service ... Running  Autol Start
Ektron Workflow Timer Service  This service .. Running  Autor
+: Encrypting File System (EFS) Provides th... Manu; Siup
Extensible Authentication Proto... The Extensi... Manu; Pause
« Function Discovery Provider H...  The FOPHO... Manu; Resume

Function Discovery Resource P...  Publishes th... Manu;
Auton

+; Google Update Service (gupdate] Keeps your .. Al Tack
asks
. Google Update Service (gupdat.. Keeps your .. Manu;

-~ o — - n . = Refrach

See also: Handling background processing functions with the Ektron Windows
Service on page 128.

Load-balancing assets

Asset load balancing is important when your configuration consists of 2 or more
websites that share one database. To balance requests to work with assets across
multiple servers, Ektron ensures that each server in the configuration has a copy of
every asset.

So, after setting up asset load balancing, any asset added to one server is copied to
the corresponding folder on the other servers in the configuration. There is no limit to
the number of servers that can be load balanced.

To set up load balancing for assets, follow these steps on all servers in the load
balance configuration.

1. Within the /siteroot folder, open the AssetManagement.config file using a
word processor such as Notepad.

2. Change the value of the LoadBalanced element to 1.

Save the file.

4. Open the following file using a word processor such as Notepad:

C:\Program Files (x86)\Ektron\EktronWindowsserviced0\
Ektron.ASM.EktronServices40.exe.config

[68)

5. Setthe value of the LibrarylLoadBalanced property to 1.

6. Set the value of the LoadBalServerCount property to the number of servers in
your load balance configuration.

7. Save the config file.

Ektron Reference I 95



Setting up Ektron

8. Repeat steps 1 through 7 on each server in the load balance cluster.
9. Log on to Ektron. This action sets up the load balance software in the database.

Refreshing load-balanced files

* You must be a member of the Administrators group to access the
Load Balancing screen.

» Your Ektron license key contains a load balance component

Asset and Library files may become out-of-date or lost due to equipment failures,
power outages, or other events. You Load Balance software may have the ability to
sync these files.

Ektron also provides a screen which ensures that all files in the DMS Assets folders
and the Library Files and Images folders are identical across the servers in the

LB configuration. In addition, the Refresh screen ensures that the contents of the
siteroot\Templates and siteroot\Workarea folders are identical across servers.

NOTE: For load balancing refresh to work properly, open Port 8732 on load
balanced servers.

To refresh load balanced files:

1. Workarea > Settings > Configuration > Load Balancing.

Load Balancing

(] @

Refresh Load Balanced Files
Click Start to force a refresh of DMS assets and library images and files across all Start
servers in a load balanced configuration.
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2. Click Start. A status screen appears.

Load Balance Refresh Status

w" Load balanced file folders are refreshed.

Uploaded Files Refresh Started
Uploaded Files Refresh Ended
Uploaded Images Refresh Started
Uploaded Images Refresh Ended
Private Assets Refresh Started
Private Assets Refresh Ended
Assaet Library Refresh Started
Asset Library Refresh Ended

Completed Load Balance Refresh |:||

Load Balance Refresh Complete

3. Verify that the status screen shows servers you expect to be refreshed. Server
name WS10155 is circled in the example.

IMPORTANT: If you click Start and the screen quickly returns and files do
not refresh, or if a server is missing from the status list, check Load Balancing
settings in Extron.ASM.EKtronServices40.exe.config.

4. When finished viewing the status, click Close.

Load-balancing status

* You must be a member of the Administrators group to access the
Load Balancing screen.

» Your Ektron license key contains a load balance component
To check the load balancing status:

1. Workarea > Settings > Configuration > Load Balancing.

2. Click the toolbar button (‘&). The status screen shows either the previous
refresh or the current refresh in progress

Setting up a user for the Ektron database

The installation automatically sets up user permissions based on data collected
during setup. However, if you have issues with user permissions, this section
describes how to install manually.
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NOTE: If you are using SQL Authentication, you only need to set up the SQL user.
If you are using Windows Authentication, you need to set up IUSR and an IIS_
WPG or Network Service user.

1. Inthe SQL Server Management Studio, select Security > Logins.
2. Right click and select New Login.

3. Onthe Login dialog, click Search to the right of the Login name field. Network
Service

4. Select your server.

5. Enter ASPNET, IIS_WPG, or Network Service user (depending on your
Windows version).

6. Click Add then OK.

7. Select your Ektron database. Then, assign permission to read and write to that
database.

8. Run the grant permission script.

NOTE: Before doing this, review your users and their permissions. Adjust as
necessary for your configuration. Also, if you use Windows Authentication and
all users are domain users (and the database administrator wants it this
way), you may not have to perform this step.

a. Open SQL Server Profiler.
b. Choose File > Open.

c. Openc:\Program Files
(x86) \Ektron\CMS400vnn\Utilities\SiteSetup\Database\cms400

permissions.sqgl. (nNn represents the release number)

d. Within that file, replace [MACHINENAME or DOMAINNAME\USERNAME] with
your domain name, backslash (\), and ASPNET (the ASP.NET machine
account). For example, [ws10080\ASPNET].

NOTE: If you are using Microsoft Windows 2003 Server or Microsoft
Widows Vista, the useris 11s wpG. For example, [ws10080\IIS WPG]. If
you are using Microsoft Windows 2008 Server, the user is Network
Service.

e. Click Execute Query (F).

f. Replace the text between square brackets with your domain name,
backslash (\), and the IIS Internet Guest Account. For example,

[ws10080\IUSR ws10080]. Click Execute Query ( }).

g. Ifusing SQL server authentication, replace the text between square
brackets with the SQL server authentication name only. Do not include the

domain name. Click Execute Query ( *).

Enabling email notification

Microsoft’s SMTP service can be set up to send an email that notifies a user when a
task (such as approving a content block) was performed or needs to be performed.
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This section explains how to enable email notification in Ektron.

To process email, Ektron uses CDOSYS. Using Simple Mail Transport Protocol (SMTP)
and the Network News Transfer Protocol (NNTP) standards, CDOSYS enables
Windows applications to route email and USENET-style news posts across multiple
platforms. CDOSYS lets authors create and view sophisticated emails using HTML
and data sources.

NOTE: If CDOSYS is not installed on the SMTP email server, it tries to use the
CDONTS mail server protocol.

For CDOSYS to work, set up the SMTP server on your Ektron server or a remote
system that sends and receives email. It is good practice to run SMTP on a server
separate from your Ektron server. However, your Ektronserver must relay email
messages to your SMTP server.

NOTE: To access an SMTP server on a local or remote system, consult your
organization's email administrator.

» Local. Before setting up an SMTP server locally, install IIS. Below are examples
of SMTP server settings on a local system.

“ek SMTPServer" value=“localhost”
“ek SMTPServer" value=%127.0.0.1"
“ek SMTPServer" value=“myname”

« Remote. Set up an SMTP server on a remote system. Below are examples of
SMTP server settings on a remote system.

“ek SMTPServer" value="smtp.example.com”
“ek SMTPServer" value=“example.com”

Use this article to configure SMTP in IIS7: Configuring SMTP E-mail in IIS 7.

Next, configure Ektron to use SMTP.

1. Openthe siteroot/web.configfile.
2. Find the section with these settings.

<!-- SMTP Server configuration -->
<add key="ek SMTPServer" value="localhost" />
<add key="ek SMTPPort" value="25" />

<add key="ek SMTPUser" value="" />
<add key="ek SMTPPass" value="" />
<add key="ek SMTIP EnableSsL" value="" />

3. Setthe ek SMTPServer value.

4. Setek sMIPPort to the port your system will access to retrieve email. In most
cases, the port is 25. If that is not the case, consult your organization's email
administrator.

5. Set ek SMTPUser to the username that is set up for the SMTP server to send and
receive email. Typically, the username is an email address, such as
"ek SMTPUser" value="yournamel@example.com".
This retrieval of email is based on how basic authentication is set up for you. You
do not need a username when using a local SMTP server. Check with your
system administrator for details. If you are using a remote system for accessing
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email, you must provide an authenticated username before you can send or
receive email.

6. Setek sMTPPass to the password set up for the SMTP server to send and
receive email. This password is based on basic authentication. Ektron only
accepts encrypted passwords.

7. To encrypt the password, use Ektron's password encrypting tool.
a. OpencC:\Program Files (x86)\Ektron\CMS400vxx\Utilities

b. Run EncryptEmailPassword.exe. The Encrypt Utility dialog appears.

Encrypty. 1.1.0.1

Copyright [z] 1333-2000, Ektron, Ihe.

Teut: [l

Encrypted: I

Encrypt | Cloze

c. Enter your SMTP password in the Text field.
d. Click Encrypt. The screen displays an encrypted password.

e. Copy the encrypted password and paste it into the web.config file's "ek
SMTPPass" wvalue.

8. Setek SMTP EnableSsLto true.

9. Set IP Address and Domain Restrictions by following these steps. See
also: https://portal.ektron.com/kb/10234/.
a. Onyour Web server, open IIS.

b. Click your website > workarea > services.
c. Click IP Address and Domain Restrictions in the right pane.

NOTE: If you do not see this option, enable it through your server's
Roles, or by adding it as a Windows feature.

d. Click Add Allow Entry for IP addresses or the IP address range that will
connect to the server to access the services APIs. Add all IPs for each
server, not just the primary.

100 | Ektron 9.50



https://portal.ektron.com/kb/10234/

Using Google as an SMTP server

IP Address and Domain
< - | fin| |ﬁ' ~  Restricti Add Allows Entry.
| MobileDevicePreview - estrictions add Deny Entry,
-] Moss . ) -
H - Use this feature ko restrick or grant access to Web content . |
Bl Mytiorkspace based on IP addresses or domain names, Set the Eult Fereoel
-] Motifications restrickions in order of priority, Revert To Paren
(-] Packaging ) Wigw Ordered Lis
51| PageBulder Group byt Ma Grouping -
[+ Personalization Mode = | Requestor | Ertry Type ® Help
(-] PrivateData online Help
B+ resources Add Allow Restriction Rule 3
-] search
Bllow access far the fallowing IP address or domain name:
S d> ot
[ L Commerce Specific IP address:
" soundmanager
_ 550
-] subseriptions " IP address range:
-1 svne T

e. Repeat steps b-d for the workarea > webservices folder and the
/workarea/ServerControlWsS.asmx file.

NOTE: To access the features for the ServerControlWS.asmx file:

1. Right click the Workarea folder and select Switch to Content View.
2. Locate the ServerControlWS.asmx file.

3. Right click the file and select Switch to Features View.

4. Open the IP Address and Domain Restrictions feature.

Using Google as an SMTP server

If you want to use smtp.google.com as an SMTP server, use TLS encryption and port
587.

You cannot use implicit SSL. This is because .Net Framework does not support
implicit SSL which, by default, uses port 465. See also: SmtpClient.EnableSsl

Property.

SMTP error messages

When submitting content to an approval process, if you get an error message listed
below, it is generated by the SMTP server on which you set up the mail system, not
by Ektron.

» The Transport failed to connect to the server. [CBR SendMail R1] [CBR R65]
[DIOR 36]

» The server rejected one or more recipient addresses. The server response was:
550 5.7.1 Unable to replay for yourname@example.com [CBR SendMail R1]
[CBR R1] [DIO R36]

Automatic email notification

Ektron's automated system sends email to users when an action has been, or needs
to be, performed. See also: Customizing Ektron email with tokens on the next page.

Email is generated when any of the following content actions takes place.

» Submitted to be published—email sent to next approver
o Submitted to be deleted—email sent to next approver
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» Published to website—email sent to author
» Declined to be published or deleted—email sent to author
To be notified of these actions, the following must be set:

» In the Application Setup screen
° avalid System E-Mail Address was entered

o the Enable Sending of System Notification Email box is checked
See also: General tab on page 122.

» In the Edit User screen, for each user to receive notification email
° avalid E-Mail Address was entered

o the Disable Receiving of Workflow and Task Email box is unchecked
See also: Managing users and user groups on page 1439.

The Tasks feature also has automatic email notification. See Setting up task types
and categories on page 1343.

Customizing Ektron email with tokens

Ektron can send email notification to users, informing them that actions have taken
place or are requested of them. For example, a content contributor receives an email
that the contributor's content was published. These emails are stored in resource
files, where each email consists of one string for the subject and one for the body. To
learn about editing the resource file, see Translating the Workarea on page 1431.

Each message is called in the presentation layer by its message title. Ektron does not
support HTML email, however the message text is fully customizable.

The body of an email can include tokens, located between @ symbols. Ektron
replaces them with the information for that instance of the email. For example,
@appContentTitle@ in the following sentence is replaced with the email’s title.

» Before: The content "@appContentTitle@” has been deleted.

» After: The content "Home Page Content” has been deleted.
You can customize the emails, move the tokens, add text, rewrite and reorganize.

» Before: "@appContentTitle@"” has been deleted from the XYZ website.
» After: “"About Us” has been deleted from the XYZ website.
Carriage Return/Line Feeds are represented by @appCRLF@. These cause the email
to move down one line. For example:
» Before: The content was approved.@appCRLF@Thank you!
» After: The content was approved.
Thank you!

Ektron email tokens

Ektron email tokens are specialized for the type of email message you need to send.
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» Notify CMS users

o

@appApprovallList@. The current approval list that the content block must
pass through.

@appChangeDateTime@. The date and time changes will be updated on
the website.

@appComment@. Displays the comments for the content block.
@appContentLink@. The link to the content block on the website.

NOTE: You must be logged in to see the changes.

@appContentTitle@. The title of the content block.
@appCRLF@. A carriage return.

@appDeclinerFirstName@. The first name of the user who declined the
content block.

@appDeclinerLastName@. The last name of the user who declined the
content block.

@appDeletionDateTime@. The date and time the content will be deleted
from the website.

@appEmailFrom@. The address of the email sender.
@appEmailTo@. The address of the email recipient.

@appFolderPath@. The location of the content block in the Ektron folder
tree.

@appPassword@. Displays the account password for ResetPassword and
RequestResetPassword message types.

@appSubmitterDateTime@. The date and time the content block was
submitted.

@appSubmitterFirstName@. The first name of the user who submitted
the content block.

@appSubmitterLastName@. The last name of the user who submitted
the content block.

» Notify discussion board users—Discussion board email.

[e]

o

o

o

@appForumUrl@. The forum’s URL.

@appHostUrl@. The host site’s URL.

@appPosterDisplayName@. The display name of the person who posted.
@appPosterId@. The integer ID of the person who posted.
@appPosterProfileUrl@. The profile URL for the person who posted.

@appPostMessage@. The text of the message posted to the discussion
board.

@appPostUrl@. The URL of the post on the website.
@appRecipientDisplayName@. The display name of the email recipient.
@appRecipientEmail@. The email address of the email recipient.
@appRecipientFirstName@. The first name of the email recipient.

Ektron Reference I 103




Setting up Ektron

o @appRecipientId@. The email recipient’s integer ID.

o @appRecipientLastName@. The last name of the email recipient.
o @appTopicld@. The integer ID of the topic.

o @appTopicTitle@. The title of the topic.

» Invite users to participate in a community group—Community group email.
 @appFriendDisplayName@. The recipient's name.

» @appFromUserDeleted@. Token message is from a user that was
deleted.

« @appFromUserDisplayName@. The name of the user from whom the
private message was sent.

o« @appFromUserID@. The ID of the user from whom the private message
was sent.

» @appGroupName@. The group a person is being invited to join.
 @appInvitedEmail@. The recipient's email address.

 @appInviteId@. Appends the invite ID to the registration URL. For
example:

Click <a href=http://www.example.com/register.aspx&fInvId=
@appInviteId@>here</a> to accept.

» @appMessage@. The Message field of the private message (message body
text).

« @appOptionalText@. Text a user types into the Optional Message box
on the Invite server control.

» @appPrivateMessageID@. The CMS ID for the particular private
message.

« @appSenderName@. The sender of the invitation.
 @appSubject@. The Subject field of the private message.

« @appToUserDisplayName@. The name of the user receiving the
message.

« @appToUserID@. User ID of the user receiving the message.
+ @appToUserMessageID@. The CMS ID of the recipient's message object.

» Notify a subscription list of users through a Web Alert—Web alert email.
o @appComment@. The comments for the content block.

o @appContentLink@. The link to the content block on the website.

NOTE: You must be logged in to see the changes.

o @appContentTitle@. The title of the content block.

o @appContentURL@. The URL of the content, from the quicklink and
domain.

° @appCRLF@. A carriage return. Moves text down one line.

o @appSubmitterFirstName@. The first name of the user who submitted
the content block.

104 | Ektron 9.50




email notification tokens

o @appSubmitterLastName@. The last name of the user who submitted
the content block.

o @appSubscriptionNames@. Comma separated list of subscriptions that a
user selected.

You can insert these membership tokens into the confirmation message.

= @appActivateld@. Account ID

= @appAvatar@. Avatar

= @appDisplayName@. Display name
= @appEmail@. email address

= @appFirstName@. First name

= @appLastName@. Last name

= @appSignature@. Signature

= @appUserName@. UserName

email notification tokens

The list shows tokens you can use to customize email messages. When the email is
sent, the corresponding description replaces the token.

@appApprovallList@. The current approval list that the content block must
pass through.

@appChangeDateTime@. The date and time changes will be updated on the
website.

@appComment@. Displays the comments for the content block.
@appContentLink@. The link to the content block on the website.

NOTE: You must be logged in to see the changes.

@appContentTitle@. The title of the content block.
@appCRLF@. A carriage return.

@appDeclinerFirstName@. The first name of the user who declined the
content block.

@appDeclinerLastName@. The last name of the user who declined the content
block.

@appDeletionDateTime@. The date and time the content will be deleted from
the website.

@appEmailFrom@. The address of the email sender.
@appEmailTo@. The address of the email recipient.
@appFolderPath@. The location of the content block in theEktron folder tree.

@appPassword@. Displays the account password for ResetPassword and
RequestResetPassword message types.

@appSubmitterDateTime@. The date and time the content block was
submitted.

Ektron Reference I 105




Setting up Ektron

 @appSubmitterFirstName@. The first name of the user who submitted the
content block.

« @appSubmitterLastName@. The last name of the user who submitted the
content block.

Default Ektron email messages

The following messages are used if basic workflow is applied to content. To view the
messages with advanced workflow, see Notifying users of advanced workflow
activities on page 707.

» Approved Content Awaiting Go Live Date

Message Title: content changes approved.

Message Text: Content changes have been approved.
» Approved Content Published Immediately

Message Title: content has been changed.
Message Text: Content changes have been made.

» Decline Approval Request
Message Title: approval request declined.
Message Text: Content approval request declined.
» Deletion of Content Approved
Message Title: content deletion approved.
Message Text: Deletion of content has been approved.
« Immediate Deletion of Content
Message Title: content has been deleted.
Message Text: Content has been deleted.
» Send Approval Message

Message Title: request for approval.
Message Text: Request for content approval.

Sending instant email

In addition to automatic email, Ektron lets you email a user or user group from many
screens. An email icon (1) next to a user or group name or on the toolbar indicates
your ability to do this. Screens in the following features support instant email.

o Tasks

e Approvals

* Reports

e User groups

When you click one or more user/group hames then the toolbar's email icon, a screen
appears.

NOTE: The email software must be configured for your server. See Enabling email
notification on page 98.
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When the email screen appears, the following information is copied from Ektron into
the email.

» To. User you selected to receive email. If the user does not have a valid email
address, an error message appears. If you then insert a valid address, the email
is sent. If you specify a group to receive the message, as long as one group
member has a valid email address, all group members with valid addresses
receive the email. You can edit and add recipients.

 From. User signed on to Ektron. You cannot edit this field.

» Subject. If the email message is linked to content, its title appears. You can edit
this field.

+ Body of message. If the email message is linked to content, a content link
appears. You can edit this field.

Managing logins and passwords

This section describes how to log in and out, restrict login attempts, and manage
passwords.

Logging into an Ektron website

PREREQUISITE

» URL (Web address) of your website. Your system administrator provides this.
» Username and password
To log into an Ektron site:

1. In a Web browser, enter the URL of your Ektron website.
2. Click the Login button. The Login dialog box appears.
g login

| & help |

Click here to log in|

ektron

User:

Pwd:
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3. Enter your username and password.

If you are using an Ektron sample site, you can use any of 3 standard users that
demonstrate Ektron’s flexible user-permissions model.

 Administrator. Username: admin; Password: 2?2?2?; Permissions: All

NOTE: When Ektron is installed, you are prompted to change the admin
user's name and password.

» Standard user. Username: jedit; Password: jedit; Permissions: Basic
(for example, add/edit content, manage library files, and so on)

« Membership user. Username: jmember; Password: jmember; Permissions:
Read-only permission to private content

4. Click the Login button. The Web page appears. See also: Managing content on
page 591.

Logging out

1. Click Logout from the content menu, or on the Web page. The Logout
confirmation box appears.

LOGOUT |

2. Click Logout. You return to the Web page from which you logged out. However,
it is in standard view, not Ektron view.

Restricting login attempts

Ektron can lock out a user after 5 unsuccessful attempts to log into one computer.
You control login security via the ek _loginAttempts elementin the
siteroot/web.config file.

Possible values for ek loginAttempts.

» 1 through 254. The number of unsuccessful login attempts after which a user is
locked out

e 0. Lock out all users

» -1. Disable feature; unlock all locked users

» -2. Lock out Ektron users only; membership users can log in
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If a user unsuccessfully tries to log in more than the specified number of times, an
error appears: The account is locked. Please contact your administrator.
After that happens, even if the user enters the correct password, the user is locked
out.

NOTE: You can change the error message text in the resource file. See also:
Translating the Workarea on page 1431.

Unlocking a locked account

When an account is locked out, the Account Locked field is checked on the Edit User
screen.

E-Mail Address:

Account locked 7

Content and Forum Editor: eWWebEdit400 El

To unlock the account, an administrator user (or a user assigned to the User Admin
role) accesses the Edit User screen and unchecks the box. At this point, the user can
login.

NOTE: To unlock all users, open siteroot/web.configand set ek login
Attempts to -1.

Manually locking a user from logging on
You can use the Account Locked field to manually lock a user out of Ektron.

1. Inthe Workarea, go to Settings > Users.
2. Click the user then Edit.
3. Check the Account Locked field.

That user cannot login until either you uncheck the box or open siteroot/web.config
and set ek login Attempts to-1.

Preventing Ektron users from logging on

To lock out all Ektron users, open siteroot/web.config and set ek login Attempts
to -2. If you do, only membership users can log in.

NOTE: The builtin user cannot log in if ek loginAttempts is set to -2.

Preventing all users from logging on

To lock out all users (including membership users), set the ek loginAttempts
element in the web.config file to 0. If you do, no one can log in to Ektron until you
change the value.

NOTE: The builtin user cannot log in if ek loginAttempts is setto 0.
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Changing images used for logging in and out
You can change the images used for the login and logout buttons. To do so:

1. Move the new images to the following folder:
siteroot\Workarea\images\application.
2. Openthe web.config file in your website’s root directory.

3. Change the images in this section of the file:
<add key="ek Image 1" value="btn close.png" />
<add key="ek Image 2" value="btn login.png" />
<add key="ek Image 3" value="btn login big.png" />

NOTE: You must update the images and web.config whenever you upgrade
Ektron.

Resolving a problem with the login screen

You may find that in certain browsers, the login screen occupies the entire browser
window instead of just a small box. Browsers such as Internet Explorer 8 and Firefox
have a feature called tabs. When the login window pops up, it may appear as a new
tab. You can change this behavior by turning off tabs within the browser.

Managing passwords

This section explains various aspects of managing passwords.

Editing the builtin username and password

WARNING! Use the builtin user only to correct a bad or expired license key. Itis
not designed for regular Ektron operations, such as editing content.

The builtin user is an emergency user to use if you cannot log into Ektron. The builtin
user can log in to Ektron whether or not Active Directory or LDAP is enabled.

If you log into the Workarea as the builtin user, you can access only the following
screens on the Settings tab.

e Active Directory

» Asset Server Setup

e Setup

» User

e User Group

If the builtin user password was changed and you don‘t know it, you cannot log in. In
this case, use the BuiltinAccountReset.exe utility, which resets the
username/password to builtin/builtin. This utility is located in c:\Program Files
(x86) \Ektron\CMS400versionnumber\Utilities.

The builtin username and password are entered during installation. You can change
them on Ektron's setup screen.

PREREQUISITE
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Ektron's password security policy

You are a member of the Administrators group.
1. From the Workarea, choose Settings > Configuration > Setup. The
Application Setup screen appears.
Click Edit.
Locate the Built In User fields.
Change the username or password or both.
Click Update.

vk wn

Ektron's password security policy

If you use the Workarea or the API to add a CMS or membership user, or if you
change an existing user's password, Ektron enforces a security policy. By default, the
policy enforces these criteria:

» atleast 5 alphabetical and numeric characters

» atleast one uppercase letter

You can modify the criteria by editing the Regex Expression tab on the Application
Setup screen. See also: Password Regex tab on page 126.

IMPORTANT: This policy is new as of Ektron Release 9.10. If you upgrade from
an earlier version, this policy does not affect existing users' passwords.

Enforcing a password change every 90 days

Ektron has a security feature that forces an administrator or user with the Commerce
Admin role to change the password at least every 90 days. This feature is only
enabled if the ek ecom ComplianceMode key in the site’s web.config file is set to
true.

If such a user goes 85 days without changing the password, a dialog appears upon
log-in, asking to change the password. If the user does not want to, click Skip. The
user can repeat this for the next 5 days. After 90 days since the password was
entered, the user must enter a new password before he or she can log in.

Enforcing log in after time of inactivity

Ektron has a password security feature that automatically logs out an administrator
or user with the Commerce Admin role after 15 minutes of inactivity. Activity is based
on requests made to the server.

This feature is enabled if the site’s web.configfile's ek ecom ComplianceMode key is
set to true. In addition, if you are using IIS7, the <add
name="EkUrlAliasModule"... line in the following code needs to appear between
the <modules>tags in the web.config file. This line is a part of the default install—
make sure it has not been removed.

<modules>
<add name="MyDigestAuthenticationModule"
type="Ektron.ASM.EkHttpDavHandler.Security.DigestAuthenticationModule,
Ektron.ASM.EkHttpDavHandler" />
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<add name="ScriptModule"
type="System.Web.Handlers.ScriptModule, System.Web.Extensions,
Version=1.0.61025.0, Culture=neutral,
PublicKeyToken=31bf3856ad364e35" preCondition="integratedMode" />
<add name="EkUrlAliasModule" type="UrlAliasingModule"
preCondition="integratedMode" />
</modules>

Enforcing a minimum password

Ektron has a password security feature that forces an administrator or user with the
Commerce Admin role to use at least 7 characters in a password. Further, the
password must contain at least one alphabetic and one numeric character.

This feature is enabled only when the ek ecom ComplianceMode key in the site’s
web.config file is set to true.

Enforcing a no-match password

Ektron has a security feature which ensures that when an administrator or user with
the Commerce Admin role enters a new password, it does not match that person's
previous 4 passwords. This feature is enabled only if site’s web.config file has the
ek ecom ComplianceMode key is setto true.

You can set ek _ecom PasswordHistory to a number higher than 4 if you want a
higher level of security. If you set this key to less than 4 and the ek ecom
ComplianceMode key is setto true, Ektron enforces 4.

Creating a custom password strategy

The Ektron password validation provider lets developers create custom password
validation strategies. These providers can enforce custom password rules inside the
system, beyond the out-of-box capabilities.

This section explains how to create a custom password validation provider for Ektron.

1. Create a class library project in Visual Studio.

2. Import the namespaces you need. Add references to:
o Ektron.Cms.Commerce

e Ektron.Cms.Common
» Ektron.Cms.ObjectFactory
» Microsoft.Practices.EnterpriseLibrary.Validation.dll
« System.Configuration
» Ektron.CMS.User
» Ektron.CMS.DataRW
o Ektron.Cms.Contracts
3. Add the following using statements.

using System;
using System.Collections;
using System.Configuration.Provider;
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using Microsoft.Practices.Enterpriselibrary.Validation;
using Ektron.Cms;

using Ektron.Cms.Common;

using Ektron.Cms.Commerce;

using Ektron.Cms.Commerce.PasswordValidation.Provider;
using System.Collections.Generic;

using System.Text;

using System.Text.RegularExpressions;

4. Change the namespace to Ektron.Cms.Extensibility.Commerce.Samples,
rename your class to CustomPasswordProvider, and inherit from the
Ektron.Cms.Commerce.PasswordValidation.Provider.PasswordValidation
Provider class and the Ektron.Cms.Commerce.IPasswordValidation
interface.

namespace Ektron.Cms.Extensibility.Commerce.Samples

{ public class CustomPasswordProvider :
Ektron.Cms.Commerce.PasswordValidation.Provider.PasswordValidationProvider,
Ektron.Cms.Commerce.IPasswordValidation

5. Add the following constructor.

#region constructor, member tokens
public CustomPasswordProvider () { }
#endregion

6. Add GetRegexFor methods required by the PasswordvalidationProvider base
class. These methods return the RegExs that will validate passwords in Ektron
for specific user types.

» GetRegexForMember. Returns one or more regular expressions used for
client side validation of membership users, along with corresponding error
messages to be used when client-side validation fails.

+ GetRegexForAuthor. Returns one or more regular expressions used for
client side validation of Ektron authors, along with corresponding error
messages to be used when client-side validation fails.

» GetRegexForCommerceAdmin. Returns one or more regular expressions
used for client-side validation of eCommerce administrators, along with
corresponding error messages to be used when client side validation fails.

» GetRegexForAdmin. Returns one or more regular expressions used for
client-side validation of Ektron administrators, along with corresponding
error messages to be used when client side validation fails.

NOTE: This example enforces a minimal requirement for authors/members,
and adds a length and diversity requirement for administrators.

#region public methods
public override string GetRegexForAdmin ()
{ return "[/.{7}/, Password must contain at least seven characters]
o W/ 10=9]4+/,
Password must contain at least one number]
"+ ", [/la-zA-Z]+/,
Password must contain at least one alphabetical character]
Yo U I/ \NET\"R#]+S/,

Password cannot contain spaces, tabs, single-quotes,
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double-quotes, percent-signs, or pound-signs]";

}

public override string GetRegexForAuthor ()

{ return "[/.{1}/, Password too short]"™ + ", [/~[~ \t'\"%#1+$/,
Password cannot contain spaces, tabs, single-quotes,

double-quotes, percent-signs, or pound-signs]";
}
public override string GetRegexForCommerceAdmin ()
{ return "[/.{1}/, Password too short]"™ + ", [/~[~ \t'\"%#1+$/,
Password cannot contain spaces, tabs, single-quotes,
double-quotes, percent-signs, or pound-signs]";
}
public override string GetRegexForMember ()
{ return "[/.{1}/, Password too short]"™ + ", [/~[~ \t'\"%#1+$/,
Password cannot contain spaces, tabs, single-quotes,
double-quotes, percent-signs, or pound-signs]";
}

#endregion

7. Implement the validateFor methods, which use the regexs to validate

passwords. We use the generic function validate to which we pass parameters.

public override ValidationResults
ValidateForAdmin (string password)
{ return Validate (password, GetRegexForAdmin()) ;
}
public override ValidationResults
ValidateForAuthor (string password)
{ return Validate (password, GetRegexForAuthor()):;
}
public override ValidationResults
ValidateForCommerceAdmin (string password)
{ return Validate (password, GetRegexForCommerceAdmin ()) ;
}
public override ValidationResults
ValidateForMember (string password)
{ return Validate (password, GetRegexForMember ()) ;
}
protected ValidationResults
Validate (string password, string regexErrorMessage)
{ ValidationResults results = new ValidationResults () ;
string regex, errorMessage;
string[] parts;
string[] raw = regexErrorMessage.TrimStart ('[').TrimEnd(']")
.Split (new string[] { "],[" }, StringSplitOptions.None) ;
foreach (string combined in raw)
{ parts = combined.Split (new string[] { "/," },
StringSplitOptions.None) ;
regex = parts[0].Trim('/");
errorMessage = parts[l].Trim().TrimStart ('"") .TrimEnd('"");
if (!'Regex.IsMatch (password, regex))
{ results.AddResult (new ValidationResult (errorMessage,
this, "", "", null));

(
(

}
}
return results;

}
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8. Tell the system whether to enforce password expiration on users. There are 2
requirements.
« PasswordExpirationEnabled. Enabled password expiration globally,
which allows the RequiresPasswordExpiration to be called.

 RequiresPasswordExpiration. Returns whether password expiration is
enforced for a user.

NOTE: The system handles password expiration dates. Setting
PasswordExpirationEnabled and RequiresPasswordExpiration tells
Ektron to check and enforce those values.

public override bool PasswordExpirationEnabled()
{ return RequestInformation.CommerceSettings.ComplianceMode;

}

public override bool RequiresPasswordExpiration (long userId)
{ return (userId == 1);

}
9. Build the project, and copy the assembly to the Ektron site's bin directory.

10. Register the provider, and direct Ektron to use it. The siteroot/web.config file
lets you manage password providers within Ektron.
a. Locate the <passwordvalidationProvider...>tag inthe web.config file.

b. Add a reference to the class created earlier in the <providers> key.
c. Changethe defaultProvider attribute, as shown below.

<passwordValidationProvider defaultProvider="CustomPasswordProvider">
<providers>
<add name="CustomPasswordProvider"
type="Ektron.Cms.Extensibility.Commerce.Samples
.CustomPasswordProvider, CustomPasswordProvider" />
</providers>

Logging in through Facebook

Facebook Login, an alternative to Ektron's standard login, lets users log in using their
Facebook username and password instead of creating an Ektron username and
password. Here is an example of Facebook Login control.

Register | Login | i Login |

This control lets Membership and Ektron users log into an Ektron website. If users
have an Ektron user profile, they can be prompted to link the Facebook username
and password with that profile.

Facebook Login allows log in only—it provides no other Facebook features, such as
viewing profiles or sending messages.

NOTE: The Facebook Login feature does not support Active Directory.

The OnTrek starter site includes a samples of a Facebook Login.
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NOTE: The user experience is enabled only after a developer sets up the feature.
See also: Setting up Facebook login on the facing page.

If a user clicks a Facebook Login button but is not logged into Facebook, the following
screen appears.

¥ Connect with Facebook

Connect localhost with Facebook to interact with your friends on this site and to
share on Facebook through your Wall and friends' Mews Feeds.

localhost Bring your friends and info facebook
—

Publish content to your Wall

Email:

Password:

Sign up for Facebook Connect Cancel

When you complete this screen or if you are already logged into Facebook, you are
forwarded to a page that prompts you to register with or log into Ektron.
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Register for the EktronTech Community

Hello Bob, Do you have an existing site account?

If you do, sign in here to link your existing account to Facebook, If not, register below,

User Mame: I

Paszword: I

Lagin |

{Upon successfully registering with Ektron Tech you will be redirected to our home page. Please
click login and use your e-mail to log-in to Ektron Tech.)

General 1[ Forum " Tags " Custom |
*First Marne: Bob
*Last Mame: Balt

*E-Mail Address:

*Display Marne: Eoh Baolt

Llser Language: |Eng|ish (RN j
Address:

Latitude: 0

Longitude: 1]

Avatar: https:/fsecure-profile faceboc

Click to upload your avatar

Fegister | Feset |

This screen asks if you have a membership account. If so, do you want to connect
this Facebook username and password with the Ektron account? If you agree, you
will access your membership account via the Facebook Login with Facebook
credentials from now on. If you do not have a membership account, complete the
lower half of the screen. This is the same screen that new members use to create
Ektron accounts. From then on, you can click the Facebook Login button to log into
Ektron using a Facebook username and password.

When you log out of Ektron, that action does not log you out of Facebook.
Conversely, if a user logs out of Facebook, you are not logged out of Ektron.

NOTE: Facebook often caches information in your browser. If you see JavaScript
errors or other odd behavior, clear the browser cache, close all browser windows,
and try again.

Setting up Facebook login

To set up the Facebook login feature:

Step 1: Connect Facebook to Your Ektron Website

Follow these steps to obtain Facebook keys, paste them into the web.config file, and
identify your site to Facebook.

1. Inyou do not have one, create a Facebook account. Go to www. facebook.com
and follow the sign up instructions.

2. Login to the Facebook Developer site.

3. Click +Create New App.
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4. Enter an App Name and APP Namespace for your application. The name
cannot include facebook or any variations, such as rB. Click Continue. A new
screen appears, showing your App ID and AppSecret.

Apps » My Test » Basic

My Test

App ID: 999999333333399
App Secret:  5475054554f545321 15451 851558r 2 (resek)

(edit icon]

Racic Tnfn

5. Open your website's root folder/web . config file.

6. Copy the Facebook keys into these web.config elements.
e APP ID. ek FacebookApiKey

» App Secret. ck FacebookSecret

NOTE: Keys shipped in Ektron sample sites are for localhost. Also, make sure
the Facebook keys were generated for the host header/URL to which you're
applying them. And, if you are testing secure site setup, verify that the
web.configelement ek useSsSLis true.

7. Save and close web.config.

NOTE: After you update web.config with Facebook keys, wait a few minutes
before logging into the Ektron site via the Facebook Login server control.

8. Return to the Facebook Basic screen.
9. Under Select how your app integrates with Facebook, click Website.

10. In the Site URL field, enter your website's URL.
» for a public site, enter its URL. For example, http://www.example.com.

» for a shared server or if you are accessing the site from a remote machine,
use the IP address. As examples, http://192.168.14.10,
http://192.168.14.10/QA

» for alocal server, use localhost. As examples, http://localhost,
http://localhost/EktronTech

11. Save and close the Facebook screen.

12. After setting up your application, you can return to this screen at any time to
view the keys, edit the Site URL, etc.
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Step 2: Create or Modify a Facebook Login/Signup

Step 2: Create or Modify a Facebook Login/Signup Page

A Facebook form appears if a user clicks a Facebook Login button and is not
currently logged into Facebook.

¥ Connect with Facebook

Connect localhost with Facebook to interact with your friends on this site and to
share on Facebook through your Wall and friends' Mews Feeds.

localhost Ering your friends and info facebook
—
Publish content to your Wall
Email:
Password:

Sign up for Facebook Connect Cancel

The form is created by Facebook, not Ektron. You can customize parts of it, such as
the title and site image, using Facebook's Application settings.

When the user completes the form, the user is forwarded to an Ektron form that
prompts the person to register or log in to Ektron.
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Register for the EktronTech Community

Hello Bob, Do you have an existing site account?

If you do, sign in here to link your existing account to Facebook, If not, register below,

User Mame: I

Paszword: I

Lagin |

{Upon successfully registering with Ektron Tech you will be redirected to our home page. Please
click login and use your e-mail to log-in to Ektron Tech.)

General 1[ Forum " Tags " Custom |
*First Marne: Bob
*Last Mame: Balt

*E-Mail Address:

*Display Marne: Eoh Baolt

Llser Language: |Eng|ish (RN j
Address:

Latitude: 0

Longitude: 1]

Avatar: https:/fsecure-profile faceboc

Click to upload your avatar

Fegister | Feset |

You specify which form appears via the Facebook Login server control's
SignupTemplate property.

The logic to connect a Facebook user with an Ektron account (circled) is not part of
the Facebook Login server control. However, sample code for that functionality is
included in the Ektron Tech sample site's register.aspx page.

Register for the EktronTech Community

— —
Hello Bob, Do you have an existing site account?

If wou do, signin here to link your existing account to Facebook, If not, register below,

Llzer Mame: I

Password: |
““"Il—_

Login |

(Upon successfully registering with Ektron Tech you will be redirected to our hon
dick login and use your e-mail to log-in to Ektron Tech.)

General ‘[ Forum " Tags ” Cusbtom |

*First Marne: Bob

Alternative to redirecting to the signup form

If you do not want to redirect the user to a signup form after Facebook login, you can
hook the Ekxtron FacebookNewMemberLoggedIn JavaScript event and do whatever
you want with it. For example, you could raise a modal dialog with a short signup
form. .
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Step 3: Place the Facebook login server control on

Step 3: Place the Facebook login server control on a page
1. In Visual Studio, open the template onto which you want to place a Facebook
Login server control. See also: Ektron Server Controls.
2. Drag and drop the control.

3. Use the following information to complete its properties.
» Authenticated (String)

» FacebookButtonText (String)
Enter the Facebook Login button text. The default is Connect with
Facebook.

» Hide (Boolean)

» InstructionDetail (String)

Enter additional text that appears above the Facebook Login button. The
default is Sign in using your Facebook account.

» InstructionHeader (String)
Enter text that appears above the Facebook Login button. The default is
Sign in using your Facebook account.

« Language

» SignupTemplate (String)
Enter the path to the template that appears after a user completes the
Connect with Facebook screen.

You can customize the markup for the form using the LoginTemplate and
LogoutTemplate server controls.

Using Facebook connect extension with the Targeted
Content widget

Facebook Login lets you retrieve the following Facebook profile information, using
Facebook Connect Extension.

» Age

» Gender

» Marital Status

o Likes

« Employment
See also: Creating Personalized Web Experiences with the Targeted Content Widget

Modifying setup information

You are a member of the Administrators group.

You must complete this before any user can access your Ektron website.
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In Workarea > Settings > Configuration > Setup, you can enter or edit
information for the Ektron website including:

License keys

Default language

email notification

Physical library folders on file server
Builtin user information

Editor options

Work page size settings

Password Regex

The Application Setup screen appears. Click Edit to modify the settings.

General tab
Editor Workarea System Password Regex

Version: 9.10 (Build9.1.0 162)

Default Site Language: English (U.5.)

License Key(s) (comma delimited):  eki-hkgnyn1(exp-2014-04-12)(EN){E)(XML )(users-unlimited)?1691822111448726250603067721-8

Default Application Language: English (U.5.)

System E-Mail Address: [Mone Specified]

System Notifications: Sending of E-Mail Disabled

Server Type: # Enable Staging Server — refers library links to staging server domain, as opposed to production server domain

Asynchronous Processor Location: [Mone Specified]

Publish In Other Format: + Enable Office Documents to be Published in other Format

Library Folder Creation: + Enable CMS to create filesystem folders for the library assets

Built In User: builtin

Version. This number shows the Ektron version and build numbers. This
number is important to know if you place a call to Ektron Support.

License Key(s). Enter the license key sent to you from Ektron.

Default Application Language. Select a default language for Ektron. This
user’s language determines the screens and messages that appear in Ektron. In
the user profile, you can set any user’s language to system default. Each user
set to system default uses the language assigned here.

NOTE: Do not confuse the default application language with the ek_
DefaultContentLanguage variable in web.config. For more information on
that, see Setting the default language on page 1398.

System E-mail Address. Enter a valid email address. This address will appear
in the From field in the notification emails. See also: Enabling email notification
on page 98.
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Editor tab

+ Enable Sending of System Notification Email. Check this box if you want
notification emails to be sent when triggering actions occur. See also: Enabling
email notification on page 98.

» Server Type: Staging Server. Check this box if you want your library links to
refer to the staging server domain, as opposed to the production server domain.
This would help you verify that the linked items exist on the staging server. See
also: Automatic multi-site setup on page 87

NOTE: Checking this box disables the Web Alerts feature on your server.

» Asynchronous Processor Location. If your site uses the Web Alerts feature,
enter or update the location of the asynchronous processor Web services file.
The default location is "[none specified].” See also: Setting up message queuing
and the asynchronous processor on page 1371.

 Enable CMS to create file system folders for library assets. Check the
box if you want to create physical folders on your file system server that match
the Ektron library folder tree. See also: Creating file system folders with Ektron
on page 127.

» Builtin User. Edit the username and/or password for the built in user. By
default, the username and password combination is builtin/builtin.

WARNING! Ektron strongly urges you to change the default password
assigned to the builtin user. Opportunities to do this are presented during
installation and in the above field.

Editor tab

IMPORTANT: Editor tab settings apply only to the eWebEdit400 editor.

Application Setup

EDIT Q@

General Workarea System Password Regex

* Settings apply to eWebEdit400 editor only.

Styles: % Preserve M5-Word Styles
Fonts (CSS selection always available): ¥ Enable Font Buttons

Accessibility/Section 508 Evaluation: " Do not validate

» Preserve MS-Word Styles. When Microsoft Word content is pasted into the
editor, it removes some Word styles by default. Check this box if you want to
prevent the editor from removing them.
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NOTE: Ektron does not recommend enabling this feature.

» Preserve MS-Word Classes. Similar to styles, when Microsoft Word content is
pasted into the editor, it removes some Word classes by default. Check this box
if you want to prevent the editor from removing them.

« Enable Font Buttons. Checking this option displays the following font-related
buttons on the editor toolbar:
° Font Face

o Font Size
° Font Color
° Font Background Color
» Accessibility/Section 508 Evaluation. If your editor is eWebEdit400:

Workarea tab

4 | UPDATE (]

General Editor Password Regex

Landing Page After Login:

i Select
W1 set Smart Desktop As The Start Location In The Workarea

Force preferences to O
all users

Enable Verify Email O

{The CMS will verify all new membership users by sending them an email that asks them to confirm their regisiration.)

Enable Preapproval O
Group

The following fields change the default Web page after log-in and the default
Workarea page. The default values are automatically applied to all new users, and to
all existing users when you upgrade. Normally, you can modify these values for any
user via the Edit User screen. But, you can force these values on all users, removing
the ability to personalize them.

 Landing Page After Login. If you want one page in your website to appear
after users log in, enter the URL to that page. If you do, the landing page points
to published content, not the Workarea. You can click Select Page to browse to
a landing page. The last published version of the page appears. If the page has
never been published, nothing appears.

By default, the page from which the user logged in reappears.

* IMPORTANT: If you are logging in from the OnTrek sample site, this field is
ignored. OnTrek has its own landing page after login, regardless of this
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System tab

setting.

+ Set Smart Desktop as Start Location in the Workarea. If you want the
Smart Desktop to appear as soon as a user enters the Workarea, click this box.
By default, the user sees the Smart Desktop after log in. If you leave this box
blank, when a user enters the Workarea, the folder of the content specified in
the user profile at the Landing Page after login field is displayed.

» Force Preferences to all users. To force these settings on all Ektron users,
check this box. If you do, users can see the values in the user profile screen but
not change them. If you leave this box blank, users can personalize these values
in their User Profile.

« Enable Verify Email. Check this box if site visitors who complete the
membership form are placed on the Users Not Verified list. Upon confirming their
interest, these site visitors become membership users. If you do not check this
box, site visitors who complete the membership form automatically become
membership users. See also: Allowing membership users to self-subscribe on
page 1510.

IMPORTANT: When using the Checkout server control on an eCommerce
site, the Enable setting must be unchecked. Otherwise, new users will
receive an error message when they sign-up using this control. See also:
Checkout.

+ Enable PreApproval Group. Use this field to enable Automatic Task Creation.
See also: Setting up an automatic task for pre-approving content on page 1356.

System tab
General Editor Workarea

Application: Restart

User may see an error while application is restarting.

Use this button to clear Ektron's cache, which recycles the application pool. For
example, you updated the web.config file but cannot yet see the changes.

Under certain circumstances, Ektron's support group may instruct you to click this
button.

Administrators would use this button if they cannot access the hosting servers yet
need to reset their website. The button is an alternative to submitting a request to
their IT department or hosting company.

Impact on Ektron

After you click Restart, the first request takes longer than usual since the application
needs to recompile. Subsequent requests should be processed normally.

To minimize the impact on site visitors, visit your home page immediately after the
restart, so that your request is the first "hit."

See also: Managing Application Pools in IIS 7
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Password Regex tab

Application Setup

EDIT W

General Editor Workarea System

Regex Value: A= {8 = Az ?=" A2 s ) *E

Error Text: Your password should be at least 5 characters, and to be a mix of
letters, and at [east one uppercase |etter.

Type: Default

Use the Application Setup screen's Password Regex tab to customize Ektron's
password security policy, and the error text that appears if a user's entry does not
conform to the policy. Ektron provides a default policy and error text. The default
policy enforces these criteria:

« minimum of 5 alphabetical and numeric characters

» at least one uppercase letter

The password policy is enforced if either the Workarea or the API is used to add a
CMS or membership user, or an existing user's password is changed.

Additional Password Policy Notes

» The policy is not enforced when using the Membership User Reset Password
screen. See also: Activating other membership actions on page 1513.

» The policy is not enforced during installation, when you are prompted to enter a
password for admin and builtin users. The policy is enforced if you later change
those users' passwords.

» The policy is not enforced if you are using Active Directory. See also: Using
Active Directory with Ektron on page 1472.

Customizing the password security policy and error text

« Knowledge of RegEXx.
* You are a member of the Administrators group.

To customize the password security policy:

1. Go to Settings > Configuration > Setup > Edit > Password Regex.
2. Change the Type drop-down to Custom.

3. If desired, edit the error text. This appears if a new password does not conform
to the RegEx expression.
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Restoring the default password RegEx and error

Workarea Custom Activities

“Username:  [jedit
D: 3
*First Name:  [John |
“LastName:  [Edit |
*Display Name:  [JE |
Password:  [eewe |

*Confirm Pwd: enncenesl

Your password should be at least 5 characters, and to be a mix of letters,
nd at least one uppercase letter.

. If desired, edit the RegEx expression.
. Click Update.
. Ektron recommends creating a new "dummy" user and entering passwords that

both pass and fail the updated RegEx expression, to verify the expected
behavior.

Restoring the default password RegEx and error text

To restore the default password policy and error text:

1.

Go to Settings > Configuration > Setup > Edit > Password Regex.

2. Change the Type drop-down to Default.
3.
4. Ektron recommends creating a new "dummy" user and entering passwords that

Click Update.

both pass and fail the RegEx expression, to verify the expected behavior.

Creating file system folders with Ektron

If this option is enabled, each time you create a new content or library folder in
Ektron, a corresponding physical folder is created on the file system to organize
library files on your file server. The following image shows a library folder tree and its
corresponding system folder structure.
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) Content Block

) Content Rating

) Forms

) Index Search
+ ) List Summary

Ektron CMS400 File server folder tree
folder tree
|2 Library = |2) uploadedimages A
+ () CME54000ema + [2) CM34000emo
=l |Z) Developer =l |Z) Developer
) Blog |Z) Elog
) Business Bules I3 BusinessRules
) Cache 12 Cache
) Calendar |2) Calendar
# [2) Collection 2 Collection

|2 Content_BElock
|2 Conkent_Rating
|Zh Forms

|0 Index_Search
|20 List_Summary

|2 Membership
) Memberzhip 3 Menu
) Menu ) Meta
) Meta ) Roles
) Roles ]rss
) RSS | Search
) Search + ) =ML -
) =kl

NOTE: If you are upgrading, the installation does not create sample website
folders on the file server. You must add these folders manually. However, all
folders that you create are also created on the file server when enabled.

Handling background processing functions with
the Ektron Windows Service

Ektron provides a Windows service (EWS) to handle the following background
processing functions.

» Balancing the load on your servers on page 94
e Bad link report on page 982

» Scheduling Content to go live at a future time, and removal of content scheduled
to expire.

« Applying Metadata to content: When a new metadata definition is created, the
Windows service applies it to all content in the Ektron database. However, the
metadata definition is only activated for the content when it is enabled for the
content’s folder.

Also, the EWS propagates updates that are made to the database connection string
or the site path in the web.config file. The service copies the new value to the
data.configand sitedb.config files, which are located in C:\Program Files
(x86) \Ektron\EktronWindowsservice40. Any Ektron components that reference
these values can retrieve the current information from these files.

The data.configand sitedb.config files are updated once each day at a time
prescribed in the updateTime valuein C:\Program Files
(x86) \Ektron\EktronWindowsserviced0\Ektron.ASM.EktronServices.exe.conf

ig. You can change this time.
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WARNING! Do not edit the data.configand sitedb.config files. They are
dynamically generated by Ektron. If these files have incorrect values, edit the
web.config file, which is used to generate them.

The EWS starts automatically when Ektron is installed, and again whenever the
server is restarted.

To see the status of the service, go to Start > Computer, then right click and
choose Manage.
» Windows 7: The Computer Management screen appears. Choose Computer
Management > Services and Applications > Services.
» Windows 2008: The Server Manager screen appears. Choose Server Manager
> Configuration > Services.

If you're using Windows 8 or 2012, press the Windows key (E) /Q then enter
Services.

Look for Ektron Windows Services. You can see its status in the Status column.
=l

E Computer Management

| action  tiew |J<:=-h||||§|] y om oIl m

Tree I Mame £ | Description | tatus
Q Computer Management (Locall =) % MET Runtime Opkimization Seeyv,.. Microsoft ...,
E'ﬁﬁ System Tools %Alerter Motifies sel...  Started
@ Event Yiewer %Applicatian Management Provides ...
@ Syskem Information %ASP.NET Skate Service Provides s...
ﬁ Performance Logs and Alerts %.ﬁ.utumatic Updates Enables th...  Started
Shared Folders %Backgruund Inteligent Transfer... Transfersf..,
) Device Manager % ClipBaak Supparts C...
|- ¥ Local Users and Groups 88 COM+ Event System Provides a...  Started
El@ Storage 8 Computer Browser Maintains a... Started
(] Disk Management %DHCP Client Manages n...  Started
{ @ Dis}‘:‘ DeFrE.lgmenter %Distributed File System Manages lo... Started
=) Logical Drives 8 Distributed Link Tracking Client  Sends natif... Started
& 'é:j:erzﬂ:: db!:.pSptl;?:;i?DEns %Distributed Link Tracking Server  Stores info...
8 Telephony %Distributed Transaction Coordin,., Coordinate.., Started
__ Micrasoft SOL Servers %DNS Client Resolves a,,,  Started
g WMT Cankral | | ‘E 14 This servic,..  Started
% Services %Event Log Logs event,..  Skarted
g Indexing Service vl ?‘i":“ Serice Bl o) S

On your file system, the EWS is located in C:\Program Files
(x86) \Ektron\EktronWindowsservice40. Within that folder, the
Ektron.ASM.EktronServices.exe.config file runs the EWS.

Additional resources
Upgrading the Ektron Windows Service

Viewing the EWS activity log
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The EWS has an Activity Log that tracks all related events. To view detail for any
event, double click it.

 Windows 7: Computer Management > System Tools > Event Viewer >

Ektron Log
 Windows 2008: Server Manager > Diagnostics > Event Viewer > Ektron
Log
J Ackion  Wiew |J o~ -P‘|| |@
Tree I Tvpe | Date | Time | Saurce | _at... | E..| ... |
Q Computer Management (Local) @Infurmatiun 6/3/2006 3:29:00 AM  Ekkron Mome O MfA
E‘ﬁa System Taols QEerr BI3f2006  3:29:00 AM  Ekkron Mone O MjA
{ E@ Event Viewer QEerr 6/9/2006  3:29:00 AM  Ekkron Mone O MfA
P ' anplication eEerr 692006  3:29:00 4M  Ekkron Mome 0O Mi&
€ error 6/3/2006 3:26:58AM  Ektron  MNone O A
3| Securiby
©0 et System
a3 Cuckars TrFoerakinn ;I

A common source of errors is that the service cannot find Ektron sites, because they
have not been created yet, as shown in the sample below.
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Event Properties

Ewent l

Drate: 6/9/20068  Souwrce:  Ektron

Tirne; 16:44 Category: Mone

Type: Errar EventID: 0O

Uzer A

Computer: PRODIGAL

D escription:

Mo Servers exist in the system

Ok Cancel |

Setting up an Ektron site to use Amazon BLOB
storage

This section explains how to set up a local site to use Amazon BLOB storage. The
resulting configuration stores assets in BLOB storage rather than the local file
system.

This configuration also serves files from the BLOB store, by redirecting requests to
the BLOB URL rather than the local system.

1. Create new bucket on Amazon.
a. Name: [ektronbucket]

b. Region: [Asia Pacific (Singapore)]
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2. Toinstall the package to your website project, run the Install-Package
AWSSDK command.
Ensure that the latest AwssDk.d11 file resides in the Ektron site's bin folder.

3. Modify your website's web.config file.
a. Changethe unity.storage section to match the sample below:

<section name="unity.storage"

type="Microsoft.Practices.Unity.Configuration.UnityConfigurationSection,
Microsoft.Practices.Unity.Configuration,
Version=3.0.0.0,
Culture=neutral,
PublicKeyToken=31bf3856ad364e35" />

b. Define unity.storage as follows:

<unity.storage>
<assembly name="Ektron.Storage"/>
<assembly name="Ektron.Cloud"/>
<namespace name="Ektron.Cloud.Amazon.Storage"/>
<namespace name="Ektron.Storage"/>
<container name="storageContainer">
<register type="IFileService" mapTo="S3FileService"/>
<register type="IDirectoryService" mapTo="S3DirectoryService"/>
</container>
</unity.storage>

c. Modify appsettings keys, or add them to match the sample below:

<add key="ek CloudStorageType" value="AMAZON" />
<add key="BlobStorageName" value="ektronbuket" /> <!--bucket name-->
<add key="AWSAccessKey" value="****x**xm /5 <l_—pucket access key-->
<add key="AWSSecretKey" value="****x*x**xm /5 <l__pucket secret key-->
<add key="AWSRegion" value="ap-southeast-1" /> <!--bucket region-->
<add key="AWSPublicRead" value="false"> <!--bucket block publicACL setting--
>
d. Add the following to the <modules> section:

<add name="EkBlobModule" type="BlobRedirectModule"
preCondition="integratedMode" />

4. Delete all contents (except web.config) from the following folders on the
Amazon vm.
» [siteroot]\assets

[siteroot]\privateassets
[siteroot]\uploadedfiles
[siteroot]\uploadedimages
C:\assetlibrary\[sitename]

For eSync

1. Create 2 sites. Configure and run a successful eSync between them. Ensure that
the profile is one way sync (Upload/Download).
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ForeSync

2. Create a sync relationship from the local server to the remote server that has the

CDN settings.
a. Apply appropriate certificates to both sides.

b. Make sure appropriate ports are open. See
https://portal.ektron.com/kb/10123/.

c. Make sure appropriate ports are open on the remote server network
security group.

d. Make sure you can access the remote server site from the local server.

3. Run the initial sync.

At this point, the db sync should work, and assets will be uploaded. But, they will
be uploaded to the local folder of the remote server, not the BLOB store. The
next steps change sync to push directly to the BLOB.

Update the scheduler row in the database.

Replace the tokens in the following statement, and run it on the database in
which you just created the relationship (the sending side). This updates the most
recent relationship created. See notes later in this section if you need to update
an older relationship.

update scheduler set external args=N'
<CloudServiceRequest
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<SubscriptionID>[Leave blank for Amazon]</SubscriptionID>
<StorageAccountID>[AWSAccessKey from web.config]</StorageAccountID>
<StorageAccountKey>[AWSSecretKey from web.config]</StorageAccountKey>
<UseHttps>True</UseHttps>
<CDNEndpoint />
<ContainerConfigName>amazon</ContainerConfigName>
<WebSites>
<SiteInfo>
<ContainerAddress>[BlobStorageName from web.config]</ContainerAddress >
<LocalSitePath>[Your local website path ex.,
c:\inetpub\sitel]</LocalSitePath>
</SiteInfo>
</WebSites>
<ServiceArguments>
<ComputeArguments>
<Location>ap-southeast-1</Location>
</ComputeArguments>
<StorageArguments>
<PublicRead>[AWSPublicRead from web.config]</PublicRead>
</StorageArguments>
</ServiceArguments>
</CloudServiceRequest>'
where scheduleid=(select top 1 scheduleid from scheduler
where parentsyncid = 0 order by date created desc)
or parentsyncid=(select top 1 scheduleid from scheduler
where parentsyncid = 0 order by date created desc)
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5. Run the updated profile again.
a. Validate that the assets went into the BLOB.

b. Validate that the assets are viewable from the Amazon site.

6. Delete all content (except for the web.config file) from inside the following
folders on the Amazon BLOB.

» [siteroot]\assets

» [siteroot]\privateassets

» [siteroot]\uploadedfiles

» [siteroot]\uploadedimages

o C:\assetlibrary\[sitename]
Notes:

» The SQL statement must be run again after new sync profiles are created.

If you hover over the plus sign (+) on the relationship, the URL is similar to:
http://95site.com/workarea/sync/SyncProfile.aspx?action=add&id=7.

The ID at the end of the URL is the parent sync row. The statement to update all
profiles on that ID is:

update scheduler set external args=N'
<CloudServiceRequest
xmlns:xsd=http://www.w3.0rg/2001/XMLSchema
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<SubscriptionID>[Leave blank for Amazon]</SubscriptionID>
<StorageAccountID>[ AWSAccessKey from web.config]</StorageAccountID>
<StorageAccountKey>[ AWSSecretKey from web.config]</StorageAccountKey>
<UseHttps>True</UseHttps>
<CDNEndpoint />
<ContainerConfigName>amazon</ContainerConfigName>
<WebSites>
<SiteInfo>
<ContainerAddress>[ BlobStorageName from web.config]</ContainerAddress >
<LocalSitePath>[Your local website path ex.,
c:\inetpub\sitel]</LocalSitePath>
</SiteInfo>
</WebSites>
<ServiceArguments>
<ComputeArguments>
<Location>ap-southeast-1</Location>
</ComputeArguments>
<StorageArguments>
<PublicRead>[AWSPublicRead from web.config]</PublicRead>
</StorageArguments>
</ServiceArguments>
</CloudServiceRequest>"'
where scheduleid=[parent id from url (in this case 7)]
or parentsyncid=[parent id from url (in this case 7)]

» The profiles to sync assets cannot be bi-directional. They must be upload or
download. You can have both types of profiles.
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Setting up an Ektron site to use Azure BLOB

storage

This section explains how to set up a local site to use Azure BLOB storage. The
resulting configuration stores assets in BLOB storage rather than the local file

system.

This configuration also lets files be served from the BLOB store, by redirecting
requests to the BLOB URL rather than the local system.

1. Create a new storage account on Azure.
a. Select Storage Accounts.

+ = & ] o . 4 = —r
Eecont
= O 5
il lin Ariire mokde app
[ @ oo | P e
b. Click Create storage acco
- i~ ] o e
Storage accounts o
[ e mavage secot |
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c. Enter datain the form.
» Select or create a new Resource group.

» Name: [ektronblob]

» Account kind: StorageV2 (general purpose V2)
= Microsoft Azure

2. In Visual Studio, open your site and install the Azure.Storage.Blobs package

Instance details

The default deple

using the Cias

Stora g

e aocount name *

Review + create |

Data protection

Create storage account

]

Advanced Tags Review +

ce providing cloud storage that is

s (objects)

nds on the usage and tt

rts the latest Azure

eate

o

e Files, Az

¢ available, secure, durable, scalable, and

and Azure

Zure Lueuet

TCE Qroup 1o organize ang
You may choose to deploy

(Asia Pacific) Southeast Asia
®) Standard Premiurm

StorageV2 (genera

Next : Networking =

by running the following command:

Install-Package Azure.Storage.Blobs -version 12.8.1
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3. Modify your website's web.config file.
a. Changethe unity.storage section to match the sample below:

<section name="unity.storage"
type="Microsoft.Practices.Unity.Configuration.UnityConfigurationSection,
Microsoft.Practices.Unity.Configuration,
Version=3.0.0.0,
Culture=neutral,
PublicKeyToken=31bf3856ad364e35" />

b. Define unity.storage as follows:

<unity.storage>
<assembly name="Ektron.Storage"/>
<assembly name="Ektron.Cloud"/>
<namespace name="Ektron.Cloud.Azure.Storage"/>
<namespace name="Ektron.Storage"/>
<container name="storageContainer">
<register type="IFileService" mapTo="S3FileService"/>
<register type="IDirectoryService" mapTo="S3DirectoryService"/>
</container>
</unity.storage>

c. Modify appsettings keys or add them to match the sample below:

<add key="ek CloudStorageType" value="AZURE" />
<add key="ek StorageConnectionString" value="xxxxxx" />
<--storage connection string-->

d. Add the following to the <modules> section:

<add name="EkBlobModule" type="BlobRedirectModule"
preCondition="integratedMode" />

Deleting old assets

After you update web.config, new assets are stored in Azure BLOB instead of local
folders. You can no longer view old assets in local folders because the storage is
changed to Azure storage. If you do not want to use the old assets, you can delete all
contents except for web.config from inside the following folders on the remote
server:

» [siteroot]\assets

» [siteroot]\privateassets

» [siteroot]\uploadedfiles

» [siteroot]\uploadedimages

» Assetlibrary folder (typically at C:\assetlibrary\[sitename] )

Uploading old assets to Azure BLOB

If you want to upload the old assets to Azure BLOB, perform the following steps:

1. Create 2 sites.
a. Create and run eSync profile from the local site with direction = Upload
(from the local site to the Azure-configured site) > Assets.
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b. Create and run eSync profile from the local site with direction =
Download (from the Azure-configured site to the local site) > Assets.

2. Configure and run a successful eSync between the local and remote servers.

3. Create sync profile to upload assets from local to remote server.
a. Apply appropriate certificates to both sides.

b. Make sure appropriate ports are open. See
https://portal.ektron.com/kb/10123/.

c. Make sure appropriate ports are open on the remote server network security
group.
d. Make sure you can access the remote server site from the local server.
4. Run the initial sync.

At this point, the database sync should work, and assets are uploaded. But, they
are uploaded to the local folder of the remote server, not the BLOB store. The
next steps change sync to push directly to the BLOB.

5. Update the scheduler row in the database.

Replace the tokens in the following statement, and run it on the database in
which you just created the relationship (the sending side). This updates the most
recent relationship created. See notes later in this section if you need to update
an older relationship.

update scheduler set external args=N'
<CloudServiceRequest

xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"

xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">

<SubscriptionID> [xxxxxxxxxx]</SubscriptionID>

<StorageConnectionString>[StorageConnectionString from
web.config]</StorageConnectionString>

<CDNEndpoint />

<ContainerConfigName>azure</ContainerConfigName>

<WebSites>

<SiteInfo>
<ContainerAddress>[Leave blank for Azure]</ContainerAddress>
<LocalSitePath>[Your local website path ex.,
c:\inetpub\sitel]</LocalSitePath>
</SitelInfo>

</WebSites>
</CloudServiceRequest>"
where scheduleid=(select top 1 scheduleid from scheduler where parentsyncid = 0
order by date created desc)
or parentsyncid=(select top 1 scheduleid from scheduler where parentsyncid = 0
order by date created desc)

6. Run the updated profile again.
a. Validate that the assets went into the BLOB.

b. Validate that the assets are viewable from the Azure site.

7. Delete all content (except for the web.config file) from inside the following
folders on the remote server.
» [siteroot]\assets

» [siteroot]\privateassets
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» [siteroot]\uploadedfiles
» [siteroot]\uploadedimages

» Assetlibrary folder (typically at C:\assetlibrary\[sitename] )
Notes:

» The SQL statement must be run again after new sync profiles are created.

If you hover over the plus sign (+) on the relationship, the URL is something
like:

http://95site.com/workarea/sync/SyncProfile.aspx?action=add&id=7.

The id at the end of the URL is the parent sync row. The statement to update all
profiles on that id is:

update scheduler set external args=N'
<CloudServiceRequest
xmlns:xsd=http://www.w3.0rg/2001/XMLSchema
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<SubscriptionID> [xxxxxxxx]</SubscriptionID>
<StorageConnectionString>[StorageConnectionString from
web.config]</StorageAccountID>
<CDNEndpoint />
<ContainerConfigName>azure</ContainerConfigName>
<WebSites>
<SiteInfo>
<ContainerAddress>[Leave blank for Azure]</ContainerAddress>
<LocalSitePath>[Your local website path ex.,
c:\inetpub\sitel]</LocalSitePath>
</SitelInfo>
</WebSites>
</CloudServiceRequest>"
where scheduleid=[parent id from url (in this case 7)]
or parentsyncid=[parent id from url (in this case 7)]

» The profiles to sync assets cannot be bi-directional. They must be upload or
download. You can have both types of profiles.
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Setting up your CMS folder
structure
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Folders are containers for . Ektron provides the following types of folders:

. Standard. See this chapter
#4 Root. The top-level container for all folder types

Y Site. See Supporting multi-site configurations on page 86

« [*% Community. See Community folders on page 1520
. | ©!Blog. See Working with blogs on page 887
« | “/ Discussion Board. See Working with discussion boards on page 933

. eCommerce catalog. See Creating a catalog folder on page 1687
« | 7| Web Calendar. See Working with calendars on page 913

Planning your CMS folder structure

At their core, all Web content management systems serve the same purpose: to
manage content. The only real difference among systems is the way in which that
content is used. You can divide content into 3 categories:

 Complete Content. A content item that is considered ready for visitor
consumption without further manipulation of the content. It may be comprised
of several other items. For example, a Press Release is complete if does not have
dependencies on other data. Also, a PageBuilder Page Layout, which has had its
dependencies on other content fulfilled, is a complete object. These items
require no other context in order to convey their intended meaning.

» Resource Content (or Incomplete Content). A content item that is not yet
ready for visitor consumption because it lacks some surrounding context to
complete its message. It is not intended to be viewed without the complete
context. For example, a call to action (CTA) is a resource that needs to be placed
in the context of a complete page to make sense. You also do not want a CTA
showing up in search results, and shown without more information.

« Custom Configuration Data. Settings or global configuration to the site. This
data is not complete and useful without context, yet it is also not content to be
dragged onto a larger page. Rather, it helps define smaller, more global
elements and settings. This data is stored in a Smart Form and can vary among
the following items: selecting other CMS content, menus or other objects, or
providing a text template for your copyright statement and standard values for
your Previous and Next buttons in pagination.

The following base CMS folder structure uses the 3 categories to organize your
content to provide sufficient separation of roles, search scopes, and content purpose
to satisfy most Ektron implementations. You can further sub-divide the structure. The
structure may be your root architecture in a single-site instance, or developed within
site folders in a multi-site environment.

This structure lets you clearly identify configuration roles, resource roles and content
versus page layout roles with user groups and setup permissions accordingly. The
folder structure gives you an easy means of keeping unwanted content from showing

142 | Ektron 9.50



Using folder menus

up in the site search results by having clearly defined locations for the various
content types and functions.

= &5 Folders

= [ MultiSiteQOne
Configuration
Content
Images
Master Layouts
Fages
Resources

+ Shared Content

Configuration. Administrative content, such as Smart Forms, that supports
Custom Configuration Data.

Content. Complete content that can be indexed and included in the scope for
your site search. You should consider any content URL or Alias within these
folders as complete and requiring no additional context.

Images. An image is resource content because it is frequently part of a larger

content item and therefore should not be independently searchable. If you want
to have some images on your site returned in search results (for example, info-
graphics or gallery photos), place them in a sub-directory of the Content folder.

Master Layouts. PageBuilder Master Layouts or Page Layouts used as
templates for other pages or content, respectively, within the CMS. This content
is not searchable and, without the additional content, does not stand on its own
as an individual site page.

Pages. PageBuilder Page Layouts that may rely on other data, but the page
itself is complete. Because these pages are complete, they should be indexed for
search.

Resources. Smart Form or HTML content that requires a larger context are
resource content; for example, slides for your home page banner, CTAs, or
descriptive text to be placed at the top of a careers listing. Content in this folder
should not be searchable because each item does not make sense on its own.

By dividing the content data into categories that are based on how the content is
used in the application, everything else falls into place more easily.

Using folder menus

The following menus and button appear across the top of the View Contents of Folder
screen. Depending on your permissions, you may not see all menu options.

View Contents of Folder "Conditions™ £

NEW VIEWW DELETE ACTION Ij

Ektron Reference I 143



Setting up your CMS folder structure

For information on Add Asset (), see Working with assets in the Document
Management System on page 649.

New menu

Lets you create and upload new items into a folder.
+ Add Calendar Event. Add calendar event. This option is only available in a
WebCalendar folder.) See also: Adding system calendar events on page 916
* Blog. Add blog. See also: Working with blogs on page 887
» Calendar. Add Web calendar. See also: Working with calendars on page 913

» Catalog. Add eCommerce catalog. See also: Creating a catalog folder on
page 1687

» Collection. Add collection. See also: Working with collections on page 740.

« Community Folder. Add folder whose content can be updated by membership
as well as regular users. See also: Community folders on page 1520.

» Discussion Board. Add discussion board. See also: Working with discussion
boards on page 933.

« DMS Document. Add Office document, managed file, or multimedia file, any
supported type. See also: Managing Microsoft Office assets on page 661,
Managing assets on page 653.

» Folder. Add folder. See also: Setting up your CMS folder structure on page 141.

« HTML Content. Add HTML content. See also: Creating new content on
page 626.

« HTML Form/Survey. Add HTML form, poll, or survey. See also: Creating
surveys and polls on page 798.

+ Master Layout. Add master layout. This option is only available in a
PageBuilder folder. See also: Creating a PageBuilder master layout on
page 1010.

 Menu. Add menu. See also: Creating menus for your website on page 1235.

« Multiple DMS Documents. Add several Office documents, managed files,
multimedia files, any supported type. See also: Adding multiple DMS documents
on page 656.

» Page Layout. Add page layout. This option is only available in a PageBuilder
folder. See also: Developing wireframe templates on page 1007.

» Site. Add website. This option is only available in the root folder. See also:
Supporting multi-site configurations on page 86.

 Smart Form. Add Smart Form. This option is only available if one or more
Smart Form configurations are assigned to the folder. See also: Working with
Smart Forms on page 815.

View menu

Lets you display information about content in a folder.
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All types. Displays all content types of selected language.

Archived Content. View and work with content that passed its scheduled End
Date and whose archive option is either Archive and remove from site or
Archive and remain on Site. When a Web Calendar folder is selected, this
menu item is labeled "Archived Events".

Collection. Work with collections assigned to this folder. See also: Working with
collections on page 740.

HTML content, HTML Form/Survey, Office Documents, Managed Files,
Multimedia, or Image Assets. Limits folder display to selected content type.
For example, choose View > Managed Files and see only managed files in the
folder; other content types are suppressed. This is especially helpful if the folder
has many items, and you are looking for only one type of content. If a
PageBuilder folder is selected, you can limit the display to Page Layouts or
Master Layouts. For more information on specific types of content:

» Creating new content on page 626

» Working with HTML forms on page 775

e Managing Microsoft Office assets on page 661
e Managing assets on page 653

» Managing multimedia assets on page 657

Language. Limits display of folder content to one language, or lets you display
all languages. If set to one language, this also determines the language of new
items you create or upload into the folder.

Menu. Work with menus assigned to this folder. See also: Editing a menu item
on page 1245.

Properties. Only members of the administrators group and those assigned to
the Folder-Admin role see this option. It lets you assign folder properties, such
as which users can edit a folder’s content. See also: Defining roles on page 1464,
Setting folder properties on page 150.

Delete menu

Lets you delete folder or content within folder.

Content. Delete one or more content items in folder. See also: Deleting content
on page 631.

This folder. Delete current folder and all of its content. If a Web Calendar is
selected, the menu option appears as "This calendar.” You cannot delete the
Root folder. See also: Deleting a folder on page 158.

Action menu

Lets you perform actions on the folder or content within the folder.

Cut/Copy. Move or copy content to another folder. See also: Moving or copying
content on page 629.
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« Export For Translation. Prepare content for translation by a translation
agency. See also: Exporting content to XLIFF on page 1418.

» Search. Search content in the Workarea. See also: Searching the Workarea on
page 363.

» Synchronize Folder. Sync this folder on the current server with the same
folder on another server. This option is only displayed if eSync has been set up,
you have the required privileges, and content has changed. See also:
Synchronizing content and folders on page 1855.

Workarea content menu

The View Contents of Folder screen features a context-sensitive, drop-down menu of
options you can perform for content.

{2 Footer - HTML Content

View
Edit
View Properties

{2 Home HTML Content

. Synchronize
$2| Privacy HTML Content

Delete

{2 Products | HTWL Content

The options depend on several factors, such as

» your folder permissions

« your position in the workflow (if any)

» the content’s status

« whether the item is a Microsoft Office document or asset
To see any content item's menu options:

1. Go to the folder that contains the content.

Title Conten g Language
f] About Us - HTML Content B
@Ahnums—lndex | HTML Content B
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2. Click the triangle. A menu of options for that content item appears. The following
options may be available:

Approve. Approve content that was submitted for publishing. See alsoe: Approving cont

Check-In. Change content status to checked in. Might use if you checked
out and saved a document then it became lost or corrupted. This option
changes original document’s status to checked in. However, it does not
replace the version of the file in Ektron. To replace content that was checked
out and edited, drag and drop it into Ektron. See also: Updating an Office
document on page 662.

Check out and Save As. Change a content item’s status to checked out
and save it to your local computer. When you finish editing the item, drag
and drop it to Ektron. See also: Updating an Office document on page 662.

Decline. Decline an approval request submitted to you. This option rejects
the changes and keeps the current version live on website. You are
prompted to enter a reason for the decline. After you decline, the author
who made the change is notified by email and the content is removed from
the workflow. If the author updated content then submitted it for approval,
the updated content remains in the file. If you do not want it to remain,
choose the Edit option. See also: Approving content for publication on
page 689.

Delete. Submit content for deletion. See also: Deleting content on
page 631.

Edit. For HTML, HTML form, or Smart Form content, edit content within the
editor. For assets, use Check out and Save As or Save As to save asset
to your computer and edit it. Then, use Edit to replace version in Ektron.

Edit in Microsoft Office. Edit Office document within Ektron. See also:
Managing Microsoft Office assets on page 661.

Edit Properties. Edit item’s Ektron information, such as summary,
metadata, Schedule, and taxonomy. After you complete the edit screen,
you proceed to the View Content screen. From here, you can perform
additional content activities, such as move/copy, delete, and view
history.See also:

» Scheduling content on page 640
Force Check In. Only appears if login user is a member of the
Administrator group or assigned the folder user admin role and content is
checked out. This option lets an administrator check in content even though
the administrator did not check it out.

Publish. Accept changes to content and publish it to the site.

Request Check In. Allows either admin user or non-admin user with edit
permission for the content’s folder to email the user who checked out
content. The email asks the check-out user to check it in.

Save As. Save Office document or asset to your computer. See also:
Saving an Office document on page 663.
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» Submit. Submit current version of content for publishing. When you do this,
the first user or user group in the workflow is notified that your content is
ready for review.

* Synchronize. Synchronize content or folders between 2 servers. See also:
Synchronizing servers using eSync on page 1787.

» View. View item’s Ektron information, such as summary, metadata,
Schedule, and taxonomy. After viewing, you can also edit that information if
you have permission

* View in Microsoft Office. View Office document within Office application.
Cannot change.

» View Properties. View Office document’s Ektron information, such as
Summary, Metadata, Schedule, and Taxonomy. After viewing, you can edit
the information if you have permission.

Viewing a folder

The View Contents of Folder screen lists the following information about each content
item.

Title. The content title.

Content Type. HTML content, HTML form, XML Smart Form, managed asset,
image, and so on.

Language. The content language. See also: Working with multi-language
content on page 1393.

ID. The number assigned to the content by Ektron. It is used to retrieve the
content from a database.

Status. The content status. See also: Content statuses on page 624.

Date Modified. The most recent date the content was added, edited, or
published.

Last Editor. The last user who edited the content.

To view a folder, follow these steps.

NOTE: You can only view folders for which your system administrator has granted
permission. See also: Managing folder and content permissions on page 160
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1. Access the Workarea and click the Content tab.

Content Library:

Content Tab
[ rogers MM oncr of Foider ook s
-
=1 € Folders NEW DELETE | | ACTION @
= CMS400Demo
_Rotatinglmages T All Types Menus D Sta
+ About Us HTML Content - y
= £2]AmE  HTML FormiSurvey = 332 A
piog Ass
Book Etﬁore ﬁEE Office Documents
# [ Conditio, \ Enc  ManagedFiles
Folders ) )
Contact In}_ ) Multimedia
# [ Ektron Medical Center F £ . Image Assets
ron edica EnNter -orum @Ams =
Events 4 Ass
/ anguage All
Flash ( ) VA .
Flash Content in i Gui Nederlands [Dutch]
asnnews | foder | JETT English (U.S.)
2 Furniture - T @Elea Collection Francais [French]
e Health Centers Wit Archived Content Deutsch [German]
Map ltaliano [ltalian]
Properties . ;
PageBuilder Espariol [Spanish]

All content in the root folder and the selected language appear in the right
frame. Subfolders appear in the left frame.

NOTE: The View menu option lets you filter content by type. For example,
you can set it to view only HTML content. Therefore, you may only see
content of a selected type in the folder.

. To work with any folder or its content, click the folder. When you do, its content

appears in the right frame.

If your system supports more than one language, you can view content for a
particular language or all languages using the View > Language option.

Adding a folder

To organize content on your website, create folders to store related content. See
also: Planning your CMS folder structure on page 142

1.

Go to and click the folder within which you want to create the new folder (that is,
the parent folder).

Choose New > Folder. Alternatively, you can hover the cursor over a folder,
right click the mouse, and choose Add Folder. The Add a Folder screen appears.

- About Us
* Carg ="
Con  [add Folder
ever  Add Blog
Mew  Add Discussion Board
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3. Complete the fields. See Setting folder properties below.
4. Click Add Folder.
You can modify the folder’s properties, permissions, workflow, and so on.

« If this is a Community Folder, see Community folders on page 1520.
« If this is a Site Folder, see Supporting multi-site configurations on page 86.
» If this is a Catalog Folder, see Creating a catalog folder on page 1687.

Setting folder properties

The folder properties screen lets you set permissions and workflow for a folder. You
can also assign or modify the folder’'s metadata, Web Alerts, and Smart Forms.

PREREQUISITE

Only members of the Administrator Group and those assigned to the
Folder User Admin role can view, add, or edit folder properties. (See also:
Defining roles on page 1464).

In addition, if a user is not a member of the Administrators Group, the
user must be given permission on the View Permissions for Folder screen.
(See also: Managing folder and content permissions on page 160).

NOTE: If you are using an eCommerce catalog, see Creating product types and
catalogs on page 1675 for a description of the Product Types screen. If you are
using a Web Calendar folder, see Viewing system calendar properties on

page 920.

1. Select the folder.

2. From the View Contents of Folder screen, choose View > Properties.
Alternatively, from the left panel, right click the mouse and choose View
Properties.
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View Properties for the folder "My Account™

€ || EDIT PROPERTIES | P L @ View: English (U.S.) - =]
Taxonon’fl Templates Flagging Metadata Web Alerts Smart Forms Breadcrumb Aliasing
7 Y

/|
Folder Properties Toolbar I

| Folder Properties Tabs ‘
Mame: My Account h -

Description:
Style Sheet: [Mone Specified)
(Inherited from parent)
Office Documents: — 7 ) )
Fublish in native format ~ Folder Properties Fields
ContentSearchable: Inherit parent configuration
Caontent Searchable.
DisplaySettings: Inherit parent configuration

Display All Tabs
Display Surmmary Tab
Display hetaData Tab
Display Aliasing Tab
Display Schedule Tab
Display Cormment Tab
Display Templates Tab

Display Taxonomy Tab

The Folder Properties screen contains these toolbar buttons.

» Edit Properties. Access the Edit Folder Properties screen.
. ,ﬁ Permissions. Access the folder’s Permissions screen; see Managing

folder and content permissions on page 160.

. iModify Preapproval Group. Set or update preapproval group
assigned to folder; see Setting up an automatic task for pre-approving
content on page 1356

. Approvals. Access the folder’s workflow; see Managing folder and

content permissions on page 160
. !dg Purge History. Access the folder’s purge history table; see Purging

content history on page 159
 F) Restore Web Alert Inheritance. Assigns the folder’'s Web Alert

properties to all content in folder; see Restoring folder-level Web Alert
settings to content on page 1387

¢ Back. Go to previous screen
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3. To change properties, click Edit Properties to open the edit screen.

The Properties screen lets you set the following folder properties, arranged by
tab:

Properties tab

« Name. Edit the name of the content folder. You cannot change the root
folder name.

» Description. Edit the description of the content folder.

» Style Sheet. Specify a style sheet filename that defines styles that may be
applied to content in this folder. The style sheet populates the style drop-
down list within the editor. Leave this field blank to inherit the parent
folder’s style sheet.

This style sheet affects content being edited. It does not necessarily affect
the content’s appearance on your website. To set or edit the style sheet that
determines your Web pages’ appearance, open the page’s Web form and
placea <link rel="stylesheet”...tag withinits <HEAD>tags. If desired,
you can identify the same style sheet in both locations. To include user-
selectable styles, they must be generic classes.

The Ektron editor ignores the CSS custom properties caption and
visible. To address this problem for Internet Explorer, replace them with
the custom CSS properties 1localeRef, captionand visible. For other
browsers, use the custom CSS selectors localeRef and unselectable
(same asvisible: false). TO achieve cross-browser compatibility, use
both approaches. Non-IE browsers have no equivalent forcaption.

« Multi-site Domain Configuration. The Site Name, Staging Domain,
and Production Domain fields only appear for Site folders. These fields
are used to set up and manage several websites under one CMS. See also:
Supporting multi-site configurations on page 86.

» Office Documents. This field only appears if the Enable Office
documents to be published in other format property is checked in the
Settings > Configuration > Setup screen. See also: General tab on
page 122. Enable the Publish Office documents as PDF check box if
Office documents in this folder are published as PDF files. This property is
not inherited from a parent folder, nor is it inherited by any subfolders below
this folder.

+ Content Searchable. Check the Inherit Parent Configuration box if
you want this folder to inherit the Content Searchable value from its parent
folder. Uncheck this box to break inheritance and apply a unique Content
Searchable setting to this folder.

Check this box to set the default value of the Content Searchable property
for new content added to this folder. It does not affect existing content in
the folder, or content copied or moved to this folder. Regardless of the
default value, an authorized user can change the Content Searchable value
while adding content to the folder or at any other time. See also: Making
content searchable on page 346.

152 | Ektron 9.50




Setting folder properties

» Display Settings. Enable the Inherit Parent Configuration check box if
you want this folder to inherit the Display Settings value from its parent
folder setting. Disable this check box if you want to break inheritance and
apply a unique Display Settings setting to this folder.

« Display All Tabs. Check this box to display all tabs on the Create or Edit
Content screen. Or, check any tab-specific check boxes to display the
selected tabs on the Create or Edit Content screen. If you enable the
Display All Tabs check box and other tab-specific selections, only the
individually checked tabs remain when you click Update. Also, if a tab has a
"required" property on it, the tab displays even if you uncheck its box.

Taxonomy tab. See Assigning categories to a folder on page 1262

- Taxonomy. Enable the Inherit Parent Configuration check box if you
want this folder to inherit taxonomy configurations from the parent folder. If
you disable Inherit Parent Configuration, you can then select
taxonomies that can be applied to content in this folder. Check the At least
one category is required check box if you want all content in this folder to
be assigned at least one taxonomy category. See also: Organizing content
with taxonomies on page 1253

Templates tab. See Working with templates on page 769

 Page Templates. Lets you specify one or more templates for content in
this folder. This folder’s content uses the specified template when appearing
on your website. Enable the Inherit parent configuration check box to
inherit the template from the parent content folder. Or, do not check this
box and specify one or more templates.

Flagging tab. See Assigning a flagging definition to a folder on page 1592

« Flagging. Enable the Inherit Parent Configuration check box if content
in this folder inherits a flagging definition from its parent folder. If you do
not check the box, use the drop-down list to apply a flagging definition to
content in this folder. See also: Defining flags for content on page 1590,
Assigning a flagging definition to a folder on page 1592.

Metadata tab. See Working with Metadata on page 755.

 Metadata. Enable the Inherit Parent Configuration check box if you
want this folder to inherit the metadata values from its parent folder setting.
Uncheck this box if you want to break inheritance and apply unique
metadata settings to this folder. If inheritance is disabled, check the
applicable boxes to determine which metadata definitions can be used.Only
metadata definitions whose Assigned box is checked can be completed by
users working with content in the folder.

Web Alerts tab. See Assigning a Web Alert to a folder or content on page 1383.

» Web Alerts. Lets you specify custom Web alert settings for this folder or
inherit settings from the parent folder. For a description of the Web alert
settings, see Assigning a Web Alert to a folder or content on page 1383.

Smart Forms tab. See Working with Smart Forms on page 815.
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» Smart Forms. Lets you specify custom Smart Form settings for this folder
or inherit settings from the parent folder. For a description of the Smart
Form settings, see Assigning a Smart Form to a folder on page 831.

Product Types tab. See Creating product types on page 1675.

» Default product type. Enable the Inherit Parent Configuration check
box if you want this folder to inherit the metadata values from its parent
folder setting. Uncheck this box if you want to break inheritance and apply
unique metadata settings to this folder. If inheritance is broken, use the
radio buttons to enable a default product type.

Breadcrumb tab. See Creating a sitemap breadcrumb trail on page 1322

« Breadcrumbs. Lets you specify custom breadcrumb settings for this folder
or inherit settings from the parent folder.

Site Alias tab. See Creating a URL alias for a site on page 1316

« Name. A URL to be used as an alias for the site. This tab and field
combination only appears for Site folders.

Aliasing tab. See Creating user-friendly URLs with aliasing on page 1293
» Aliasing. Only appears if some form of aliasing is enabled. Enable the
Manual Alias Required check box to force the user creating or updating
content in the folder to add a manual alias (if none exists). Enable the
Inherit parent configuration check box (disabled by default) if you want
the folder to inherit the Manual Alias Required value from the parent
folder.

Copying and moving a folder

You can copy a folder and paste it into another folder. Or you can cut and paste one
folder into another. Cut and paste is synonymous with move.

1. Inthe left panel of the Workarea, hover the cursor over the folder you want to
copy/move.

2. Right click the mouse.
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3. Click Copy or Cut folder name.
+ CM3S4000Demao

+ Developer

Imagelﬁnllnn-‘

PageBl  1d Folder

+ Starter Add Blog
! WebCz  add Discussion Board
' Wiki E  Add Community Folder
Add Calendar
Add Catalog
View Properties

Cut ImageGallery

LIEEY alyestaallely

Delete Imagews

4. Hover the cursor over the folder to which you want to paste the copied/cut
folder.
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5. Right click the mouse and select Paste Folder.

Brnl Stors

Add Folder

Add Blog

Add Discussion Board
Add Community Folder
Add Calendar

Add Catalog

View Properties

Cut Book Store
Copy Book Store

m ol MORW |-

Delete Book St

6. A warning message appears. Click OK.
Message from webpage )

'6' Folder properties for Permissions, Metadata, Templates, Web Alerts,

' " Approvals, Sitemap, Taxenomy, Flagging, Aliasing and XML Smart
Forms retain their previous values in the new location. Alsa, the Inherit
checkbox is unchecked for moved/copied folder.

You may later adjust the folder's properties as needed,

Continue?

[ OK ] | Cancel

. ¥

Who can copy and move folders
These users can copy or move folders.

» users who have Add, Edit and Delete permissions for the folder being
moved/copied and the destination folder See also: Managing folder and content
permissions on page 160

 members of the Administrators user group
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users assigned in the Roles > Folder Specific > Folder User Admins screen
users assigned in the Roles > Folder Specific > Move or Copy screen

See also: Defining roles on page 1464

Rules for copying and moving folders

When you copy or move a folder, you also copy/move all of its subfolders.

All properties assigned to a folder (permissions, metadata, templates, and so
on) remain assigned after the copy or move. You can edit the folder in its new
location and adjust properties as needed.

Inherit checkboxes that were checked are now unchecked. After the
copy/move, check them as needed.

Properties Taxonomy Templates Flagging

Meta Data/Custom-Fields available for new folder: 'ImageGallery’

@erit parent cnnﬁg@

You cannot copy or move the root folder
You cannot copy or move a folder into its own subfolder
You cannot move a folder to same level in the folder structure

You can copy a folder to same level in the folder structure. If you do, a number is
appended to the folder name, such as calendar (1).

If you move a folder, its content retains its status. That is, if content's status was
checked out (O) before the move, it is checked out after the move.

If you copy a folder, only Approved content is copied. Content in other statuses
is not copied.

All folder content that follows the above rules is moved/copied. This includes all
language versions of those items.

Folder types that can be moved and copied

The following folder types can be copied or moved into other folder types.

Content folders. Can be copied or moved into Content, Site, and Root folders.
Blog folders. Can be copied or moved into Content, Site, and Root folders.

Discussion Board folders. Can be copied or moved into Content, Site, and
Root folders.

Forum folders. Cannot be copied or moved into any other folder.

Community folders. Can be copied or moved into Content, Community, Site,
and Root folders.

Web Calendar folders. Can be copied or moved into Content, Site, and Root
folders.

Catalog folders. Only the folder can be copied or moved into Content, Catalog,
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Site, and Root folders; the content of the Catalog folder is not copies or moved.
» Site folders. Cannot be copied or moved into any other folder.

Deleting a folder

You can delete obsolete folders from the Ektron website.

NOTE: The top-level folder, Root, cannot be deleted nor renamed.

WARNING! Deleting a folder permanently deletes the content and Quicklinks that
belong to the folder and all of its subfolders. You cannot retrieve deleted content.

NOTE: Only certain users are allowed to delete Ektron folders. See Auditing
changes on page 632.

1. Inthe Workarea, go to the content folder you want to delete.
2. From the options across the top of the screen, choose Delete > This Folder.

View Contents of Folder "Books on radiology™

NEW VIEW DELETE ACTION

4!

Title This Folder

3. Alternatively, you can hover the cursor over the folder in the folder display panel,
right click the mouse, and choose Delete folder name.
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= Book Staore

Add Folder

Add Blog

Add Discussion Board
Add Community Folder
Add Calendar

Add Catalog

View Properies

Cut Books on radiolagy
Copy Books on radiology
Faste Folder

Delete Content from Books on radiology

4. Click OK.

Purging content history

WARNING! Purging permanently deletes content. You cannot retrieve purged
content.

The Purge History option lets you delete historical versions of content in a folder. For
more information on content versioning, see Managing versions of content on
page 643.

Purging is generally performed due to storage space concerns or to clear away
obsolete versions before going live or migrating a site. Before purging, make sure
you are aware of any organizational or legal data retention policies.

When purging, you can:

» specify a date to limit which historical versions are purged. Only historical
versions with an edit/publish date before this are purged.

» indicate whether a folder’s subfolders are purged

» purge published as well as checked-in versions of content

PREREQUISITE

Only members of the administrators group and users identified on the
Manage Members for Role: Folder User Admin screen can purge history.

To purge the history for a folder:
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In the Workarea, go to the folder whose content you want to purge.
Click View > Properties.
Click Purge History (Jdir;). The Purge History screen appears.

1.
2.
3.
4.

Customize the purge options.
« Only purge historical versions before (required). Specify a date to limit
which historical versions are purged. When specified, only historical
versions with a date before this date are purged.

+ Recursive Purge (optional). Purges historical content versions in this
folder’s subfolders.

» Purge versions marked as Published (optional). Purges published
versions of content as well as checked-in versions. If you do not check this
box, Published version are not purged.

5. Click Purge History.
6. Click OK to execute the purge.

Managing folder and content permissions

Permissions determine which actions Ektron users and user group members can
perform on content, library items, and content folders. For example, you let your
Webmaster perform advanced actions, such as adding folders, editing folder
properties, and deleting folders. At the same time, you let content contributors only
view, edit, and add content.

You can set permissions for a folder or content item. Content item permissions
override the associated folder permissions. When you assign permissions to a folder,
they affect all of its subfolders and content unless you break inheritance for a
subfolder or content item.

Unlike some folder properties (such as workflow), permissions are not language-
specific. They apply to all language versions of a content item.

Only Ektron administrators and users identified on the Manage Members for Role:
Folder User Admin screen can set permissions. See also: Using the roles screens on
page 1465

NOTE: Use the Roles screens to assigh permissions not defined in the Permissions
screen, such as the ability to create tasks. See also: Defining roles on page 1464

NOTE: You can view and update permissions for membership users by selecting
Membership users from the User Type drop-down menu; see Assigning
membership permissions on page 1516.

Accessing the permissions screen

IMPORTANT: Members of the administrators group have all permissions for all
Ektron folders, whether or not they appear on a folder’s permissions screen.

You manage the following permissions through the Permissions screen.
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+ Content management: view, add, edit, delete, restore

» Library File Management: view, add images, add other types of files, add
hyperlinks, overwrite files

» Folder management: add, edit, delete, traverse
* Work with collections and menus
To access the Permissions screen:

1. From the left frame of the Workarea, select a content folder.
2. Choose View > Properties. The Folder Properties screen appears.
3. Click Permissions (.fﬁ). The Permissions screenappears.

View Permissions for Folder "Authors™

4 || ADD PERMISSIONS b4 =]
Advanced User Type: CMS users -|
(CMS users |
Allow this object to inherit permissions Membership users
The content in this folder is private and can only be viewed by authorized users and members
up Name Read Only Ed Add Delete Restore Library Read Only Add Images perlin ibrary
& admin « 4 4 4 v 4 « Vg T g
&2 Approver - o 4 L4 L4 4 4 4 4 o L4
Documentation
&3 Author - L4 L4 L4 L4 L4 4 4 4 4 4

The Permissions screen displays each user or group’s abilities to act on content in the
selected folder. Because all permissions cannot fit on one screen, click the Advanced
tab to see additional actions.

NOTE: To let users copy or move content, assign the Move or Copy role. See also:
Defining roles on page 1464

Standard permissions

 Read Only. View content

» Edit. Edit content

« Add. Add content

» Delete. Delete content

» Restore. Restore old versions of content

» Library Read Only. View items in the corresponding library folder See also:
Working with files in the library on page 673

+ Add Images. Upload images to the corresponding library folder
» Add Files. Upload files to the corresponding library folder
» Add Hyperlinks. Add hyperlinks to the corresponding library folder

» Overwrite Library. Overwrite images and files to the corresponding library
folder

Advanced permissions
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« Collections. Manage collections See also: Working with collections on page 740

IMPORTANT: If a user is assigned any of the following roles, the user can
create, edit, and delete collections regardless of the user's Collections folder
permission: Collection and Menu Admin, Collection Admin, Collection
Approver.

» Add Folders. Add sub folders See also: Adding a folder on page 149

» Edit Folders. Edit folder properties See also: Setting folder properties on
page 150

» Delete Folders. Delete the current folder or its subfolders See also: Deleting a
folder on page 158

» Traverse Folders. Access folders under the root folder. By default, the
Everyone user group has permission to view all subfolders. If you disable or
modify the Everyone user group, and you want to grant users/groups permission
to a folder other than the root folder, you must also assign Traverse permission.
If you do not, the user cannot access the folder. In that case, the user cannot
perform any other granted permissions.

» Modify Preapproval. Set or update a folder’s preapproval group. This
permission is only displayed if preapproval groups are enabled. See also: Setting
up an automatic task for pre-approving content on page 1356

Inheriting permissions

By default, folders and content items inherit permissions from their parent folder.
You have 2 options for modifying folder or content permissions.

» Modify the parent folder's permissions
» Break inheritance then modify the permissions fr the folder/content

Breaking inheritance

IMPORTANT: You cannot break inheritance if you are using advanced workflow,
and any content in the folder is in Submitted status.

From the left frame of the Workarea, select a content folder.
Choose View > Properties. The Folder Properties screen appears.
Click Permissions (#”). The Permissions screenappears.

Uncheck the Allow this object to inherit permissions box.
Click OK.

uau A W N =

Restoring inheritance

IMPORTANT: You cannot restore inheritance if you are using advanced workflow,
and any content in the folder is in Submitted status.

1. From the left frame of the Workarea, select a content folder.
2. Choose View > Properties. The Folder Properties screen appears.
3. Click Permissions (7). The Permissions screenappears.
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4. Check the Allow this object to inherit permissions box.
5. Click OK.

Adding a user or user group to the permissions screen

NOTE:

* Before adding users or groups, you must break inheritance. See Breaking
inheritance on the previous page.

* If a user and a user group to which that user belongs are both given permission
to a folder, the user has all permissions to which he/she is assigned as well as
permissions assigned to the group.

*You can assign only Read Only permission to a Membership user or group. See
also: Membership users and groups on page 1507.

1. From the left frame of the Workarea, select a folder.
2. Choose View > Properties. The Folder Properties screen appears.
3. Click Permissions (#°). The Permissions screenappears.

View Permissions for Folder "Authors™

€| ADDPERMISSIONS | 3 )
Advanced User Type: CMS users v|
CMS users |
Allow this object to inherit permissions. Membership users
The content in this folder is private and can only be viewed by authorized users and members.
Read Only =~ Edit  Add  Delete  Restore
& admin « s < < v L4 L4 g ' L'
&2 Approver - L4 L L4 L4 L4 L4 L4 L4 L4 L4
Documentation
83 Author - 4 4 g g g L' L' g 4 g

4. Select CMS users or Membership users from the User Type drop-down menu.
Users and groups of the selected type appear.

5. Click Add Permissions. The Add Permissions screen appears. Only users and
groups not assigned to the Permissions screen appear.

6. Check users and groups to add to the Permissions screen.
7. Click Save. The Add Permissions screen appears.
8. Check the standard and advanced permissions for the user or group.

NOTE: Check Enable All to assign all permissions on the screen.

9. Click Save.

Deleting a user or user group from the permissions
screen

IMPORTANT: If a user or group is assigned to an advanced workflow, before you
can delete the user or group, you must remove it from all workflows. See also:
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Editing an advanced workflow for a folder on page 712, Editing an advanced
workflow for content on page 716

From the left frame of the Workarea, select a content folder.
Choose View > Properties. The Folder Properties screen appears.
Click Permissions (.fﬁ). The Permissions screenappears.

Select CMS users or Membership users from the User Type drop-down menu.
Users and user groups of the selected type appear.

Click Delete (.%.). The Remove Permissions screen appears.

i S s

Select the user or group to remove from the Permissions screen.
Click Remove Permissions for folder.
Click OK.

® NSO WU

NOTE: When you delete the permissions of a user or user group, that change
is propagated to all subfolders and content that inherit the permissions. Also,
if the user or group was part of a workflow, they are removed from it.

Editing user or user group permissions

IMPORTANT: If a user or group is assigned to an advanced workflow, before you
can edit the user or group, you must remove it from all workflows. See also:
Editing an advanced workflow for a folder on page 712, Editing an advanced
workflow for content on page 716

From the left frame of the Workarea, select a content folder.

Choose View > Properties. The Folder Properties screen appears.

Click Permissions (.fﬁ). The Permissions screenappears.

Select CMS users or Membership users from the User Type drop-down menu.
Users and user groups of the selected type appear.

5. Click the user or group for which you want to edit permissions. The Edit
Permissions screen appears.

6. To assign any permission, check the box. To remove any permission, uncheck
the box. See also: Standard permissions on page 161, Advanced permissions on
page 161

i S

NOTE: Remember to toggle between standard and advanced permissions.

7. Click Update.

Setting permissions for content

For an overview of permissions, see Managing folder and content permissions on
page 160.

Users can only add, edit, or delete content in folders if they have traverse permission
for its parent folders all the way up to root. If the folder to which you assign
permissions is not the root folder, you must grant the user the Traverse Folder
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permission to all folders above that folder. Otherwise, the user cannot go to the
folder. For example, consider the following folder structure.

= i) Folders
= CMS400Demo
_Rotatinglmages
+ About Us
= Blog

+ Conditions

To let a user edit the Book Store folder only and no other folders, assign to the user
Traverse Folder permission for the 2 folders above Book Store: CMS400Demo and
Folders (root folder).

PREREQUISITES

» Traverse permission to the folder containing the content, and all
folders above it

» Edit permission for the content

1. Access the content by navigating to its folder, selecting a language, and clicking
on it.

2. Click View Permissions (.fﬁ’ ).

3. Uncheck the box next to Allow this object to inherit permissions.

NOTE: If Allow this object to inherit permissions is already checked,
you cannot uncheck this box. The content in this folder is private and can only
be viewed by authorized users and members; see Making content private on
page 637. In that case, this folder is inheriting this setting from its parent
folder.

4. Click OK.

5. You can perform any action on the content that you can perform on a folder.
These options are described in Managing folder and content permissions on
page 160.
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Versions of Ektron previous to 8.5 featured 2-tier architecture, in which the
Application and Presentation tiers resided on the same server. In 3-tier architecture,
you can locate the Application tier in the client’s environment or an Ektron hosting
environment. This represents a true separation of the Web server from the database.
The Application tier does the bulk of the work, while the Presentation tier does basic
processing.

IMPORTANT: You are not required to use 3-tier architecture—Ektron continues
to run successfully on 2-tier architecture.

A 3-tier architecture lets you spread the processing of Ektron data among 3 tiers,
shown in the following figure. Each tier should reside on its own server.

Development Staging site Production site
site
Presentation Presentation Site ‘”5”05 T~ Presentation
: . access this .
tier tier corver tier
! T |
Application = s Application (= =
tier PN tier i Application
% tier
| Administrators, |/ -
authors, and
I developerswork | I

here

Data tier . Data tier . Data tier

NOTE: You may run all 3 tiers on a single server for development purposes only.

The 3 tiers are Data, Application, and Presentation.
» Data. Contains SQL and Ektron database objects (stored procedures, views,
tables, and so on).

» Application. Full Ektron installation.
o Ektron DLLs

Ektron Workarea

o

o

Ektron Windows Services
Ektron WCF Services
Custom WCF Services

* Presentation.
° Handles site visitor requests and displays Web pages

o Minimal footprint, lightweight
o Requires IIS
No Ektron installation

o

e}

e}
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°o Contains
o Standard ASP.NET website

o Minimal set of Ektron .dlls in bin folder
o Configuration files (web.config, unity.config)

o Workarea required only if website uses PageBuilder or templated server
controls.

The Ektron Framework API uses the Microsoft Unity Framework to inject
business logic implementations into our Framework API. When running in 3-Tier
mode, the Framework API on the Presentation tier uses a WCF service client
implementation, thereby routing Framework API calls through WCF services,
while the actual logic is running on the Application server.

To minimize network requests the between Presentation and Application tiers,
Ektron includes a caching tier.

NOTE: 3-tier architecture is different from MVC coding style, which consists of a
data layer, business logic layer, and an API layer.

NOTE: To communicate between servers, you can choose any unused port. If you
choose a port other than 80, Ektron recommends one outside the well-known port
range (0 to 1023).

Benefits of 3-tier architecture

3-tier architecture provides the following benefits.

» Scalability. Each tier can scale horizontally. For example, you can load-balance
the Presentation tier among 3 servers to satisfy more Web requests without
adding servers to the Application and Data tiers.

+ Performance. Because the Presentation tier can cache requests, network
utilization is minimized, and the load is reduced on the Application and Data
tiers. If needed, you can load-balance any tier.

« Availability. If the Application tier server is down and caching is sufficient, the
Presentation tier can process Web requests using the cache.

Limitations of 3-tier architecture

3-tier architecture has the following limitations.

* You must manually push templates, assets, private assets, uploaded images,
and uploaded files from the Application tier to the Presentation tier. You may use
a tool like Robocopy to do this.

» You create content (HTML, assets, PageBuilder pages, and so on) only in the
Application tier. You can only view content from Presentation tier.

» Because 3-tier architecture uses WCEF, it requires:

o the 8.5 or higher Framework API and databinding. You cannot use API calls
outside of the Framework API
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o templated server controls
o widgets created by the Framework API

« Because the business logic executes on the Application tier, its website directory
must be identical to the Presentation tier's.

Impact of 3-tier setup on a developer

The Unity Framework provides the same developer experience, whether you use 2-
or 3-tier architecture, by defining which container to use in the web.config file. See
also: Introduction to Unity, Creating a sample content block in 3-tier architecture on
page 175.

NOTE: You do not need to know about the Unity Framework—it is mentioned here
to help you understand how Ektron achieves 2-tier and 3-tier architecture.

Ektron has 3 main containers, which transmit data between tiers.

» Business object (BusinessObjects.Content)
o contains Ektron's implementation of business logic

° used in 2-tier architecture
o in 3-tier architecture, executed in the Application tier

» WCF service proxy (Framework.Services.Content.ContentServiceClient)
o used in 3-tier architecture to communicate between Application and
Presentation tiers
» Cache (BusinessObjects.Caching.Content)
o Ektron uses the Unity Framework to insert a caching layer
° When an API call is made (or a templated server control is used) from the
Presentation tier, Ektron caches frequently-used objects

° Caching minimizes API calls between Application and Presentation tiers

NOTE: Caching uses a provider model. By default, Web caching is
implemented, but you can replace it with other caching options.

The following chart shows how the Framework API uses the containers.

1. Content manager gets initialized and implements the 1ContentManager
interface.

2. The Presentation tier uses the container specified in web.config. In
web.config, if defaultContainer= “Default”, the Presentation tier first looks
in cache for the requested data object. If the data object is not there, the
Presentation tier looks in the ChildContainer property value, which is WCF by
default.
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Ektron.Cms.Framework.Content.ContentManager

HUSEse

[ServiceContract)

winterfaces
IContentManager

Ektron Cms. Framework, Unity. config
determines which IConteniManager

BusinessObjects,Caching Content

Cache
Implementation

implemeniation ObjectFactory
instantiates for Framework AP

BusinessObjects.Content

BusinessObject
Implementation

Framework. Services.Content.ContentServiceClient

L WCF Snrv;-u'.e Proxy

Setting up 3-tier architecture

» The IP address of your application tier server

« If the Ektron machine is running Windows 2012 server, you must
install WCF HTTP Activation.
Installing WCF HTTP Activation

a. Launch Server Manager from the task bar or Start menu.
b. Choose the server on which you want to install WCF.

c. From the task drop-down, scroll to Roles and Features.
d

. On the Add Roles and Features Wizard dialog, in the left panel,
select Features.

e. Expand .NET Framework 4.5 Features.

NOTE: If you have not installed .NET 4.5, go back to Server
Roles and install it.

f. Under WCF Services, check the HTTP-Activation box.

Ektron Reference I 171



Distributing resources with 3-tier architecture

g. Click Install.

E Add Roles and Features Wizard

Select features

Select one or more features to install on the selected server,
Installation Type Features

4 ET Framewark 3.5 Features (Installec

D15 ¥ ET Framewark 3.5 {includes .MET 2.0 and 3.0
[ HTTP Activation

[] Men-HTTP Activation

] Message Queuing (MSMQ) Activation
[] Mamed Pipe Activation

1. On your Web Application server, install an Ektron website to the site root folder
(if you do not already have one). During installation, install the Ektron database
to a remote SQL Server.

NOTE: The 8.5 and higher installation includes a
startersites\3TierMin\Content folder that contains files needed for the
Presentation tier.

2. Onthe Web application server, copy the C:\Program Files
(x86) \Ektron\CMS400vxx\startersites\3TierMin\Content folder.

3. On the Presentation tier server, paste that folder to the website root folder.

4. On the Presentation tier server, open IIS and make the new folder a website. See
also: Creating multiple websites on a single server on page 90.
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[ Add Web site )

Site name:;

Sample3T Sample3T Select...

Content Directory

Physical path:
Chinetpubwwwroot' Sample3T

Pass-through authentication

| Connect as.. | |Test5-e1:tir1gs...
Binding

Type: IP address: Port:
http - | All Unassigned - &0
Host name:

SampledT

Example: www.contoso.com or marketing. contoso.com

|| Start Web site immediately

| QO | | Cancel

.

5. On the Presentation tier server, open the site root/web.config file.

6. Update ek ServicesPath to point to the workarea/services folder on your
Application tier server.

<appSettings>
<!-- This is the path to your CMS App Site.
It should always end in workarea/services/ -->

<add key="ek ServicesPath" value="http://[YOUR CMS SERVER]
/workarea/services/" />
</appSettings>

7. If you want to turn on caching, set the following values in the web.config file.

<ektron.cacheProvider defaultProvider="webCache">
<providers>
<add name="webCache" cacheTimeSeconds="300"
type="Ektron.Cms.Providers.Caching.WebCacheProvider,
Ektron.Cms.Providers" />
</providers>
</ektron.cacheProvider>

8. Make sure the value of the framework defaultContainer tagis Cache, and the
framework childContainer tagis WCF.

<framework defaultContainer="Cache" childContainer="WCFEF">
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9. On the Application tier server, open IIS.
10. Click your website > workarea > services.
11. Click IP Address and Domain Restrictions in the right pane.
12. Click Add Allow entry and enter your Presentation layer's IP address.

IP Address and Domain
< - | o] |$ ~  Restricti Add Allow Entry,
| MobileDevicePreview - estrictions add Deny Entry,
| Moss . .
Use this feature to restrick or grant access to web content " |
Myiorkspace based on IP addresses or domain names, Set the Eelt Fechirc ol
-] Motifications restrickions in order of priority, Revert To Paren
- Packaging ) Wiew Ordered Lis
-] PageBuider Group by: Mo Grouping -
B[] Personalization Mode = | Requestor | Entry Tvpe ® Help
[+ ] PrivateData Orline Help
[+ resources Add Allow Restriction Rule =
- | search
Allow access For the Following IP address or domain name:
E‘ : m ' Specific IP address:
- | Commerce
: soundmanager
7 550
-] subseriptions " IP address range:
-1 swnc T

13. Click your website > workarea > webservices. Then, click IP Address and
Domain Restrictions in the right pane.

14. Click Add Allow entry and enter your Presentation layer's IP address.
15. Open a browser and browse to your site.
16. Deploy templates and supporting files to the Presentation server.

Files copied to the Presentation tier

The following files are copied from the Application tier server to initialize the
Presentation tier after you complete the set up. The files are located in the
startersites\3TierMin\Content folder.

e App Code folder. Contains URL Aliasing module See also: Aliasing with 3-tier
architecture on page 176.

» Bin folder. Subset of full bin folder; contains binaries for Presentation tier only

* Workarea folder. Subset of full Workarea folder; Framework Ul is required to
run templated controls and PageBuilder controls on Presentation tier
» The following configuration files:
° Ektron.cms.framework.ui. Contains default templates for templated
server controls
° Ektron.cms.framework.unity. Has mapping interfaces and
implementation
° Ektron.cms.framework.ui.unity. Has mapping for templated control to
services
» Within web.config
o Within <configsections> tags. <sectionGroup> settings define how the
Presentation tier communicates with the Application tier

° ek ServicesPath. Defines the path to the Application tier's Web services
file
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o The following UI elements for templated server controls
<ui.unity configSource="ektron.cms.framework.ui.unity.config" />
<ui configSource="ektron.cms.framework.ui.config" />

» The <ektron.framework.services> tag defines the container.

<ektron.framework.services>
<unity configSource="ektron.cms.framework.unity.config"/>
<framework defaultContainer="Default" childContainer="WCE"/>
</ektron.framework.services>

If defaultContainer="Default”, the Presentation tier first looks in cache for the
requested data object. If the data object is not there, the Presentation tier looks in
the childContainer property value, which is WCF by default.

» content of <pages> tag. Controls used by PageBuilder and templated server
controls.

e The <modules> section manages Aliasing. See also: Aliasing with 3-tier
architecture on the next page.

<system.webServer>

<modules runAllManagedModulesForAllRequests="true">

<add name="EkUrlAliasModule" type="UrlAliasingModule"
preCondition="integratedMode" />

</modules>

</system.webServer>

Creating a sample content block in 3-tier
architecture

This example illustrates how the same code can work in the Application and
Presentation tiers. Ektron uses the Framework API to get a content item.

1. In Visual Studio, open the Presentation tier's website.

2. Add a new Web form.

3. Add a label control that can render a content block.

<asp:Label ID="contentblockl” runat="server”> </asp:Label>
4. Open the form’s code-behind file.
5. Insert the following code.

NOTE: This example assumes that ID 30 is a valid Ektron content item.

long id = 30;

if (!string.isNullorEmpty (Request.QueryString[“id”]))

{ long.TryParse (Request.QueryString[“id”].ToString (), out id);
}

6. While in the code-behind file, initialize content manager as the logged in user.

ContentManager contentManager = new ContentManager () ;

7. Getthe content and return it to the asp Label control.

ContentData data = contentManager.GetItem(id) ;
contentblockl.Text = data.Html;
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8. Build and run.
9. Open a Web browser.

10. Insert the Presentation server/page you just created into your browser address
field, where you will see Ektron content through the Presentation tier.

Creating a PageBuilder page with 3-tier

architecture

» A PageHost file in the Presentation tier used specifically to support 3-
tier architecture. The file lets you view only; you cannot edit.

» A widget built using the Framework API (for example, the sample
Content Block widget).

NOTE: A 3-Tier site contains many widgets. Only those built using
the Framework API work on the Presentation tier.

» A wireframe template (content.pb.aspx) that exists on the
Application and Presentation tiers.
1. Go to the Application tier website's Workarea.

2. Create a sample PageBuilder page. See also: Developing wireframe templates on
page 1007.

3. Goto afolder to which the content.pb.aspx wireframe template is applied.
4. Create new Page Layout.

5. Drag and drop a content block widget onto the page layout and assign an Ektron
content item.

6. Publish.
7. Browse to the Presentation website to see the content.

Aliasing with 3-tier architecture

URL Aliasing works within 3-tier architecture. See also: Creating user-friendly URLs
with aliasing on page 1293.

NOTE: Aliasing code is stored in the App Code/CSCode/UrlAliasingModule.cs
file.

3-tier architecture requires the Aliasing module files (Ur1AliasingModule.cs and
UrlAliasingBase.cs inthe App Code/CScCode folder), and the registration of that
module in the web.config file. To verify the registration:

1. Inthe Presentation website, open siteroot/web.config. See also: Setting up
3-tier architecture on page 171.

2. Go to the <Modules> tag.
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3. Verify that the URL alias module is registered, as shown in the following code.

<modules runAllManagedModulesForAllRequests="true">

<add name="EkUrlAliasModule"
type="UrlAliasingModule"
preCondition="integratedMode" />

</modules>

To test URL aliasing, follow these steps.
1. Go to the Application tier website.

2. Create a content block.
3. Onits Alias tab, enter a manual alias.

Edit Content in Folder "SelfServe HelpDesk Pro Release™

€ | pususe | @) g [= [ @
Title: | Self Serv HelpDesk Pro Released [English {U.5.]]
Content Summary Metadata m Schedule Comment Templates Categ
Manual
Primary Alias Name: onTrek] helpdesk | aspx [d
Automatic
Type Aliaz Mame

4. On the Template tab, choose a template that exists on the Application and
Presentation tiers.

5. Publish the content.
6. Verify that Aliasing works on the Application tier.
7. Verify that Aliasing works on the Presentation tier.

Using eSync with 3-tier architecture

You may use eSync to move files among tiers and sites, but eSyncis not a
prerequisite of 3-tier architecture.

You can use eSync to move changes from the development to the staging to the
production sites. You also can use eSync to move changes from the Data to
Application tier. Then, use Web services to move files from the Application tier to the
Presentation tier. However, see Limitations of 3-tier architecture on page 169.

Using search with 3-tier architecture

If you use Microsoft Search Server 2010 with 3-tier architecture, you do not need to
make any adjustments.

To use Solr search with 3-tier architecture, see Using Solr search with 3-tier
architecture on the next page.

To use Microsoft FAST Search Server 2010 search with 3-tier architecture, see Using
Solr search with 3-tier architecture on the next page.
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Using Solr search with 3-tier architecture

If you are using Solr search for your presentation layer, follow these steps to prepare
it for Solr.

1. Open the presentation layer's site root/ektron.cms.framework.unity.config file.
2. Locate the following section.

<!-- Search-->

<typeAlias alias="BusinessObjects.ICrawler"
type="Ektron.Cms.Search.SearchServerCrawler, Ektron.Cms.Search"/>

<typeAlias alias="BusinessObjects.ISearchSettings"
type="Ektron.Cms.Search.SearchSettings, Ektron.Cms.BusinessObjects"/>
<typeAlias alias="BusinessObjects.ISynonyms" type="Ektron.Cms.Search.CmsSynonyms,
Ektron.Cms.Search"/>

<typeAlias alias="BusinessObjects.ISuggestedResults"
type="Ektron.Cms.Search.SuggestedResults, Ektron.Cms.BusinessObjects"/>
<typeAlias alias="BusinessObjects.ISearchManager"
type="Ektron.Cms.Search.SearchManager, Ektron.Cms.BusinessObjects"/>
<typeAlias alias="BusinessObjects.ISearchPropertyRule"
type="Ektron.Cms.Search.SearchPropertyRule, Ektron.Cms.BusinessObjects"/>
<typeAlias alias="BusinessObjects.ISearchProvider"
type="Ektron.Cms.Search.SS2010.SS2010SearchProvider, Ektron.Cms.Search"/>
<typeAlias alias="BusinessObjects.ISearchResultBuilder"
type="Ektron.Cms.Search.SharePointSearchResultBuilder, Ektron.Cms.Search"/>
<typeAlias alias="BusinessObjects.IIntegratedSearchMapping"
type="Ektron.Cms.Search.IntegratedSearchMapping, Ektron.Cms.BusinessObjects"/>
<typeAlias alias="BusinessObjects.IPropertyNameResolver"
type="Ektron.Cms.Search.SharePointPropertyNameResolver, Ektron.Cms.Search"/>
<typeAlias alias="BusinessObjects.IDocumentPromotionManager"
type="Ektron.Cms.Search.DocumentPromotionManager, Ektron.Cms.Search"/>
<typeAlias alias="BusinessObjects.IQueryProposition"
type="Ektron.Cms.Search.SharepointQueryPropositionService, Ektron.Cms.Search"/>
<typeAlias alias="BusinessObjects.IQueryPropositionManager"
type="Ektron.Cms.Search.QueryPropositionManager, Ektron.Cms.BusinessObjects"/>
<typeAlias alias="BusinessObjects.IRecordQueryStatisticsHelperService"
type="Ektron.Cms.Search.SharepointRecordQueryStatisticsService,
Ektron.Cms.Search"/>

3. Replace that section with the following code.

4. <!-- Search-->
<typeAlias alias="BusinessObjects.ICrawler" type="Ektron.Cms.Search.SolrCrawler,
Ektron.Cms.Search"/>
<typeAlias alias="BusinessObjects.ISearchSettings"
type="Ektron.Cms.Search.SearchSettings, Ektron.Cms.BusinessObjects"/>
<typeAlias alias="BusinessObjects.ISynonyms" type="Ektron.Cms.Search.CmsSynonyms,
Ektron.Cms.Search"/>
<typeAlias alias="BusinessObjects.ISuggestedResults"
type="Ektron.Cms.Search.SuggestedResults, Ektron.Cms.BusinessObjects"/>
<typeAlias alias="BusinessObjects.ISearchManager"
type="Ektron.Cms.Search.SearchManager, Ektron.Cms.BusinessObjects"/>
<typeAlias alias="BusinessObjects.ISearchPropertyRule"
type="Ektron.Cms.Search.SearchPropertyRule, Ektron.Cms.BusinessObjects"/>
<typeAlias alias="BusinessObjects.ISearchProvider"
type="Ektron.Cms.Search.Solr.SolrSearchProvider, Ektron.Cms.Search"/>
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<typeAlias alias="BusinessObjects.ISearchResultBuilder"
type="Ektron.Cms.Search.Solr.SolrSearchResultBuilder, Ektron.Cms.Search"/>
<typeAlias alias="BusinessObjects.IIntegratedSearchMapping"
type="Ektron.Cms.Search.IntegratedSearchMapping, Ektron.Cms.BusinessObjects"/>
<typeAlias alias="BusinessObjects.IPropertyNameResolver"
type="Ektron.Cms.Search.Solr.SolrPropertyNameResolver, Ektron.Cms.Search"/>
<typeAlias alias="BusinessObjects.IDocumentPromotionManager"
type="Ektron.Cms.Search.DocumentPromotionManager, Ektron.Cms.Search"/>
<typeAlias alias="BusinessObjects.IQueryProposition"
type="Ektron.Cms.Search.Solr.SolrQueryPropositionService, Ektron.Cms.Search"/>
<typeAlias alias="BusinessObjects.IQueryPropositionManager"
type="Ektron.Cms.Search.QueryPropositionManager, Ektron.Cms.BusinessObjects"/>
<typeAlias alias="BusinessObjects.IRecordQueryStatisticsHelperService"
type="Ektron.Cms.Search.Solr.SolrRecordQueryStatisticsHelperService,
Ektron.Cms.Search"/>

Using Microsoft FAST Search Server 2010 with 3-tier
architecture

If you are using Microsoft FAST Search Server 2010 for your presentation layer,
follow these steps to prepare it for FAST.

1. Open the presentation layer's site root ektron.cms.framework.unity.config file.
2. Locate the following section.

<!-- Search-->

<typeAlias alias="BusinessObjects.ICrawler"
type="Ektron.Cms.Search.SearchServerCrawler, Ektron.Cms.Search"/>

<typeAlias alias="BusinessObjects.ISearchSettings"
type="Ektron.Cms.Search.SearchSettings, Ektron.Cms.BusinessObjects"/>
<typeAlias alias="BusinessObjects.ISynonyms" type="Ektron.Cms.Search.CmsSynonyms,
Ektron.Cms.Search"/>

<typeAlias alias="BusinessObjects.ISuggestedResults"
type="Ektron.Cms.Search.SuggestedResults, Ektron.Cms.BusinessObjects"/>
<typeAlias alias="BusinessObjects.ISearchManager"
type="Ektron.Cms.Search.SearchManager, Ektron.Cms.BusinessObjects"/>
<typeAlias alias="BusinessObjects.ISearchPropertyRule"
type="Ektron.Cms.Search.SearchPropertyRule, Ektron.Cms.BusinessObjects"/>
<typeAlias alias="BusinessObjects.ISearchProvider"
type="Ektron.Cms.Search.SS2010.SS2010SearchProvider, Ektron.Cms.Search"/>
<typeAlias alias="BusinessObjects.ISearchResultBuilder"
type="Ektron.Cms.Search.SharePointSearchResultBuilder, Ektron.Cms.Search"/>
<typeAlias alias="BusinessObjects.IIntegratedSearchMapping"
type="Ektron.Cms.Search.IntegratedSearchMapping, Ektron.Cms.BusinessObjects"/>
<typeAlias alias="BusinessObjects.IPropertyNameResolver"
type="Ektron.Cms.Search.SharePointPropertyNameResolver, Ektron.Cms.Search"/>
<typeAlias alias="BusinessObjects.IDocumentPromotionManager"
type="Ektron.Cms.Search.DocumentPromotionManager, Ektron.Cms.Search"/>
<typeAlias alias="BusinessObjects.IQueryProposition"
type="Ektron.Cms.Search.SharepointQueryPropositionService, Ektron.Cms.Search"/>
<typeAlias alias="BusinessObjects.IQueryPropositionManager"
type="Ektron.Cms.Search.QueryPropositionManager, Ektron.Cms.BusinessObjects"/>
<typeAlias alias="BusinessObjects.IRecordQueryStatisticsHelperService"
type="Ektron.Cms.Search.SharepointRecordQueryStatisticsService,
Ektron.Cms.Search"/>

Ektron Reference I 179




Distributing resources with 3-tier architecture

3. Replace that section with the following code.

<!-- Search-->

<typeAlias alias="BusinessObjects.ICrawler"
type="Ektron.Cms.Search.SearchServerCrawler, Ektron.Cms.Search"/>

<typeAlias alias="BusinessObjects.ISearchSettings"
type="Ektron.Cms.Search.SearchSettings, Ektron.Cms.BusinessObjects"/>
<typeAlias alias="BusinessObjects.ISynonyms" type="Ektron.Cms.Search.CmsSynonyms,
Ektron.Cms.Search"/>

<typeAlias alias="BusinessObjects.ISuggestedResults"
type="Ektron.Cms.Search.SuggestedResults, Ektron.Cms.BusinessObjects"/>
<typeAlias alias="BusinessObjects.ISearchManager"
type="Ektron.Cms.Search.SearchManager, Ektron.Cms.BusinessObjects"/>
<typeAlias alias="BusinessObjects.ISearchPropertyRule"
type="Ektron.Cms.Search.SearchPropertyRule, Ektron.Cms.BusinessObjects"/>
<typeAlias alias="BusinessObjects.ISearchProvider"
type="Ektron.Cms.Search.FS2010.FS2010SearchProvider, Ektron.Cms.Search"/>
<typeAlias alias="BusinessObjects.ISearchResultBuilder"
type="Ektron.Cms.Search.SharePointSearchResultBuilder, Ektron.Cms.Search"/>
<typeAlias alias="BusinessObjects.IIntegratedSearchMapping"
type="Ektron.Cms.Search.IntegratedSearchMapping, Ektron.Cms.BusinessObjects"/>
<typeAlias alias="BusinessObjects.IPropertyNameResolver"
type="Ektron.Cms.Search.SharePointPropertyNameResolver, Ektron.Cms.Search"/>
<typeAlias alias="BusinessObjects.IDocumentPromotionManager"
type="Ektron.Cms.Search.DocumentPromotionManager, Ektron.Cms.Search"/>
<typeAlias alias="BusinessObjects.IQueryProposition"
type="Ektron.Cms.Search.SharepointQueryPropositionService, Ektron.Cms.Search"/>
<typeAlias alias="BusinessObjects.IQueryPropositionManager"
type="Ektron.Cms.Search.QueryPropositionManager, Ektron.Cms.BusinessObjects"/>
<typeAlias alias="BusinessObjects.IRecordQueryStatisticsHelperService"
type="Ektron.Cms.Search.SharepointRecordQueryStatisticsService,
Ektron.Cms.Search"/>
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Ektron Web search finds relevant results within several parts of the CMS structure
and offers massive scalability, scaling to tens of millions of items and beyond. Search
capability is based on Microsoft Search Server or Apache Solr technology, which
provide superior search capability with performance and extensibility currently
demanded by enterprises world wide. There are specific search functions for the
visitor using the website and the administrator using the Workarea. You can search
content, documents, metadata, keywords, descriptions, titles, community content,
users, groups, and activity streams.

For more information about Search, see the Ektron Framework API >
Ektron.Cms.Framework.Search and the Framework UI > Templated Server
Controls > Search in the Ektron Online Developer's Reference.

Search providers

» The server hosting your search provider needs at least 120 GB free
space.

» Install SQL Server on a standalone server
» Operating system is Microsoft Windows Server 2008 R2 or 2012

You can choose from the following search providers. Use the following guidelines to
determine which search server is best for you.

e Solr Search
° An open-source, enterprise-level search platform, from the Apache Lucene
project, that is known for scalability and performance.

o Installing Solr on a single on-premises (local) server on page 216
» Microsoft Search Server Express 2010

IMPORTANT: As of Ektron version 9.3 SP1, Microsoft Search Server 2010
Express is no longer supported.

o A free, enterprise search solution that is simple and flexible to configure,
and powerful enough to meet your needs.

o Requirements: Hardware and software requirements (Search Server 2010)
o Installation: Setting up Microsoft Search Server 2010 Express on page 295
» Microsoft Search Server 2010

IMPORTANT: As of Ektron version 9.3 SP1, Microsoft Search Server 2010 is
no longer supported.

° You are indexing more than 10 million items.
o Requirements: Hardware and software requirements (Search Server 2010)
o Installation: Setting Up Microsoft Search Server 2010 on page 302

» Microsoft Search Server 2013 or 2016
o Installation: Installing and Setting up Microsoft Search Server 2013 or 2016
on page 378
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e Microsoft FAST Search Server 2010

° You are indexing more than 100 million items.

Search providers

°o Requirements: Hardware and software requirements (FAST Search Server
2010 for SharePoint)

o Installation: Working with Microsoft FAST search on page 423

» Optimizely Search & Navigation
o A powerful and scalable query platform that lets you index and query large

amounts of structured or unstructured content

o Using Optimizely Search & Navigation with Ektron on the next page
Search provider comparisons

The following table compares functionality available with search providers.

Function

Providing
suggested results
on page 350

(managed within
Ektron)

Microsoft

Search
Server
Express

Solr search

Microsoft

2010, 2013,

Microsoft
FAST
Search
Server

Synonym sets

(managed within

Ektron)

Integrated search v~ v’ v’

Load balanced v

search

Faceted search v’ v

Similar Results v’ v’

Autosuggest see auto- v v’
complete
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Microsoft

Microsoft Search Microsoft
. Search FAST
Function Solr search Server Server Search
Express 2010, 2013, Server
P or 2016
Autocomplete v’
"Did you v’ v v v

on .
mean?" feature single word only

as supported

5y [iaTesat as supported as supported

14 supported by Microsoft by Microsoft

Language support Search
guage supp "out of the box"?! Search Fast Search
Server
Server Server
Express

1_additional languages may be enabled; see Solr language support on page 282

This chapter also contains the following topics.

» Using Solr search on page 204

» Setting up Microsoft Search Server 2010 Express on page 295

» Setting Up Microsoft Search Server 2010 on page 302

» Installing and Setting up Microsoft Search Server 2013 or 2016 on page 378
» Working with Microsoft FAST search on page 423

» Using Microsoft Search Server features on page 335

o Search Templated Server Controls

» Using Optimizely Search & Navigation with Ektron below

Using Optimizely Search
& Navigation with Ektron

Optimizely Search & Navigation is a powerful and scalable query platform that lets
you index and query large amounts of structured or unstructured content. Using
Optimizely Search & Navigation, you can create customized website search
functionality or build advanced navigation for non-hierarchical content. Other search
providers use a crawl to update site content, which can delay the updating of search
results. Optimizely Search & Navigation, on the other hand, uses push technology,
which means that search results on your website are updated in near real-time.
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Setting up Optimizely Search & Navigation

Optimizely Search & Navigation provides search capabilities for all Ektron content,
including HTML content, HTML forms, Smart Forms, assets, and PageBuilder. When
using Optimizely Search & Navigation with Ektron, Ektron content and documents are
initially pushed to a Find index. from then on, the Find index is updated whenever
Ektron content is edited, deleted, or added. For example, if content is scheduled to go
live at a future date and time, Optimizely Search & Navigation can retrieve the
content after the go-live date and time. Similarly, content scheduled to be archived
and removed from site is no longer available in search results as of the scheduled
date and time. To query the index and return search results, use Find APIs.

Because Find does not impact existing search capabilities, it can co-exist with your
current search provider.

Setting up Optimizely Search & Navigation

This section explains how to set up Optimizely Search & Navigation as a search
provider for your Ektron website.

PREREQUISITE

Ektron version 9.10 SP1 or higher

Obtaining Find indexes

Upon creating a developer account, you can use a free development index for testing.
This index has a 10,000 document limit, a 90-day lifespan, and a maximum file size
of 5 MB.

After completing testing, if you want to move into a production environment, obtain a
production index. See http://www.episerver.com/orderfind.

Installing Optimizely Search & Navigation

1. Create an Optimizely Search & Navigation developer service.
a. Go to http://find.episerver.com/.

b. Create an account and verify it.

c. Click Add Developer Service. The Create Developer Service screen
appears.

d. Enter an index name, choose languages to support, accept the terms and
conditions, and click Create Service. The Index Details screen displays
your information.

TIP — SAVE THIS PAGE WITH YOUR BROWSER FAVORITES SO YOU CAN QUICKLY OPEN

IT IN THE FUTURE.
2. Prepare the Ektron website in Visual Studio.
a. Open the Ektron site as a website.
b. Save a solution file for the site.
c. Setthe site's Target Framework to .NET Framework 4.5.
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3. Update the Ektron web.config file with snippets from the Create Service screen.
a. From the Optimizely Search & Navigation Create Service screen, copy the
web.config snippet within the <configSections> tag.

Open your Ektron siteroot\web.config file.
Find the closing configSections tag (</configSections>).
Paste the copied text above the closing </configSections> tag.

From the Optimizely Search & Navigation Create Service screen, copy the
web.config snippet below the closing </configSections>tag and above
the closing </configuration> tag.

®© o 00

f. Within the Ektron siteroot\web.config file, find the closing configuration
tag (</configuration>).

g. Paste the copied text above that tag.

4. Create an Optimizely Search & Navigation package source.
a. In Visual Studio, choose Tools > Library Package Manager > Package
Manager Settings. The Options screen appears.

b. Under Package Manager, choose Package Sources.

c. Add a new source called Episerver Find. Assign it a URL of
http://nuget.episerver.com/feed/packages.svc/

5. Install the Ektron.Cms.Find Nuget package.
a. In Visual Studio, open Solution Explorer.
Right-click the Ektron website project.
From the context menu, choose Manage NuGet Packages...
In the left panel, choose Online.
In the Search field, enter Ektron.cms. find.
f. Click the Ektron.Cms.Find package's Install button.

6. Update the Global.asax file with a reference to bootstrapper file.
a. Open yoursiteroot\Global.asax.

i

NOTE: If your siteroot folder does not contain a Global.asax file,
create one.
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b. Find the following method:
void Application Start (object sender, EventArgs e)

{
}

c. Between the curly brackets ({}), insert the following code.

Ektron.Cms.Find.AspNetBootstrapper.EktronFindBootstrapper.Start () ;

7. To update the Find index with content changes created by Ektron eSync, follow
these steps.
a. Stop the Ektron Windows Service.

b. Copy the Ektron.Cms.Find.EsyncNotification.dll file from the bin folder.
Paste itto the c:\Program Files
(x86) \Ektron\EktronWindowsService40 folder.

c. Openthec:\Program Files
(x86) \Ektron\EktronWindowsService40\objectFactory.config file.

d. Find the following section of the file.

<add name="ESyncNotification”>
<strategies>
</strategies>

</add>

e. Within the <strategies> tags, insert the following line.

<add name="FindStrategy"
type="Ektron.Cms.Find.EsyncNotification.FindStrategy,
Ektron.Cms.Find.EsyncNotification"/>

f. Save the objectFactory.config file.
g. Restart the Ektron Windows Service.

Loading Ektron content into the Find index

After installing Optimizely Search & Navigation, push your website content to the
Find index.

PREREQUISITES

* You completed all installation steps. See Installing Optimizely Search
& Navigation on page 185.

* You are a member of the Ektron Administrators Group.

1. Open the following URL: yoursiteroot/episerverfind/. The following screen
appears.

EPiServer Find Provider ndex All Content Refresh Status

System Status
Find Configuration OK
Find Availability Available

Total Documents Indexed 131
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« The Find Configuration field indicates that the Global.asax file includes
the correct reference to the bootstrapper file. (This step was covered in
Installing Optimizely Search & Navigation on page 185.)

» The Find Availability field indicates that your web.config file was updated
with snippets from the Create Service screen. (This step was also covered in
Installing Optimizely Search & Navigation on page 185.)

2. Click Index All Content. The screen indicates that indexing has begun.

3. Click Refresh Status occasionally to view progress. When the Total
Documents Indexed number stops changing, indexing is complete.

Using Find with Ektron content types

IMPORTANT: When you edit the bootstrapper file or code that it references, you
must restart IIS to push the latest changes to Find. Then, clear the Find index and
reindex. These actions prevent mismatches between the Find index and custom
types that use it.

Using Find to query HTML content

You can used FIND APIs to query and filter published HTML content by the following
properties.

o Title

» Body

e Summary

« Taxonomy category

» Creation date

» Modification date

» Last editor

» Folder

e Content ID

e Language

e Quicklink

Using Find with a PageBuilder page

Optimizely Search & Navigation returns search results for all searchable content on a
published PageBuilder page. Text that appears on such a PageBuilder page is
indexed, along with the page's title. For example, if a PageBuilder page includes a
collection widget, and each collection item's teaser is displayed, the teaser text is
searchable.

Indexing PageBuilder master layouts

Pagelayout pages are indexed. Master layouts are not indexed, but PageBuilder
pages based on a master layout are indexed. See also: Creating a PageBuilder
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master layout on page 1010.

Suppressing page elements from search results

You may want to suppress certain page elements from search results. For example,
you want to exclude navigation menus or footers. The following Knowledge Base
article explains how to do this: How to hide an element on a PageBuilder page from
showing up in search results.

NOTE: Any text that is not visible to the builtin user is not indexed.

Using Find with Ektron Smart Forms

NOTE:

* If you want a Smart Form to be indexed, you must select its Content
Searchable checkbox.

* The Indexed checkbox on Smart Form configuration field's dialog has no effect
on whether the field’s content is searchable. Any property specified in your
custom Smart Form class and populated by serialization logic is searchable.

You can query Smart Forms using the content type Smartform. For
example: SearchResults<Ektron.Cms.Find.Models.SmartForm> results;

If you use this approach, Episerver Find returns Smart Form content as a single
string. To extract field data, developers must use a string split technique.

If you want to query data stored in Smart Form fields, use a type mapper to store a
custom content type. This type lets you convert each field in Smart Form
configuration to a field in a custom object. You can then use Find to query that object
using this syntax.

var results = client.Search<customclassname>().Filter (..).GetResult();

For example, if the class created for your Smart Form configuration is OurTeam, you
would use this.

var results = client.Search<OurTeam> () .Filter (..).GetResult():;

To learn how to use a type mapper to store a custom content type, see Converting a
Smart Form configuration to a class below.

Converting a Smart Form configuration to a class

Converting a Smart Form configuration to a class

Complete these steps for each Smart Form configuration that you want to convert
into a class. After you complete the procedure, Optimizely Search & Navigation
indexes registered configurations when a Smart Form is edited or added.

NOTE: To learn about updating Find upon deleting, see Updating Find index upon
deletion of a Smart Form on page 195.
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Part 1: Analyze the Smart Form configuration

1. Obtain the Smart Form configuration’s ID. You use this information in later
steps.

View Smart Form Configuration "0

€| ADD SMARTFORM | [ L2
Display Infc
™
General Information:

Title: Our Tean

2. Analyze the configuration’s XML structure: its root class and subclasses. These
appear on the View Smart Form Configuration screen's Display Information

190 | Ektron 9.50




Part 2: Create class and move .dll to bin folder

tab. Consider the following example.

View Smart Form Configuration "Our Team™

€| ADD SMARTFORM | [&f L& M) Q@

Froperties Display Information Preview
—

XSLT1:

XSLT 2:

XSLT 3:

XSLT (Packaged)®

rootiEmployeeProfile/Name
froot/EmployeeProfile Title

froot'EmployeeProfile/Summary
rootiEmployeeProfile/lmage/img/@alt
Iroot/EmployeeProfile/lmage/img/@src
froot'EmployeeProfile/Linkedin
froot'EmployeeProfile Twitter

root/EmployeeProfile/Bio

This Smart Form configuration has the following structure. You use this information
in later steps

Root class: Ourteam
Subclass: Employee profile

Subclass: Image
Subclass: img

Part 2: Create class and move .dll to bin folder

1. In Visual Studio, create a class library.

2. Save the Smart Form configuration schema as an XSD file, then generate a class
from it. This procedure is explained in steps 1 (Save Schema XSD File) and 2
(Generate Class from XSD) in the Ektron Knowledge Base article "Generate Class
for Smart Form.

3. Move the .cs file created in step 2 to the Visual Studio class library.
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4. Build your Ektron solution. This action creates a .dll file in your Visual Studio

project's bin\Debug folder. For example: C:\Users\jedit\Documents\Visual

Studio

2012\Projects\MySmartFormClassLibrary\MySmartFormClassLibrary\bin\

Debug.
The file name matches the Smart Form configuration name.

5. Copy the .dll file to your Ektron website's bin folder.

Part 3: Register the class

1. In Visual Studio, open your Ektron website solution.
2. Openthe findbootstrapper.cs file, located in C:\Users\user

name\Documents\Visual Studio

version
\Projects\yoursitename\packages\Ektron.Cms.Find.1.0.0\content\App
Code\CSCode\.

Find these comments.

// Register type mappings below to translate Smart Forms

// to custom models.

// Example:

// ektronMessaging.Types.Register (content => new MySmartFormModel { ... })
// .For (content => content.XmlConfiguration.Id == ...);

Below the comments, register the class you created in Part 2: Create class and
move .dll to bin folder on the previous page. To do that, use this syntax:

ektronMessaging.Types.Register (SmartForm configuration name.Create)
.For (SmartForm configuration name.CanCreate) ;

For example:

ektronMessaging.Types.Register (OurTeam.Create) .For (OurTeam.CanCreate) ;

NOTE:

* The Ektron Messaging class’s Types property configures how Ektron
indexes content.

* Register converts Ektron content data to an object that Optimizely Search
& Navigation can query.

* As an argument, the Register method takes a delegate, which receives
content data and returns an object. This object is pushed to the Find index.

* The .rFor statement enables you to map only content data that satisfy a
criterion. . For takes a delegate, which returns a Boolean. Content is only
converted to the registered class if Ektron content data matches this criterion.
Without a . For statement, the type mapper applies to all content passed
through the system.

* The canCreate method is defined in your configuration's .cs file. See step
10 later in this section.

5. Open the .csfile that you created in step 2 of Part 2: Create class and move .dll

to bin folder on the previous page. It contains your configuration's XML
structure. For example:
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6.

9.

Part 3: Register the class

namespace MySmartFormClassLibrary

{
public class Image
{
public img img { get; set; }

}

public class EmployeeProfile

{
public string Name { get; set; }
public string Title { get; set; }
public string Summary { get; set; }
public string LinkedIn { get; set; }
public string Twitter { get; set; }
public string Bio { get; set; }

public Image Image { get; set; }
}

Find the following section. The sample below continues using the ourTeam
configuration.

[XmlRoot ("root") ]
public class OurTeam

{

Under that section, insert the following code. It creates a unique identifier for the
Smart Form configuration.

public long Id { get; set; }

public int LanguageId { get; set; }

public string Title { get; set; }

IMPORTANT: Repeat steps 8 through 10 for each subclass directly below
/root/ inyour Smart Form configuration.

Declare the first subclass in your configuration. (This was discovered in Part
1: Analyze the Smart Form configuration on page 190.)

public EmployeeProfile EmployeeProfile { get; set; }

Add the following code to set property values for the OurTeam configuration.
Replace references to OurTeam with your Smart Form configuration name.

NOTE: Ektron Smart Forms store rich text HTML as valid XML. This code
deserializes rich text HTML into an encoded XML string, which Find can
consume.

public static OurTeam Create (ContentData content)
{
XmlSerializer serializer = new XmlSerializer (typeof (OurTeam)) ;
OurTeam oTeam = (OurTeam)serializer.Deserialize (new StringReader
(content.Html)) ;
oTeam.Id = content.Id;
oTeam.LanguageId = content.Languageld;
oTeam.Title = content.Title;
return oTeam;
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10. Define the cancreate method, which is referenced in the findbootstrapper.cs
file's registration method, which returns the config ID for registering the type

(see step 4 above).

11. Replace the ID number with your configuration ID, which you obtained in Part

1: Analyze the Smart Form configuration on page 190.

public static bool CanCreate (ContentData content)
{
return content.XmlConfiguration.Id == 8;

}
Here is the complete sample file, OurTeam.cs.

OurTeam.cs sample file

using Ektron.Cms;

using System;

using System.Collections.Generic;
using System.IO;

using System.Ling;

using System.Text;

using System.Threading.Tasks;
using System.Xml.Serialization;

namespace MySmartFormClassLibrary

{

public class Image

{
public img img { get; set; }

public class EmployeeProfile

{
public string Name { get; set; }
public string Title { get; set; }
public string Summary { get; set; }
public string LinkedIn { get; set; }
public string Twitter { get; set; }
public string Bio { get; set; }

public Image Image { get; set; }
[XmlRoot ("root") ]
public class OurTeam
{
public long Id { get; set; }
public int LanguageId { get; set; }
public string Title { get; set; }

public EmployeeProfile EmployeeProfile { get; set; }

public static OurTeam Create (ContentData content)

{

XmlSerializer serializer = new XmlSerializer (typeof (OurTeam)) ;
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OurTeam oTeam = (OurTeam)serializer.Deserialize (new StringReader
(content.Html)) ;

oTeam.Id = content.Id;
oTeam.LanguagelId = content.Languageld;
oTeam.Title = content.Title;

return oTeam;

}

public static bool CanCreate (ContentData content)

{

return content.XmlConfiguration.Id == 8;

}

Updating Find index upon deletion of a Smart Form

If you delete a Smart Form configuration, its content remains in the Find index. To
remove the custom type entries of a Smart Form from the index, remove the type
mapper by not registering it. Then, clear the index and reindex. These actions index
the Smart Form contents as the default Smart Form type.

Alternatively, you can delete individual documents from the Find index using the
following article: http://world.episerver.com/documentation/Items/Developers-
Guide/Episerver-Find/9/DotNET-Client-API/Deleting-documents/.

Smart Form indexing guidelines

When you create a Smart Form configuration, no indexing occurs because there is
nothing to index at this point. If Smart Form content is published before the
configuration is converted to a class, it is indexed as HTML content. If you later
convert the configuration to a class, you should clear the index and reindex your site
to make Smart Form content available to Optimizely Search & Navigation.

Similarly, if you modify a class, you should clear the index and reindex your site.

Using Find to search by taxonomy

Taxonomy and category information is updated in the Find index whenever any of
these events occurs.

» A taxonomy category is assigned to content.

» A taxonomy category is removed from content.

» A taxonomy category is updated.

» A taxonomy category is removed.
Find divides taxonomy paths into individual taxonomies, indexes each category, and
returns the following string-based properties.

« Id. the taxonomy ID.

« Path. the taxonomy path using category titles.
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« IdPath. the taxonomy path using IDs.
For example:

Root taxonomy

"Id$S$Sstring":"154",
"Path$S$Sstring":"\Food",
"IdPath$S$string":"\154",

Child taxonomy

"Id$$string":"155"
"Path$S$string":"\Food\Chinese"
"IdPath$$Sstring™:\154\155

IMPORTANT: All properties are stored as strings.

Taxonomy-based search and parent/child nodes

When a search query uses a taxonomy filter, the results include content assigned to
child categories even if the query only specifies the root taxonomy. Similarly, if a
query specifies a child category, parent taxonomy categories are available, so users
can find content by searching any category in the tree.

Consider the following example.

» Content title. General Guidelines for Cooking
o ID. 68

°© Taxonomy path. \Food

o Content title. Grilled Asian Chicken
o ID. 231

°© Taxonomy path. \Food\Chinese
Search query 1

IClient client = Client.CreateFromConfig(); //A client retrieved from config or

injected into the method

client.Search<Ektron.Cms.Find.Models.Content> ()
.Filter<Ektron.Cms.Find.Models.Content>(c =>

c.Categories.MatchContained<TaxonomyCategory> (tax => tax.Path, @"\Food"))
.GetResult () ;

When executed, this code returns content assigned to the Food and Chinese
categories. So, content IDs 68 and 231 are returned even though 231 is not assigned
to the Food category.

Search query 2

client.Search<Ektron.Cms.Find.Models.Content> ()
.Filter<Ektron.Cms.Find.Models.Content> (c =>

c.Categories.MatchContained<TaxonomyCategory>(tax => tax.Path, @"\Food\Chinese"))
.GetResult () ;

When executed, this code returns content assigned to the Chinese and Food
categories. So, content IDs 231 and 68 are returned.
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Using Optimizely Search & Navigation to search
assets

Episerver Find can retrieve search results from assets as it does with HTML content.

« Maximum file size. Developer index: 5 MB; Production index: 50 MB.

NOTE: Indexed files are sent base 64 encoded, which increases their size by
roughly 1/3.

» Supported file types. See
http://world.episerver.com/documentation/Items/Developers-Guide/Episerver-
Find/9/DotNET-Client-API/File-attachments/.

 Text-based documents. You can search text inside PDFs, Word documents,
and so on.

* You can search and filter by the following criteria:
o Ektron title

° summary
o path
o searchable metadata

Using Optimizely Search & Navigation to search
Ektron metadata

If you want to query data stored in Ektron metadata, use a type mapper to store a
custom content type. This type lets you convert selected metadata definitions to a
field in a custom object. You then can use Optimizely Search & Navigation to query
that object using this syntax.

var results = client.Search<custommetadataclassname> () .Filter(..).GetResult ()
For example, if the class created for your metadata definition is
UnstructuredContentModelWithMetadata, you would use the following code.

var results = client.Search<UnstructuredContentModelWithMetadata> () .Filter
(...) .GetResult () ;

To convert a metadata definition to a class, use the following steps.

PREREQUISITE

Your Ektron CMS has metadata definitions that are applied to content and
to which values are entered. The definitions must be of the Searchable
Property type, publicly viewable, and active. See also Metadata types on
page 755.
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View Metadata Definifion "SearchText"

£ EDT | X 9@
Name: SearchText
ID: 163
@ Searchahle@
Editable: Yes
Style: Text
Default: redder

1. Create a class for each group of Ektron metadata definitions that Find will query.
Within the class, create a property that maps to each metadata definition. The
class's type must match the metadata definition's type. For example:

public class UnstructuredContentModelWithMetadata : UnstructuredContent
{

public string SearchTextMetadata { get; set; }

public List<string> SearchSelectionMetadata { get; set; }

public DateTime SearchDateMetadata { get; set; }

public int SearchNumberMetadata { get; set;

public string mymeta { get; set; }

public UnstructuredContentModelWithMetadata ()

{

SearchSelectionMetadata = new List<string>();

}
This example illustrates the following metadata definitions and their types.

» SearchTextMetadata. type:string

» SearchSelectionMetadata. type:List<string> (user can select one or
several string values)

» SearchDateMetadata. type:datetime
 SearchNumber. type:integer

2. To enable Optimizely Search & Navigation to search a class, register it in the
EktronFindBootstrapper file, located in siteroot\App Code\CSCode\. Enter
the register statement below applicationBuilder.App.Start () ; as shown in
the following example:
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ektronMessaging.Types.Register (CreateMyUnstructuredContentModelWithMetadata)

.For (content => (content.XmlConfiguration.Id == 0 &&
(content.SubType ==
Common .EkEnumeration.CMSContentSubtype.Content && content.Type == 1)

)) i

» Register specifies how to convert Ektron ContentData to an instance of the
new type created in Step 1. It accepts a condition that selects eligible CMS
content to be indexed as this type. The
CreateMyUnstructuredContentModelWithMetadata method is described in
step 3.

e .For is a filter that determines which Ektron ContentData can be mapped.
In this example, only HTML content is eligible.

3. Create a function that accepts an Ektron contentData object and converts it to a

type defined in step 1. This type is indexed by Find for content matching the .For
filter condition specified in step 2.

You define the function (CreateMyUnstructuredContentModelWithMetadata in
this example) under your site's AppCode directory or in a separate class
library/dll.

In the following example, the function populates

UnstructuredContentModelWithMetadata with Ektron metadata for the Find
index.

private static UnstructuredContentModelWithMetadata
CreateMyUnstructuredContentModelWithMetadata (
ContentData data)
{

UnstructuredContentModelWithMetadata contentWithMeta = new
UnstructuredContentModelWithMetadata () ;

if (data.MetaData == null || data.MetaData.Length <= 0)

return contentWithMeta;

IEnumerable<ContentMetaData> eligibleMetadata = GetMetadataForContent
(data.MetaData.ToList (),
data.FolderId, data.Languageld);

\\ See note #1 below

ContentMetaData cm = eligibleMetadata.TolList () .Find(m => m.Name == "SearchText");
if (cm != null)
{

string metaValue = (string)cm.Text;

if (!String.IsNullOrWhiteSpace (metaValue))
{

contentWithMeta.SearchTextMetadata = metaValue;

}
\\ See note #2 below
cm = eligibleMetadata.ToList () .Find(m => m.Name == "SearchNumber") ;
if (cm != null)
{
int value;
if (Int32.TryParse (cm.Text, out value))
contentWithMeta.SearchNumberMetadata = value;
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}
\\ See note #3 below
cm = eligibleMetadata.ToList () .Find(m => m.Name == "SearchDate");
if (cm != null)
{
DateTime mydate;
if (DateTime.TryParse (cm.Text, out mydate))
contentWithMeta.SearchDateMetadata = mydate;
}
\\ See note #4 below

cm = eligibleMetadata.ToList () .Find(m => m.Name == "SearchSelection") ;
if (cm != null)
{

string metaValue = (string)cm.Text;

if (!String.IsNullOrWhiteSpace (metaValue))
{

string[] metaValues = metaValue.Split (new string[] { ";" 1},
StringSplitOptions.RemoveEmptyEntries) ;

if (metaValues != null && metaValues.Length > 0)

{
contentWithMeta.SearchSelectionMetadata = metaValues.ToList ();

}
Notes on the above sample

» #1 The following snippet uses the find-extension method to select only
SearchText metadata from ContentData. This type is a string, as defined in
the class and the Ektron metadata definition. If this metadata exists, apply it
to the searchTextMetadata property of your class.

ContentMetaData cm = eligibleMetadata.TolList () .Find(m => m.Name ==
"SearchText") ;

if (cm != null)

{

string metaValue = (string)cm.Text;
if (!String.IsNullOrWhiteSpace (metaValue))

{
contentWithMeta.SearchTextMetadata = metaValue;

}

o #2 In the following snippet, the searchNumber metadata is an integer in the
class and the Ektron metadata definition.
cm = eligibleMetadata.ToList () .Find(m => m.Name == "SearchNumber");
if (cm !'= null)
{
int value;
if (Int32.TryParse (cm.Text, out value))
contentWithMeta.SearchNumberMetadata = value;

}

o #3 In the following snippet, the searchDate metadata is a DateTime object
in the class and the Ektron metadata definition.
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cm = eligibleMetadata.TolList () .Find(m => m.Name == "SearchDate");
if (cm != null)
{
DateTime mydate;
if (DateTime.TryParse (cm.Text, out mydate))
contentWithMeta.SearchDateMetadata = mydate;
}

* #4 In the following snippet, searchSelection metadata is a list of strings
(List<string>) in the class, and multiple selections in the Ektron metadata
definition. Ektron stores values as a single string, and each value is
separated by a delimiter (in this case, a semicolon (;)). For example, if
metadata definition stores transportation methods, its value might look like
this: train;bus;automobile.

cm = eligibleMetadata.TolList () .Find(m => m.Name == "SearchSelection") ;
if (cm != null)
{

string metaValue = (string)cm.Text;

if (!String.IsNullOrWhiteSpace (metaValue))
{

string[] metaValues = metaValue.Split (new string[] { ";" 1},
StringSplitOptions.RemoveEmptyEntries) ;

if (metaValues != null && metaValues.Length > 0)

{
contentWithMeta.SearchSelectionMetadata = metaValues.ToList ();

}

}

The string[ ] line separates the multiple selection string into individual
values that Find can query.

How Find manages archived content

Content that has expired and is set to Archive and remove from site or Archive
and remain on site is not automatically removed from the index. Such content is
removed upon the next full reindexing. Until then, to exclude expired content from

search results, use the Find Client API's EndDate and EndDateAction properties to

filter results.

NOTE: Content that has expired but is set to Add to CMS Refresh reports is
considered live content, so remains in the Find index.

Working with the Optimizely Search & Navigation API

Usage of the Find Service and API is outside the scope of this document.

Querying and filtering Ektron content by type

Use the Ektron.Cms.Find.Models namespace to query and filter Ektron content. A
search page's .cs file typically contains a Searchresults command like this:

SearchResults<Ektron.Cms.Find.Models.Content> results;
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The namespace contains these classes.

e Content. Returns Ektron content types. See Fields that you can query and filter
using the content class below.

» PageBuilder. Returns PageBuilder content. It inherits all properties from the
content class.

* UnstructuredContent. Returns HTML content. It inherits properties from the
content class.

» SmartForm. Returns content from Smart Forms, as explained in Converting a
Smart Form configuration to a class on page 189. It inherits all properties from
the content class.

» asset. Returns content from assets. You can filter them using their summary or
path. It inherits properties from the content class.

» Taxonomy. Returns content assigned to selected categories. It inherits properties
from the content class.

Fields that you can query and filter using the content class

namespace Ektron.Cms.Find.Models
{
public class Content : IHaveReferences
{

public Content () ;
public string Body { get; set; }
public IEnumerable<TaxonomyCategory> Categories { get; set; }
public DateTime CreationDate { get; set; }
public Author Editor { get; set; }
public Folder Folder { get; set; }
public long Id { get; set; }
public int Language { get; set; }
public DateTime ModificationDate { get; set; }
public string Quicklink { get; set; }
public DocumentReference Reference { get; set; }
public string Summary { get; set; }
public string Title { get; set; }
public DateTime EndDate { get; set; }
public EndDateAction EndDateAction { get; set; }

Using Episerver Find with eSync

If you want the Find index to be updated whenever eSync moves content changes
between servers, follow Step 7 in the installation instructions.

It takes longer for changes triggered by eSync to appear in search results than other
content changes. This is because, after an eSync is completed, a full reindex is
launched.
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Notes and limitations of Episerver Find integrated with
Ektron

» Basic search, Advance search with match all, none, any word case can search in
fields:
o Title
° Body
°© Summary
o Editor first name
o Editor last name
o Folder name
o Quicklink
e« Taxonomy name
» Synonym only works when searching one keyword
» PDF and docx files: search by title only; cannot search by content
« In Library: can only search for images

» Archived content: If “Expired and remove from site” assigned, cannot be
searched.

e Search API (expression tree) limitations
» Does not support: ImplicitAnd, Scope, Permission, Boost, Keyword
expression

» Supports fields in filter: return and order by:
o Id
o Language
o Folderld
o ContentType
o ContentSubType
o Title
° QuickLink
o Path
o HighlightedSummary
o Description
o DateCreated
o DateModified
o ExpiryDate
o ExpiryType
o FolderName
° Private
o FolderPath
o FolderIdPath
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» Not supported fields
o TaxonomyCategory

° Tags

o Author

° Rank

o Size

° GolLiveDate
°o MapDate

°© MapLongitude
o MapLatitude
°© MapAddress
o AssetVersion
o Siteld

Related information

Optimizely Search & Navigation provides extensive capabilities for monitoring search
activity and customizing search functionality on your website. See the following
related information.

+ Developer documentation.
http://world.episerver.com/documentation/Items/Developers-Guide/Episerver-
Find/9/

» Searching (Episerver World article).
http://world.episerver.com/documentation/Items/Developers-Guide/Episerver-
Find/9/DotNET-Client-API/Searching/Searching/

- Developer forum. http://world.episerver.com/forum/developer-
forum/Episerver-Search/

» Get started developing with Find.
http://world.episerver.com/documentation/Other-products/Episerver-Find/Get-
started-with-Find/

» Episerver Find home page. http://world.episerver.com/add-ons/episerver-
find/

Using Solr search

Solr is an open-source, enterprise-level search platform, from the Apache Lucene
project, that is known for scalability and performance. In its implementation of Solr,
Ektron uses Apache Tomcat to host the Solr application, and ManifoldCF to manage
the crawling of new or updated content. According to
https://lucene.apache.org/solr/, "Solr powers the search and navigation features of
many of the world's largest internet sites."
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Solr Search Components

Using Solr, you can search all Ektron content, including Smart Forms and assets.
Ektron's Solr implementation supports advanced search features, such as
Refinements, Synonym Sets, Suggested Results, and Autocomplete. Solr also
supports Ektron's templated search server controls and API. So if you previously
worked with these components, you only need to master a few new concepts to
migrate to Solr.

NOTE: To compare Solr with other Ektron search providers, see Search provider
comparisons on page 183.

Solr Search Components

/ Ektron Solr Search \
Ektron CMS [ \ N\
s1 Ektron Crawler
—
o
H Ektron Admin Service SOI r
Pr—
Ektron CMS Ektron Query Services
SN

The Ektron Solr search provider is made up of several components, which can crawl
your content to index the latest changes, as well as manage search queries. Solr
manages the search for any number of Ektron instances, each of which can support
several sites.

Ektron crawl service

This diagram explains the crawl service's activities.

__________________________________________________________

ManiFold CF

Content Job

Ektron

CMS User Job

10123Uu0)
Aoyisoday

Community Group Job

10199UU0) INdINO

Ektron Crawl Service
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The Apache ManifoldCF (connector framework) crawls data from a repository
connector to an output connector. Ektron's Solr deployment uses its own repository
connector with the Solr output connector that updates the Solr Index.

When a site is registered, the following steps occur within ManifoldCF.
1. An Ektron repository connection is created, using database information from the

Ektron site.

2. A Solr output connection is created with a connection to a Solr core exclusive to
the Ektron site.

3. Content, user, and community group jobs are created for each Ektron
repository/Solr output connection pair to crawl the various Ektron items.

Asset transfer service

Ektron's crawl component uses the Asset Transfer Service as the endpoint for
crawling assets. The Ektron Asset Transfer Server, which resides on the Ektron Web
server, is one half of a pair of services that supports the indexing of assets. (The
Ektron Asset Transfer Client resides on the Solr server.) When an asset is indexed, it
must be transferred to a cache on the Solr server before its content can be extracted.

When the crawl service requires an asset, it asks the Ektron Asset Transfer Client to
retrieve it. If the Ektron site and Solr run on the same server, the client directs the
indexer to the asset's location on the file system. If the asset resides on a remote
server, the client requests the asset from the appropriate Ektron Asset Transfer
Server and stores it in cache for indexing.

The crawl database

The crawl database stores and maintains the crawl state and crawl queues during a
crawl.

Ektron Solr admin service
The Ektron Solr Admin service manages

« site registration requests (from the Solr Admin Console)

» crawl management requests (from Ektron and EWS during eSync)

» status requests from the Ektron Workarea's Search Status screen
During site registration, the admin service performs

» validation tasks prior to site registration
» job deletion and creation in ManifoldCF
» Solr core deletion and creation

» search configuration store and Ektron database updates with registration
information

the Solr Admin service also communicates with the crawler component (ManifoldCF)
of the Ektron site and fires an appropriate crawl of jobs for the core.

Ektron query services
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This diagram depicts IIS query services that act as a proxy to the Solr counterparts.

N
| |\‘

Apache

Solr

Query Service

Sites
Query

Proposition

Service

Ektron - ] .

Ektron Query Services

The Query Service routes queries from sites registered with the Solr Search server to
the Solr core that corresponds to the site.

The Query Proposition service is a RESTful service that routes autocomplete queries
to the Solr core that corresponds to the site.

The Search Config database serves as a "centralized store." It maintains
configuration information for search endpoints, Solr, ManifoldCF, Admin Service, and
registration information for the registered sites.

Solr core

This diagram details the Solr core, the rectangle on the right side of the above image.
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————————————— —— — — —— —————————I
Queries Admin Content
Requests

Handlers

“a i

Core

One core per site

Solr service (Tomcat)

A Solr core is a single instance of Solr with its own configuration, schema, and
independent index. Each Solr core can be thought of a compartmentalized Solr
application. It has several endpoints, called handlers, that serve requests addressed
to the core.

Ektron's search deployment uses handlers to manage queries (search queries &
completion requests), administrative requests (to manage cores), and content
updating.

Mime types supported by Solr search

Solr's ExtractingRequestHandler uses Tika to lets users upload binary files to Solr,
and then have Solr extract text from and index them. For a list of supported file
types, see https://tika.apache.org/1.4/formats.html.

Also, Ektron has its own list of files types that may be uploaded to the Workarea. You
can only upload supported file types. See Supported types of assets on page 650.

See also: Excluding Library Images When Using Solr Search.

Solr search concepts

This section explains some inner workings of the Solr search. It is intended to help
explain why you do or do not get certain search results.

Keyword search
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Stemming

Keyword search is the search performed when a user types text or a phrase into a
text field. (A phrase is several words enclosed in quotes. For example, “This is a
phrase”). Keyword search is performed against the content title and the body only,
because they contain the "meat" of a content item.

NOTE: For HTML content, content body corresponds to the content table's
content html column. For PageBuilder pages, content body corresponds to the
content table's content text column.

Content title and body are subject to linguistic processing, which applies rules based
on the language of the search text or phrase. (By default, this is the site language,
but it can be changed via the Search API). For Solr-based search, linguistic
processing refers to stemming and stop word recognition only.

Stemming

Stemming reduces a word to its stem. English examples of stemming:

e engineering > engine
e parsing > pars
» analysis > analysi

Stemming helps a user find desired content because, in most cases, the useris
unsure of the exact text in the document.

Stemming is applied when content is indexed and when query terms are processed.
During indexing, the content language is used to perform language-specific
stemming. During querying, the language of the query (by default, the site language)
is used to perform stemming.

Sometimes, stemming produces false matches. For example, the terms
"engineering" and "engine" are both reduced to "engine" during indexing. So, a query
for "engine" matches a document that contains "engineering". Also, since Solr only
performs stemming reduction, a query containing "ran" does not match a document
containing "running", since these words get reduced to "ran" (query side) and "run"
(index time). Out-of-the-box Solr only supports stemming and not the more
extensive lemmatization, which provides more accurate results and fewer false
positives.

Stop words

Stop words are terms that are removed from queries and indexes because they do
not contribute to the quality of a search. For example, these are English stop words:
"the", "in," "an", Ilall.

Query expression

The QueryText property of the KeywordSearchCriteria class contains the text or
phrase that a user enters when submitting a keyword search. With regards to Solr,
any query expression assigned to the ExpressionTree property of the
KeywordSearchCriteria class is treated as a filter query. The filter query merely
helps in reduction of the result subset and does not improve relevance.
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Rank computation (relevance)

When ranking content returned as search results, Solr uses the quality of a
document's match against query text. Match quality is based on these factors.

» Frequency of search text or phrase in the content.

» Rarity of search terms with regards to the whole corpus of content (the entire
site).

» Proximity of search terms in the content. For example, if a query has the phrase
"content repository", content having "The content item rocks" in closest
proximity is ranked higher than content with the terms "lack of actual content in
an item."

» If search terms include an OR operator, content with the greatest number of
terms ranks highest. For example, if a query consists of "valid OR resultant OR
set OR items", content with "valid resultant set" ranks higher than content with
"resultant set."

Notes regarding rank computation (relevance)
» When computing rank, Ektron Solr only considers terms in the content's title and
body.

* Only terms entered against the QueryText property of the
KeywordSearchCriteria class are used for rank computation. Other fields
specified in the ExpressionTree property are not considered for rank
computation.

» A match on content title has the same weight as a match on content body.

ContainsExpression vs EqualsExpression

When using Solr, the ContainsExpression can be tricky.

NOTE: A ContainsExpression involves using ContainsExpression directly or
indirectly via SearchContentProperty.<PropertyName>.Contains.

Unlike the C#/.NET string.Contains, Solr's ContainsExpression matches whole
words only—it does not match on substrings. For example, if a text metadata field
contains "Tax Revenue Statement, Year 2012," a contains search returns the
content if a query using ContainsExpression includes "Tax" or "Revenue
Statement" or "Revenue" as whole words. The query is not a match for the substring
term "State."

Also, the containsExpression query is case-insensitive. So for example, "Revenue
is the same as "revenue" and "rEvenUe."

The EqualsExpression, on the other hand, performs a letter to letter, case-
sensitive, exact search on the entire text of a field.

NOTE: An EqualsExpression involves either EqualsExpression directly or
indirectly via SsearchContentProperty.<PropertyName>.EqualTo.
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To continue the above example for an EqualsExpression, a match results only if the
query is submitted as “Tax Revenue Statement, Year 2012". Note the comma in the

query.

Using .Contains with Solr in Ektron version 9.30

When using the Solr search provider in Ektron version 9.30, the Folderld, FolderPath,
and TaxonomyPath .Contains syntax acts like a startswith expression instead of a
Contains one. Examples:

FolderldPath examples
e FolderIdPath .Contains "72/" returns content in folder 72 and subfolder 73

e FolderIdPath .Contains "72/73/" returns contentin folder 73
e FolderIdPath .Contains "73/"™, "73", "/73/" returns no content

Taxonomy examples

e TaxonomyPath .Contains "12/" returns contentin category 12 and sub-
category 13

e TaxonomyPath .Contains "12/13/" returns contentin sub-category 13
e TaxonomyPath .Contains "73/", "73", "/73/" returns no content

Exception

e FolderIdPath or TaxonomyPath .Contains "/" returns contentin the root
folder/taxonomy only

Configuring the Ektron Solr package for Java Heap Memory

The Ektron Solr package has the Java Heap Memory (HSQLDB-Crawl Database,
ManifoldCF-Crawler, and Tomcat-Solr Process) tuned to support the simultaneous
registration and crawling of multiple sites. This tuning is optimized for a server with
at least 8GB RAM and 2 high speed disks (1 for the search index, and 1 for search
installation). The tuning also accommodates servers with more than 8GB RAM.

Because the Solr configuration is less reliant on the Java Heap for loading the index ,
the default tuning should suffice for most production usages. Before changing the
Java Heap configuration, Ektron's Professional Services Group must evaluate your
plans to ensure that correct choices are being made with regards to garbage
collection patterns and search/crawl performance.

After a site is registered, the first query served by Solr is slower than subsequent
ones. If the Solr server is rebooted, you can expect similar slowness for registered
sites. To avoid this slow first response, create a dummy search request to be run
after a site is registered for the first time. You can also avoid this slow first response
by issuing a search request from a site (for every site) after the Solr search server
has been rebooted.

You may perform additional performance tuning via the Apache Solr site. Before
making any adjustments, you must have a thorough understanding of the
technologies. Be very careful when tuning for performance.

Query suggestions vs query completions
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Query suggestions are a search type-ahead feature, in which a search field presents
query options as the user begins to type in characters. Suggestions are based on
previously used, successful queries submitted by other users.

Demo

Search Text: |b 3| |

MNote: This sample for Get( backup

banner
banneri
banner?
base
basic
battery

Query completions are another search type-ahead feature in which the search field
presents query options as a user begins to type in characters. However, in this case,
query options are based on either the search index (the default option) or a
dictionary of terms.

Ektron Solr only supports query completions.

You can change the source of query completions from the search index to a dictionary
of terms. See also: Managing Solr autoComplete on page 285.

With regards to query completions, the search only considers terms from the title by
default. You can use a custom field instead of title. To accomplish this, customize the
configuration during registration. See also: Part 2: Register your Solr site on

page 223.

Securing the Solr server

To maximize the security of your Solr server, follow these guidelines.

» Limit traffic to the immediate network between the Web server and the Solr
server. To do this, open these ports and place these restrictions on them.
° Solr server base port (by default, port 7600): Create a firewall rule that
restricts base port access to the IP addresses of
®= the Ektron server

® gservers on which users will access the Admin Console to register Ektron
sites for search

° Solr server base port + 1 (by default, port 7601): Create a firewall rule that
restricts access to the Ektron server only.

o Ektron server port 8732: Create a firewall rule that allows access to the Solr
search server only.

» Block unused Solr server ports (for example, ports 80 and 443).

» Use a firewall to lock down port 7602 so it is accessible only on the local
machine.
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o Restrict which IP addresses can access the Solr site's Web services to Ektron
Web servers that use Solr.

» Leave other needed service ports open (for example, RDP). Use a firewall to lock
these ports down, so they are accessible to localhost only.

Setting up Solr search

Setting up Solr search on a single on-premises (local) server

« For the configuration database, SQL 2008 or higher (Express version is
supported); can be installed to any server, for example the Ektron server, the
Solr server, or any other database server.

Preparing the Ektron server to work with Solr search
1. On the Ektron search server's firewall, open port 8732. This runs Ektron
Windows service and asset transfer server services.

2. Restart the Ektron server to apply all changes, not only those affecting SQL but
also the JDK installation, new environment variables, and so on.

NOTE: You must generate an eSync certificate to start Ektron Windows Service to
register a site.

Preparing the Solr search server to work with Ektron

During Solr installation, the user selects a base port (the default is 7600). The
installation allocates that port and nine above it to accommodate Solr search. For
example, if you use the default value of 7600, ports 7600 through 7611 are
dedicated to Solr search.

On the Solr search server's firewall, open to the Ektron Web server ports +0 and +1
in the range—they are used by Ektron’s query and admin services. To continue the
default example, open ports 7600 and 7601.

PREREQUISITES

» Solrserver
o Hardware requirements: minimum 8 gigabytes of RAM, quad
core, 64-bit processor

° Operating system: Windows 2008, Windows 2012, Windows
2016

NOTE: For a production server, use Windows 2008 R2,
Windows 2012, or Windows 2016.

o Enable the following
° Roles
= Application Server Role Services
® NET Framework 4.5
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IMPORTANT: With Windows Server 2008 or
2008 R2, be sure that .NET 3.5 is installed
before installing 4.5.

= Web Server IIS Support

® Web Server (IIS) Role Services
® Windows Authentication feature

® NET Extensibility 4.5
= ASP.NET 4.5

°o Features
= NET Framework > WCF Activation

NOTE: Make sure that HTTP activation is also
checked.

® Static content
°o SQL browser, if not using default instance
o For optimal performance, use a separate disk (that is, not the
system drive) for index and asset cache
° May be installed on Ektron server but only in a development
environment.
Consult an Ektron certified partner to determine your server

requirements. Ektron does not recommend installing Solr on a
server that also hosts Microsoft Search Server.

° Java Development Kit , Windows x64 version.

IMPORTANT: If you upgrade the JDK version, you must
replace it in the same directory to which you originally
installed it. You may not install more than one JDK version to
that directory.

» An Ektron site installed on an Ektron server. See also: Installing
Ektron on page 9, Upgrading to on page 35.

NOTE: During the Ektron installation, you should have selected
Solr as your search provider. If you need to change your search
provider to Solr, see Changing your search provider to Solr on
page 277.

» The Ektron Solr installation file. Contact your Ektron account manager
to obtain a link to the file.

» Users
° A SQL login account assigned the dbcreator role. This account is
used to create the search configuration database.

° A SQL login account that Ektron search components use to
access the search configuration database.

Both SQL accounts must follow these rules:
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m If integrated security is set to true

...and Solr search and the Ektrondatabase are on different
servers, a domain user is required.

...and Solr search and the Ektron database are on the same
server, a local Windows user is required.

® if integrated security is set to false, a SQL server user.

BEST PRACTICE

Use SQL authentication rather than Integrated
Security. Although Integrated Security is supported,
the connection is made in the context of the search
service account (Windows user) provided during
installation. If this user does not have access to the
database, the connection fails.

o A Windows user account under which Solr services will run. This
account, which manages Solr components and authenticates
queries, must have permission to

® write to the search 2.0 folder and its subfolders
® gstart the Solr admin service
® |og on as a service

This user can be either a Windows user on the search server, or a
domain user. If it is a domain user, the Netlogon service must be
enabled and running.
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T3 Local Security Palicy
File  Action  Miew Help

= | #1EXRE = HE

_i;, Security Settings Palicy Security Setting
2 Account Policies

Access Credential Manager as a trusted caller

4 Lacal Polici : ini
4 g Localfolicies Access this computer fram the netwark Everyone Administrators...

a4 Audit Poli
2 uel - ey - Act as part of the operating systerm
7, User Rights Assignment — i - .
. R X 5 Add warkstations to domain EKTROMINWUK Adrmin,EK...
7 Security Options )
© indows Firewsall with Adwanced Sect Adjust mermony quotas for a process LOCAL SERVICE, METWO...
j Metwork List Manager Palicies Al log on locally Guest Administrators,Us...
| Public Key Policies :'j.&llow log on through Remote Desktop Services Everyone EKTROMINDo..
= Saftware Restriction Palicies Back up files and directories Adrinistrators,Backup ...
| Application Control Policies Bypass traverse checking Ewveryone LOCAL SERVIC...
\ g IP Security Policies on Local Compute Change the system time LOCAL SERVICE Admini...
| Advanced Sudit Policy Configuration Change the time zane LOCAL SERVICE Admini...
Create a pagefile Administrators

Create a token object
Create global objects LOCAL SERVICE METWO..,
Create perrnanent shared objects

Create symbalic links Administrators
Debug programs Administrators
Dermy access to this computer fram the netnork Guest

Deny log on as a batch job

Demy log on as a service

Deny log on locally SophosSAUNME106750,G..,
Dery log on through Remote Desktop Services

Enable computer and user accounts to be trusted for delega..,

Force shutdown fram a remote systerm Administrators

Generate security audits LOCAL SERWICE,METWO..,
Impersonate a client after authentication LOCAL SERVICE METWO..,
Increase a process working set Users

Increase scheduling priority Adrinistrators

Load and unload device drivers Administrators

Lock pages in memary EKTRONIN\crnacrmore

Log on as a batch job Administrators,Backup ..

Manage auditing and securitelog Administrator

» Knowledge of Solr, for administrators who want to perform advanced
tasks

Installing Solr on a single on-premises (local) server
After installing Ektron, you can install Solr. This is a 2-step procedure.

1. Install files needed to run Solr.
2. Register the Ektron site with the Solr search engine.
See also: Using Solr search with 3-tier architecture on page 178.

Part 1: Run Solrinstall.exe

1. Contact your Ektron account manager to obtain a link to download the Solr
installation file.

2. Login as a Windows Administrator user.
3. Download and run the Ektron Solr installation file as an administrator.
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Part 1: Run Solrinstall.exe

4. Accept the license agreement.

Solr Installation [ x|

Licenze Agreement

EKTRON PERPETUAL SOFTWARE LICEMSE AGREEMENT

Thiz License Agreement [“Agreement'’] containg the terms and conditions upon which Ektron,
Inc., a Delaware Corporation with a principal place of business at 542 Amherst Steet,
Mashua, NH 03083, ["Licenszar'] grants to you [ Licenzee'"] a licenze to uze the Licenzed
Software [az defined below] on the terms and conditions identified herein.

DEFIMITIOMNS:

Annual Maintenance Services Fee: Shall mean the amount identified as such in this
Agreement or accaompatying Exhibit.

Authorized System(s]: Shall mean computer systems, storage devices and networks owned,
operated or under the supervizion and control of Licenzee.

Lutharized User [othenmize referred to as "Mamed Uszer'): For purposes of this Agreement, the
term “Authorized Uzer” zhall mean any individual employes, agent or contractor of Licenzes
accessing or using the Licensed Software solely on behalf and for the benefit of Licensee in
the operation of Licensee's business. Such uzer shall have a uzemame and password

registered in the Content Management System through single sign on or directly within
Licensors work-area,

ent

greement

’ < Back ” Mest > ] Cancel

5. Select a folder in which to save the Solr installation files.

Solr Installation

Ektron 5olr Installation

kiron M :

| e

6. You are prompted to select a base port. After you select a port, itand 9
consecutive ports are designated for Solr use. For example, if you accept the

[ cea |
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default port 7600 as the base, ports 7600 through 7611 are used for Solr.

NOTE: Do not use a port number below 1025. Also, do not use ports 6080,
6081, and 8732: they are reserved for other Ektron components.

SolrInstallation

Service Port Selection

it of FEO0

’ < Back ” Mest > ] Cancel

7. Enter credentials (domain, user name, and password) of the Windows user
account under which Solr query services will run. This account manages Solr
components and authenticates queries. The account must have permission to

» write to the search 2.0 folder and its subfolders

o start the Solr admin service

» lock pages in memory. You can assign this in the machine's Local Security
Policy under Local Policy > User Rights Assignment.

» log on as a service. If the user does not have "Log on as a Service" right, you
are prompted to assign it.

If you are using a domain account, the Netlogon Service must be enabled and
running.
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Solr Installation

Search Service Account

Please enter the credentials of the Windows user that will serve az your search service account.
k'l'ron This account will be used to manage Solr components and authenlicate queries from your Ektion
zites,

The search service accourt must have the Log on a2 a service’ nght. This can be assigned via
the ‘Windows Local Secuity Policy management console,

Domain
vserane: [
Passvend (I

I < Back R Nest > I

8. Enter the SQL Server that will host the Solr configuration database. Then either
select Trusted Connection or enter the username and password of the user
who will create the search configuration database. The user must be assigned
the SQL Server dbcreator role.

=

Solr Installation

Search Configuration Database

Databaz ion Credentials

h configuration database that will support the

socbsertione: |
L

TiystallEhield < Back l l Hext» Cancel

Ektron Reference | 219




Setting up search for your website

9. Enter a unique name for your search configuration database. Spaces are not
allowed.

nfiguration D atabase

Pleaze enter a uniguee name that vill be used to identify your conbguration databage,

kiron

10. Enter credentials for a SQL login account that Ektron search components will use
to access the search configuration database.

Search Configuration Databaze

Diatabase Connection Credentials

uger account that will be used by Ektion seaich

kll.ron - ents to '--Ts i -lss- --; ur;iq'Jaticlndal-al;-ase.

W Trusted Connection

eS|

Passnort (e S
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11. Enter the host name of the server on which you are running the Solr installation.
The Ektron server must be able to access this host.

Solr Adminiztration Service

Services will be instalied an this server to receive quenss and route administrative requests
ron from Ektron stes lo Sok, Flease specily the host name for this senver.

Important: The host name must be accessible fiom the web server(s] hosting wour Ektion
sitex. If not, quesies and adminestrative requests from pour ite vall not be received.

Host Name: IR

ache 5ol Installation

ax Location

Flease speciy the location where Solr should store its index data. For optimal pesformance, index

k'r ron data should be stored on a fast, local disk with a laige cache,
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13. Specify the location of your asset cache. The asset cache is used only if the
Ektron asset files are not stored on your Solr search server.

Apache Solr

Aszet Cache

Aszet fles from pour Ekiron stes are cached as part of the indexing process. Flease
ktron location whete that cached dat uld be stared. For optimal performance, the asse
should be stored on a fast, local disk.

De ion Folder
C:\Program Files [#85NEkon\Searchs IhWAsselCache

Click Install to begin the installation.

kiron

[F wow wart to review or chanae anv of vour installation settinas, click Back, Click Cancel to esit
Search Service Account:

Configuration D atabage: _SaliCantig

Port Summary:

Query Service Port: 7600
Admin Service Port: P
Tarneat Connector and Marifald CF Part: 7602
Tameat Shutdown Port: 7EO3
Manifald CF D atabase Port: VEO4
Agzet Transfer Clisnt Port: VEOS
Fracess Management Parl: TEO9 *
Salr Port 7B

"Please add a firewall esception to allow communication between the Load Balancer and the
niades of the cluster and allow communication to the fallawing ports on Load Balanser such that
it is accezsibles from the Ektran CMS Site,

el et Cancel r

Key points on this screen:
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Part 2: Register your Solr site

» The query service port is always the base port.

» The screen lists your search service account, configuration database, and
the port number assigned to the following:
° Query service. Outbound from Ektron server

o Admin service. Outbound from Ektron server
o Tomcat connector. For local communications between Solr and Tomcat
Tomcat shutdown. For local communications between Solr and Tomcat

[e]

[e]

ManifoldCF. For local communications between Solr and ManifoldCF
o Asset Transfer Client. Two-way between Ektron and Solr servers

IMPORTANT: The summary screen's first 2 ports have an asterisk (*). Set
up the Ektron server's firewall such that these ports let the Ektron site
communicate with the Solr service.

Part 2: Register your Solr site

1.

Remote onto the Solr machine and go to the following URL:
https://YourSolrMachineName:7600/SolrAdminConsole/Index.html.

. If prompted, enter the credentials of the search server user used to install Solr.

If you are uncertain of the username, go to the Windows Services panel, locate
the Ektron Solr Process Manager service, and identify the user in the Log On As
column. Use this user to login to the site listed in step one.

. Inthe Web Server Name field, enter the machine name of the server that

contains the CMS site you are registering and click Connect.

. A list of Ektron databases on the server should be listed. Identify the database

you wish to register.

. If you deleted the crawl database, click the Start over button, confirm that the

crawl filter and polling interval settings are correct, and hit the Register button.
Take time to consider the crawl filters-your choice can make a considerable
difference in crawl time.
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Ektron Database(s)

http://stage, http://stagemultisite %

Database Name:
Database Server:

E Start Over

Crawl Filters

f content should be indexed by search? (Only checked items will be crawled

Automatic Polling Interval

We found Ekiron databases to configure with Solr. If your site’s database has not yet been configured, yo

now. If it's already configured, you can start over with a fresh index or edit the existing settings

HTML and Smart Forms Documents Forums

Products Community Members Community Content

How often (in minutes) do you want your CMS site to check for new or updated content and related CMS objects

Close

If you are registering the site for the first time, the steps are the same minus the

start over step.

6. If everything is configured correctly, you see a registration successful
message. Otherwise, search the knowledge base for the error you are receiving.

If necessary, contact Support.

Setting up Solr search in the Amazon cloud

This section explains how to set up Solr search to support an Ektron website deployed

to the Amazon cloud.

Part 1: Set up an Ektron site in the Amazon cloud

When prompted to select a Web Instances Type, select m1.large.

Part 2: Create a security group

The security group authorizes the opening of ports, which access search components

between Ektron and the Solr VM. Two of the ports, selected during the Solr

installation, are base port and base port+1. By default, they are 7600 and 7601.

NOTE: The base port is for the Admin Console/Registration UI and Query services.

The base+1 port is for the Ektron Solr Admin Service.
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NOTE: Create the Security Group for the region you selected for the Cloud site

(for example, US East).

1. Sign in to the Amazon Web services console.
2. Click Services > EC2 > Security Groups > Create Security Group.

T

Services ~

EC2 Dashboard

Edit ~

Create Security Group

Events
Tags viewing: [EC2 Security Groups (Search
.‘
- Group ID Name VP
Instances [] sg-10ea3078 [ udaidemo_port_8732
Spot Requests [J  sg-301b6258 ) elasticbeanstalk-windows
Reserved Instances _
[] sg-e6876a8e | quick-start-1
= L] sg-al9f4ica } Web Content Managemer
AMIs [  sg-bc8469d4 | default
Bundle Tasks [] sg-ffeeb194  RpiresSearch
L] sg-992bea32 » ektron-marketplace
Volumes U] sg-6550930e 4 eng008acloud-EkironSeci
Snapshots []  sg-e354488b @ quicklaunch-1
O] 5g-8db37eeb 4y amazona-cosj1eg-ec2-54-
Security Groups
Elaoctisr 1D~
3. Add a Name, Description and select No VPC.
Cancel x

Name:
Description:

VPC:

Create Security Group

lsolrsearch

[Solr Search Demo| X

|No VPC

‘ Cancel ‘ Yes, Create
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Click the group and add these 2 inbound rules.

Rule: TCP
Port range: 3389
Source: 0.0.0.0/0

Rule: TCP
Port range: 7600-7601
Source: 0.0.0.0/0

NOTE: For the second inbound rule, you are not required to use ports 7600
and 7601. These are only examples of ports you might use.

@ Security Group: solrsearch
Details Inbound
Create a ‘Custom TCP rule g
new rule:
Port range: 7600-7601
(e.g., 80 or 49152-55535)
Source: 0.0.0.0/0
(e.g., 192.168.2.0/24, sg-47ad482e, 0
1234567890/ default)
28 Add Rule

Click Apply Rule Changes.

Part 3: Create Solr search VM
In this part, you create a Solr search version on an Amazon virtual machine.

NOTE: Create the Solr Search VM in the same region you selected for the Cloud
site.

Awon e

Sign in to Amazon Web services console.
Click EC2 > Instances > Launch Instance.
Click the Quick Start tab.

Select a Microsoft Windows server that supports Solr search. Do not choose one
that is bundled with a SQL server. See also: Setting up Solr search on a single
on-premises (local) server on page 213
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™

SUSE Linux Enterprise Server 11 Service Pack 2, B4-hit architecture, and HVM bag

SUSE Linux Foot device type: ehs Wirtualization type: hvm

Ubuntu Server 13.10 for HYM Instances - ami-390e67fal
Ubuntu Serer 13.10, with support available from Canonical (http: e ubuntu. com

Root device type: ehs Virtualization type: hvm

iy @indows Server 2012 Base _hAmi-hB52c986

Windows Microsoft Windows 20T Standard edition with Bd-bit architecture. [English]

Root device type: ehs Wirtualization type: hvm

Microsoft Windows Server 2012 with SGIL Server Express - ami-c453
Microsoft Windows Serer 2012 Standard edition, B4-bit architecture, Microsoft SG

Windows

Roat device type: ebs Wirtualization type: bvm

by Microsoft Windows Server 2008 R2 Base - ami-1e53c8le

5. Click the Select button. A new window appears.
6. Select All Instance Types > M1 large and click Next.
Step 2: Choose an Instance Type

Amazon EC2 provides a wide selection of instance types optirmized to fit different use cases. Instances are wirtual
resources for your applications. Learn more about instance types and how they can meet your computing needy

Currently selected: m1 large (4 ECUs, 2 wCPUs, 7.9 GIE memory, 2 x 420

All instance types All instances

o Select an instance type to suit your requirements
Micro instances

Free tier eligible Size ECUs i/ vCPUs i)  Memory (GiB) Instance
General purpose t1.micro upto 2 1 0613 EES onl
hemary optimized m1.small 1 1 1.7 1% 160
Storage optimized m1.medium | 2 1 3.7 Tx410
Compute optimized 4 2 7.5 2x 420
GPU instances ml.xarge g 4 13 4 %420

7. On the Configure Instance screen, check Protect against accidental
termination and click Next.
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Step 3: Configure Instance Details
Configure the instance to suit wour requirements. You can launch multiple instances from the same Al request §
management role to the instance, and more.
Number of instances (j 1
Purchasing option (j Request Spot Instances
Network (j wpc-c93327ah (172.31.0.0/16) (default) | C
Subnet (j Mo preference (default subnet in any Availability Zar v
Public IP (i ¢ Automatically assign a public IP address to your instances
1AM role (j MWaone v
Shutdown behavior (j Stop v
Enable termination protection (j @against accidental t@
Monitoring  (j Enable Cloudvatch detailed monitoring
Aocdoliticmal clnoys Pt |

8. The Storage Device Configuration screen appears. Click Next. The Tag Instance
screen appears.

9. Add atag. For the Key, enter search. For the Value, enter solr. Click Next.

Step 5: Tag Instance
A tag consists of @ case-sensitive key-wvalue pair. For example, wou could define a tag with key = Mame and walue = Wekbd
Learn more about tagging your Amazon EC2 resources.

Key (127 characters maximurm) Value (255 characters maximurn)

search salr

Create Tag (Upto 10 tags maximum)

10. Select the security group you created in Part 2: Create a security group on
page 224 and click Review and Launch.
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Select an existing key pair or create a new key pair X

A key pair consists of a public key that AVWS stares, and a private key file that you store. Todether,
they allow you to connect to your instance securely. For Windows AMIs, the private key file is required
to obtain the password used to log into your instance. For Linuxs AMIS, the private key file allows wou to
securely S5H into your instance.

Choose an existing key pair

Select a key pair
JT A

| acknowledge that | have access to the selected private key file (JT.pem), and that without
this file, 'won't e able to log into my instance.

Cancel

11. Review screen information then click Launch.

12. Select the key pair that you created and click Launch Instances.
If you created a new key pair when you ran the deployment wizard, the
CloudPemFile is created in the Ektron on-premises Windows Service install
directory, C:\Program Files
(x86) \Ektron\EktronWindowsService40\CloudPemFile.

NOTE: If you do not have an existing key pair, create new pair and save the
key pair file on your computer. You will need it later to log in.

Select an existing key pair or create a new key pair X

A key pair consists of a public Key that AWS stores, and a private key file that wou store. Together,
they allow ywou to connect to your instance securely. For Wwindows AMIs, the private key file is required
to obtain the password used to log into your instance. Faor Linux AMIS, the private key file allows you to
securely S5H into your instance.

Choose an existing ke pair

Select a key pair
JT v

| acknowledge that | have access to the selected private key file (T perm), and that without
this file, | won't be able to log into my instance.

Cancel

13. Move the cursor to the row containing the new instance, click the Name field,
then insert a name.

NOTE: This step is not required but will ease identification of your VM later.
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Launch Instance Actions

Filter: All instances ¥  All instance typ4

Mame 4+ |Instance ID Instai

0dbe0504 m1 la

14. When the launch is finished, right click the instance and select Get Windows
Password.

Launch Instance Connect Actions ¥

Filter: All instances ¥  All instance types ~

[ ] Name < Instance ID Instance Ty

@  ektronsearg Instance Management

Launch hare Like This

Add/Edit Tags

Change Instance Type

Create Image

Bundle Instance (instance store Al

Metworking

Change Security Groups

Attach Metwork Interface

15. Browse to the keypair file described in Step 10, EktronSolrSearchKP.pem, and
click Decrypt Password.
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Retrieve Default Windows Administrator Password x

To access this instance remotely (e.g. Remote Deskiop Connection), you will need your Windows Administrator
password. A default password was created when the instance was launched and is available encrypted in the
system log.

To decrypt your password, you will need your key pair for this instance. Browse to your key pair, or copy and
paste the contents of your private key file into the text area below, then click Decrypt Password.

The following Key Pairwas associated with this instance when it was created.
Key Name  solrsearch
In arder to retrieve your password you will need to specify the path of this Key Pair on your local machine:
Key Pair Path Choose File | solrsearch.pem

Orwou can copy and paste the contents of the Key Pair below:

MITEpQIBAAKCAQE AULNRIA+SEESAT10rSweseP4To9uESVEr47546M4/ £78WIESCLIowuxFSTUPEY
EVZNI/ Jt1f5855E1l0UFFoScRILéziaCKlcomTIVt+DsMOSx7pD1aMV?e199FUNECOvh HEeKIECIVE
O0zlulOVilFH4TS0X11033PNTHZ yASS 13 9ghAosI7CEPalgGRMNG/ 0+2 RVEZ6SIL6A4 1DeS TV IRS
wiD3 ZoTOsSEOvE YN T+0a+h ¥k IkANEIIT/ REMI W p+vc/ 00rgOGSgqivo j TnLHyerCxD139Dx0

Cancel Decrypt Password

16. You see the decrypted password & hosthname. Save them for future access to the
EC2 Instance Remote Desktop Session.

Part 4: Set up the Amazon Solr search VM

On the Solr search Amazon VM (which you installed in Part 3: Create Solr search VM
on page 226), install the Solr search prerequisites.

PREREQUISITES

e Solrserver
° Hardware requirements: minimum 8 gigabytes of RAM, quad
core, 64-bit processor

° QOperating system: Windows 2008, Windows 2012, Windows
2016

NOTE: For a production server, use Windows 2008 R2,
Windows 2012, or Windows 2016.

o Enable the following
° Roles
® Application Server Role Services
® _NET Framework 4.5

IMPORTANT: With Windows Server 2008 or
2008 R2, be sure that .NET 3.5 is installed
before installing 4.5.

= Web Server IIS Support
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® Web Server (IIS) Role Services
= Windows Authentication feature

® _NET Extensibility 4.5
= ASP.NET 4.5

°o Features
= NET Framework > WCF Activation

NOTE: Make sure that HTTP activation is also
checked.

® Static content
o SQL browser, if not using default instance
o For optimal performance, use a separate disk (that is, not the
system drive) for index and asset cache

° May be installed on Ektron server but only in a development
environment.
Consult an Ektron certified partner to determine your server
requirements. Ektron does not recommend installing Solr on a
server that also hosts Microsoft Search Server.

o Java Development Kit , Windows x64 version.

IMPORTANT: If you upgrade the JDK version, you must
replace it in the same directory to which you originally
installed it. You may not install more than one JDK version to
that directory.

« An Ektron site installed on an Ektron server. See also: Installing
Ektron on page 9, Upgrading to on page 35.

NOTE: During the Ektron installation, you should have selected
Solr as your search provider. If you need to change your search
provider to Solr, see Changing your search provider to Solr on
page 277.

» The Ektron Solr installation file. Contact your Ektron account manager

to obtain a link to the file.

e Users
° A SQL login account assigned the dbcreator role. This account is
used to create the search configuration database.

° A SQL login account that Ektron search components use to
access the search configuration database.

Both SQL accounts must follow these rules:
m If integrated security is set to true

...and Solr search and the Ektrondatabase are on different
servers, a domain user is required.
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...and Solr search and the Ektron database are on the same
server, a local Windows user is required.

® if integrated security is set to false, a SQL server user.

BEST PRACTICE

Use SQL authentication rather than Integrated
Security. Although Integrated Security is supported,
the connection is made in the context of the search
service account (Windows user) provided during
installation. If this user does not have access to the
database, the connection fails.

o A Windows user account under which Solr services will run. This
account, which manages Solr components and authenticates
queries, must have permission to

® write to the search 2.0 folder and its subfolders
® gstart the Solr admin service
® |og on as a service

This user can be either a Windows user on the search server, or a
domain user. If it is a domain user, the Netlogon service must be
enabled and running.
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T3 Local Security Palicy
File  Action  Miew Help

e | 2EIXE = HE

T Security Settings
5 Account Policies
4 | g Local Policies
a Audit Policy
7, User Rights Assignment
7 Security Options
| W¥indowes Firewall with Sdwanced Seci
j Metwatk List Manager Policies
| Public Key Policies
| Software Restriction Policies
| Application Contral Policies
; g IP Security Policies on Local Compute
| Advanced Audit Policy Configuration

Palicy

Access Credential Manager as a trusted caller
Access this computer from the network

Act as part of the operating system

:f]Add workstations to domain

Adjust mernory quotas for a process

Al log on locally

-5 Allow log on through Rernote Desktop Services

Back up files and directories

Bypass traverse checking

Change the system time

Change the tirme zone

Create a pagefile

Create a token object

Create global objects

Create perrnanent shared objects

Create symbalic links

Debug programs

Dermy access to this computer fram the netnork
Deny log on as a batch job

Demy log on as a service

Deny log on locally

Dery log on through Remote Desktop Services

Enable computer and user accounts to be trusted for delega..,

Force shutdown fram a remote systerm
Generate security audits

Impersonate a client after authentication
Increase a process working set

Increase scheduling priority

Load and unload device drivers

Lock pages in mernary

Log on as a batch job

Security Setting

Everyone, Administrators..

EKTRONINUE Admin,EK..,
LOCAL SERVICE METWO..,
Guest,Administratars,Us...
Eweryone, EKTROMINDO..,
Adrinistrators,Backup ...
Ewveryone LOCAL SERVIC...
LOCAL SERVICE Admini...
LOCAL SERVICE Admini...

Administrators

LOCAL SERVICE METWO..,

Administrators
Administrators
Guest

SophosSALMSI06T50,G..,

Administrators
LOCAL SERVICE, METWO...
LOCAL SERVICE METWO...
Users

Administrators
Administrators
EKTROMINcrmacmaore
Administrators,Backup ..

Manage auditing and securitelog

Ldministrator

» Knowledge of Solr, for administrators who want to perform advanced
tasks

Part 5: Install Solr on the Soilr VM

Remote into your Solr VM then complete these steps.

1. Contact your Ektron account manager to obtain a link to download the Solr
installation file.

2. Login as a Windows Administrator user.
3. Download and run the Ektron Solr installation file as an administrator.
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4. Accept the license agreement.

Solr Install

Licenze Agreement

EKTRON PERPETUAL SOFTWARE LICEMSE AGREEMENT

Thiz License Agreement [“Agreement'’] containg the terms and conditions upon which Ektron,
Inc., a Delaware Corporation with a principal place of business at 542 Amherst Steet,
Mashua, NH 03083, ["Licenszar'] grants to you [ Licenzee'"] a licenze to uze the Licenzed
Software [az defined below] on the terms and conditions identified herein.

DEFIMITIOMNS:

Annual Maintenance Services Fee: Shall mean the amount identified as such in this
Agreement or accaompatying Exhibit.

Authorized System(s]: Shall mean computer systems, storage devices and networks owned,
operated or under the supervizion and control of Licenzee.

Lutharized User [othenmize referred to as "Mamed Uszer'): For purposes of this Agreement, the
term “Authorized Uzer” zhall mean any individual employes, agent or contractor of Licenzes
accessing or using the Licensed Software solely on behalf and for the benefit of Licensee in
the operation of Licensee's business. Such uzer shall have a uzemame and password
registered in the Content Management System through single sign on or directly within
Licensors work-area,

’ < Back ” Mest > ] Cancel

5. On the Deployment Type screen, choose Install Solr on a single server.

Solr Installation BE

Deployment Type

I deployment that w

r K

-0mpon

< Back l [ MHest » Cancel
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6. Select a folder in which to save the Solr installation files.

Solr Installation [ x|

Ektron Solr Installation

e installed in the following directary:

kiron

- Cancel

7. You are prompted to select a base port. After you select a port, itand 9
consecutive ports are designated for Solr use. For example, if you accept the
default port 7600 as the base, ports 7600 through 7611 are used for Solr.

NOTE: Do not use a port number below 1025. Also, do not use ports 6080,
6081, and 8732. They are reserved for other Ektron components.
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Solr Installation

Service Port Selection

’ < Back ” Mest » ] Cancel

8. Enter credentials (domain, user name, and password) of the Windows user

account under which Solr query services will run. This account manages Solr
components and authenticates queries.

The account must have permission to

® write to the search 2.0 folder and its subfolders
® gstart the Solr admin service

® |og on as a service. If the user does not have "Log on as a Service" right,
you are prompted to assign it.

If you are using a domain account, the Netlogon Service must be enabled and
running.
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Solr Installation

Search Service Account

Please enter the credentials of the Windows user that wil serve a3 your search service account.
k'l'ron This account will be used to manage Solr components and authenlicate queries from your Ektion
zites,

The search service accourt must have the Log on a2 a service’ nght. This can be assigned via
the ‘Windows Local Secuity Policy management console,

Domain
vserane: [
Passvend (I

9. Enter the SQL Server that will host the Solr configuration database. Then either
select Trusted Connection or enter the username and password of the user
who will create the search configuration database.

Solr Installation

Search Configuration Databasze
Dat I3

oo | administrator. clffvsdwiBoy. ug-east-1.1ds. amazonaws. com

| Trusted Cormection

L ista el < Back ” Meut > Cancel
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Part 5: Install Solr on the Solr VM

To get the SQL server name, use the Endpoint field in the Amazon Cloud
Instances screen. Exclude the Endpoint's port number.

RDS Dashboard Launch DB Instance Show Monitoring Instance Actions v
4
Database Filter: All Instances v Q Search DB Instances x

DB Instance +« VPC~- Multi-~ Class - | Status Storage -

Reserved Purchases

- [ cashby No db.m1.small available 30 GB

Snapshots
Endpoin€_cashby.clffvsdyréov.us-east-1.rds.amazonaws.copdl433 ( available )
Security Groups =

N -
Configuration Details Security and N~ Exclude the port Stancs
Parameter Groups Name: Awailability Zone: number S
Option Groups Engine: sqlserver-ex{10.50.2789.0.v1) VPC ID: nstance

Username: administrator Subnet Group:
Subnet Groups ) ;
Option Group(s): default:sglserver-ex-10-50 ( in-sync ) Subnets: None
Evenis Character Set- Securitv Grouns-  default { active )

The user must be assigned Create Any Database permission on the RDS
database server. See also: Amazon Relational Database Service
(RDS) documentation.

Enter a unique name for your search configuration database. Spaces are not
allowed.

Solr Installation =

Search Configuration Database

Please enter & unique name that vall be used to identify your conhguration databass.

Enter credentials for a SQL login account that Ektron search components will use
to access the search configuration database.
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Solr Installation

Pleate specily the credentials of the uset account that will be used by Ekbion seach
components bo access the search configuration database.

W Trusted Connection

STeevE—
Passort (e

— <Back ']I'r Newt > ]_T Cancel |l

12. Enter the host name of the server on which you are running the Solr installation.
The Ektron server must be able to access this host. Your host name may look like
this.

Solr Installation

Solr Administration Service

ktron

14 | SearchT est-BE7E44R29 us-east-1.elb.amazonaws. cor

ListallBHield [ < Back H Mest = l Cancel

The following image indicates where to get the Amazon load balancer host name.
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EC2 Dashboard Create Load Balancer | | Delete |
Events
Tags viewing: | All Load Balancers |+ Iii-ez ch :I
= INSTANCES [] Load Balancer Name DNS Name Port Configuration
Instances
O ,qL; udailoadbalancer udailoadbalancer-1018222968 us-east-1.elb.am 80 (HTTP) forwarding to 80 (H
Spot Requests
Reserved Instances O ,qL;vpctesl vpetest-508513581.us-east-1.elb.amazonaws.c 80 (HTTP) forwarding to 80 (H
O ,gL; udaid0tes-ElasticL-1VFPL udai90tes-ElasticL-1VFPLEKDIZZ1D-1791161¢ 80 (HTTP) forwarding to 80 (H
= IMAGES O MattTestLB WMattTestLB-1415975509.us-east-1.elb.amazon  §0 (HTTP) forwarding to 50 (H
AMIs
Bundle Task O ,qL; Randytest-ElasticL-L2Q8] Randytest-ElasticL-L2Q8FNTGMG4M-10071417 80 (HTTP) forwarding to 80 (H
undle [asks
] ,qL; BobTest2LB BobTest2LB-454043144 us-east-1.elb.amazon: 7600 (TCP) forwarding to 760
=] ELASTIC BLOCK STORE O ,qL; anotherBobLB anotherBobLB-2098061091 us-east-1.elb.amaz 7600 (TCPF) forwarding to 760
Volumes O _+; SolrGaziz-ElasticL-MNME  SolrGaziz-ElasticL-MMMSJJICEZQN-23661661 80 (HTTP) forwarding to 80 (H
Snapshots _ﬁL; SearchTest SearchTest-687844689 us-east-1.elb.amazona 80 (HTTP) forwarding to 80 (H
=] NETWORK & SECURITY
Security Groups
Elasfic IPs 1 Load Balancer selected
Placement Groups
Q(Gad Balancers 4 Load Balancer: SearchTest
Key Pairs Description | Instances || Health Check Listeners
Network Interfaces DNS Name: earchTest-687844689.us-east-1.elb.amazonaws.com (& Recor
ipva., th 44680 Lsasastal alb. TETTS-COM Record
dualstack.SearchTest-687844689.us-east-1.elb.amazonaws.com (A or A4

13. Select a folder in which Solr will store its index data.
Solr Installation

yal Installation

Please specily the location wihere Solr should store its index data. For optimal performance, ndex
data should be stored on a fast, local disk wath a large cache,

Diestination F
C:\Pragram Files [#BENEkton\S earch2 INS ol \Index

14. Specify the location of your asset cache. The asset cache is used only if the
Ektron asset files are not stored on the Solr search server.
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ache Solr Installation

Destination Folder
C:\Program Files [#85NEktron\Searchs (hWAsselCache

Click Install ta begin the installation.

If oy want to review or chanae ary of vour installation settings, click Back, Click Cancel to esit
Search Service Account:

Configuration D atabage: _SaliCantig

Port Summary:

Query Service Port: 7600
Admin Service Port: P
Tamcat Connector and Manifald CF Part: 7602
Tamcat Shutdawn Part: 7603
Manifald CF Database Port: VEO4
Agzet Transfer Clisnt Port: VEOS
Fracess Management Parl: TEO9 *
Salr Port 7B

"Plaase add a firawall ssception to allaw cormmunication between the Load Balancer and the
riades of the chuster and allow communication ta the fallawing ports on Load Balancer such that
it is accessible fram the Ektron CMS Site,

T el | Iy Cancel

Key points on this screen:
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» The query service port is always the base port.

» The screen lists your search service account, configuration database, and
the port number assigned to the following:
° Query service. Outbound from Ektron server

°o Admin service. Outbound from Ektron server

° Tomcat connector. For local communications between Solr and Tomcat
° Tomcat shutdown. For local communications between Solr and Tomcat
o ManifoldCF. For local communications between Solr and ManifoldCF

o Asset Transfer Client. Two-way between Ektron and Solr servers

IMPORTANT: The summary screen's first 2 ports have an asterisk (*). On
the Ektron server, adjust the firewall to allow these ports to communicate
between your Ektron site and the Solr service.

Part 6: Set up a search load balancer

In this section, you load balance your search. You need to do this so the cloud-based
Ektron site can access search components on the Solr VM, which will be accessible
through the load balancer.

1. From the Amazon Web services console, go to EC2 > Load Balancers >
Create Load Balancer.

2. Give the Load Balancer a name.
At Create LB Inside, choose EC2.

4. Map the base and base + 1 ports (by default, 7600 and 7601) between load
balancer and Instance. Use TCP protocol, not Http. Click Continue.

W

Create a New Load Balancer Cancel [x

This wizard will walk you through setting up a new load balancer. Begin by giving your new load balancer a unique name so
that you can identify it from other load balancers you might create. You will also need to configure ports and protocols for
your load balancer. Traffic from your clients can be routed from any load balancer port to any port on your EC2 instances.
By default, we've configured your load balancer with a standard web server on port 80.

Load Balancer Name: Ektron Solr LB

Create LB inside: g2 -

(what's this?)

Listener Configuration:

Load Balancer Protocol Load Bal Port  Inst Protocol Instance Port  Actions

TCP 7601 TCP 7601

TCP ~ | 7600 TCP ~ | 7600
Continue

5. On the Health Check dialog
» at Ping Protocol, select HTTP.

» at Ping Port, enter the base port. By default, it is 7600.
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Create a New Load Balancer

the health check to meet your specific needs.

Configuration Options:

Ping Protocol: |HTTP =

Ping Port: I?GUU

Ping Path: [/ping| html
Advanced Options:

Response Timeout: |5 Seconds

Health Check Interval: |0.5 Minutes
Unhealthy Threshold:

Healthy Threshold:
10

Cancel | X

Your load balancer will automatically perform health checks on your EC2 instances and only route traffic to instances that
pass the health check. If an instance fails the health check, it is automatically removed from the load balancer. Customize

Time to wait when receiving a response from
the health check (2 sec - 60 sec).

Amount of time between health checks (0.1 min
- & min)

Mumber of consecutive health check failures
before declaring an ECZ2 instance unhealthy.

Mumber of consecutive health check successes
before declaring an EC2 instance healthy.

6. The Add EC2 Instances screen appears. Select the instance you created in Part

3: Create Solr search VM on page 226 and click Continue.
7. Areview screen displays the settings. When you are ready, click Create.

Amazon sets up a Search Load Balancer.

NOTE: The health check may fail since Solr Install has not run yet, and

ping.html is not present on the VM.

Part 7: Edit health check, create inbound rule, and verify QueryService

URL

1. From the Amazon Web services console, go to EC2, click Load Balancers, and

select the load balancer you created.
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EC2 Dashboard Create Load Balancer | | Delete q
Events
Tags ! Viewing: | All Load Balancers j' ) 1to7
= " Load Balancer Name DNS Name Port Configuratior
Instances
r % udailoadbalancer udailoadbalancer-1018222968.us-east-1.elb.amazonaws.com 80 (HTTP) forwardin
Spot Requests
Reserved Instances ™  vpctest vpctest-508513581.us-east-1.elb.amazonaws.com 80 (HTTP) forwardin
[ @ udai90tes-ElasticL-1VFPLAKDSZZ1D udai90tes-ElasticL-1VFPLEKD9ZZ10-1791161823 us-east-1 elb amazonaws con 80 (HTTP) forwardin
= r @ cashbyekt-ElasticL-EOX1BFB3HEXV cashbyekt-ElasticL-EOX1BF89HEXV-766754643 us-east-1 elb amazonaws com = 80 (HTTP) forwardin
Al I  MattTestLB MattTestLB-1415978509.us-east 1.elb.amazonaws.com 80 (HTTP) forwardin
Bundle Tasks
[ @ ektronsolrsearch ektronsolrsearch-297349953 us-east-1 elb.amazonaws com 7600 (TCP) forwardi

= 2 @, Thursday3-ElasticL-14NM3L7Q3GIS hursday3-ElasticL-14NM3L7Q3GIS-379278841 us-east-1.elb.amazonaws comi: R GIRISYRLTEL: ]
Volumes ( ) hY
Snapshots DNS name of search
load balancer
Security Groups
Elastic IPs 1 Load Balancer selected
Placement Groups N ~
P ¥ Load Balancer: Thursday3-ElasticL-14NM3L7Q3GIS _|
Load Balancers
Key Pairs Description Instances Health Check Monitoring Security Listeners
Network Interfaces DNS Name: ~Thurad/ I3 Elactio 1 4NM3L7Q3G1S-379278841.us-gast-1.elb.amazonaws.com (A Record)
He: tab lficL-14NM3L7Q3GIS-379278841.us-east-1.elb.amazonaws.c (AAAA Record)
b —er3-ElasticL-14NM3L7Q3GIS-37927884 1.us-east-1.elb.amazona A or AAAA Record)
Note: Because the set of IP addresses associated with a LoadBalancer can change over time,
you should never create an "A" record with any specific IP address. If you want to use a friendly
DNS name for your LoadBalancer instead of the name generated by the Elastic Load Balancing
service, you should create a CNAME record for the LoadBalancer DNS name, or use Amazon Route 53
to create a hosted zone. For more information, see the Using Domain Names With Elastic Load Balancing
Scheme: internet-facing
Status: 1 of 1 instances in service
Port Configuration: 80 (HTTP) forwarding to 80 (HTTP)

Stickiness: AppCookieStickinessPalicy, cookieName='EktGUID" {edit)

8732 (HTTP) forwarding to 8732 (HTTP)
h et S S A

2. On the Amazon Solr server, create an inbound rule to allow connections to Solr
ports.This allows your Ektron VM to communicate with the Solr Admin Console.
To do this:
a. Go to Control Panel > Windows Firewall > Advanced settings >
Inbound Rules > New Rule.

NOTE: Leave firewall status "Turned On".

#® windows Firewall with Advanced Security

File  Action View Help

s 2oL B
P virdows Eraual wih acvanced s |

B outbound Rules Enabled
B Connection Security Rules Yes
B, Monitoring

et Mew Rule.

ST Filter by Profile
T Filter by State

'O'Tast All Yes Allowe
'BranchCache Content Retrieval (HTTP-In) BranchCache - Content Retrie... Al Mo Allaw

SF Filter bv Groyin

b. On the Rule Type screen, choose Port.

On the Protocols and Ports screen, choose TCP. In the Specific local ports
field, enter your baseport and baseport + 1. For example, 7600-7601.

d. Click Next then Allow the connection.
e. On the When does this rule apply? screen, check all boxes.
f. Assign a name to the rule.

3. Click the Health Check tab. Click Edit Health Check. Change the value of
ResponseTimeout to any value and save. Verify that this action changes your
load balancer status to In Service.

4. On the Amazon Ektron server, create an inbound rule to add 8732 as an inbound
port. This allows the Solr Admin Console to communicate with your Ektron VM.
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To do this:
a. Onthe Amazon instance that hosts Ektron, go to Control Panel >
Windows Firewall > Advanced settings > Inbound Rules > New
Rule.

NOTE: Leave Firewall status "Turned On".

b. On the Rule Type screen, choose Port.

On the Protocols and Ports screen, choose TCP. In the Specific local ports
field, enter 8732.

d. Click Next then Allow the connection.
5. From Amazon EC2 console, obtain the DNS Name of the search load balancer.

EC2 Dashboard Create Load Balancer Delete
Events p
Tags viewing: | All Load Balancers |+ ||
B [ Load Balancer Name DNS Name Port Configuration
Instances . . ) )
O v udailoadbalancer udailoadbalancer-1018222968 us-east-1.elb.am 80 (HTTP) forwarding to 80 (H
Spot Requests !
Reserved Instances O ¥ vpctest vpctest-508513581 us-east-1.elb.amazonaws.c 80 (HTTP) forwarding to 80 (H
O ¥ udai90tes-ElasticL-1VFPL udai90tes-ElasticL-1VFPLEKD9ZZ1D-1791161¢ 80 (HTTF) forwarding to 80 (H
B O @ MattTestLB MattTestLB-1415978509.us-east-1.elb.amazon 80 (HTTP) forwarding to 80 (H
AMIs
O e Randytest-ElasticL-L2Q8] Randytest-ElasticL-L2Q8FNTGMG4M-1007141% 80 (HTTPF) forwarding to 30 (H
Bundle Tasks
O ¥ BobTest2LB BobTest2LB-454043144 us-east-1.elb.amazon: 7600 (TCP) forwarding to 760
= O ; anotherBobLB anotherBobLB-2098061091.us-east-1.elb.amaz 7600 (TCP) forwarding to 760
Volumes [ 4 SolrGaziz-ElasticL-MNMS  SalrGaziz-ElasticL-MNMSJJICEZQN-23661661 80 (HTTP} farwarding to 80 (H
Snapshots #, SearchTest SearchTest-667844689 us-east-1.elb.amazona 80 (HTTP) forwarding to 80 (H
Security Groups
Elastic IPs 1 Load Balancer selected
Placement Groups
Q(5ad Balancers % Load Balancer: SearchTest
Key Pairs Description || Instances || Health Check || Monitoring | Security || Listeners
Network Interfaces DNS Name: earchTest-687844689.us-east-1.elb.amazonaws.com (A Record)
ipvB. i, AA580 ueagact.l alb o WA TRAAA Record
dualstack.SearchTest-5687844689.us-east-1.elb.amazonaws.com (A or AA|

6. Verify that the QueryService Url works from the Ektron server via this

URL: https://load balancer DNS name:baseport
number/SolrQueryService/SolrQueryService.svc

Part 8: Disable "Set Computer Name"

1. On the Solr search Amazon VM, press Windows key\S to open the search box
and enter EC2ConfigService.
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2. On the Ec2 properties dialog, uncheck the Set Computer Name box.

Ec2 Service Properties M
General Image | Storage | Support Iil

et Camputer Mame

[] Set the computer name of the instance to ip-<hex Internal 1Py name.
Dizable this feature bo persist your own computer name setting.

dzer Data

[] Enable UserDrata execution for nest service start [automatically enabled at Sysprep)
eqg. <scnplx</sonpty or <powerzshels < /povwershell:

Ewvent Log

[] Output event lag entries on the console for easy monitoring and Settings

debugaing from the client.

W allpaper Infarmation

Check the box to overlay infarmation on the current wallpaper.
Thiz will be generated evemtime a uger logs in.
ncheck the box to reset the background to what was previously et

Mote: These changes will take affect on next boot or restart of the ecZconfig zerice.

Part 9: Register the load-balanced site

Register the load balanced site using the following URL: https://load balancer
DNS name:baseport number/SolrAdminConsole/index.html.

Additional steps if Ektron is installed manually on Amazon
EC2

If Ektron was manually installed in an Amazon EC2 environment, and you want Solr
search to crawl Ektron resource files, follow one these procedures to enable that
crawl.

Store resource files on the EC2 instance

Follow these steps to allow Solr search to crawl Ektron resource files (assets, private
assets, uploaded images, uploaded files, asset library) on an EC2 instance. To
properly configure this, create an elastic IP for the Ektron EC2 instance. This enables
Solr's asset transfer client to connect to Ektron's asset transfer service.

1. From the Amazon Web services console, go to EC2 > Network & Security
> Elastic IPs.

2. Select the Ektron machine name and click Allocate New Address.
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EC2 Dashboard
Events

Tags

Reports

Instances
Spot Requests
Reserved Instances

AMIs

Bundle Tasks

Volumes

Snapshots

Security Groups
F'Ia!ﬁ Eft Groups

Edit ~

e —
\ Allocate New Address

Filter:

Setting up search for your website

All addresses v

Address

107.20.172 245

Associate

~  Instance ID

i-e40083ca (gaziz_S3)

( Ektron machine name)

3. The Associated Address dialog appears. Check the Ektron server that will work

with this Amazon Solr instance.
4. On the Solr VM, open the hosts file

(C:\Windows\System32\Drivers\etc\hosts).

5. Add a new host file entry. Insert the Elastic IP address of and the name of the
Ektron EC2 instance.

# il

#
# 182.54,94.97
# 38.25.63.18

rhinc.acme. com

Xoacme . Com

# localhost name resolution is handled within DNS itself.
# 127.68.@.1

localhost
localhost

187.26.172.245  WIN-PIQKKYHL171] |

m q machine ﬂame)

# source serwver
# x client host

Store resource files in the Amazon S3

Follow these steps to allow Solr search to crawl Ektron resource files stored in the
Amazon Simple Storage Service (S3). To set up this capability, update the following
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section of your site's siteroot\web.config file, in the <appsettings> section.

<add key="ek CloudStorageType" value="" />
<add key="ek CloudAccountId" value="" />
<add key="ek CloudAccountKey" value="" />
<add key="ek CloudContainer" value="" />

* ek CloudStorageType—Enter AMAZON.
* ek CloudAccountId—Enter your Amazon account access key.
e ek CloudAccountKey—Enter your Amazon account secret key.
* ek CloudContainer—Enter the S3 bucket name.

For these changes to take effect:

1. On the Ektron EC2 instance, restart the EktronWindowsServices40 and
EktronAssetTransferServer.

2. Onthe Solr EC2 instance, restart EktronAssetTransferClient2.0 and
EktronSolrAdminService.

3. Register the site again. See Part 9: Register the load-balanced site on page 247

4. All new resource files will be stored in the S3 bucket. Verify that they are
searchable from the Ektron site.

Setting up Solr Search in the Azure cloud

If you want to deploy an Ektron website to the Azure cloud, deploy Solr search to
Azure cloud, then connect both cloud-based systems, you have 2 options:

» Install an Ektron site to an on-premises server then push the site up to an Azure
VM. Next, deploy Solr to the cloud. Finally, connect both cloud-based systems.
To view these instructions, see Pushing an Ektron site to the Azure cloud and
connect it to Solr search below.

» Install an Ektron site on an Azure VM. Next, deploy Solr to the cloud. Finally,
connect both cloud-based systems.

To view these instructions, see Installing Ektron site on Azure cloud and
connecting it to Solr search on page 266.

Pushing an Ektron site to the Azure cloud and connect it to
Solr search
Part 1: Deploy Ektron Site to the Cloud

Follow the steps in Using Ektron in the Windows Azure Cloud to deploy an Ektron site
to the Azure cloud. But note this important difference:

You cannot update the ektron.cms. framework.unity.config file directly on the
Ektron VM that hosts the Solr search provider. This restriction occurs because, when
the machine reboots, your changes are lost. So, follow these steps to update the
ektron.cms.framework.unity.config file.

1. During the Ektron installation, select Solr. If you did not do this, see Changing
your search provider to Solr on page 277.
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2. Copy the siteroot/ektron.cms.framework.unity.config to:
C:\Program Files (x86)\Ektron\CMS400vxx\CommonFiles\Configs
3. Run the initial cloud deployment.

If you need to make these changes after the initial cloud deployment, update the
unity.config filein the
C:\sync\azuredeploy\GUID\HostedServiceName\’HostedServiceName’ web
folder.

To upload this file to a cloud-based site, use the EktronConfigUploader.exe utility
in C:\Program Files (x86) \Ektron\EktronCloud\bin\ms\2.0.0.0 .

Part 2: Create Azure Solr search VM
Create an Azure virtual machine to host Solr search.

1. Log into https://manage.windowsazure.com.
2. Click Virtual Machines > New.

Bl Windows Azure | v

virtual machin

VIRTUAL MACHIME INSTAMNCE!

VIRTUAL MACHINES i
3

arch

i

solrsearch

SolrToDaCloud

»¢ O

COMNMECT RESTART

3. Click Quick Create.

4. For the new server, enter a DNS Name.

5. For the image, choose Windows Server 2012.

6. Choose a large size with at least 8 GB of memory.
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7. Enter your user name and password.

8. At Region/Affinity Group, select the region selected when setting up the
Ektron site (in Using Ektron in the Amazon EC2 Cloud).

9. Click Create a Virtual Machine.
10. Wait until the status changes from Starting (Provisioning) to Running.
11. Select the VM and click Connect.

Bl Windows Azure | v

virtual machines

VIRTUAL MACHIME INSTAMCES IMAGES D
VIRTUAL MACHINES NAME T | STATUS
5

BobSolrTest Running
BobSolrTest2 -

chadsearch Running
solrsearch Running
SolrTolaCloud Running

COMNMECT RESTART SHUT DOWN
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12. The following dialog appears. Click OK to connect to the virtual machine.

(Opening s X
You have chosen to open:
& solrsearch.rdp

which is a: Remote Desktop Connectian (76 bytes)
from: https: fmanage.windowsazure.com

What should Firefox do with this file?

¥ Qpen with |RE'n:-t—:- Desktop Connection (default) ﬂ
{~ Save File

[T Do this sutomatically for fles like this fram now on.

| Cancel I

13. When you are prompted for Windows credentials, prefix your username with the
DNS Name you created in Step 4.

Part 3: Set up Solr search on Azure VM

This section explains how to set up Solr search on the Azure VM.

1. Apply all prerequisites to the Azure VM. You already set up an Ektron site in
Using Ektron in the Windows Azure Cloud (PaaSs).
* An Azure database server is required. You have 2 options:
° Use the database server that hosts Ektron.

o Create a new database server.

» If you installed Ektron manually on an Azure VM (see Installing Ektron site
on Azure cloud and connecting it to Solr search on page 266), follow these
steps to enable the crawling of assets and private assets.

a. On the virtual machine that hosts the Ektron site, locate the Public
Virtual IP (VIP) address.
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DASHBOARD  MONITOR  ENDPOINTS  CONFIGURE
@ CPUPERCENTAGE @ DISKREAD BYTES/SEC @@ DISK WRITE BYTES/SEC NETWORK IN NETWORK OUT RELATIVE ~ 1HOUR A C
25.94%
214 KB/fs
Z L} 0B/s
4! 3 035 4 4
web endpoint status quick glance
You have not configured a web endpoint for monitoring. Cenfigure one to get started.
STATUS
COMFIGURE WEB ENDPOINT MONITORING @ Running
DMNS NAME
chadvm.cloudapp.net
autoscale status
HOST MAME

To start using autescaling, add virtual machines to an availability set

chadVM1

COMNFIGURE AVAILABILITY SET @
PUBLIC VIRTUAL IP (VIP) ADDRES!

99.99.99.999

AUTOSCALE OPERATION LOGS @

INTERMAL IP ADDRESS

On the virtual machine that hosts Solr search, open the hosts file
(located in $systemroot%\system32\drivers\etc).

Into the hosts file, insert the VIP obtained in Step 1, followed by the
hostname of the VM that hosts Ektron.

E| hosts - Notepad
File Edit Format VMiew Help
Copyright (c) 1993-2889 Microsoft Corp.

This is a sample HOSTS file used by Microsoft TCP/IP for Windows.

#

#

#

#

# This file contains the mappings of IP addresses to host names. Each
# entry should be kept on an individual line. The IP address should

# be placed in the first column followed by the corresponding host name.
# The IP address and the host name should be separated by at least one
# space.

#

# Additionally, comments (such as these) may be inserted on individual
# lines or following the machine name denoted by a '#' symbol.

#
#
#
#
#

For example:

182.54.,94.97 rhino.acme. com # source server
38.25.63.18 ¥.acme.com # x client host
# localhost name resolution is handled within DNS itself.
# 127.8.8.1 localhost
# HEN localhost

99.99,99,999 chadvMl
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2. Onthe Azure VM, copy the following into a .bat file and run it. This code fixes a
problem in which Java JDBC to SQL Azure connections are being forcibly closed.
REG ADD HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters

/v KeepAliveTime /t REG_DWORD /d 30000

REG ADD HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters
/v KeepAliveInterval /t REG _DWORD /d 1000

REG ADD HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters
/v TcpMaxDataRetransmission /t REG DWORD /d 10

3. Onthe Azure VM, register ASP.NET.
a. As an administrator, open a command prompt.
b. Enter cd C:\Windows\Microsoft.NET\Framework64\v4.0.30319
C. RuncC:\wWindows\Microsoft.NET\Framework64\v4.0.30319>aspnet
regiis.exe -1

4. Copy your storage access account and primary key to the Azure web.config file.
This enables the Asset Transfer service to correctly transfer Azure assets to Solr
Search VM. To do this:

a. Onthe Azure VM, find your storage account primary key by navigating to
Storage Accounts > your storage account.

NOTE: You created the storage account when you deployed an Ektron
site to the Azure cloud, as described in Deploying a Site Package to the
Azure Cloud.

Click Manage Access Keys.

Copy the Storage Account Name and Primary Access Key. you will
paste them in Step g.
Log on to the on-premises Ektron server.

Open the file
C:\sync\azuredeploy\GUID\HostedServiceName\HostedServiceName

web\web.config.
f. Within the <appsettings> tag, add these keys. Insert the values you
collected in Step 4c.

<add key="ek CloudStorageType" value="AZURE"/>
<add key="ek CloudAccountId" value="storage account name"/>
<add key="ek CloudAccountKey" value="storage account primary key"/>

g. Restart the Azure VM.

5. Push the web.config changes to your Azure site. To do this:
a. On the on-premises Ektron server, go to C:\Program Files
(x86) \Ektron\EktronCloud\bin\ms\2.0.0.0.

b. Open EktronConfigUploader.exe.

Enter your storage account name and storage account primary key. (You
obtained them in Step 4.)

Click Browse and go to the web.config file that you updated in Step 4.
Click Upload.
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Part 4: Run the Solr Installation

6. Reboot the Worker Hosted service. This, in turn, restarts the Ektron Windows
service. To do this:
a. Loginto https://manage.windowsazure.com.

b. Click Cloud Services.

c. Click your cloud service. (You created the cloud service when setting up the
Ektron site in the Azure cloud.

d. Click Instances.
e. Click the instance hosted service name worker IN 0.
f. Click Restart.
7. Log into the VM you created in Part 2: Create a security group on page 224.

Part 4: Run the Solr Installation

Contact your Ektron account manager to download the Solr installation file.
Log in as a Windows Administrator user.

Download and run the Ektron Solr installation file as an administrator.
Accept the license agreement.

H W

Solr Installation

Licenze Agreement

Fle: ad the fallowing lic reement carefully.

r

ektron

EKTRON PERPETUAL SOFTWARE LICEMSE AGREEMENT

This License Agreement [“Agreement'’] containg the terms and conditions upon which Elktron,
Inc., a Delaware Corporation with a principal place of business at 542 Amherst Street,
Mashua, NH 03083, ["Licenszar'] grants to you [ Licenzee'"] a licenze to uze the Licenzed
Software [az defined below] on the terms and conditions identified herein.

DEFIMITIOMNS:

Annual M aintenatice Services Fee: Shall mean the amount identified az such in this
Agreement or accompanying Exhibit.

Authorized System(s]: Shall mean computer systems, storage devices and networks owned,
operated or under the supervision and control of Licensee.

Autharized Uszer [othenmize referred to as "Mamed Uzer'): For purposes of this Agreement, the
term “Authorized Uzer” shall mean any individual employes. agent or contractor of Licenses
acceszing or uzing the Licensed Software solely on behalf and for the benefit of Licenses in
the operation of Licehsee's business. Such uzer shall have a uzemane and password
registered in the Content Management System through single sign on or directly within
Licenzors work-area.

® | accept the terms of the lic agreement

Q¥ | do not accept the terms of the lic

< Back | | Mest = Cancel |
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5. On the Deployment Type screen, choose Install Solr on a single server.

Solr Installation [ x|

Deployment Type

Cl & 5ol deployment that be:

Irvstal Sield ’ < Back ” Mest » ] Caticel

6. Select a folder in which to save the Solr installation files.

Solr Installation

Ektron 5olr Installation

kiron Praganios BN -

| e

7. You are prompted to select a base port. After you select a port, itand 9
consecutive ports are designated for Solr use. For example, if you accept the

L =teal | e ld
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default port 7600 as the base, ports 7600 through 7611 are used for Solr.

NOTE: Do not use a port number below 1025. Also, do not use ports 6080,
6081, and 8732: they are reserved for other Ektron components.

SolrInstallation

Service Port Selection

mized below. [For example, selecting a baze port of FEO0

’ < Back ” Mest > ] Cancel

8. Enter credentials (domain, user name, and password) of the Windows user
account under which Solr query services will run. This account manages Solr
components and authenticates queries.

The account must have permission to

o write to the search 2.0 folder and its subfolders
o start the Solr admin service

» log on as a service. If the user does not have "Log on as a Service" right,
you are prompted to assign it.

If you are using a domain account, the Netlogon Service must be enabled and
running.
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Solr Installation

Search Service Account

Please enter the credentials of the Windows user that will serve 3 your seaich service account.
- k'l'ron This account will be used to manage Solf components and athenticate queries fiom vour Ektion
—4 sites.

The search service accourt must have the Log on a2 a service’ nght. This can be assigned via
the ‘Windows Local Secuity Policy management console,

Domain

vserane: [

Passvend (I

9. Enter a fully qualified DNS name for the Azure SQL Server that will host the Solr
configuration database. Then either select Trusted Connection or enter the
username and password of the user who will create the search configuration
database. If you enter a user, select someone who is either the server-level
principal login or assigned the dbmanager database role. See also: Managing
Databases and Logins in Windows Azure SQL Database.
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Part 4: Run the Solr Installation

Pleace chogse a SOL Server 1o host the search configuration database that will support the
search components beng nstaled.
You may also *p-u:'i‘-- the accourd credentials used to create the database.

sed bo create the iguration database. '
cn be used by search components to connect to this

o T oloBEkiBel databaze. windows: net

H Truzted Connection

SL User Name: I

10. Enter a unique name for your search configuration database. Spaces are not
allowed.

Search Configuration Database

k'l'ron Pleace enter & unique name that will be used to identify your conhguration database.
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11. Enter credentials for a SQL login account that Ektron search components will use
to access the search configuration database.

Solr Installation -

Please specily the credentials of the user account that will be used by Ekbion sesich
components bo access the search configuration database,

M Trusted Connection

Tee—

Passnort (e

12. Enter the fully-qualified DNS name of the server on which you are running the
Solr installation. The Ektron server must be able to access this host.
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Solr Administration Semvice

Services will ba installed on thiz server to 1ecenve quenas and route administrative requests
ron frerm Ekiron sites 1o Sok, Flease specily the host name for this senver.

Irmpostant: The host name must be accessible from the web server(s] hosting your Eklion
sitez. | nok, quesies and administeative requests o pour site vall not be received.

Host Nane: B R

Please speciy the location where Solr shoubd store its index data. For optimal performance, ndex
data should be stored on a fast, local disk wath a large cache,

Destination Folder
C:\Pragram Files [#BENEkton\S earch2 INS ol \Index

14. Specify the location of your asset cache. The asset cache is used only if the
Ektron asset files are not stored on your Solr search server.
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ache Solr Installation

Destination Folder
C:\Program Files [#85NEktron\Searchs (hWAsselCache

Click Install ta begin the installation.

If oy want to review or chanae ary of vour installation settings, click Back, Click Cancel to esit
Search Service Account:

Configuration D atabage: _SaliCantig

Port Summary:

Query Service Port: 7600
Admin Service Port: P
Tamcat Connector and Manifald CF Part: 7602
Tamcat Shutdawn Part: 7603
Manifald CF Database Port: VEO4
Agzet Transfer Clisnt Port: VEOS
Fracess Management Parl: TEO9 *
Salr Port 7B

"Plaase add a firawall ssception to allaw cormmunication between the Load Balancer and the
riades of the chuster and allow communication ta the fallawing ports on Load Balancer such that
it is accessible fram the Ektron CMS Site,

T el | Iy Cancel

Key points on this screen:

262 | Ektron 9.50




Part 5: Add Inbound Rules and Endpoints

» The query service port is always the base port.

» The screen lists your search service account, configuration database, and
the port number assigned to the following:
° Query service. Outbound from Ektron server

°o Admin service. Outbound from Ektron server

° Tomcat connector. For local communications between Solr and Tomcat
° Tomcat shutdown. For local communications between Solr and Tomcat
o ManifoldCF. For local communications between Solr and ManifoldCF

o Asset Transfer Client. Two-way between Ektron and Solr servers

IMPORTANT: The summary screen's first 2 ports have an asterisk (*). On
the Ektronserver, adjust the firewall to allow these ports to communicate
between your Ektron site and the Solr service.

Part 5: Add Inbound Rules and Endpoints

Add inbound rules to allow TCP communication for Solr Search components and
the Solr Administration Service. You defined these ports while completing Part 4:
Run the Solr Installation on page 255. To do this:

NOTE: Leave firewall status "Turned On."

1. Go to Server manager > Windows Firewall with Advanced settings
> Inbound Rules > New Rule.

2. Onthe Rule Type screen, choose Port.

3. On the Protocols and Ports screen, choose TCP. In the Specific local ports
field, enter your base port and base port + 1. For example, 7600-7601.

Click Next then Allow the connection.

On the When does this rule apply? screen, check all boxes.
Assign a name to the rule.

7. Click Finish.

Add 2 endpoints. To do this:
1. Return to the Windows Azure portal, https://manage.windowsazure.com.

2. Click your virtual machine.

o
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3. Click Endpoints > Add.
B8 Windows Azure

bobsolrtest?

&3 DASHBOARD  MONITOR C

BobSolrTest NAME T  PROTOCOL PU

chadsearch

solrsearch
Remote Desktop TCFP 497

SolrToDaCloud

Bob5oliTest2

4. The following dialog appears. Click the => (next) button.

x

Add an endpoint to a virtual machine

Traffic coming to this endpoint will be sent to the virtual machine.
@ ADD STANDALONE ENDPOINT
ADD ENDPOINT TO AN EXISTING LOAD-BALANCED SET

(Mone)

©) -

5. Add 2 endpoints that make Ektron Solr components on the Azure Solr
Search VM accessible from the Ektron VM. To do this.

* Name: SolrSearchSite
° Protocol: TCP

o Public and private ports: base port (by default, this is 7600)
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NOTE: To identify the base port number, log on to the virtual
machine, open IIS, click EktronSolrSearch2.0 > bindings, and
view the port value.

* Name: SolrAdminSvc
° Protocol: TCP

o Public and private ports: base port plus 1 (by default, this is 7601)

* Do not check Create a Load-Balanced Set and Enable Direct
Server Return boxes

Part 6: Test and register Solr on the Azure VM

1. Verify you can reach the Solr Search components by using this ping Url under
the EktronSolrSearch site.
https://DNSname.cloudapp.net:baseportnumber/ping.html
For example, if the DNS name you assigned in Part 2: Create a security group on
page 224 is solrsearch, and your base port is 7600, the URL would be
https://solrsearch.cloudapp.net:7600/ping.html.

2. Register site using this URL.
https://DNSname.cloudapp.net:baseportnumber/SolrAdminConsole/index.html

See also: Part 2: Add a storage account in Azure manager on page 268

SQL Azure database firewall permissions

» To understand server-level and database-level SQL Azure permissions, refer to
this Azure documentation.
o How to: Configure the Server-Level Firewall Settings (Windows Azure SQL

Database)

o How to: Configure the Database-Level Firewall Settings (Windows Azure
SQL Database)

o Windows Azure SQL Database Firewall

» If your SQL Azure configuration > Windows Azure Services box is checked or
the allow all azure IPs rule is added to your master database using exec sp
set database firewall rule N'AllAzurelIps','0.0.0.0','0.0.0.0',any
database in this SQL Azure instance is accessible by any Azure IP.

» To grant your Azure Search VM permission to access the search configuration
database (created by the SolrInstall), add your Azure Search VM to your search
configuration database's firewall rules, and remove server-level permissions.

o Add the public virtual IP of your Azure Search VM to your database firewall
rules (after connecting to your search config database). Example:

exec sp set database firewall rule
N'ALLAzureIPs','137.135.70.139','137.135.70.139"

° To delete server-level permissions using the Azure portal:
1. Select your SQL Azure server.

2. Configure it.

3. Remove rules, or revoke them in the master database, using
exec sp delete database firewall rule N'ALLAzureIPs'
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Azure recommends waiting 5 minutes for rule changes to take effect.

» If you have one IP address in your server-level rule and another IP address in
your database-level rule, both the IPs have access to the search configuration
database. Server-level rules apply to all databases in an instance, while
database-level rules apply to specific databases.

e To list all rules, use

select * from sys.database firewall rules

Installing Ektron site on Azure cloud and connecting it to Solr
search

Follow this procedure if you want to manually install an Ektron site on an Azure VM.
Next, deploy Solr to the cloud. Finally, connect both cloud-based systems.

PREREQUISITES

» Contact your Ektron account manager to obtain a link to download
EktronCloudSetup.exe.
Part 1: Provision a virtual machine for the Ektron site
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Part 1: Provision a virtual machine for the Ektron

Part 1: Provision a virtual machine for the Ektron site

1.
2.

® NGO AW

10.

Log into https://manage.windowsazure.com.
Click Virtual Machines > New.

Bl Windows Azure | v

virtual machin

VIRTUAL MACHIME INSTAMNCE!

VIRTUAL MACHINES i
3

arch

i

solrsearch

SolrToDaCloud

»¢ O

COMNMECT RESTART

Click Quick Create.

For the new server, enter a DNS Name.

For the image, choose Windows Server 2012.
Choose a large size with at least 8 GB of memory.
Enter your user name and password.

At Region/Affinity Group, select the region selected when setting up the
Ektron site (in Using Ektron in the Amazon EC2 Cloud).

Click Create a Virtual Machine.
Wait until the status changes from Starting (Provisioning) to Running.
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11. Select the VM and click Connect.

Bl Windows Azure | v

virtual machines

VIRTUAL MACHIME INSTAMCES IMAGES ]
VIRTUAL MACHINES NAME T | STATUS
5

BobS5SolrTest Running
BobSolrTest2 -

chadsearch Running
solrsearch Running
SolrToDaCloud Running

CONMECT RESTART SHUT DOWN

12. The following dialog appears. Click OK to connect to the virtual machine.

You have chosen to open:
& solrsearch.rdp
which is a: Remote Desktop Connection (76 bytes)

from: https: /fmanage.windowsazure.com

What should Firefox do with this file?

* Qpen with |Fi.E'nut—:- Desktop Connection (default) LJ
{~ Save Fle

[T Do this automatically for flles like this from now on.,

| Cancel I

13. When you are prompted for Windows credentials, prefix your username with the
DNS Name you created in Step 4.

Part 2: Add a storage account in Azure manager
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Part 3: Install Ektron site on virtual machine

You need a storage account to store site resources in the cloud storage service, and
to store and synchronize assets, private assets, uploaded files, uploaded images and
the asset library. To create a storage account:

1. From the home page of https://manage.windowsazure.com, click Storage. The
Storage screen appears.
2. At the bottom of the screen, click New. The New panel opens.
3. Choose Data Service > Storage > Quick Create.
a. Specify a URL name for your cloud service (for example, cloudservicename).
The .core.windows.net Will be appended to your name to complete the
URL.

b. Choose the Location or Affinity Group from the drop-down list. For example,
East US.

c. Leave Enable Geo-replication checked if you have multiple servers.

4. Click Create Storage Account at the bottom of the panel.

Part 3: Install Ektron site on virtual machine
On the Azure VM, install Ektron. See Installing Ektron on page 11.

Part 4: Run EktronCloudSetup.exe on virtual machine

On the Azure VM, install ExtronCloudSetup.exe.

After you download and install EktronCloudSetup.exe, the Cloud Manager is added
to the Workarea Settings.

Part 5: Run security configurator

1. Onthe Azure VM, click the Windows Start button > All programs > Ektron >
CMS400 v9x > Utilities > Security Configurator. Right click and choose
Run As Administrator.

If you're using Windows 8 or 2012, press the Windows key (ﬂ)/Q then enter
Security Configurator. Right click and choose Run as Administrator.

The security configurator screen appears.
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£ Ektron eSync Security Configurator hi & IEIIE]

— Certificate Generator

— Generate Certificates

Web Site Dezcrption: | [castarm/cmzd D0min _"_I
Site Path: C:Alnetpubhlcestormbemzd 00min
Web Site [D: 1131313464
| Local Server Name: ICESTORM
[Databaze Server: [localhSCELE #preszs
Dratabaze M ame: crisd00rmin

[MNzzard Exsting Feys 5

—Apply Bemote Server Certificates

@ R E'T_"?'te Server i Ektron\EktronCloud\bin\worker\certificate
Certificate Folder

Statuz Mot started

Help Apply

Check the Remote Server Certificate Folder radio button. Then use the
browse button to go to the Ektron\EktronCloud\bin\worker\certificate
folder.

Click Apply.

Part 6: Add inbound rules for ports
On the Amazon Solr server, create inbound rules to allow connections to Ektron port 8732 and
database port (for example 1433). The rule enables the Ektron VM to communicate with the
Solr Admin Console. To do this:

1. On the Amazon Solr server, go to Server Manager> Windows Firewall with

Advanced settings > Inbound Rules > New Rule.

NOTE: Leave firewall status "Turned On".

#® wWindows Firewall with Advanced Security

Filz Action  Wiew Help
L N N
i Windows Firewsll with Advanced 5 [ETNNerTl 1 e

S0 Inbound Rules

Profile

&3 Cutbound Rules
:i. Connection Security Rules

Al 3 Mew Rule.
5 B et es
# lanitaring = 7 Filter by Profile

T Filter by State

4 BranchCache Content Retrisval (HTTP-In) BranchCache - Content Retrie. ..

F Filter b Gronn

On the Rule Type screen, choose Port.

On the Protocols and Ports screen, choose TCP. In the Specific local ports
field, enter 8732.

Click Next then Allow the connection.
On the When does this rule apply? screen, check all boxes.
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Part 7: Add endpoints for port 8732 and the

6. Assign a name to the rule.
7. Click Finish.
8. Repeat steps 1-7 for the database port.

Part 7: Add endpoints for port 8732 and the database port

1. Return to the Windows Azure portal, https://manage.windowsazure.com.
2. Click your virtual machine.

3. Click Endpoints > Add.
B8 Windows Azure

bobsolrtest?

&3 DASHBOARD  MONITOR c

BobSolrTest MAME 1+  PROTOCOL PU
chadsearch
solrsearch

Remote Desktop TCP 497

SolrToDaCloud

Bob5olrTest2

4. The following dialog appears. Click the => (next) button.

x

Add an endpoint to a virtual machine

Traffic coming to this endpoint will be sent to the virtual machine,
@ ADD STANDALONE ENDPOINT

ADD ENDPOINT TO AN EXISTING LOAD-BALANCED SET

(None)

©) -
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5. Add your Ektron Windows Service port.
 Name: EWSPort

» Protocol: TCP
» Public and private ports: base port 8732
6. Repeat steps 1-5 for the database port.

Part 8: Update the Ektron web.config

1. Onthe Azure VM, open the Ektron site's siteroot\web.config file.
2. Replace the unity.storage section with this:

<unity.storage>
<assembly name="Ektron.Storage" />
<assembly name="Ektron.Cloud" />
<namespace name="Ektron.Cloud.Azure.Storage" />
<namespace name="Ektron.Storage" />
<container name="storageContainer">
<register type="IFileService" mapTo="CloudFileService" />
<register type="IDirectoryService" mapTo="CloudDirectoryService" />
</container>
</unity.storage>

Save but do not close the web.config file. You will update further soon.

3. Obtain your Azure Storage Account Name and Primary Access Key. To do this:
a. In a browser, go to https://manage.windowsazure.com.

b. From the left panel, click Storage. The Storage screen appears.

c. Select the storage account you created in Part 2: Add a storage account in
Azure manager on page 268.
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8.

Part 9: Set up Solr search on the Azure cloud

d. Click Manage Access Keys at the bottom of the page.

s1oapril Cnline East LIS

s3april Online East LS

latabasavha Online Southeast.

swstorage Online East US
solrcms Cnline East LIS

»

MAMNAGE ACCESS
EEY S

Manage Access Keys

When you regenerate your storage access keys, you need to update any virtual machines,
media services, or applications that access this storage account to use the new keys.
Learn more,

RAGE ACCOUNT NAME

&

searchservervm

PRIMARY ACCESS KEY

Oek+C778aGIUXc | [l

SECOMDARY ACCESS KEY

WroBCoq3eMhaZhekQHWIjrkdLBOrfwjxs | R

e. A screen shows your Storage Account Name and Primary Access Key.
Within the web.config file, find the following element:

<add key="StorageConnectionString"
value="DefaultEndpointsProtocol=http;AccountName={0};

AccountKey={1}"/>

Replace {0} with the Storage Account Name you obtained in Step 3. Then,
replace {1}with the Primary Access Key that you obtained in Step 3.
Within the web.config file, locate the <appsettings> section then add these
keys within it.

<add key="ek CloudStorageType" value="AZURE" />

<add key="ek CloudAccountId" value="MyStorageAccountName" />

<add key="ek CloudAccountKey" value="MyKeyValue" />

<add key="ek CloudContainer" value="" />

In the above elements, replace MyStorageAccountName With the Storage
Account Name you obtained in Step 3. Then, replace MyKeyVvalue with the
Primary Access Key you obtained in Step 3.

Save and close web.config.

Part 9: Set up Solr search on the Azure cloud

Follow these steps.

e Part 2: Create Azure Solr search VM on page 250
e Part 3: Set up Solr search on Azure VM on page 252
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e Part4: Run the Solr Installation on page 255
e Part 5: Add Inbound Rules and Endpoints on page 263
e Part 6: Test and register Solr on the Azure VM on page 265

Unregistering a Solr site

If you remove an Ektron Web site which uses a Solr search server, use this procedure
to unregister the Ektron site from Solr. This is especially important if you will install
another Ektron site in the same location as the one that was removed.

1.

(6]

On the server on which you completed Part 1: Run Solrinstall.exe on page 216,
and using an HTML5 CSS3-compliant browser, click Windows Start menu > All
Programs > Ektron > Ektron Solr Search 2.0 > Ektron Solr
Administration. If you're using Windows 8 or 2012, press the Windows key (
H)/Q then enter Ektron Solr Administration. The site registration screen
appears.

. Enter the host name of the Ektron server then click Connect.
. Click the Search System Management tab.
. Under Existing Configurations, find the Ektron database that was removed. If

you are unsure, compare the code following the Ektron database name with the
Search Configuration Details screen's Solr Core name field.

Ektron Workarea = Settings >

3 @ @ L Configuration =Search Status
screen
Index Information
Value
Solr Url hitp:/AWS10875:7602/s0lr — - - 1
Existing Configurations
Crawler Url NS 10875:7602/mef-crawler-ui - ) Ektron Solr Administration >
We found configurations for these E[ Search System Management tab
registered elsewhere, its configurati|
Search Provider Apache Solr
Ektron Database
Solr Core Name
ws10875\SQLExpress / OnTrek2 (9ad90869)
eki-5t3vik1\SQLExpress / OnTrek (def96i3a)
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Editing Solr registration information

5. Click the Remove button.

Ektron Solr Administration ~ cus site Registration

Search Service Account

What user account should all CMS sites use to authenticate with the query services on this server? This only needs to
be updated if your search senice account credentials change

Domain Ektron1
Username bbolt

Password Test

Existing Configurations Refresh

We found configurations for these Ektron databases on your Solr server. If a database is no longer active or is now
registered elsewhere, its configuration can be removed

Ektren Database

(local\SQLExpress / OnTrek2 (ef4a73f3)

Editing Solr registration information

After a site is configured, the buttons below the database change to Edit and Start
Over.

Ektron Database(s)
We found Ektron databases to configure with Solr. IT your site™

now. If it's already configured, you can start over with a fresh it

http:/[EKT-5T3VFK1/OnTrek

Database Name: OnTrek
Database Server: (local\SQLExpress

Edit

Ektron Database Connection String

How should Ekiron search components connect to your site's ¢

o e — e s A O] Dawrmoroume - dababomen—imomT enle ledoomare

Start Over is a full reconfiguration. The index, schema, and configuration data are
completely overwritten, and the site’s data is re-indexed. Because the index and
supporting configuration are overwritten, search functionality is unavailable while the
site is being registered and re-indexed.

Consider this option if
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* You need to change the site’s connection string, which is used to extract data at
index time.

* You need to change the physical location of the asset files.
» Yourindex is in a state where you want to start fresh.

Edit updates an existing search configuration's settings. The index, schema, and
configuration data remain intact. When settings are saved, the site’s data is
reindexed. Search functionality remains available throughout this process.

Consider this option if you need to

» update the type of data indexed for your site
» change the automatic polling interval
» update advanced configuration options

Uninstall Solr search provider from an on-premises
(local) server

The following scenarios describe uninstalling the Solr search provider.

IMPORTANT: Before uninstalling Solr, back up related files that have been
customized. For example, these Ektron Search2.0 directory files may have been
customized.

* solrconfig.xml

* schema.xml

* dictionary files

* wddf types

* .txt files

Simultaneously uninstall Ektron and Solr search provider
To uninstall Ektron and Solr at the same time:

1. Back up any Solr files that have been customized.
2. Use the uninstall procedure described in Uninstalling Ektron on page 31.
3. On the Uninstall dialog, check the Remove Ektron Solr Files and Services
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Uninstall Ektron, but do not uninstall Solr search

box.

(B CMS Uninstaller (el e S |

CLOSE VISUAL STUDIO BERORE CLICKING UNINSTALL!
Choose the site you want to uninstall

Ainetpubwewwroot\On Trek * || Remove Website

Site Version: 9.0.0.131
Database Mame: OnTrek

| Remove Websites Database
Remove Ektron Application directory (includes CeH)

Remowve Ektron Solr Files and Services

Remove All Sites and Application Directory (includes CheH)

| Uninstall |

Uninstall Ektron, but do not uninstall Solr search provider

To uninstall Ektron but leave Solr installed, use the uninstall procedure described in
Uninstalling Ektron on page 31. On the Uninstall dialog, do not check the Remove
Ektron Solr Files and Services box.

Uninstall only the Solr search provider

To uninstall the Solr search provider:

1.
2.
3.

4.

Back up any Solr files that have been customized.
Close the four command windows that open at the end of the Solr installation.

Run the Ektron Solr installation file as an administrator. (You used this file to
install Solr.)
On the screen that has Upgrade and Remove options, choose Remove.

Changing your search provider to Solr

If you selected a search provider other than Solr during site setup and want to
change to Solr, follow these steps.

Change the search provider to Solr and uninstall the Microsoft Search Server.

1.

Uninstall Microsoft Search Server.

2. Onthe Ektron server, open c:\Program Files

(x86) \CMSvXXX\Utilities\SetSearchProvider.

3. Click setsearchProvider.exe.
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4. Select the website that you want to change.
5. Select Apache Solr 4.0.
6.

Install the Solr search provider. See Installing Solr on a single on-premises
(local) server on page 216.

Change the search provider to Solr but do not uninstall the Microsoft Search Server.
1.

“voR W

o

On the Ektron server, open c:\Program Files
(x86) \CMSvXXX\Utilities\SetSearchProvider.

Click setSearchProvider.exe.
Select the website that you want to change.
Select Apache Solr 4.0.

Install the Solr search provider. See Installing Solr on a single on-premises
(local) server on page 216.

On your search server machine, stop the Search Server Service.

7. On your search server, open C:\Windows\System32\SiteConfiguration.exe

8.
9.

and remove your website's entry.
Run an IISReset.
Start the Search Server service.

Monitoring the status of search

The Ektron Workarea provides 2 screens to help you monitor the status of your
search. For information about managing the search crawl, see Managing the search
craw/ on page 368.

Solr search configuration details screen

The Solr Search Configuration Details screen provides information about

Solr server host

Ektron Solr Administration Service URL
Ektron Solr Query Service URL

Solr core name

Query credentials

incremental crawl interval—to adjust, use the Solr site registration screen's
Automatic Polling Interval field.

crawl filters

To access the screen, go to the Ektron Workarea > Settings > Configuration
> Search > Configuration.
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Solr Search node status screen

Solr Search Configuration

Value Description
Solr Server Host smacdonald1 The Solr Search Serve
Ektron Solr Adminisfration Service hitp:/ismacdonald1:7801 The ervice

Ekiron Solr Query Service hitp:ismacdonald1.7800/SolrQueryService/SolrQueryService svc The Ekiron Solr Query service URL associated
Solr Core Name: 8d28t0db Name of the Solr Core associated with your site
Query Credentials smacdeonald 1\admin2 The Windows user authorized to communicate
Incremental Crawl Interval 60 eme

l_:rawi Filters.
Filter Descripfion
HTML Content Included Content blocks, blogs, forums, etc
Document Content Included Office documents, PDFs, images, et
Forum Content Included Discussion topics, replies, efc
Product Content Included eCommerce data, etc
Community Members Included Community users and groups, eic
Community Content Excluded Community workspaces, photos, and related content, e

Solr Search node status screen
The Solr Node Status screen provides information about the search crawl on 2 tabs.

« Crawl status tab shows
° The crawl status, as returned by ManifoldCF
° The current and next indexing activities
° For the most recent crawl: start time, end time, duration

o If an incremental crawl request is pending See also: Full vs. incremental
crawls on page 368.
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Crawl Status

@

Crawl Status

Current Action

Next Action

Crawl Start Time

Crawl End Time

Crawl Duration

Setting up search for your website

Process Status

Incremental Crawl Request Pending

@

Crawl Status

Current Action

MHext Action

Crawl Start Time

Crawl End Time

Crawl Duration

Pending Crawl
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Process Status

Idle

Idle

9/2/2014
1:25:38 PM

9/2/2014
1:26:01 PM

00:00:23

Incremental

Content Users
Done Done
Idle Idle
Idle Idle
31972014 31972014
5:21:07 PM 5:21:07 PM
31972014 31972014
52117 PM 52117 PM
00:00:10 00:00:10
No No

Done

Idle

Idle

9/2/2014

1:25:38 PM

94272014

1:25:51 PM

00:00:13

Mone

Community Groups

Done

Idle

Idle

319/2014
5:21:07 PM

3/19/2014
5:21:17 PM

00:00:10

No

Idle

Idle

9/2/2014 1:25:38
P

9/2/2014 1:25:51
PM

00:00:13

MNone

Description

The end time of the most
recent crawl.

1]

duration of the most




Apache Manifold CF status screen

» Process Status tab shows the status of the (Ektron search) Java processes on
the Solr Search server, such as Apache Tomcat, crawl database, and Apache

ManifoldCF.
Crawl Status Process Status
@ Activity Iz Running?
Apache Tomcat Idle Yes
CrawlDB Idle Yes
Apache ManifoldCF Idle Yes

From this screen, you can launch an incremental or full crawl using toolbar buttons.
See also: Full vs. incremental crawls on page 368.

Request full crawl

Reguest
incremental crawl

Crawl Status Process Status

(i ]

Crawl Status

Apache Manifold CF status screen

To view the Apache Manifold CF status screen, on the Solr server, click the Windows
Start button > All Programs > Ektron > Ektron Solr Search 2.0 > Tools
> Apache Manifold CF. If you're using Windows 8 or 2012, press the Windows

key (H) /Q then enter Apache Manifold CF.

The Apache Manifold CF screen displays the status of the jobs crawling your Ektron
content. For more information, see ManifoldCF-End-user Documentation.

Apache Solr console
To view the Apache Solr console screen:

1. On the Solr server, go to Windows Start button > All Programs > Ektron
> Ektron Solr Search 2.0 > Tools > Apache Solr. (If you are using
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Windows 8 or 2012, press the Windows key (E) /Q then enter Apache Solr.)
A login screen appears.
2. Enter the username solr.

3. Enter the password which you can find in C:\Program Files
(x86) \Ektron\Search?2.0\Administrative
Service\Ektron.Cms.Search.Solr.ServiceHost.exe.configinthe
SolrPassword field. This solr password is unique for each installation.
The Apache Solr console screen provides information about available logging levels,

how to get management information about each core, the Java information about
each core, and so on.

For more information, see Using the Solr Administration User Interface.

Managing Solr administrative tasks

The following topics explain how to perform administrative tasks that are unique to
Solr. The following list shows other search-related functions that apply to all search
providers.

» Basic versus advanced website search on page 336

e The "Did you mean?" feature on page 345

» Managing searchability of Ektron content on page 346

» Managing search results on page 347

e Using synonym sets on page 348

» Providing suggested results on page 350

e Searching the Workarea on page 363

» Reporting search activity on page 375

Solr language support

The following languages are supported, along with their two-letter language codes,
without customization. Support is limited to Solr's linguistic capabilities (tokenizing,
stemming, and so on).

» English (en)

* German (de)

o Greek (el)

» Spanish (es)

» French (fr)

e Hindi (hi)

 Italian (it)

» Japanese ( ja)

» Korean (ko)

e Dutch (nl)

* Norwegian ( no)

» Portugese (pt)
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Managing the stopwords list

e Russian (ru)
e Thai (th)
» Chinese ( zh)

You may customize Solr to support additional languages. Refer to the guidelines
specified <SolrInstallPath>\Search2.0\Solr\core0\conf\schema.xml.

Managing the stopwords list

When processing a search query, Ektron's Solr search ignores all words in the

stopwords file for the selected language. The stopwords list's default location is:
C:\Program Files (x86)\Ektron\Search2.0\Solr\cores\<core id

number>\conf\<lang>\stopwords <languagecode>.txt.
The language code is a 2-character alphabetic code. For example, English is en.

Your Solr core name appears on the Solr search configuration details screen on
page 278.

To modify the stopwords list, add or remove terms and save.

NOTE: To change the path to the stopwords file, customize the schema.

Filtering results with Solr refinements

Refinements lets users explore search results by applying one or more filters. Here is
an example from epicurious.com. Refinements are often called facets.
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Search Results

recipes articles & guides

show

results for drink recipes member recipes  all recipes

pumpkin |
showing 1 - 10 of 359 sort by | relevance El
Bed Fife and Pumpkin Seed Cookies
main ingredient ¥ Epicurious, December 2011
One Sweet Cookie
mealicourse )
L cuising ] R . . =
s = Classic Vegan Pumpkin Pie ¥
U_SE these l_.flletarsr consideration ¥ Epicurious, November 2011
T'“erﬁ to ,"'t-ype , Vegan Holiday Kifchen
refine search
results. holiday/celebration ] _
M ) Y¥YY | g, Pumpkin Flan with Spiced Pumpkin E ¥
S\ preparation method ¥ ﬁ Seads -
in season ) =——  Gourmet, November 2005
A m part of menu (130) TTT] Ginger-Pumpkin Soufflé B Q b4

- Epicurious, November 2005
{L] quick & easy (33)

T wine pairing (234)

@ nheatthy (52) 11y E Warm Pumpkin Salad with Polenta

% and Candied Pumpkin Seeds
B Gourmet, October 2001

search within results

When describing the refinements feature within Ektron's deployment of Solr search,
the following terms are used.

» Facet. A categorization of search results by values of an index field. A facet is
made up of buckets: each bucket contains a collection of values, and the humber
of result items that contain that value.

« Refinement Specification. A data structure defining a request for a particular
facet to be returned with the results for the associated query. The specification
may include data (thresholds) defining how the data should be categorized.

+ Refinement. The classification by which you want to restrict a search query.
This can be thought of as an identifier representing a particular facet bucket. By
applying a refiner to a query, you indicate that you only want to see results
within that facet bucket.

You can create refinements from any indexed content property, Smart Form field, or
content metadata. Content properties are always indexed for searchable content.
Smart Form fields and metadata that you feel may enhance your site’s search
experience can be marked as searchable, at your discretion. To indicate that Smart
Form fields are searchable, check the Indexed box on the properties dialog. For
metadata, choose searchable type.

Use the following fields on the Solr Registration screen to configure certain elements
of working with facets.
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e Minimum Facet Count
» Facet Sorting

You request facets by adding refinement specifications to search criteria. A
specification primarily identifies the target field for which a facet should be
generated. For example:

criteria.Refinement.Add (new IntegerRefinementSpecification
(SearchContentProperty.Size)) ;

If you are working with index fields whose data types may represent ranged values,
you may specify a collection of bounds to help categorize the data.

To access the API for managing refinements:

1. Install the Ektron 9.10 SP3 version of the OnTrek Sample site.

2. From the site's home page, go to Developer Reference > Framework
API > Ektron.Cms.Framework.Search.

3. Look at KeywordSearchCriteria and terms with “refinement” or “facet.”

NOTE: The Ektron Search API supports Solr field types that translate directly to
string, long, double, and DateTime. Other field types (for example, LatLonType)
are not supported as facets.

NOTE: If you do not apply thresholds when submitting a refinement specification
for a field with a ranged-value data type, data is categorized by each individual
value. (Ranges are not auto-generated.)

Every facet bucket references a refinement. The refinement represents a filter that,
when applied to a subsequent query, ensures the results only include items
corresponding to that facet bucket.

BEST PRACTICES FOR WORKING WITH REFINEMENTS

When you work with Solr refinements, consider the following advice.

» Limit the number of refinement fields applied to a query. Six or fewer is a "good
rule of thumb." More than that can be confusing and overwhelming, which
undermines your goal of creating a better experience.

» Use fields with a smaller set of unique values.

» As you organize content and design Smart Forms, think about key properties
that will enable users to identify content of interest.

» Consider the significance of the property in determining the placement of a
facet. For televisions, brand and price are probably the most significant
properties, so should receive more prominent placement. Less significant
properties do not require faceting and can be displayed within the product
listing.

» Tag content. Content tags are a quick and easy way to provide free-form
classifications of your content and be a very effective facet. See also: Tagging
content, library items, users, and groups with keywords on page 1596.

Managing Solr autoComplete
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Solr's Autocomplete feature suggests terms based on the user's input. For example,
if you enter ba, autocomplete provides the following suggestions.

Demo

Search Text: |b 3| |

Mote: This sample for Get backup
banner
banneri
banner?

base
basic
battery

If a user selects a word from the list, a query is executed using that word.

Since the suggestion list is based on user input, it changes as a user enters more
characters. By default, the suggestion list is based on words within searchable Ektron
content. If you prefer, you can create a custom autocomplete suggestions list. You
might do this to control which terms appear on the list, thereby directing site visitors
to desired content. If you create a custom list, only its terms appear as suggestions—
Ektron content is ignored. See also: Creating a custom autocomplete suggestions list
on the facing page.

Additional points about working with AutoComplete:
» AutoComplete works with single words only—if the user enters a space,
AutoComplete terminates.
» Suggestion list terms may include a special character, like power-shot

» Special characters (such as exclamation point (!) or period (.)) within a search
term are ignored.
Apache Lucene supports the escaping of special characters that are part of the

query syntax. Here is the current special characters list:
+-&& ) DT\

NOTE: The period (.) is not listed a special character at Apache Lucene -
Query Parser Syntax.

Enabling autocomplete

...via Server Control

To enable autocomplete for a templated server control, modify the
SiteSearchController control by adding the following

property: EnableAutoComplete="true". See also: SiteSearch templated server
control.

When using Solr search with templated controls, note these restrictions:
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Creating a custom autocomplete suggestions list

* You cannot retrieve custom content.

» The FacetsView control does not support ranged facets for integer, decimal, and
date properties.
...via API

For a sample of enabling autocomplete via the API:

1. Install the latest version of Ektron's OnTrek Developer Sample site.

2. From the site's home page, go to Developer Reference > Framework
API > Ektron.Cms.Framework.Search > QueryPropositionManager.

On an Ektron server, the page's path is
siteroot\developer\Framework\Search\QueryPropositionManager.

Creating a custom autocomplete suggestions list
Follow these steps to create a custom autocomplete suggestions list.

Part 1: Changing the source of autocomplete suggestions

1. Access the Solr registration screen by inserting the following URL into a browser:
https://localhost:base port/SolrAdminConsole/index.html

For example, if you selected the default base port of 7600 during the Solr
installation, enter https://localhost:7600/SolrAdminConsole/index.html.

2. Under the database that you are working with, click Show Advanced Options.

3. Within the screen section Query Completion Dictionaries, check the box next
to the default dictionary (term list).

4. Click Register.

5. After a few minutes, the change is registered. If the registration is successful,
the change is registered in the Search configuration database.

Part 2: Create a custom suggestions list

PREREQUISITES

* Your Solr Server and Core Name, available on the Workarea > Settings
> Configuration > Search > Configuration screen.

1. On the Solr search server, open the Ektron Search2.0 folder. (You selected its
location when installing Solr. By default, it is installed to c: \Program Files
(x86) \Ektron\ )

2. Within that folder, open Solr\cores\core number\conf\staticfile.txt.

Insert custom words into that file, each on a separate line, and save it.

4. Access the Solr Administrator page: https://Solr server from Search Status

screen/#/~cores/Solrcore name from Search Status screen. For example:
https://localhost:7602/solr/#/~cores/56428657

w
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5. Select Core Admin > your core > Reload.

ry

Apache " E3 Add Core m =[ Rename 38 Swap (G 1) & Optimize
Solr ~ ~
56428657 [*] core
& Dashboard startTime: 19 minutes ago
=) Logging instanceDir: C:\Program Files (x856)\Ektron\Search1.0\Solr\cores\56
% Core Admin dataDir: C:\Program Files (x86)\Ektron\Search1.0\Solr\Index\5€
o Java Properties il Index
Thread Dum
P lastModified: 19 minutes ago
version: 13
numbDocs: 314

For more information on using the Custom Suggestions List, see
https://wiki.apache.org/solr/Suggester > Dictionary.

Maximum size of Solr assets

For optimal performance, Ektron imposes a 10 MB limit on assets. Assets greater
than 10 MB can be found by searching for their title or description.

NOTE: The description is searchable via the
API's searchContentProperty.description property.

Accessing Solr AP| documentation

To access documentation for the Solr search API:

1. Install the current version of Ektron's OnTrek Developer Sample site.

2. From the site's home page, go to Developer Reference > Framework
API > Ektron.Cms.Framework.Search.

3. The search API classes, methods and properties are available for all search
providers, including Solr. Tabs explain behavior or functionality differences for
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each search provider.

Ektron Framework API

» Ektron.Cms. Framework. Activity
Ektron.Cms.Search.DateRefinementSpecification

» Ektron.Cms.Framework.Calendar The DateRefinementSpecification represents a strongly typed refi
¥ Ektron.Cms.Framework. Commerce

Property Description
¢ Ektron.Cms. Framework. Communmnity

Property Gets or sets the re
» Ektron.Cms.Framework. Content
¢ Ektron.Cms.Framework.Flag Method

DateRefinementSpecification()

DateRefinementSpecification(DatePropertyExpression)

il
il
|

= Ektron.Cms.Framework.Search DateRefinementSpecification
(DatePropertyExpression, [Collection=BoundedValue=DateTime:

AP DateRefinementSpecification{DateMultiValuePropertyExpressiol

SearchManager
PropositionMana DateRefinementSpecification

Data (DateMultivaluePropertyExpression,| Collection=BoundedValue=
AdministratorPermission
AdvancedSearchCriteria Remarks
BoundedFacetBucket

]

BoundedValue FAST Search for SharePoint 2010 Solr
CurrentUserPermission
Datefacet = Specifying explicit bounds for date refinements is not su
DateRefinementSpecification Search for SharePoint 2010. The date ranges will be aut
DecimalFacet

Search Framework API Tutorial is an excellent resource for learning Ektron's Search
APIs.

Troubleshooting Solr

Problem: A request to Manifold CF failed unexpectedly
After completing the Solr registration screen, you see this error:

Validation of your input parameters has failed
A request to Manifold CF failed unexpectedly

Cause: The Search Process services stopped running.

Solution: Run Process Manager as an administrator (C:\Program Files
(x86) \Ektron\Search2.0\ProcessManager\ProcessManager.exe).

Problem: HTTP Error 500.19 - Internal Server Error
HTTP Error 500.19 - Internal Server Error

The requested page cannot be accessed because the related configuration data for
the page is invalid.
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Server Error

Internet Information Services]

- Error v

HTTP Error 500.19 - Internal Server Error

The requested page cannot be accessed because the related configuration data for the page is invalid.

- Detailed Error Information

Module IIS Web Core Reguested URL http://localhost:7600/SolrQueryProposition/QueryPropositionService.svc

Notification BeginRequest Physical Path C:\Program Files (x86)\Ektron\Searchl.0\Web\SolrQueryProposition
Handler Not yet determined \QueryPropositionService.svc

Error Code DxB0070021 Logon Method Not yet determined

Canfig Error This configuration section cannot be Logon User  Not yet determined
used at this path. This happens when
the section is locked at a parent
level. Locking is either by default
(overrideModeDefault="Deny"), or
set explicitly by a location tag with
overrideMode="Deny" or the legacy
allowOverride="false".

Config File \\?\C:\Program Files (x86)\Ektron
\Search1.0

\Web\SolrQueryProposition
\web.config
- Config Source
16:  <system webServers
27: <modulecs

18: <ndd name ="removesve®

Cause: The modules section is locked at the server level.

Solution: IIS > Configuration Editor > System.webServer/modules > Unlock
section.

@ Configuration Editor

— — T — g
Sectid | SECUIENNTIIREENE] > | + | From: | Default Web Site Web.config |~ ¥

B Deepest Path: MACHINE/WEBROOT/APPHOST/Default Web Site .
(Collection) (Count=42) Configuration
runAllManagedModulesForAliRequest False Search Cenfiguration

runManagedModulesForWebDavReqr False

*(Collection)” Element &

Problem: Error: (405) Method Not Allowed; also 404.17 may be encountered.

No search results in the Workarea. You see the following error in the Windows Event
Viewer/WindowsLogs/Application:

Timestamp: 12/16/2013 10:06:32 PM

Message:Ektron.Cms.Search.SearchException: An error occurred while submitting the
query.

---> System.ServiceModel.ProtocolException: The remote server returned an unexpected
response: (405) Method Not Allowed.

Cause: WCF Activation is not enabled.

Solution: For IIS 7.5, use the Add Features Wizard. Go to .NET Framework 3.5.1
Features > select both WCF Activation and HTTP activation .
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For IIS 8 (Windows Server 2012), use the Add Roles and Features Wizard. The HTTP
Activation feature is located under .NET Framework 4.5 Features > WCF Services.

https://www.iis.net/learn/web-hosting/configuring-servers-in-the-windows-web-
platform/windows-communication-framework-wcf

Known Solr issues and limitations

Installation and launch

» Whenever you use Solr, log in as the user who installed it. Do not let that user's
credentials expire.

» If you need change port numbers selected during installation, you must reinstall
Solr.

» If you upgrade your JDK version, you must replace it in the same directory to
which you originally installed. You may not install more than one JDK version to
that directory.

Site registration

» While re-registering a site, there may be an error (returned by ManifoldCF) while
deleting a pre-existing connection corresponding to your core.

Error description

During site registration, old jobs for existing connectors (output and Ektron
connector) are deleted prior to deleting the connectors themselves. Although the
jobs are deleted, Manifold may perform clean-up operations on deleted jobs.
During clean up, attempts to delete connectors for such jobs may fail.

In this case, the site registration process attempts to delete the connection again
after a specific interval. You can configure the maximum number of re-tries or
the retry interval in the Ektron Solr Admin Service config file (C:\Program Files
(x86) \Ektron\Search2.0\Administrative Service\

Ektron.Cms.Search.Solr.ServiceHost.exe.config). Within that file, edit the
MaxDeleteAttempts and MaxDeleteInterval properties. Then, restart the
Ektron Solr Admin Service.

Solution

If you see errors like Exceeded MaxTries while trying to delete
output/repository connection in the Ektron Solr Admin Service logs (Verbose
logging), increase these parameters or wait for the jobs to be completely
removed from Manifold CF. Depending on the size of your index, the clean up of
a deleted job may take a few minutes.

» Afterinstalling Solr, until you register at least one site, if you attempt to browse
to the Solr Admin screen, this message appears: There are no Solr cores
running. Using the Solr Admin UI currently requires at least one Solr
core.

After you register a site, this message disappears.

Ektron Reference I 291


http://www.iis.net/learn/web-hosting/configuring-servers-in-the-windows-web-platform/windows-communication-framework-wcf
http://www.iis.net/learn/web-hosting/configuring-servers-in-the-windows-web-platform/windows-communication-framework-wcf

Setting up search for your website

« If you edit the schema.xml file and try to re-register your site, an error is thrown.

Error Description

The site registration process encountered an error while attempting to remove
an existing Solr core for your site. Could not find a part of the path
'C:\Program Files (x86) \Ektron\Search2.0\Solr\cores\1ca92f29\conf.

Solution
Stop and start the Manifold Agent and Tomcat.

« If you reload a core and try to register your site again, an error is thrown.

Error Description

The site registration process encountered an error while attempting to remove
an existing Solr core for your site. The process cannot access the file
't1og.0000000000000000000"' because it is being used by another process.

Solution

Stop and start Tomcat.

General issues

» If you used the Framework API and templated controls to create search controls
using Microsoft Search Server, you can reuse that code with Solr for the most
part. The Ektron Developer Reference documents functional differences among
search providers.

» Only templated server controls and the Framework API are supported.

° Since version 8.5, the following controls and API are not supported:
® TndexSearch server control

= \Web Search server control

® ProductSearch server control
® CommunitySearch server control

® Search APIs that predate the Framework API
> Ektron.Cms.Framework.Search

» To improve performance, assign to the user account under which Solr services
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Crawling

will run permission to lock pages in memory.

E: Local Security Policy

File  Action  Yew Help

ez |HEIRE = | HE

_i:!l Security Settings Folicy =
o Account Policies Bypass traverse checking
=1 g Local Palicies Change the system kime
4, Audit Policy “hange the time zone
o User Rights Assignment Create a pagefile
5 Security Options Create a token object
| Windows Fireveall with Advance Create global objscts
j Mebwork Lisk Manager Policies )
Public Key Policies Create permanent shared objects
| Software Restrickion Policies Create symbolic links
| Application Control Policies Debug programs _
g IP Security Policies on Local Co Deny access ko this computer Fram the
| Advanced Audit Palicy Configu Deny log on as a batch job
Deny log on as a service
Dery log on locally
Deny lag on through Remaoke Deskiop
Enable computer and user accounts tc
Force shukdown From a remote sysker
Generate security audits
Impersonate a client after authenticat
Increase a process working set
Increase scheduling priority
Load and unload device drivers
Lock pages in memary
Log on as a batch job
Log on as a service
Crawling

» If a full crawl fails, the next crawl is a full one (even if a request for an
incremental crawl was received).

Search results

The search ignores words in a custom summary.

If you search a Web calendar title, the results include random words with the
search text.

Some results from PageBuilder pages return concatenated text.

In some asset summaries, asterisks (*), question marks (), and other special
characters appear.

If you

1. Import a .doc file to the Ektron Workarea.
2. Copy and paste that file in another folder.
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3. Run acrawl.
4. The second document can only be searched by its title.
o Ifyou
Publish a content block.
Crawl the content.
Edit the content block, and set the golive date to a future date.
Publish the content.

Crawl the content, you see this error:
Error: java.lang.IllegalArgumentException: Source input stream
may not be null
» Ifyou

1. Install and register a site.

2. Open the Solr admin console and reload your core.

3. Try to register the site again, you see this error:
The site registration process encountered an error while
attempting to remove an existing Solr core for your site.

The process cannot access the file 'tlog.0000000000000000000'
because it is being used by another process.

u A W N =

4. Toresolve, stop and start Tomcat to register the site again.
» Solr misinterprets some complex queries.

» The Workarea’s search results include content for which the user does not have
read permission. If a user clicks such content, he is denied access.

» If a search term exists in a document in a location beyond 100,000 characters,
the document appears in search results but its highlighted summary is blank.

“In & country with high lew Search

Advanced Search ¥

No highlighted summary appears

fworkareaDownloaddsset aspxTid=431 472172014 4.37.01 PIL

175PMP

fworkareaDownloaddsset asprTid=424 472172014 1.59:53 P

If desired, you can increase the number of characters beyond which the
highlighted summary appears with search results. If you do, you may see a
degradation in your search's performance. To increase the number of characters,
follow these steps.
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1. OpencC:\Program Files (x86)\Ektron\Search2.0\Solr\cores\
[CoreName]\conf\solrconfig.xml.

2. Increase the value of the hl.maxAnalyzedChars property.

<int name="hl.maxAnalyzedChars">100000</int>

Solr ManifoldCF database maintenance
See https://portal.ektron.com/KB/10171/.

Templated search controls

The FacetsView control does not support ranged facets for integer, decimal, and date
properties.

Setting up Microsoft Search Server
2010 Express

IMPORTANT: As of Ektron version 9.3 SP1, Microsoft Search Server 2010 and
Microsoft Search Server 2010 Express are no longer supported.

This section explains how to install Microsoft Search Server 2010 Express. After
installing it, follow Configuring Microsoft Search Server on page 311 to configure the
search provider. To learn how to use the search, read Using Microsoft Search Server
features on page 335.

Prerequisites

» You have purchased and deployed Microsoft Search Server 2010. See also:
Product Licensing Search.

» An understanding of Microsoft Search Server 2010, Best practices for Search
Server 2010

Before beginning the installation, review these Microsoft documents.

o Hardware and software requirements: https://technet.microsoft.com/en-
us/library/bb905370(v=office.14).aspx#BKMK_hw_regs

o User requirements: https://technet.microsoft.com/en-us/library/ff717834
(v=office.14).aspx
o Installation of Microsoft Search Server 2010:
https://technet.microsoft.com/en-us/library/ee808898(v=office.14).aspx
» Both servers can browse to each other across the network.
» The search, SQL, and CMS servers must be on the same domain.
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» On your Microsoft Search Server 2010 server
o Create a Windows user for search purposes. The user should be
® a domain user

® assigned the "log-on as a service" role

® a member of the administrators group. That user must be logged in
when Microsoft Search Server 2010 is being installed.

o Open port 6080 (used by the Protocol Handler Service)

e On your Ektron server
°© Open ports 6080 and 6081 (used by the CMS File Helper Service to
communicate Ektron services and copy files between the Web and Search
servers)
o Set SQL Security to SQL Server and Windows Authentication mode
° Through SQL Management Studio, add the Windows login that you created
on your Microsoft Search Server 2010 server. Assign to that user
® db_creator role
® securityadmin SQL role
Microsoft Search Server 2010 uses that login to access the Ektron database.

BEST PRACTICE

You should update your Ektron site's web.config file's
<connectionstrings> tag with the username and password of
that SQL user. Set Integrated Security to False. Then, log
into Ektron to verify that the connection string is valid. See also:
Managing web.config on page 74.

» On your database server
° Open Port 1433

Installing Microsoft Search Server 2010 Express

1. Install or upgrade Ektron on its server, using the normal procedure. See also:
Installing Ektron on page 9, Upgrading to on page 35.

2. When prompted to choose a search provider, choose Microsoft Search Server
2010 Express. If you already chose another search provider but want to switch,
see Changing your search provider to Solr on page 277.
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Ektran CMSA00.MET =

Search Provider

klrron I':.- = e :' ch provi r:-. : bo -|_l,l-|:il.u Ij:l:.tn:-n :iz:itEe.- .

® Apac

v that iz free to

’ < Back ” Mest > l Cancel

3. Continue the Ektron installation.

4. Download Search Server Express 2010 on the server that will host it. See
http://www.microsoft.com/en-us/download/details.aspx?id=18914.

NOTE: If you are using SQL Server 2012, install Microsoft Search Server
Express 2010 SP1.

5. Launch the Search Server Express installation file. The installation wizard installs
the necessary prerequisites.

6. Accept the Microsoft Software License Terms. Click Continue.
7. When asked to install as a Standalone or ServerFarm, choose ServerFarm.

8. On the Server Type dialog, choose Complete then click Install Now. The
Installation Progress screen appears.

9. The following screen appears. Click Run the SharePoint Products
Configuration Wizard now then Close.
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. Microsoft® Search Server 2010 Exeress

Run Configuration Wizard

To complete configuration of your server, you must run the SharePoint Products
Configuration Wizard.

| Bun the SharePoint Products Configuration Wizard now.

10. The SharePoint Products Configuration Wizard appears. Click Next.

11. A notice about services that may be affected during the configuration appears.
Click Yes.

12. The Connect to a server farm dialog appears. Select Create a new server
farm then click Next.

13. Enter the database server and name along with account information. Then click
Next.

SharePaint Products Configuration Wiza s S

|_ Specify Configuration Database Settings

All serversin aserverfarmmust sharea configurationdatabase, Typethe databaseserver and database
name. If the database does not exist, it will be created. To reusean existing database, the database must be
empty. Foradditional information regarding databaseserver security configuration and nebwork access
pleasesee help.

Databaseserven |

Database name: SharePoint_Config

Specify Database Access Account

select an existing Windows account that this machine will always useto connect to the configuration
database. Ifyour configurationdatabase is hosted onanotherserver, youmust specify a domain account.

Typetheusernameinthe form DOMAIN\User_Name and passwordforthe account.

Username:

Password:

< Back Mext Cancel
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14. The Specify Farm Security Settings screen appears. Enter any password. You will

need this password to work with the SharePoint Products farm.

15. The Configure SharePoint Central Administration Web Application screen

16.
17.
18.

19.

20.
21.
22.
23.

24.

appears. Accept the default port number or enter a different one.

SharePoint Products Configuration Wizal C=e X

Configure SharePoint Central Administration Web Application

A SharePoint Central Administration Web Application allows you to manage configuration settings for a server
farm. The first server added to a server farm must host this web application. To specifya port numberfar the
web application hosted onthis machine, checkthe box below and type a number between 1 and 65535, If

you do not specify a port number, a random one will be chosen.

Specify port number: 47435

Configure Security Settings
Kerberos is therecommended security configuration to use with Integrated Windows authentication. Kerberos
requires special configurationby the domain administrator. NTLM authentication will wark with amy
application poolaccountand thedefault domainconfiguration. Show memaore information.
Choosean authentication provider for this Web Application.
@ NILM
Negotiate (Kerberos)

@)

‘ <« Back H Mext = H Cancel ‘

Under Configure Security Settings, choose NTLM. Click Next.
The Configuration Successful message appears. Click Finish.

The SharePoint Central Administration opens with dialog about Customer
Experience Improvement. Select No (or Yes) then click OK.

The Central Administration > Configure your SharePoint farm page appear. Click
Start the Wizard.

Select Use existing managed account then click Next.
The page to create a top-level website displays. Click Skip.
The Farm Configuration Wizard complete page appears. Click Finish.

On the Ektron server, copy C:\Program Files
(x86) \Ektron\CMS400

versionnumber\Utilities\SearchServer\EktronSearchConfiguration.exe.

On the Search Server Express server, paste and run
EktronSearchConfiguration.exe as an administrator. The Search
Administrator Credentials screen appears.
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25. Enter the domain, username, and password of a user who is a member of the
Windows Administrator group on the Search Server Express server. Click Next.

EktronSearchConfiguration - Installshield Wizard

Search Administrator Credentials

Ifetal el ’ < Back ” Mest > ] Cancel

26. Determine the location of the folder that maintains the Ektron query service files.

EktronSearchConfiguration - InstallShield Wizard E3

WebSite location

Please enter the path pou want the Elktran Queryi lo be: located.

ktron

ion Folder

Cancel

et el <Back ] [
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27. Select the port number to use with the Ektron query service website.

EktronSearchConfiguration - InstallShield Wizard [ x|

Ektron website port number

’ ¢ Back ” Mest » ] Cancel

28. The following screen appears. Click Yes even though you are using Search
Server Express.

Question m |

Are you using Microsoft Search Server 2010 as

I.-"'_"“-I vour search provider?

k- .f

If you are using Microsoft FAST Search for
SharePoint 2010, click 'No'.

Yes

29. The Ektron Search Configuration files are installed and configured.
30. You are prompted to run the Ektron Search Configuration Utility. Click OK.
31. The InstallShield Wizard Complete dialog appears. Click Finish.

32. Run the Search Configuration utility on the Ektron server. For documentation of
that process, see Configuring Microsoft Search Server on page 311.
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Setting Up Microsoft Search Server
2010

IMPORTANT: As of Ektron version 9.3 SP1, Microsoft Search Server 2010 and
Microsoft Search Server 2010 Express are no longer supported.

This section explains how to install Microsoft Search Server 2010. After installing it,
follow Configuring Microsoft Search Server on page 311 to configure the search
provider. To learn how to use the search, read Using Microsoft Search Server features
on page 335.

Prerequisites

* You have purchased and deployed Microsoft Search Server 2010. See also:
Product Licensing Search.

» An understanding of Microsoft Search Server 2010, Best practices for Search
Server 2010

Before beginning the installation, review these Microsoft documents.

o Hardware and software requirements: https://technet.microsoft.com/en-
us/library/bb905370(v=office.14).aspx#BKMK hw_regs

o User requirements: https://technet.microsoft.com/en-us/library/ff717834
(v=office.14).aspx

o Installation of Microsoft Search Server 2010:
https://technet.microsoft.com/en-us/library/ee808898(v=office.14).aspx
» Both servers can browse to each other across the network.
» The search, SQL, and CMS servers must be on the same domain.

» On your Microsoft Search Server 2010 server
o Create a Windows user for search purposes. The user should be
® 3 domain user

® assigned the "log-on as a service" role

® a member of the administrators group. That user must be logged in
when Microsoft Search Server 2010 is being installed.
o Verify that the server meets the Optimizing Microsoft Search Server 2010
with Ektron on page 317
o Open port 6080 (used by the Protocol Handler Service)
e On your Ektron server

o Open ports 6080 and 6081 (used by the CMS File Helper Service to
communicate Ektron services and copy files between the Web and Search
servers)
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Microsoft Search Server 2010 features

o Set SQL Security to SQL Server and Windows Authentication mode

° Through SQL Management Studio, add the Windows login that you created
on your Microsoft Search Server 2010 server. Assign to that user
® db_creator role
® securityadmin SQL role
Microsoft Search Server 2010 uses that login to access the Ektron database.

BEST PRACTICE

You should update your Ektron site's web.config file's
<connectionstrings> tag with the username and password of
that SQL user. Set Integrated Security to False. Then, log
into Ektron to verify that the connection string is valid. See also:
Managing web.config on page 74.

» On your database server
°© Open Port 1433

Microsoft Search Server 2010 features

» A configuration screen for connecting Ektron server with the server hosting
Microsoft Search Server 2010. That screen also monitors the status of search
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crawls.
=10lx]

W00 net Site Registration |

Content sources for your CM3 site must be registered with the Microsoft Search Server, A content source
is @ sat of options specifying the type of content to crawl, whan to perform that crawl, and how desp to
crawl.

CMS Databases:

W510652 | CM5400Developer  This site has been registered.

Further changes can be saved by

I Site Registration CMS Database: W510652 | CMS400Developer
Crawl Management
Site ID: 1
Database: CMS400Developar

Database Server:  W510652
Sike URL: hittp:/ /WS 10652/CMS400Developer
Version: 8.5.0.320

CMS Database Connection String:

Zearch Server must connect to your CMS site's database in order to crawl its content. Pleass
verify that the connection string that appears below is valid.

$10652;database=CMS400Developer; Integratad Security=Ffalse;user=remote;pwd=remats;  10)

Crawl Interval:

Your CMS site checks to see if content or related CMS objects were added or updated within
the interval configured below. If any changes occurred, a crawl is performed.

Interval: IEDD saconds

Search Server Credentials:

Your CMS site must authenticate with Search Server when submitting a query. Please enter
the cradantials for 2 Windows user with access to your Szarch Server indexes.

m

Domain: I

Uszrname: I Administrator

Pasgword: teeesssses é

+ | Advanced Options...

* You can also manage search via SharePoint 2010's Central Administration
console.
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Site Actions - @

Browse

Page

Microsoft Search Server 2010 features

| SﬁgrePointmm Central Administration » Search Service Application: Search Administration

Administration
Search Administration

Farm Search
Administration

Crawling

Content Sources

Crawl Rules

Crawl Log

Server Name Mappings
Host Distribution Rules
File Types

Index Reset

Crawler Impact Rules

Queries and Results
Authoritative Pages
Federated Locations
Metadata Properties
Scopes

Search Result Removal

Reports
Administration Reports

Web Analytice Reports

System Status
Crawl status

Background ac

Recent crawl rate
Searchable items

ry rate

Default content a

Contact e-mail add

Search alerts status

Query logging

Crawl History

Content Source

n1SMACDONALDIONTrek

106520nTrek

ektro

ektroniy

ektron1WS10652elntranet
WS10196 PressReleases
W310196_ PressReleases

WS510196_PressReleases

Type
Incremental
Full
Incremental
Incremental

Incremental

Incremental

» Workarea screens that let you
o view the status of search crawls

° begin new ones if needed

Search Status
) ) iga ¥

Status Iltem
Content Source Name
Query Credentials
Crawl Request Pending
Current Action
Pending Action
Crawl Start Time
Crawl End Time
Crawl Duration

Crawl Interval

Walue

ektran1WwsS10652CMS4000eveloper

Administrator

Mo

ldle

Mone

SI212011 2:02:36 PM
SI212011 2:05:16 P
00:02:40

00:05:00

Start Time

ar

Description

1dle

SMACDONALDL\Administrator
no-reply@ektron.com

None

1dle

futomatically scheduled

Off Enable

On Disable

End Time

The index assaciated with your site.

Duration

259

Success All Errors

The Windows user authorized to caommunicate with the query service.

Indicates whether or not the site has a request for a crawl to submit.

The indexing activity that is currently in progress.

The indexing activity that will execute upon completion ofthe current activity,

The starttime ofthe most recent crawl.

The end time ofthe most recent crawl.

The duration of the most recent crawdl.

Indicates how often the site will submit crawl requests.

» Create and maintain synonym sets

lonym Set
€ | SAVE SYNONYMS L2
Terms:

Check for Duplicates

eparate each term with 2 semicolon ;). Mo

y illegal
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» Create and maintain suggested results

Add Suggested Res

L 4 SAVE SUGGESTED RESULTS L2
Kame Tuition
Phrases tuition:account.check:invoice:statement;balance
Enter terms that, when searched, return the content listed below in the suggested results area of

search results. Separate each term with & semicolon

Suggested Results Click below to see your option

Tuition and Fees
Fall bills are posted to student Blackboard accounts in mid June and are due in early December.

+ Manage the Integrated Search

Integrated Search Mappinags

)

Select a start address and enter the corresponding URL path, relative to your site root. Press @ to save it

Start Address Wapping

file:/fws10196/Press%20Releases
Example: /WMyWirtualDirectony'Files’
» Templated controls let developers deploy search functionality to the website

INPUT PROCESS QUTPUT
SiteSearchResultsiews

SiteSearchinputyisw SiteSearchContraller

Workarea search, which lets Ektron administrators and editors find content

within the Workarea

Search Content Folder 2=

{ @

Search Published Advanced Search

Basic Search

Ste  ~|[Search]

Installing Microsoft Search Server 2010
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. Log into the search server as the user created for search purposes. As explained
in Prerequisites on page 302, the user must be
« adomain user

» assigned the "log-on as a service" role

« a member of the administrators group. That user must be logged in when
Microsoft Search Server 2010 is being installed.

. Install Microsoft Search Server 2010. Make sure you use the farm install.

. Install or upgrade Ektron on its server, using the normal procedure. See
Installing Ektron on page 9, Upgrading to on page 35. If you already installed
Ektron, skip to Step 6.

. During the Ektron installation, choose Microsoft Search Server 2010 (Full).

Ektron CMS400.NET E3

Search Provider

kiron

@ Microzoft FAST 5

& Mone

Cancel
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5. After the Ektron database setup, the following dialog appears. Click No.
Question I

@™ %  Your Ekkron site must be connected ko a search provider before
' ' search features can be applied.
Would you like to connect your site wikh your search provider
ylality

-If ywour have already set up your search provider &ND vou have
installed the Ektron search components on the server hosting wour
search provider, click "es',

-If vou have not already sek up wvour search provider, click Mo,
Your provider must be set up before you can configure the search
functionality For wour site, {Search Server 2010 Express is freely
available and can be installed with the
‘Search3erverExpressinstall, exe’ setup file packaged wikh your
Ektron installation Files.

-If ywou have nok inskalled the Ektron search components on the
server hosting wour search provider, click 'Mo', Copy the
'Ektron3earchConfiguration. exe’ setup file From the CMS server ko
wour search server, Execute the setup file and Follow any
on-screen inskruckions,

Moke: Search setup and configuration files can be found in the
Following location:C:\Program
FilestEkkront CMS400wE51 klities) SearchTerver,

The Ektron installation completes.

6. On the Ektron server, copy C:\Program Files
(x86) \Ektron\CMS400
versionnumber\Utilities\SearchServer\EktronSearchConfiguration.exe.

7. Log onto the Microsoft Search Server 2010 server as the same user who ran the
Search Server 2010 Install.

8. On the Microsoft Search Server 2010 server, paste and run
EktronSearchConfiguration.exe. The Search Administrator Credentials
screen appears.

9. Enter the domain, username, and password of a user with Windows
Administrator privileges on the server you will use for Microsoft Search Server
2010.
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EktronSearchConfiguration - InstallShield Wizard

Search Adminiztrator Credentials

ktron

Tl Ehied ’ < Back ” Mest > ] Cancel

10. Determine the location of the folder that maintains the Ektron query service
files.

EktronSearchConfiguration - Installshield Wizard

WebSite location

want the Ektron Queryir

ktron

Browse...

Cancel

Inetalsield < Back ] [
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11. Select the port number to use with the Ektron query service website.

EktronSearchConfiguration - InstallShield Wizard [ x|

Ektron website port number

r

Flease enter the port number pou want to uze with the Ektron Queryir

kiron

’ ¢ Back ” Mest » ] Cancel

12. The following screen appears. Click Yes if you are using Microsoft Search Server
2010. Click No if you are using Microsoft FAST Search Server 2010

Quesktion E |

@™, Areyou using Microsoft Search Server 2010 as vour search
Y provider?
If wau are using Micrasaft FAST Search For SharePaint 2010, click,
o',

13. The Ektron files are installed and configured. A message instructs you to run the
Search Configuration utility on the Ektron server. For documentation of that
process, see Configuring Microsoft Search Server on the facing page.

During installation, Ektron creates a new website in IIS to host the search services.
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qE'Internel: Information Services (IIS) Manager

@ 4 | %5 » swacoona: »

File  Wiew Help

@ H|17 18

= ‘:} Application Pools
[=-- @] Sites
‘E?J Default Y

b Site
Ektronsearchsite
- | aspret_client
i‘i‘ EkkronuerySuggeskion
i‘i‘ EktronSearchstatistics
-[2¥ EktronebService

SharePoint Central Administration w4
‘EE?; SharePaoint Web Services
AL

SITF 7

£
£
£
Ia

Configuring Microsoft Search Server

This section explains how to configure search using the Express or full version of
Microsoft Search Server 2010. The Search Configuration screen lets you manage the
Ektron's implementation of Search Server.

IMPORTANT: Ektron's Search Configuration screen provides access to a few
commonly-used features of your search provider. To fully use search capabilities,
use the search provider's administration utility.

Also, if you remove or edit Ektron website information using IIS, you must restart
the Ektron Windows Service before using the Search Server Configuration screen.

Before you log into the Search Configuration screen

e Is the Ektron Search Server Service started?

» For ports opened between the Ektron server and the search server, are firewalls
off?

» Verify that the user entered during the Search Server installation is also the user
running these Windows services:
o SharePoint 2010 Timer

o SharePoint Server Search 14
o Ektron Search Server

» Verify that the user entered during the Search Server installation is also the user
set in the Advanced Settings > Identity field running these Application Pools:
°© <GUID> (there may be more than one)

o SecurityTokenServiceApplicationPool
o SharePoint Central Administration v4
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Logging into Ektron's Search Configuration screen

1. Log on to the server hosting Search Server as an administrator.
2. Click the Windows Start menu > All Programs > Microsoft SharePoint

2010 Products > SharePoint 2010 Central Administration. If you're using

Windows 8 or 2012, go to C:\Programbata\Microsoft\Windows\Start
Menu\Programs\Microsoft SharePoint 2010 Products\SharePoint 2010

Central Administration.

The port number appears in the browser address field, following http://server
name

ﬁﬁearch Administration - Windows Internet Explorer

IQ http: )l serveradl 99999 Ysp/adminSearchadministration, asp

+.¢ Favarites | = L Suggested Sikes = @& | Web Slice Gallary -

& search Administration | |

@l Search Server

Home

Search Administration

3. Click the Windows Start menu >All Programs > Ektron > CMS400Vxx >
Utilities > Search Configuration. If you're using Windows 8 or 2012, press

the Windows key (E)/Q then enter Search Config. Right click and choose
Run as Administrator.
4. The Connection Information screen appears.

W Ektron Search Cenfiguration [i_z-,

Step 1: Connection Information
Please enter the connection details for your CMS server and SharePoint
Central Administration server,

CMS Server Machine Name: EKTEMGS

w | 'What is the CM5 Server Machine Mame?

SharePoint Administration URL: http:f_r’EliTENEE*'_EE-’-l

% | What is the SharePaoint Administration URL?

| Next || Bat |

5. Inthe CMS Server Machine Name field, enter the Ektron server.
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6. Inthe SharePoint Administration URL field, enter http://, your search
server name, colon(:), and port number (see Part 1: Install Microsoft Search
Server 2010 on page 327) For example, http://MySearchServer:12345.

7. The Search Service Applications screen appears. Select appropriate Content and
Query Service applications. Click Next.

“a Ektron Search Configuration X | |

Step 2: Search Service Applications

Please select the service applications relevant to your CMS site.

Content Service Application: | Search Service Application - |

Query Service Application: | Search Service Application - |

w | What are s=rvice applications?

| Back || next || mat |

Ektron's Search Server Configuration screen appears.

Managing the search configuration

This section explains how to use the Search Configuration screen.
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Ektron Search Configuration I;Ii-

ektron Site Registration

CMs400.net

CMS Databases:

EKTENG / SearchAPI o

Content sources for your CMS site must be registered with the search provider (Microsoft Search Server / FAST).
A content source is a set of options specifying the type of content to crawl, when to perform that crawl, and how
deep to crawl

¥ This site has not yet been registered or requires re-registration.

You can register your site by entering the data requested below.

I Site Registration

CMS Database: EKTENG1 / SearchAPB|
Crawl Management

Site ID: 2

Catabasze: SearchAPI
Database Server:  EKTENGT

Site URL: http://ektengla
Version: 9.1.0.151

CMS Database Connection String:
The indexing companents must connect to your CMS site's database in order to
crawl its content.

Mote: The connection string is not displayed here for security reasons. If you do not

Crawl Interval:

Your CMS site checks to see if content or related CMS objects wers added or
updated within the interval configured below. If any changes occurred, a crawl is
performed.

Interval: |22 seconds

Credentials:

Your CMS site must authenticate with the search provider when submitting a query.
Please enter the credentials for a Windows user with access to your search provider's
indexes

Daomain: ‘ EKTENGT

Username: ‘Adminislr&tar

Passward: =5

v Advanced Options...

Register Site

When your Search Server configuration is properly set to connect to your Web server,
the following appears on the screen.

" This site has been registered.
Further changes can be saved by registering your site again.

» CMS Database. Information about Search Server's connections to your
website.
o Site ID. The IIS site ID on the Web server.

o Database. The database that Search Server crawls.

o Database Server. The name or IP address of the site's Web server.
o Site URL. The URL visitors use to view the website.

o Version. The website's Ektron version.

« CMS Database Connection String. Search Server uses the CMS Database
Connection string to connect to your Ektron database. If the database is on the
same domain as your search server, set Integrated Security to true.
Otherwise, set Integrated Security to false and enter a SQL username and
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password.

You may leave the field blank to use the connection string in your web.config file
(for a first-time registration) or a previously-used string (for subsequent
registrations).

Or, you can enter a connection string if you wish to override the default
connection string chosen by the registration process. Here is a sample
connection string that gives search access to a specific SQL user:

connectionString="server=Ektronl;database=OnTrek;Integrated
Security=FALSE;user=ABC;pwd=123;"

If you manually enter a connection string, the server name and database name
must match those values in the web.config's connection string.

BEST PRACTICE

Use SQL authentication rather than Integrated Security. Although
Integrated Security is supported, the connection is made in the
context of the search service account (Windows user) provided during
installation. If this user does not have access to the database, the
connection fails.

Crawl Interval. Set the incremental crawl interval.

Search Server Credentials. Enter the domain, username, and password of a
user with privileges to connect to Search Server.

 Advanced Options

o Crawl Tracing. Use the drop-down to specify a level of detail collected by
the crawl log. A separate log is created for each crawl, and is saved to the
Data Directory.

o Data Directory. Identify the folder on your Search Server that stores a
copy of Ektron content needed by Search Server. The directory also stores
protocol logs, which track crawl activity. The default value is
C:\EktronSearchData.

o Secondary Search Servers. Use this area to add secondary search
servers to a load-balanced cluster. You would only do this on a primary
server, to identify its secondary servers. See also: Setting up a load-
balanced search with Microsoft Search Server 2010 on page 321

1. In the Secondary Search Servers section, click Add ().

2. Insert the name of the secondary servers.
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3. Click Register Site.

Secondary Search Servers:

If you've manually setup & distributed Search S=rver environment, the servers hosting your
distributed components also require registration. Pleass identify thoss servers by their
maching name in the list below.

Note: Each server listed below is reguired fo have the sppropriate Ektron search
companants instaliad prior o registration. IF you have not siready dons s, pleass instal
those componants (EktronsearchConfiguration.exa) before procseding.

L~ .
(G ° ©

Register Site

Updating the site registration panel

If you make changes to the Site Registration panel, you need to register the site
again.

1. Start the Search Configuration Utility. See also: Logging into Ektron's Search
Configuration screen on page 312.

2. If the Ektron server has several databases, select one from the drop-down.

Wi100 et Site Registration

Cantent sources for vour CM3 site must be registered with the Microsoft Sea
is a ==t of options specifying the type of content to crawl, when to perform t
crawl.

CM5 Databases:

SMACDONALD1 / cms400min2 : & This site has been registered.

SMACDOMNALDY [ CMS4000eveloper Further changes can be saved by registering your site again.
SMACDONALDT [ cms400min
SMACDOMALDT / OnTrek CMS Database: SMACDONALDI f cms400min2
SMACDONALDY [ CMS4005ite352
SMACDOMALD1 / cs00min2

e Tika The L\\

. CMS databases s4g0minz

1 dropdown
P ACDONALDL
Tk IR e HICBAACTERLATL T 1O T rmmimmide

NOTE: If your Ektron version supports multi-site, the CMS Databases drop-
down lists the multi-site database only once. The site Url may correspond to
the main site or any sub-site (depending on their order in IIS).

3. In the Search Server Credentials area, enter the Domain, Username, and
Password for your Search Server.
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4. Click Register Site. A confirmation window appears.
5. Click Yes. Progress appears in a window.

“a Register Site

1/14/2011 11:41:34 AM: Creating content source.

1/14/2011 11:41:39 AM: Content source craated.

1/14/2011 11:41:39 AM:  Performing initial site crawd.

1/14/2011 11:41:42 AM:  Site reqistration completed successfully.

| dose |

6. When finished, click Close.

Troubleshooting site registration

Error: Failed to connect to specified Search Server. Please verify that your Search
Server URL and port number are valid and try again.

Possible solution:

1.

ok WN

Open the Windows Services control panel.

Right-click Ektron Search Server Service.

Choose Properties from the context menu.

Select the Log On tab from the properties dialog window.
Select the radio button labeled This account.

Enter the credentials to match those of the SharePoint Server Search 14
(OSearch14) service.

Commit your changes.

Optimizing Microsoft Search Server 2010 with Ektron

After installing Microsoft Search Server 2010, you can do several things to optimize
Ektron's use of that technology. These actions ensure you are doing everything
possible to help site visitors find Ektron content.

» You want Ektron to search text within Visio files. See Installing the Visio IFilter

on page 346.

You want Ektron to search aliased pages, and their extension is not one of
Search Server's standard file types. See Defining unusual file extensions used in
aliasing on the next page.

The crawl is taking a long time and your website has over 1 gigabyte of assets,
and over 100 PDFs. Install Foxit PDF Filter from Foxit® PDF IFilter - Server.
After installing, update the registry:
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[HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Office
Server\14.0\Search\Setup\Filters\.pdf] "Extension"=".pdf"
"FileTypeBucket"=dword: 00000001

"MimeTypes"="application/pdf"

HKEY LOCAL_MACHINE\SOFTWARE\Microsoft\

Office Server\14.0\Search\Setup\ContentIndexCommon\Filters\Extension\ .pdf]
@="{987£8d1a-26e6-4554-b007-6b20e2680632}"

See also: Index and Search PDF Files in SharePoint Server 2010.

» Either the crawl or the response time for search queries is too slow. See Setting
up a load-balanced search with Microsoft Search Server 2010 on page 321.

Defining unusual file extensions used in aliasing

Ektron's Aliasing feature lets you create human-readable URLs, such as
support.episerver.com. The URL Aliasing Configuration screenlets you define file
types that may be applied to aliased pages. See also: Creating user-friendly URLs
with aliasing on page 1293

If you define an aliasing file type that is not on Search Server's file type list, you must
add the missing type to Search Server. Follow these steps to accomplish that.

1.

Go to Windows Start button > All Programs > Microsoft Search Server >
Search Administration. If you're using Windows 8 or 2012, press the

Windows key (E) /Q then enter Search Administration.
Click File Types (as illustrated in the following figure).

Search Administration

Farm Search

=i Mew File Type
Administration

Icon Fien., Create new file type File type
Crawling B ASE.NET
Content Sources ’;-E;"'] asp asp docu
Crawl Rules 3 . R
Crawl Log ’.Gj i i

Server Name Mappings Ek Bl O
Host Distribution Rules .ﬂ bmp Bitmap I
cav cev docul
Index Reset EIJ s e

Crawler Impact Rules

Review the Search Server's file type list.

If you do not see all extensions defined on the URL Aliasing Configuration screen,
click New File Type (shown in the previous image), then add the missing file
types.

Windows services used by Microsoft Search Server
2010
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How services process content updates

Ektron's search feature uses several Windows services to monitor database updates,
determine if a new crawl needs to be launched, and perform the database crawl. This
section explains the operation of these services.

» Ektron Search Server Service
° Runs on search server and Ektron site server.
o Responsible for communicating between servers. It triggers search tasks
such as crawling, synonym sets, and so on.
o Whenever content is added, updated or deleted, this service changes the
Search Status screen's Incremental Crawl Request Pending flag to
Yes. As a result, the next time the crawl interval is reached, this service
launches the Ektron CMS File Helper Service. See also: Using Microsoft
Search Server features on page 335
» Ektron ProtocolHandler File Helper Service
°© Uses protocolhandler.dll file
o Runs on Ektron server during a crawl
o Gets content updates from database server and feeds them to Search
Server
+ Ektron CMSFileHelper Service
o Runs on Ektron site server
o Indexes assets and sends them to Ektron ProtocolHandler File Helper
Service
» Ektron Query Service. Passes search term from Ektron server to Microsoft
Search Server 2010 and returns results

How services process content updates
1. As Ektron content is added, changed or deleted, the Ektron database is updated.

NOTE: To learn about which events trigger a crawl, see Full vs. incremental
crawls on page 368.

2. Ifthe change warrants a full crawl, it is launched immediately.

3. Ifthe change warrants an incremental crawl, the Ektron Search Server Service
updates the flag that determines if a crawl needs to be started to Yes. You can
view this flag on the Search Status screen's Incremental Crawl Request
Pending field. When the crawl interval expires, the Ektron CMS File Helper
Service sends content updates to the Ektron Protocol Handler Service.
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4. The Ektron Protocol Handler Service feeds the content updates to Search Server.

Database Server

Retrieve site content for
indexing

CMS Site
Database

-
-
’
7
’
/
/
/ - Issue crawl command to
I Site Server Search Server
_ [
su"":::;:vﬁ:es‘ for Ektron Search
9 Server Service Server
Protocol
CMS Site Ektron Search Handler

Server Service

Ektron Query
Service

Submit query request to
Search Server

Search Server

How queries are processed

Querying is the process by which Ektron retrieves content from the search index.

The Ektron site uses Ektron's Query Service to connect to Microsoft Search Server

!" ' ( ' )
Database Server
Retrieve site content for
indexing
—————— »
- -
-
-
Ed
s
s
/
[
/ . Issue crawl command to
I Site Server Search Server
P —
t3\113r1:-|:.rll:<‘!(!:::st for Ektron Search
srawiing Server Service O
Ektron
=Letre P Protocol
CMS Site l_'kL on 5?'“”'“ Handler
Server Service

Ektron Query
Service

Submit query request to
Search Server

Search Server
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Default settings for managed properties created by

Default settings for managed properties created by Ektron

When Ektron content is crawled by Microsoft Search Server 2010, the following
default values are set for these metadata properties. You can edit the values using
the Microsoft Search Server 2010 Central Administration console.

* Queryable. True

» StemmingEnabled. False

« RefinementEnabled. False

» MergeCrawledProperties. True

e SubstringEnabled. False

» DeleteDisallowed. False

» MappingDisallowed. False

» MaxIndexSize. 1024

» MaxResultSize. 64

» DecimalPlaces. 10

» SortableType. SortableEnabled

 SummaryType. Static

Setting up a load-balanced search with Microsoft
Search Server 2010

You can use load balancing to distribute your search's workload across multiple
servers. Load balancing improves search's performance by significantly decreasing
the time to complete search crawls and process search queries (especially when a
site is under a heavy load).

This section describes 2 scenarios for setting up Load Balanced search.

* You already installed Microsoft Search Server 2010 on one server, and now want
to bring additional servers into the cluster—see Adding a site to a server that
hosts Microsoft Search Server 2010 and Ektron below

» You have not yet installed Microsoft Search Server 2010—see Installing
Microsoft Search Server 2010 to a primary server in a load balance cluster on
page 323

Adding a site to a server that hosts Microsoft Search Server
2010 and Ektron

1. On the Ektron server, run the Site Setup utility: Windows Start button >
Programs > Ektron >version> Utilities > CMS400 Site Setup. If you're

using Windows 8 or 2012, press the Windows key (E) /Q then enter CMS400
Site Setup.
See also: Installing a site on page 17
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2. During the Ektron installation, you are prompted to choose a search provider.
Choose Microsoft Search Server 2010 Full.

Ektron CMS400.NET E3

Search Provider

kfron lea he gearch provider you intend to
200 Exp

2010 [Full)

Tnistal Enield

| o]

3. The setup continues as normal. After the installation is complete, the following
dialog appears. Click Yes.
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Queskion

@™, ‘four Ekkron site must be connected to a search provider before
' ' zearch Features can be applied.
Would vou like to connect wour sike with vour search provider
ylalliFy

-If vou have already set up vour search provider AMD vou have
installed the Ektron search components on the server hosking your
search provider, click "es'.

-If wou have not already set up your search provider, click o',
Your provider must be set up before wou can configure the search
functionality For your site, (Search Server 2010 Express is freely
available and can be installed with the
'SearchServerExpressInstall. exe' setup file packaged with wour
Ektron inskallation files,

-If wou have nok installed the Ektron search components on the
server hosking wour search provider, click ™o’ Copy the
'EkkronSearchConfiguration. exe' setup File From the CM3 server to
wour search server, Execute the setup file and Follow any
on-screen instructions,

Moke: Search setup and configuration files can be found in the
Following location:C:\Program
FilestEkkront CMS400wE51 klities) SearchServer,

Installing Microsoft Search Server 2010 to a

|

The Search Configuration screen appears. For documentation of that process,
see Managing the search configuration on page 313

Installing Microsoft Search Server 2010 to a primary server in
a load balance cluster

Use this procedure if you have not installed Microsoft Search Server 2010 on the
primary server in a Load Balance cluster.

PREREQUISITE

» See Hardware and software requirements (Search Server 2010).

» A SQL user with the sysadmin role

1. Obtain, download, and install Microsoft Search Server 2010.

NOTE: You may be informed that you need to run the Products Preparation

Tool before beginning the installation.
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2. Choose Server Farm when you are prompted for an installation type.

ﬂ Microsofti® Search Server 2010

\* }-\, Choose the installation you want

Please choose your preferred type of Microsoft® Search Server 2010 installation below,

i ;
Standalone Install single server standalone using defaulf settings

house settings for single server or server fam,

3. Onthe Server Type tab, select Complete then click Install Now. Search
server is installed.

Server Type | File Location ]

Server Type

l

Select the type of installation you want to install on the server,

r'rstall &l components. Can add servers to form & SharePoint farm,

i+ Stand-alone - Instal all components on a single machine (ndudes S0 Server 2008
Express Edition). Cannot add servers to create a SharePoint farm. Click the Help button

for more information about using this type of installation in production,

4. Run the Configuration Wizard, which lets you set up Microsoft Search Server
2010. The SharePoint Configuration Wizard is launched.

5. Choose Create a new server farm on the Connect to a server farm screen.

SharePoint Products Configuration Wizard

Connect to a server farm

& server Farm is a collection of kwo or more computers that share configuration data. Do wou wank to
conneck ko an existing server Farm?

¥ Conmect bo an exjsting server Farm
6. Specify a database server, name, and user name and password for access to the

account.
a. For Database name, accept the default of SharePoint_Config.

b. Enter a Username and Password of a SQL user with the sysadmin role.
Microsoft Search Server 2010 uses them to access your Ektron database.
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Click Next.

SharePoint Products Configuration Wizard

Specify Configuration Database Settings

all servers in a server Farm must share a configuration database. Type the database server and database
name, If the database does not exist, it will be created, To reuse an existing database, the database must be
empty. For additional information regarding database serwer security configuration and network access
please see help,

Database server: |

Database name: |ShareP0int_Canfig

Specify Database Access Account

Select an existing Windows account that this machine will always use to connect to the configuration
database. If vour configuration database is hosted on another server, wou must specify a domain account,

Type the username in the Form DOMAINUser_MName and password For the account,

Username; |

Password: |n.nnnn

Mext = | Cancel |

7. Enter a password for access to the server farm.

SharePoint Products Configuration Wizard -

Specify Farm Security Settings

Please enter a new passphrase for the SharePoint Products Farm, This passphrase is used to secure Farm
configuration data and is required For each server that joins the Farm. The passphrase can be changed after
the Farm is configured,

Passphrase: |".-------u

Confirm passphrase: |..........u

8. Enter a port number and Security settings. You may enter any open http port.
For Security Settings, choose NTLM.
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SharePoint Products Configuration Wizard

Configure SharePoint Central Administration Web Application

& SharePoint Central Administration Web Application allows vou to manage configuration settings For a server
farm. The first server added to a server Farm must host this web application. To specify a port number For the
web application hosted on this maching, check the box below and type a number between 1 and 65535, IF
wau do nat specify a port number, a random one will be chaosen,

¥ Specify port number: ISDSE||

Configure Security Settings

Kerberos is the recommended security configuration to use with Integrated Windows authentication. Kerberos
requires special configuration by the domain adminiskrator, MTLM authentication will work with any
application pool account and the default domain configuration, Show me maore information.

Choose an authentication provider For this Web Application.

& NILM
" Megotiate (Kerberos)

< Back | MNext = I Cancel |

9. Click OK to confirm the information you entered.

10. Click Finish to launch the SharePoint Central Administration site to allow for
additional configuration and provisioning. Noted that the first installation in a
farm does not create a Web application or provision a site. See also: SharePoint
2010 Central Administration.

The following screen appears within SharePoint.

Centrsl Administration » Configure your SharePaoint farm

This mizard will help you sanfigurs your SharsPaint e

Howe clo you want to configure your SharePoint farm®?

i walk y thraugh the
his wizard will halp with tha initial confiquration of your SharaPoint farm, You ean selact the rfiguration of my u.-.-_:--u-.b
servicas to use t m and orec 2ard

fou can launch this wizand again fr the Configuration Wizards page
&dministrztion site

Carcel

11. Click Start the Wizard and complete the wizard.

Adding servers to a load balance cluster

2 servers running Microsoft Search Server 2010; the servers cannot use
Search Server Express.

326 | Ektron 9.50



http://technet.microsoft.com/en-us/edge/Video/ff945209
http://technet.microsoft.com/en-us/edge/Video/ff945209

Part 1: Install Microsoft Search Server 2010

See Hardware and software requirements (Search Server 2010)

When setting up search load balancing, you need to decide which server is the
primary one, and which is/are the secondary one(s). This procedure describes how to
set up a single secondary server in a load balanced cluster. To set up additional
secondary servers, follow these instructions for each secondary server. See also:
Installing Microsoft Search Server 2010 to a primary server in a load balance cluster

on page 323
Part 1: Install Microsoft Search Server 2010

1. Obtain, download, and begin to install Microsoft Search Server 2010.

NOTE: You may be informed that you need to run the Products Preparation

Tool before beginning the installation.

2. For aninstallation type, choose Server Farm.

l Microsofti Search Server 2010

{ Cl |

& Choose the installation you want

Please choose your prefierred type of Micosoft® Search Server 2010 installation below.

Install single server standalone using default settings.

Standalomns

h:me settings for single server or server farm.

3. Onthe Server Type tab, select Complete then click Install Now.

Server Type | Fie Location |

y ] Server Type
Select the type of installation you want to install on the server,

mstall 2l components. Can add servers to form a SharePoint farm,

* Stand-alone — Instal all components on a single machine (indudes SQL Server 2008
Express Edition). Cannot add servers to create a SharePoint farm. Click the Help button
for more information about using this type of installation in production,

Search server is installed.

4. Run the Configuration Wizard, which lets you set up Microsoft Search Server

2010. The SharePoint Configuration Wizard is launched.

5. On the Connect to a server farm screen, choose Connect to an existing

server farm.
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SharePoint Products Configuration Wizard

Connect to a server farm

& server Farm is a collection of two of maore computers that share configuration data, Do wou wank to
conneck to an existing server Farm?

0 Conneck ko an existing server Farm
i Create a new server Farm

6. On the Specify Configuration Database Settings screen, in the Database server
field, enter the primary server in the load balance cluster.

7. Click Retrieve Database Names. The primary server's database appears in the
Database name field.

SharePoint Products Configuration Wizard =] B

Specify Configuration Database Settings

All servers in a server Farm must shate a configuration database, Type the name of the database server, click
Retrieve Database Mames, and select an existing configuration database. Faor additional information
regarding database server security configuration and network access please see help,

Database server: ektsqazl Retrieve Database Names |

[

Database name: charePoint Config

ShatePoint_Config

8. Enter the same passphrase that you entered when setting up the primary server.
See also: Installing Microsoft Search Server 2010 to a primary server in a load
balance cluster on page 323

9. Complete the remaining prompts; the wizard uses information to configure
Microsoft Search Server 2010.

Part 2: Set up query components

In this procedure, you create 2 query components. One defines this secondary server
as a failover server, which takes over processing if the primary server goes offline.
The second query component distributes the processing of search queries among
search servers.
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1. Open Microsoft Search Server 2010's Central Administration screen.

e

2. Click Manage service applications (highlighted). The Service Applications

Home - Central Administration

Erowse

i SharePoint 2010 Central Administration

= Computer
£, SharePoint 2010 Management Shell -
;ﬁ\ . . ar
i SharePoint 2010 Products Configuration Wi Network
| Microsoft SQL Server 2008
., Startup e

Central o
Administration = Application Management

ne

Application Management |--_Q Manage '.NI: appll;atlcns

System Settings
Monitoring

Backup and Restaore Monito ring

Review problems and =olutions
Check job status
View Web Analytics reports

Security

Upgrade and Migration

General Application
Settings i SR = PO

& Internet Explorer (64-bit) - istrators
Internet Explarer ‘ -J
Windows Update
. Accessories
| Administrative Tools N
| Foxit PDF IFilter
, Maintenance
| Microsoft SharePoint 2010 Products
42 SharePoint 2010 Central Administration

) Lints

ections
Documents

screen appears.

3. Click Search Service Application 1. The Search Service Application 1: Search

Administration screen appears.

-

N\
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MNew Connect Delete
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Manage Administrators Properties

Publish Permissions

Create Operations Sharing
Central
Administration MName

Application Management
System Settings
Monitoring

Backup and Restore
Security

Upgrade and Migration

General Application
Settings

Configuration Wizards

4. Scroll down to Search Application Topology and click Modify (highlighted).

r unt

Application Discovery and Load Balancer Service Application

Application Discovery and Load Balancer Service Applicatior
Proxy_B67c6134-e661-4820-a2fc-607a7alc382a
Search Administration Web Service for Search Service Applicatior

Service Application 1
Security Token Service Application
WIOD | lasmaafmmliastiae

Authoritative Pages
Federated Locations
Metadata Properties Crawl History
Scopes

Search Result Rernoval

Reports
administration Reports

Current [

Web Analytics Reports

There are no itemns to show in this view,

Search application Topology

Server

Category Name Status
= Admin

Administration Companent EKTSOAZL Onling
= crawl - ektsgaz1\Search_Service_Application_1_Crawl|StoreDB_30524ebbb9b7459badac7d89c94e2d25

Crawl Component 0 EKTSQAZL Online
= Databases

adrinistration Database : Search_Service_Application_1_DB_f4654f16f5794a94b9fed465658celen EKTSQAZL

Craw| Database : Search_Service_application_1_CrawlStoreDB_30524ebbb9b745%badac?dg9c9dezdzs EKTEQAZ1

Property Database : EKTS0AZL

Search_Service_Application_1_PropertyStoreDB_1ef598b13daad183aZodbelier 393612

S Index Partition - O - ektsga21\\Search_Service_Application_1_PropertyStoreDB_1ef598b13daa4183a2c4bel13e7393812

Query Component 0

EKTSQAZL online

5. To set up the failover server, under Index partition 0, click Query
Component, then Add Mirror.
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Part 2: Set up query components

Central
Administration

Application Management
System Settings
Monitoring

Backup and Restore
Security

Upgrade and Migration

General Application
Settings

Configuration Wizards

A Recycle Bin

) all Site Content

6. Use the following information to complete the Add Mirror Query Component

screen.

Topology for Search Service Application: Search Service

Learn more about search topology

= Mew »
Category =1l
= Admin
Administration Component Eb

= Crawl - ektsgaz1\Search_Service_Application_1_CrawlStoreDB_30524ebbb9b7459badac7d89c94
Crawl Component 0 Eb
=l Databases

Adrinistration Database @ Ek
Search_Service_aApplication_1_DB_f4654f16f5794 a94b9%fedd 68658 celac

Crawl Database : Eb
Search_Service_aApplication_1_CrawlStoreDB_30524ebbbob7459%badac?da9codezdzs

Property Database : Et
Search_Service_Application_1_PropertyStoreDB_1ef598b13daad183a2e4bel3e7393812

= Index Partition - 0 - ektsgaz1\Search_Service_Application_1_PropertyStoreDB_1ef598b13daa41

Query Component 0 2 Et

» Server. Enter the server to which you are currently signed on.

» Associated Property database. Select the primary server and the
database you specified in Step 4.

* Location of Index. Accept the default.

» Failover-only Query Component. Ektron recommends checking this box.
If you do, and the primary search server goes offline, the secondary server
processes all search queries until the primary server returns.

7. The Search Service Application 1: Search Administration screen reappears. Click

Apply Topology Changes.

The secondary server now appears under Index Partition (highlighted).
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Fearch application Topology

Current 'I

Category El';:::r Status
= Admin
Administration Component EKTS0A21  Online

= Crawl - ektsqa21\Search_Service_Application_1_CrawlStoreDB_30524ebbb9b7459badac7d89c94e2d25
Crawl Component 0 EkT=0A21  Online
Crawl Component 1 EKT=QA20  Initializing
= Databases

Adrministration Database ! EKTS0AZ1
Search_Service_application_1_DB_f4654f16f5794a94bofedd4686580e0ec

Crawl Database ! EKTS0AZ1
Search_Service_application_1_Crawl|StoreDB_30524ebbb2b7459badac?dEac94e2dz25

Property Database : EKTSQAZ1

Search_Service_application_1_PropertyStoreDB_1ef5958bl3daad183a204bel 37393512
= Index Partition - 0 - ektsqaz1\Search_Service_Application_1_PropertyStoreDB_1lef598b13daa4183a2c4bel3e7393812

KTSQAZ0  Online -
Failover Onl

Query Component 1

Query Companent 0 EKT=0A21  Online

Set up a query component to distribute the workload of handling search queries.
To do that, from the Search Application Topology area, click New > Index
Partition and Query Component.

Learn more about search topology

= Mew - WView
& Crawl Component
& Crawl Database Server Mame Pending Chan
& Index Partition and Query Component |

9 & Property Database

......... hdl"h'l'hi'st’r‘ét’lﬁh"C'o'l‘ﬁ'bﬁh’é’ht'"""""""""""E EKTSQAZL
=l Crawl - ektsqa21ySearch_Service_Application_1_CrawlStoreDB_30524ebbb9b7459badac7d89c94e2d25

Crawl Component 0 EKTEQAZ1
Crawl Component 2 EKTSQAEZ0

=l Databases

Administration Database : EKTEQAZ1
Search_Service_application_1_DB_f4654f16f5794a94b%fed4 68658 ce0an
Crawl| Database : EKTSQAZL

Search_Service_application_1_Crawl|StoreDB_30524ebbb9b7459%badac?ds9c94e2d2s

Property Database : EKTEQAZ1
Search_Service_application_1_PropertyStoreDB_1efS598bl3daad183a20cdbel3e?3935812

= Index Partition - 0 - ektsqaz1\Search_Service_Application_1_PropertyStoreDB_1ef598b13daa4183a2c4bel3e7393812
Query Component 2 EKTSQAZ1

= Index Partition - 1 - ektsgaZz1\Search_Service_Application_1_PropertyStoreDB_1ef598b13daa4183a2c4bel3e7393812
Query Component 3 EKTSCAZD

| Apply Topology Changes I Cancel

The Add Query Component Screen appears. Complete Part 2: Set up query
components on page 328, but this time do not check the Failover-only Query
Component box.
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omponent

Server
lect ko host: thi k ki
Select a server ko host this query component |EKTSQA20 =
Associated Property Database
perty Associated Property Database
Seleck the property database to associake with this query component. ektsqa2l\Search_Service_Applicati;I

Location of Index
Specify the lacation on this server that will be used For storage of the index files after receiving

Location of Inde:x:

them from the crawl components, The space used For the index files will increase with the number IC hquery

of items in an index partition,

Failover-onl C t .
ailover-only Query Componen [ 82 s query component as Failover-onl

Set this query component as Failover-only, & Failover-only query compaonent will receive queries
only in the event of a Failure of the primary query component in the same indesx partition,

10. The Search Service Application 1: Search Administration screen reappears. Click
Apply Topology Changes.

11. To do that, from the Search Application Topology area, click New > Crawl
Component.

Site Actions - g

Central Topology for Search Servic«

Adrministration

Application Management
Learn more about search topology
Systemn Settings
Manitaring

Backup and Restore

security o Crawl Database :
Upgrade and Migration & Index Partition and Query Component :
izeneral Application . & FProperty Database :
Settings e L * :

Server
) Server
Select a server ko host this crawl component.,

A iated C | Datab
ssoclated Lrawl Database Associabed Crawl Database

Select the crawl database to associate with this crawl component. ektsqaZl\Search_Service_npplicati;l

Temporary Location of Index

Specify the location on this server that will be used for creating the index files before propagating
theri ko the query cormponents, The space required in this directory will be relatively small and
constant, independent of the total number of items crawled.

Temporary Location of Indesx
|C tindex

» Server. Enter the server to which you are currently signed on.
» Associated Crawl database. Select the primary server and the database
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16.
17.

18.
19.
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you specified in Step 4.
« Temporary Location of Index. Accept the default.
The secondary server appears under Crawl (highlighted).

tearch application Topology

Current vl

Category zg::r Status
= Admin
Administration Component ELTSQAZ1  Online

= Crawl - ektsqaz1\Search_Service_Application_1_CrawlStoreDB_30524ebbb9b7459badac7d89c94e2d25
Craw onent 0 EkTSQAZ1  Online

Crawl Component 1 ELTSQAZ0  Initializing
= Databases

Administration Database @ ELTSQAZ1
Search_Service_Application_1_DB_f4654f16f5794a%4bofed468655celec

Crawl| Database : EkTSOAZ1
Search_Service_Application_1_Crawl|StoreDB_30524ebbb9b7459badac?dd9c94e2d25

Froperty Database ! ELTSQAZ1
Search_Service_Application_1_PropertyStoreDB_1ef598b13daad183aZcdbel 387393512

=) Index Partition - D - ektsgaz1\Search_Service_Application_1_PropertyStoreDB_lef598b13daa4183a2c4bel3e739:

Close Search Server Administration.

NOTE: You only need to follow the next 2 steps once. So, if you are setting up
multiple secondary servers, you can skip these 2 steps after setting up the
first one.

On the Ektron server, copy C:\Program Files
(x86) \Ektron\CMS400

versionnumber\Utilities\SearchServer\EktronSearchConfiguration.exe.
On both search servers, paste EktronSearchConfiguration.exe and run it.

On your Ektron Web server, open the Search Configuration screen, available
from C:\Program Files
(x86) \Ektron\CMS400vxx\Utilities\SearchServer\Ektron.Cms.Search.Co

nfig.UI.exe.
Click Advanced Options.

In the Secondary Search Servers section, click Add () then insert the name
of the secondary server(s).

334 | Ektron 9.50




Using Microsoft Search Server features

Secondary Search Servers:

If you've manually setup a distributed Search Server ervironment, the servers hosting your
distributed components also require registration. Pleass identify thoss servers by their
machine name in the list below.

Note: Each senver listed below is reguired fo Aave the sppropriate Elitron search
companants instalied prior to registratian, IF vou fave not already dons =a, pleass instal
those componants (EktronfearchConfiguration.exval before proceeding.

= .

| Reqister Site

20. Click Register Site.

Using Microsoft Search Server
features

NOTE: This section applies to Microsoft search servers. Exceptions within Search
Server versions (including FAST) are noted. For information about Solr search
servers, see Using Solr search on page 204.

Visitors choose search to go your website more frequently than any other navigation
option. Search usage often exceeds links, menus, or site maps. This is especially true
when visitors have a term or phrase in mind. Advanced visitors may narrow down
search results by adding special terms or query strings.

As an administrator or developer, you want to provide the optimum search results
quickly, with the most relevant results near the top. To accomplish this, adjust the

search engine results by setting Using synonym sets on page 348, Suggested
Results, and keywords.

In some cases, you can anticipate what the visitor is looking for and provide a
convenient way to display results with the click of a button or image. To do this,
developers can create automated queries that provide the unique combination of
keywords and terms that provide results that are highly targeted to the visitor's
quest. These queries are found in the code-behind and use the search API.

The website search should provide a simple user interface and relevant results.
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Basic versus advanced website search

To provide your website with search capabilities, your developer places Site Search
server controls on a page. See also: SiteSearch Templated Server Controls

The search may look like the following image, although your developer has total
control over its appearance.

Search

& dvanced Seatch +

Basic search

NOTE: You can designate a folder outside of Ektron to be searched. For more
information, see Including external files in a search on page 359.

The Basic Search finds content that satisfies these criteria.

» Published. Changes checked in but not published are not accessible.

NOTE: New and updated content is available only after the next crawl
completes. See also: Managing the search craw/ on page 368.

» Active. Also, expired content appears if the archive option is Archive and
remain on Site.

» Content’s Content Searchable box is checked.

» Public. Private content is only available to those with permission to view it, such
as membership users after logging in. See also: Making content private on
page 637.

IMPORTANT: Private content is hidden from search results if your search
provider is Microsoft Search Server 2010. It is not hidden if you are using
another search provider.

« Library items are searchable by title and file name. To make the content of non-
image files (for example Word documents) searchable, add them as assets. See
also: Working with assets in the Document Management System on page 649.

» Language

o Website search—Content in selected site language appears unless the
developer sets the language via Advanced Query Text or API

o Workarea search—Content in the Workarea’s current language appears
(user selects Workarea language via the View > Language menu option)

e Search text is contained in title or content

» If the search text is more than one term, all terms must be found. So, multiple
terms have an AND relationship.
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Basic search

NOTE: A user may force an OR relationship by entering OR between search
terms, or using the Advanced Search's any of these words option.
Developers may create an OR-based search using the API property
ImplicitAnd.

IMPORTANT: If you have a multi-site configuration, a search conducted
from any site returns results from all sites. To limit search to single site, use a
syntax like this:

AdvancedQueryText="' AND ( "parentsiteid"=0 OR "parentsiteid"=161

) 1

» Satisfies content type criterion selected on screen, if chosen.
Basic Search

Search

HTML
Documents
Images
Multimedia

Forums
Tags

NOTE: The search does not find documents inside compressed files, such as
*.zip, *.cab, and so on.

The following list explains the values in the Advanced Search tab's Content Type
field.

« Site
o Content from all options.
° Any document file type defined in the Asset Server Setup screen.

NOTE: You can find these files using Site as the content type criterion,
but not using Documents.

« HTML
° HTML

o HTML form (but not data submitted on form)

o XML Smart Form (field values but not field labels)
° Blog entries (not comments)

o Web calendar events

« Documents
o MS Office documents (includes Powerpoint, Excel)

NOTE: To search Visio documents, you must install the Visio IFilter. See
also: Installing the Visio IFilter on page 346

® Document properties (categories, comments, and so on)
o PDFfile
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IMPORTANT: The search only finds text in the first 16 MB of any
PDF document. So, for example, if the file is 32 MB, only the first
half of the text is searchable.

o txt file

Images added as assets and through the library
o Search text in file name (including file type extension) and summary.

NOTE: If you assign several images to an eCommerce catalog entry, and
want to allow searching for that catalog entry by image file name, the
search only works with the first image assigned to the catalog entry.

Multimedia (Flash, .mp3, and so on)
o Search text in file name (including file type extension) or summary
Forums
o Forum posts and replies
Tags
o Tags applied to content and library items See also: Tagging content, library
items, users, and groups with keywords on page 1596
PageBuilder Pages

o PageBuilder page: properties (summary, metadata, and so on) and content
within the page's widgets.

IMPORTANT: If a content block is added to a PageBuilder page, the
search only returns its appearance on the PageBuilder page. The search
does not find such content on a non-PageBuilder page.

Advanced search

The Advanced Search uses the same search criteria as the Basic Search. (See Basic
search on page 336). The differences are additional options and the fact that you
cannot use queries.

NOTE: The advanced search screen may look like the following image, although
your developer has total control over its appearance.”
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Search

Advanced Search =

Show results with
al of these words

none of these words

the exact phrase

atry of these words

Search

- all of these words. Web page includes all submitted terms; their position on
the page does not matter.

» none of these words. Web page does not contain the submitted term

» the exact phrase. Web page must include the exact phrase. For example, if
you enter Ektron healthcare, a page with the term Ektron provides
healthcare is not found because it is not an exact match.

« any of these words. Web page includes any submitted term

Managing search queries

Formulating search queries

NOTE: Following text extracted from Free-Text Keyword Queries.

To search for any word or phrase on a website, enter the word into the field and click
Search to begin.

Web Html Documents Images Multi Media more »

Search | Advanced Search

The following rules apply to formulating queries:

» By default, multiple words have an "and" relationship. So, the search term
calendar server returns pages that have both words.
° To find pages with either term, use the OR operator. For example, calendar
OR server returns pages that have either word.
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IMPORTANT: You must capitalize Boolean operators, such as AND.

o To find pages with several terms in exact order with no intervening words,
use quotes. For example, “calendar server” returns pages that have both
terms in that order.

° To find pages that have one term without another, use the NOT operator.
For example, For example, calendar NOT server returns pages that have
calendar and do not have server.

o To find several terms close together, use NEAR. For example, treatment
NEAR immunoglobulin finds pages with the word “treatment” near the
word “immunoglobulin.”

IMPORTANT: You cannot use the NEAR operator with Solr search
provider.

The NEAR operator is like AND because it finds pages that include both
search words. However, the rank assigned by NEAR depends on the
proximity of the search words. A page with search terms closer together has
a higher rank than a page where they are farther apart.

NOTE: The NEAR operator can be applied only to words or phrases.

Search terms are case-insensitive.
Punctuation marks, such as period (.) and comma (,), are ignored by the search.

Operators (<, >, and &) are ignored by a search. Also, the search does not find
text within angle brackets, for example <Ektron>.

To include in a query special characters that are not operators, such as +, |, »,
#,@,$, (,), enclose the query in quotation marks (*).

Use the wildcard character (*) to find words that start with a certain letter
sequence. For example, esc* returns Web pages with "ESC,” “escape,” and so
on.

To nest expressions within a query, add parentheses. Expressions within
parentheses are evaluated before the rest of the query.

Use double quotes (") to ignore a boolean or NEAR operator keyword. For
example, "Abbott and Costello” finds pages with the entire phrase, not pages
that match the Boolean expression.

The AND operator has a higher precedence than OR. For example, the first 3
queries are equal, but the fourth is not:
° aANDbORC

°© cORaANDD
© cOR (aAND b)
°© (cORa)ANDDb

Using Autosuggest

IMPORTANT: Autosuggest works with Microsoft-based search providers only. If
you are using the Solr search provider, see Managing Solr autoComplete on
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page 285.

Autosuggest is a search feature that suggests similar terms or common refinements
that searchers have used in the past which are related to the search term. As a user
enters text, possible matches appear. This immediate feedback may preclude the
user from typing an entire search phrase, and instead choose a term with which to
launch the search.

guitar]

acoustic guitar
electric guitar

bass quitar

electro acoustic guitars

guitar amp 5
guitar picks

eft handed guitars
guitar hero
classical guitar

guitar strap

Terms appear on the list if they

 include the submitted letters, and

» were previously submitted by site visitors, and

» have resulted in the viewing of a search result
Autosuggest only works with the Site Search Control.

Enabling Autosuggest

1. Every Web page that retrieves search results requires a SiteSearchController
templated server control. See also: SiteSearch Templated Server Control.
In Visual Studio, add the following properties and values to each
SiteSearchController control that will use Autosuggest.

e EnableQueryStatistics="true”
e EnableAutoSuggest="true"

e AutoSuggestMaxCount—the maximum number of entries in the
autosuggest list

2. On your search server machine:
a. Go to IIS Manager and expand the EktronSearchSite IIS Site.

b. Right click EktronSearchStatistics and choose Explore.
c. Under EktronSearchStatistics, open web.config.
d

. Within that file, set NumberOfClicksToTrigger to 1, 2 or 3. This key defines
the number of times a user chooses an autosuggest search term and then
clicks on a search results page before the term is added to the suggested
results list.
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For example, you decide that a term is added to the list only after it is
selected and users click on the results page 3 times.

Adding a term to Autosuggest

Normally, you would not add autosuggest terms, because the terms list is built from
previous successful searches. However, there may be times when you want to add
autosuggest terms that direct searches to specific content. To manually add terms to
the autosuggest list, follow these steps.

PREREQUISITE

Knowledge of SharePoint Powershell cmdlets

1. Log on to your search server.
2. Open the SharePoint 2010 Management Shell.
3. Add a term to the autosuggest list by inserting this command.

New-SPEnterpriseSearchlLanguageResourcePhrase
—SearchApplication <Search Service Application>
—-Name <Name of the term>

-Language <en-US>

-Type QuerySuggestionAlwaysSuggest

Command Parameters

» If you are using a Microsoft FAST search server, for <Search Service
Application>, enter the Search Service Application you created for FAST
Query in Part 2d: Create a search service application for querying on
page 429.

» If the search term has more than one word, surround it with double quotes.
For example, "Phrase Term."

» For Language, enter a language code followed by the locale code (as
examples: en-US, en-UK).

4. Remove the term from the block list (if it exists there) by inserting this
command.

Remove-SPEnterpriseSearchlLanguageResourcePhrase
—SearchApplication <Search Service Application>
-Identity <Name of the term>

-Language <en-US>

-Type QuerySuggestionBlockList

5. Run the timer job.

Get-SPTimerJob
-Identity "Prepare Query Suggestions" | Start-SPTimerJob

6. Check the Last Run time against the current time.

7. When the Timer Job shows the Last Run Time as the current time, the operation
has succeeded, and the term is added to the suggested terms list.

Example of adding a term to Autosuggest
To manually add a suggestion for ektron:

Sapp = Get-SPEnterpriseSearchServiceapplication "FASTQuery"
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New-SPEnterpriseSearchlLanguageResourcePhrase
-SearchApplication $app

-Language en-us

-Type QuerySuggestionAlwaysSuggest

-Name “ektron”

If ektron was added to the Block list, it must be removed. (If it does not exist and
you run these commands, you get an error: Given key not present in the
dictionary.)

Remove-SPEnterpriseSearchlanguageResourcePhrase
—-SearchApplication $app

-Identity ektron

-Language en-us

-Type QuerySuggestionBlockList

(Get-SPTimerJob —-Identity “Prepare Query Suggestions”) .RunNow ()

Wait 3 minutes to see results.

Removing a term from Autosuggest

You may need to remove inappropriate or derogatory terms from the autosuggest
list. To do that, a term to the block list by following these steps.

PREREQUISITE

Knowledge of SharePoint Powershell cndlets

1. Log on to your search server.

2. Open the SharePoint 2010 Management Shell.

3. Add a term to the block list by inserting this command. See also: Command
Parameters on the previous page

New-SPEnterpriseSearchlLanguageResourcePhrase
—SearchApplication <The Search Service Application>
-Name <Name of the term>

-Language <en-US>

-Type QuerySuggestionBlockList

4. Run the timer job.

Get-SPTimerJob
-Identity "Prepare Query Suggestions" | Start-SPTimerJob

5. Check the Last Run time against the current time.

6. When the Timer Job shows the Last Run Time as the current time, the operation
has succeeded, and the term is blocked from the autosuggest list.

If you later decide to remove a term from the block list, use this command.

Remove-SPEnterpriseSearchlLanguageResourcePhrase
—SearchApplication <The Search Service Application>
-Identity <Name of the term>

-Language <en-US>

-Type QuerySuggestionAlwaysSuggest

Example of removing a term from Autosuggest
To block the term ontrek
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Sapp = Get-SPEnterpriseSearchServiceApplication "FASTQuery"

New-SPEnterpriseSearchlLanguageResourcePhrase
-SearchApplication $app

-Language en-us

-Type QuerySuggestionBlockList

-Name ontrek

Remove the term from the suggestion list, if it exists. (If it does not exist and you run
these commands, you get an error: Given key not present in the dictionary.)

Remove-SPEnterpriseSearchLanguageResourcePhrase
—SearchApplication $app

-Identity ontrek

-Language en-us

-Type QuerySuggestionAlwaysSuggest

(Get-SPTimerJob —-Identity “Prepare Query Suggestions”) .RunNow ()

Wait 3 minutes to see results.

Viewing the blocked words list
To view the blocked words list, enter

Get-SPEnterpriseSearchLanguageResourcePhrase
—SearchApplication <Search Service Application>
-Language en-US

-Type QuerySuggestionBlockList

Troubleshooting Autosuggest

If you don't see the autosuggest drop-down, try the following.

1. Open all (3) web.configs and verify that they contain the same values for the
QuerySSA and ProviderAdmin keys.

2. Open C:\Program Files
(x86) \Ektron\EktronSearchServerService\EktronSearchServerHelperSer

vice.exe.config and verify that the following keys have correct paths.
» QueryServiceEndpoint
* QueryStatisticsEndpoint
» QuerySuggestionEndpoint
3. Inthe SharePoint Management Shell, enter
Get-SPEnterpriseSearchQuerySuggestionCandidates -SearchApplication

"<Search Service Application Name>".Inspectthe command for your
autosuggest word.
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& Administrator: ShareFoint 2010 Management Shell =]

Schedule Last Run

query sug... daily between 81:... 432012 11:53:81

“* Get-8PTimerJob —Identity "Prepare Query Suggestions'

Last Run

8 Query sug... daily between Bl:... 432812 11:53:81

» Get—SPTimewJoh —ldentity “"Prepare Query Suggestions™

Name Schedule

Prepare guery sug... daily between Bl:z... 4~ :57:16 AH

PS8 Ciny Get—-SPEnterpriselearchQuerySuggestionCandidates —SearchApplication “'Sear
ervice Application"”

« If the command returns a blank screen, check the
C:\inetpub\EktronSearchSite\EktronSearchStatistics directory for a
logs folder. If this folder is empty, verify that the SiteSearchController
contains EnableQueryStatistics="true” and
EnableAutoSuggest="true”.

» If your list appears but the autosuggest drop-down does not, verify that
your SiteSearchController contains EnableAutoSuggest="true".

4. Manually test that autosuggest words are returned to your site by entering the
URL on the Ektron server.
http://<Your EktronSearchSite website:Port # >
/EktronQuerySuggestion/SPQuerySuggestion.svc
/QuerySuggestionForCulture?keywordPrefix=sa&culture=en-US

NOTE: 'sa’ is the prefix you used to return autosuggest entries.

After submitting this url, download and open QuerySuggestionForCulture file in
Notepad to see autosuggest results. To continue the above example, you might see
{"QuerySuggestionForCultureResult": {"Suggestions": ["sample"]}}

The "Did you mean?" feature

If a site visitor enters a word that is similar to a crawled term, the "Did you mean?"
feature often suggests close alternatives. If you click a suggested term, a search is
performed on it.

|e ktran

Advanced Search

Did vou mean
ektron

The "Did you mean?" feature works only with single word queries.
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NOTE: If your search provider is Solr, the "Did you mean?" feature only works
with words in the content title.

Managing searchability of Ektron content

Making content searchable

Search only accesses data about the content if the Content Searchable field is
checked.

NOTE: Despite the value of this checkbox, if an Ektron user places this content
item in a Suggested Results list, it appears in the Suggested Results area of the
Search Results screen. See also: Providing suggested results on page 350.

Also, even if Content Searchable is unchecked, the Advanced Workarea search
can find the content.

The default value of this field is determined by the ContentSearchable folder
property.

Yiew Content “Sample Content Block™

¢ oom | @ X P o e wuﬂn@@ % ‘A

Properties Summary Metadata Alias Ci

Ektron CM5400.NET Server Controls

View Properties for the Content "Sample Content Block™

Developer productivity is a c
smaller teams, and compres ¢ UPDATE 9
developers need every advan )

Content Searchable

Flanninn Nafinitinne

Installing the Visio IFilter

The search finds text within Visio documents if the Visio IFilter is installed to the
Microsoft Search Server used by the Ektron Web server. Use the following link to
download and install the Visio IFilter.

Microsoft Office 2010 Filter Packs

IMPORTANT: The Visio IFilter does not work with the Solr search provider.

Searching for metadata

The following rules apply when searching for values inside metadata.

346 | Ektron 9.50


http://www.microsoft.com/downloads/en/details.aspx?FamilyID=5CD4DCD7-D3E6-4970-875E-ABA93459FBEE&amp;displaylang=en

Managing search results

» The search finds text within Searchable type and Content Tag metadata fields.
For example, a content block has a searchable type metadata field,
MapAddress, that contains 131 Amherst St. Searching for 131 returns that
content.

» To find content with searchable metadata whose style is yes or no, enter true
or false.

See also: Working with Metadata on page 755

Managing search results

Displaying search results
See also: Search result ranking on the next page

The following example shows the website search results screen. Your developer can
customize it using the appropriate ResultsView server control. For example, to
display eCommerce catalog entry results, the developer uses ProductSearch
templated server controls.

medical Search

Medical Workshop
Medical Workshop http://www.ektron.com/ 2006-04-11 12 00 PM 2006-04-13 12 00 PM -05 Las Vegas ..

http://smacdonaldl/ChS400Developer/dynamic.asprTid=478 4/11/2006 1:15:02 AM

American Medical Association Complete Medical Encyclopedia

The only new major medical encyclopedia ... American Medical Association Complete Medical Encyclopedia General Tom Smith American
Medical Association .. cosmetic surgery. Written and reviewed by top medical doctors and specialists, the Complete Medical Encyclopedia ..
sets anew standard for consumer medical reference. Medical editors for this AMA-authored book were Jerrold ...
http://smacdonaldl/CM3400Developer/products. aspxTid=332 4/14/2006 32748 AM

American Medical Association Familv Medical Guide

Medical bibles go out of date quickly. Diseases do not change, but our understanding of them does ... American Medical Association Family
Medical Guide General American Medical Association Wiley 28.33 2004-08-23 AMAFMG __.

uploadedimages/ChME400Demo Book_Store/ ANMAFamilyGuide zif false Medical bibles o out of date quickly ..

Customizing the postback message

By default, if a search term yields no results, a message appears.

Your search did not match any documents.
Suggestions:

+ Make sure all words are spelled correctly.
+ Try different keywords.
s« Try more general keywords.

To customize this message:
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1. Inyour site root folder, find the workarea/resources folder.

2. Open the resource file that corresponds to your site’s language. For example, if
your site is in American English, open EkResource.en-US.resources. To learn
how to work with a resource file, see Translating the Workarea on page 1431.

If your site supports multiple languages, follow these steps for each corresponding
resource file.

a. Within the resource file, find the key 1bl search no results.

b. The default text (shown above) follows this key. Modify the text as needed.

c. Save thefile.

Search result ranking

NOTE: This topic describes search rank using Microsoft Search Server 2010. To
learn about search rank using Microsoft FAST Search Server 2010, see Setting Up
Microsoft Search Server 2010 on page 302.

Each content item found by search is given a numerical rank. Search results are
sorted by rank. Criteria used to calculate rank include the

« number of occurrences of the search term

» proximity of search term to beginning of file

» proximity of search term to other occurrences of the term

« whether the term is in the title

If you need to ensure that certain content appears at the top of search results when
certain terms are entered, use suggested results. See also: Providing suggested
results on page 350

To learn about customizing ranking for Microsoft Search Server 2010, see

e Custom Ranking Models with SharePoint 2010: Background, Value and
Administrative Overview

» Creating Custom Ranking Models
« SharePoint 2010 enterprise search developer training

Using synonym sets

You must be a member of the Administrators Group or assigned the
Search-Admin role to access Synonym Sets. See also: Defining roles on
page 1464

IMPORTANT:

*Changes to a Synonym Set reset Search Server. To minimize impact on your
visitors, make such changes during off-peak hours.

* Synonym Sets apply to all Ektron sites associated with a Search Server instance.
For example, if Site A, Site B, and Site C use the same Search Server instance,
they share Synonym Sets. This means that a Synonym Sets created in Site A may
affect Site B's search results.

348 | Ektron 9.50


http://calvisblog.wordpress.com/2010/06/21/custom-ranking-models-with-sharepoint-2010-background-value-and-administrative-overview/
http://calvisblog.wordpress.com/2010/06/21/custom-ranking-models-with-sharepoint-2010-background-value-and-administrative-overview/
http://msdn.microsoft.com/en-us/SP2010DevTrainingCourse_CreatingCustomRankingModels.aspx
http://msdn.microsoft.com/en-us/sharepoint/ff960982

Creating a synonym set

You can create sets of synonyms to work with the search. If a site visitor enters into
the search field any term in a synonym set, the search returns results for that term
plus all other terms in the set.

For example:

e« Synonym Set: Tuition

« Terms: tuition, bill, payment, pay, fee, charge, price, amount, cost, balance
If a site visitor inserts bill into the search field, Ektron uses bill or tuition or
payment or pay or fee or charge, and so on., to determine search results.

The Synonym feature typically produces more “hits.” So, while visitors do no more
work, their chances of finding the right information are greatly increased.

NOTE: Previous to version 8.5, you could use Synonym sets in Suggested
Results. This is no longer provided in versions 8.5 and higher.

BEST PRACTICES FOR USING SYNONYM SETS

A search term can consist of several words as long as the term is entered
the same way in the Synonym Set. For example, love seat is part of a
Synonym Set that includes sofa. As long as both love and seat are in a
content item, the search finds it even if the words are separated. But,
entering a single term, like love, will not find that Synonym Set. So, if you
think people may search using loveseat or love seat, enter both terms
into the Synonym Set.

The metadata search does not use or support Synonyms Sets.

If a search term consists of several words, it does not return synonym
match results.

For example, you create a synonym set that contains {cms; content
management system}. If a site visitor enters CMS, the search results
include matches for cms and content management system. But, if the
site visitor enters content management system, the results do not
include matches for cms.

Creating a synonym set

IMPORTANT: A term can only appear in one Synonym set.

1. Choose Workarea > Settings > Configuration > Search > Synonyms.

2. Select a language for the Synonym Set from the language drop-down menu.
(The search is language-specific. When site visitors begin using your site, they
select a language. Only synonyms sets in that language are considered.)
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Click Add Synonym. The following screen appears.

Add Synonym Set

€ || SAVE SYNONYMS L2

Terms:

Flzase enter the terms that will be synonyms for one another. Separate each term with a semicelon (). Mote: Any illegal

characters will be removed from the terms.

[ Check for Duplicates ]

. Enter all terms in the set. Separate each with a semicolon (;). You cannot enter a

comma (,) or parenthesis character (().

Click Check for Duplicates. Ektron compares these terms against other
Synonym Sets in this language. If the same term is found in another set, you are
notified and must remove it.

Click Save Synonyms.

Editing a synonym set

A

7.

Choose Workarea > Settings > Configuration > Search > Synonyms.
Select a language for the Synonym Set from the language drop-down menu.
Click the Synonym Set that you want to edit.

Click Edit. The Edit Synonym Set screen appears.

Add or remove terms. Be sure to separate each term with a semicolon (;).

Click Check for Duplicates. Ektron compares these terms against other
Synonym Sets in this language. If the same term is found in another set, you are
notified and must remove it.

Click Save Synonyms.

Deleting a synonym set

ua A W N =

Choose Workarea > Settings > Configuration > Search > Synonyms.
Select a language for the Synonym Set from the language drop-down menu.
Click the Synonym Set that you want to delete.

Click Delete (#%).

Confirm your action.

Providing suggested results

You are a member of the Administrators Group or assigned the Search-
Admin role See also: Defining roles on page 1464

Your website may contain thousands of content items. Sometimes, depending on the
search phrase, you want to focus the visitor's attention on a few topics. The
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Using suggested results to enhance business

Suggested Results feature lets you create a set of search terms, then specify content
to appear at the top of the results when someone searches on a term.

Suggested Result links can jump to your website or an external website.

Basic Search || Advanced Search

content Site b

Site Results 1 - 8 of 8 for content. (0.14
seconds)

Ektron

Ektron CMS400.MET is the Full-Featured, Affordable
Solution. Since its founding in 1998, Ektron has
provided affordable Web content management and
authoring solutions. Ektron understands what a
successful Web, intranet or extranet site needs.

Suggested result ._

€] Ektron to Demonstrate Healthcare 2/28/2006
3:94:07 AM

Healthcare Content Indexing Framework” which enables
hospitals, medical groups and health insurers to deliver
indexed content via the Web.. Ektron to Demonstrate
Healthcare. Ithcare Content Indexing Framework at HIMSS
Dallas, TX, February 14, 2005 -Ektron Inc. an innovator in
Web content management... )

ID=31 Size=t KB Regular search

results

\ J

IMPORTANT:

* Prior to Ektron version 8.5, Suggested Results could be language-specific.
Beginning with version 8.5, Suggested Results do not filter based on language.
* As of version 8.5, Suggested Results do not use terms from the Synonyms Set

feature.

Using suggested results to enhance business opportunities

You can use Suggested Results to direct site visitors to business partners' websites.
One example is a smoking cessation clinic near your hospital. When someone visits
your website and searches for smoking, you can set the clinic to be the top

Suggested Result.

As another example, your organization creates widgets but does not implement or
customize them. Over time, several agencies develop experience at deploying and
customizing your widgets. Therefore, you want to promote the supporting businesses

on your site. The following steps describe how this works.

1. Create a phrase with synonyms—deploy, install, implement, customize, modify,

adapt.
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2. Assign the websites of approved agencies to the Suggested Results list.

3. When a site visitor searches for the word implement, he gets links to those
agencies’ websites.

Suggested Results can also be used to advertise products, as used in the sponsored
results section of search engines like Google® search and Yahoo!®.

Using suggested results to direct site visitors

Use this feature to provide search results that do not naturally appear at the top of
the page. For example, you manage a university’s website. When a site visitor wants
to know where to mail a tuition payment, he enters bill into the search field and gets
these results.

» Faculty member Bill McDermott

 The Student Bill of Rights

- How a Bill Becomes Law
Frustrated, many people call the business office to get information that exists on the
website but is difficult to find.

Using Ektron, you create Suggested Results to direct site visitors to the correct Web
pages. To continue this example, you could create
 atitle (such as Tuition) that describes a set of terms and links

« a list of synonyms that visitors might enter when searching for the tuition page
on your site

» a Suggested Results list, where you assign the content “"Tuition & Fees”

Add Suggested Results

4 SAVE SUGGESTED RESULTS 30
Hame Tuition
Phrases tuition;account;check;invoice;statement;balance
Enter terms that, when searched, return the content listed below in the suggested results area of
search results. Separate each term with a semicolon ().
Suggested Results Click below to see your option

Tuition and Fees
Fall bills are posted to student Blackboard accounts in mid June and are due in early December.

After you set up Suggested Results, this is a typical sequence of events.
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Using suggested results to direct site visitors

A site visitor enters text on your Search page.

Basic Search || Advanced Search

balance] Site w

The text matches a term in the Phrases list of a Suggested Results set.
Add Suggested Results

4 | SAVE SUGGESTED RESULTS L2
Name Tuition
Phrases

tuition;account;check;invoice; statemen(;balance

Enter terms that, when searched, return the content BT oelow in the suggested results area of

search results. Separate each term with & semicolon ().

Suggested Result links assigned to the phrase appear in a special area of the
results page. They appear in the same order that you created in the Suggested
Results set.

NOTE: The following example shows how suggested results may appear.
Your developer styles suggested results in the ResultsView server control.
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Basic Search || Advanced Search

3:54:07 AM

Web content management...
ID=31 Size=5 KB

4. The search term’s regular results may also appear. Your developer determines

their location on the results page.

Creating a set of suggested results
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Site Results 1 - 8 of 8 for content. (0.14
seconds)
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Ektron CMS400.MNET is the Full-Featured, Affordable
Solution. Since its founding in 1998, Ektronhas
provided affordable Web content management and
authoring solutions. Ektron understands what a
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T Suggested result

€] Ektron to Demonstrate Healthcare 2/28/2006

Healthcare Content Indexing Framework” which enables
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Healthcare. Ithcare Content Indexing Framework at HIMSS
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Creating a set of suggested results

1. Workarea >Settings > Configuration > Search > Suggested Results.
2. Click Add New Suggested Result Set. The following screen appears.

Add Suggested Results

4 | SAVE SUGGESTED RESULTS L2
Name
Phrazes

Enter terms that, when searched, return the content listed below in the suggested results are

Suggested Results

3. Complete the fields.

« Name. A word that names the Suggested Results set and is the first
synonym. (You cannot repeat the phrase in the Synonyms.)

« Phrases. The list of words that triggers the Suggested Results you will
create. That is, if a user enters a search phrase that matches any term in
the Synonyms, the Suggested Results appear.

¢ Suggested Results. The links to appear when a phrase or synonym is
found. To define them, place the cursor in this field and click. A menu
appears.

Add

Edit

Move Up
Move Down

Delete

4. Click Add. A screen appears.

5. Add the URL, title, and summary for each suggested result.
» Link. To create a link to...
o content on your website, click the Browse to CMS content button.
Then, go to the folder that contains the content, select it, and click
Save.

NOTE: Only content in the Workarea language appears. To change
the language, exit this screen, go to the root folder, and click View
> Language.
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o an external website, enter its full address, starting with its protocol,
such as http://.
» Title. If you created a link to...
o content on your website, its title is retrieved and displayed here. You
may edit it as needed.
o an external website, enter the text of the link that will appear on the
Suggested Results display.

Site visitors use this text to select the linked Web page.

[Tuition & Fees)

Undergraduate tuition bills are generated twice
a year, in mid-July for the fall semester,

and in mid-November for the spring semester.
Bills are no longer sent through the mail — they

« Summary. If you created a link to...
o content on your website, its summary appears here. You may edit it as
needed.

o an external website, nothing appears. Enter text to further describe this
link on the search results page.

The summary cannot exceed 320 characters (including HTML tags). For
example:

Tuition & Fees

ndergraduate tuition bills are generated twice

a year, in mid-July for the fall semester,

and in mid-November for the spring semester.

Bills are no longer sent through the mail — they are
osted to students'

6. Click Add New Suggested Result Set. The Add Suggested Results screen
reappears. You can add more links, edit existing ones, and so on.

7. Click Save Suggested Results.

Displaying suggested results

To display suggested results using templated server controls, set up a
SiteSearchResultsView control whose Eval statement refers to SuggestedResults.

<ektron:SiteSearchResultsView ID="r" runat="server" ControllerID="c">
<ItemTemplate>
<h3>Suggested Results</h3>
<asp:ListView ID="suggestedResults" runat="server"
DataSource="'<%# Eval ("SuggestedResults") %>'>
<ItemTemplate>
<span class="highlight">
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<a href="<%# Eval ("Url") $%>"><%# Eval ("Title") %></a>
<%# Eval ("Summary") %>

</span>

</br>

</ItemTemplate>
</asp:ListView>
</ItemTemplate>
</ektron:SiteSearchResultsView>

The suggested results class displays only 3 fields: title, URL, and summary.

If you want regular search results to appear below suggested results (as shown in
Providing suggested results on page 350), your developer may want to style the
suggested results to stand out. Some styling is shown above.

To display regular search results below suggested results and customize the standard
result template, make the following modifications.

<ektron:SiteSearchResultsView ID="r" runat="server" ControllerID="c">
<ItemTemplate>
<h3>Suggested Results</h3>
<asp:ListView ID="suggestedResults" runat="server"
DataSource="'<%# Eval ("SuggestedResults") %>'>
<ItemTemplate>
<span class="highlight">
<a href="<%$# Eval ("Url") $>"><%# Eval ("Title") %></a>
<%# Eval ("Summary") %>
</span>
</br>
</ItemTemplate>
</asp:ListView>
<asp:ListView ID="suggestedResults" runat="server"
DataSource='<%# Eval ("Results") %>'>
<ItemTemplate>

</ItemTemplate>
</asp:ListView>
</ItemTemplate>
</ektron:SiteSearchResultsView>

However, if you want to display standard results and use the default template, insert
a separate SiteSearchResultsView control below the suggested results control. See
also: SiteSearch templated server controls.

Adding a link to a suggested result set
1. Choose Workarea > Settings > Configuration > Search > Suggested
Results.
Select the suggested results set to which you want to add a link.
Click Edit.
Place the cursor over the first result in the Suggested Results area of the screen.
Click once and a menu appears.
Click Add. The Add New Suggested Results screen appears.

o s WN
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. See Click Add New Suggested Result Set. The Add Suggested Results screen

reappears. You can add more links, edit existing ones, and so on. on page 356

. Click Add New Suggested Result Set.
9.

Click Save Suggested Results.

Editing a link in a suggested result set

1.

9.
10.

® NSO WUN

Choose Workarea > Settings > Configuration > Search > Suggested
Results.

Select the suggested results set that you want to edit.

Click Edit.

Place the cursor in the suggested results area of the screen.
Place the cursor on the result that you want to edit.

Click once and a menu appears.

Click Edit.

See Click Add New Suggested Result Set. The Add Suggested Results screen
reappears. You can add more links, edit existing ones, and so on. on page 356

Click Add New Suggested Result Set.
Click Save Suggested Results.

Removing a link from a suggested result set

1.

WoOoNOUAWDN

Choose Workarea > Settings > Configuration > Search > Suggested
Results.

Select the suggested results set from which you want to remove a link.
Click Edit.

Place the cursor in the suggested results area of the screen.

Place the cursor over the result that you want to delete.

Click once and a menu appears.

Click Delete.

Click OK.

Click SaveSuggested Results.

Rearranging the sequence of a suggested result set

1.

@ N U R WD

Choose Workarea > Settings > Configuration > Search > Suggested
Results.

Select the Suggested Results set from which you want to remove a link.
Click Edit.

Place the cursor in the suggested results area of the screen.

Place the cursor over the result that you want to move up or down.
Click once. A menu appears.

Click Move Up or Move Down.

Click Save Suggested Results.
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Deleting a suggested result set
1. Choose Workarea > Settings > Configuration > Search > Suggested
Results.
2. Select the suggested results set that you want to delete.

3. Click Delete (+%).
4. Click OK to the confirmation message.

Including external files in a search

Use integrated search if you want the search to include files outside of Ektron but
located on your Web server. For example, you want a folder full of press releases to
be searchable but do not want to add them to Ektron. Instead, you follow the steps in
this section to make the folder searchable, and search results include the press
releases.

NOTE: The descriptions below refer to the folder that is not part of Ektron as the
external folder.

You can search non-Ektron content by file title. For example, you can find Ektron.gif
by inserting Ektron into the search field. In addition, you can find a variety text-
based files, like .doc, .pdf, and .txt, by searching their text. Finally, Microsoft Search
Server 2010 searches file metadata for media files.

Step 1: Place content in an external folder

External folders must reside in the website folder so IIS has permission to access
their content. Best practice is to create the external folder under the Webroot. Then,
place content in the folder for the integrated search.

Set permissions for the external folder

The top-level folder that contains the external files must be accessible to the website,
and the user account used by search server must have permission to read it.

The following example creates a user called IntegratedSearchUser and shares the
external folder. Search Server uses the IntegratedSearchUser account to access the
external folder's content.

1. Onthe Web Server, start Control Panel > Administrative Tools >
Computer Management and create a new user called
IntegratedSearchUser.

2. Using Windows Explorer, right click the external folder and choose Share.
3. Enter the IntegratedSearchUser user.
4. Click Add.

IntegratedSearchUser now has read permission for the external folder.

Step 2: Create a content source for the external folder
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1. Onyour search server, open the SharePoint 2010 Central Administration screen.

2. Goto Manage service applications > Search Service Application >
Content Sources > New Content Source.
If you are using Microsoft FAST Search Server 2010, go to Manage service

applications > FastContent Connector > Manage Content Sources >
New Content Source

3. Enter the following values.
» Enter a Name for the content source.
» Inthe Content Source Type field, choose File Shares.
» In the Start Addresses field, enter the external folder as a UNC path
(\\server\directory) or full file URI (file://server/directory).
° To make sure the search can access the external folder, you may want
to use cs$ in the path, like this: \\serveri\c$\integratedsearch.

» Set up Crawl Schedules for your integrated search folder contents to
automatically refresh search indexes as frequently as you need to keep
search results reliable. (This schedule is different than the crawl schedule
for Ektron content.)

» Begin a crawl by checking Start full crawl of this content source.

» Click OK.

If you successfully set this up, you see the new content source and the status
shows "starting".

Step 3: Create scope for a content source

NOTE: If you are using Microsoft FAST Search Server 2010, you can ignore Steps
3 and 4 proceed to Step 5.

1. On your Search Server, open the SharePoint 2010 Central Administration
screen.

2. Go to Manage service applications > Search Service Application >
Queries and Results > Scopes.
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10.

11.
12.

A fte .
~SharePoint 2010 Central Administration »

Administration System Status

Search Administration crawl status

Farm Search Backaround motivity
Administration Background activity
Recent crawl rate
- - Searchable items
Crawling
Recent query rate
Content Sources a ’

Crawl Rules Propagation status

Default content access

Crawl Log
) Contact e-mail address
Server Name Mappings

Step 4: Add external folder to Ektron website

account

Search Service Application: Search Administration

Online for crawling
Computing ranking
0.03 iterms per secomn
1,723

0.00 gueries per mint
Propagation not requi
SMACDONALDIVADmM

someone@example.c

R = Mone
Host Distribution Rules
File T S = update status Idle
ile Types
Index Reset S = update schedule Automatically schedu
ndex Rese
Scopes needing update 0
Crawler Impact Rules " aup _
Search alerts status On Disable
) Query logging on Disable
Queries and Results -
Authoritative Pages
Federated Locations
Metadata Properties Crawl History
Content Source Type Start Time End Time

Search Result Removal

Click New Scope.

Give it a Name (no spaces) and Description.

Leave Use the Default Search Results Page checked.
Click Ok. The View Scopes screen reappears.

Use the pull-down next to the new scope name and select Edit Properties and
Rules.
Ontrek PDFs

Integrated Search Folder
Make Copy as Shared
¥ Delete

Add a New Rule.
In the Scope Rule Type field, select Content Source.

In the Content Source field, select the content source you created in Step
2: Create a content source for the external folder on page 359.

Set Behavior to Include.
Click Ok.

Step 4: Add external folder to Ektron website scopes

NOTE: If you are using Microsoft FAST Search Server 2010, you can ignore Step 4
proceed to Step 5.

This step insures that the external folder content is included in Ektron search results.
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Open the SharePoint 2010 Central Administration screen.

Go to Manage service applications > Search Service Application >
Queries and Results > Scopes.

Aronnfts .
; SharePoint 2010 Central Administration » Search Service Application: Search Administration

Administration System Status
= i At 1 . - -
Search Administration Crawl status Online for crawling
Farm Search B e o g ST
Administration Background activity Computing ranking
Recent crawl rate 0.03 items per secomn
_ X Searchable items 1,723
Crawling
Recent query rate 0.00 gueries per mint
Content Sources q ’ 4 P
Propagation status Propagation not requi
Crawl Rules pad pag a
Default content access account SMACDONALD1VADM
Crawl Log
Contact e-mail address someone@example.c

Server Name Mappings

L X Proxy server Mone
Hast Distribution Rules
es update status Idle

File Types
es update schedule Automatically schedu
Index Reset

[=]

Scopes needing update
Crawler Impact Rules " g up

Search alerts status On Disable
) Query logging On Disable
Queries and Results =
Authoritative Pages
Federated Locations
Metadata Properties Crawl History
Content Source Type Start Time End Time

Search Result Removal

Use the pulldown next to your Ektron website's content source and select Edit
Properties and Rules.

Click New Rule.
In the Scope Rule Type field, select Content Source.

In the Content Source field, select the external folder that you created in Step
2: Create a content source for the external folder on page 359.

In the Behavior field, select Include.
Click OK.

Step 5: Add a crawl rule for the integrated search user

This step sets the permission for the search server to access the external folder.

1.

On your Search Server, open the SharePoint 2010 Central Administration
screen.

Go to Manage service applications > Search Service Application >
Crawling > Crawl Rules.

Click New Crawl Rule.

Set the path to the external folder. (For example:
\\ws10196\PressReleases\*.)

Set the Crawl Configuration to Include all items in this path.
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Step 6: Complete the integrated search mappings

Set Specify Authentication to Specify a different content access account.
Enter the Account. (For example: IntegratedSearchUser.)

Enter the Password and Confirm the Password.

Uncheck Do not allow Basic Authentication.

10. Click Ok.

© ® N

Step 6: Complete the integrated search mappings screen

You are a member of the Administrators Group or assigned the Search-
Admin role See also: Defining roles on page 1464

1. Choose Workarea > Settings > Configuration > Search > Integrated
Search Mappings.

Integrated Search Mappinags

ul

Select a start address and enter the corresponding URL path, relative to your site root. Press @' to save it

Start Address Wapping

file:/fws10196/Press%20Releases -

Example: /WMyWirtualDirectony'Files’

2. In the Start Address field, find the external folder.

3. In the Mapping field, enter the path to the external folder relative to your site
root.

4. Click () to save.

Troubleshooting integrated search

» Problem. The protocol handler cannot be found. Check that the handler has
been installed

The protocol handler is normally installed in this folder.

c:\windows\system32\DatabaseProtocolHandler.dll

Solution. If the handler is in the correct place, check that all folder names and
paths are correctly entered in the Content Sources, Crawl Rules and Scopes in
the Search Service Application settings.

* Problem. Item was not crawled because of a password change. Update
password and retry crawling.

Solution. Verify that the Search Server user account has permission to read and
write to the content database. You may have to create a unique user on the
content server for this purpose.

Searching the Workarea
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You can search any Workarea folder to locate content within it. The following sections
explain the Workarea search.

Searching a folder hierarchy

1. Go to the folder from which you want to begin the search.

NOTE: To search the entire site, search from the top-level (Root) folder. To
limit the search to a folder (and its subfolders), select it then enter search
criteria.

2. Click Action > Search. The Search Content Folder screen appears.

Search Content Folder 2

4 e

Search Published Advanced Search

Search

» Search Published is the same as the Site Search, except your results are
only retrieved from the current folder and its subfolders. If your search
provider is Microsoft Search Server or Microsoft Search Server Express, you
must have read-only or greater permission for the folder.

° You can search for content that contains a metadata value. To do this,
use the pattern emtmetadata definition: metadata value. For example,
if the metadata definition is "MapAddress" and the value is "London",
enter emtmapaddress: london.

Note that the metadata definition type must be "searchable
property." And, you must enter the definition in all lowercase letters,
even if the name includes uppercase letters.

» Advanced Search lets you expand search to include internal properties,
such as last editor, date created/modified, status, and comments. See also:
Using advanced search in the Workarea below

Using advanced search in the Workarea

The Workarea Advanced Search lets you find content using information that content
authors and publishers would typically know. For example, you can search for
content edited by a particular author within a date range.

When performing a search, enter one or more words into the text box, select search
preferences, then click Search.
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You can use an asterisk as a wildcard character to stand for any character. For
example, the phrase CMS*00 returns topics that include CMS400, CMS300, CMS200
and CMS100.

Your system administrator can add custom search fields that only appear if a user is
logged in. For more information, see Working with Metadata on page 755.

IMPORTANT: The Advanced search finds content whether or not it is marked
Searchable.

The Workarea Advanced Search finds content that satisfies these criteria.

» user has read-only or greater permission for content’s folder
» matches selected language, if site is multilingual
» satisfies criteria entered on the screen

Search Published Advanced Search

] Content [l Forms [ Assets

Include Archived

Search Text:

All the words: -

Match Partial Words

Title:
Comments:

Date Created: None]
Date Modified:

Last Editor's Last Name:

Status: Any -

The Advanced Search screen lets you find Ektron content by specifying the following
criteria. While the fields are optional, the search only returns content that satisfies all
criteria.

» content type (for example, HTML content, forms, assets)

» one or more search terms. Unlike the Search Published screen, you cannot use

a query.

» to search title only, enter search text into the Title field

» to search comments, enter search text into the Comments field

» arange of created or modified dates
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» the editor who created or most recently updated the content
» the content’s status
» any searchable metadata assigned to the folder

Specifying content type to search

Near the top of the screen, check boxes let you determine the types of content to
search.

W content ¥ Forms W Assets
™ tnclude archived

« Content. HTML content, blogs entries, and XML Smart Form field values
« Forms. HTML forms

» Assets. Content that is neither HTML nor XML, such as Office documents and
managed files. See also: Working with assets in the Document Management
System on page 649

» Include Archived. Content, forms and assets that were archived using the
Archive and remove from site or Archive and remain on Site option

Specifying a search word or phrase

In the Search Text field, enter one or more words that you want to find within
content, forms, and assets. Entering text here is optional. That is, you can use the
other fields to find content.

If you enter several terms, specify a logical relationship among them in the pulldown
under the Search Text field.

Search Text: I

|AII the words -

. _|All the words
Use pulldown to define = T —

| logic among search terms | Exact Phrase
) 2 Content ID

Title: |

« All the words. all words in the Search Text field. All Words is an “and”
function. The search returns only content that has the words content and
management and system. The words can be in any order within the content.

« Any of the words. any word in the Search Text field. This is an “or” function.
It returns content that has at least one of the words in the Search Text field; it
returns content with the word content or management or system.

» Exact Phrase. all words in the order specified in the Search Text field.
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Specifying additional search criteria

+ Content ID. To find content by ID number
1. Inthe Search Text field, enter the ID number.

2. From the pulldown below Search Text, select Content ID.
3. Click Search.

Search Published Advanced Search

¥| Content [¥|Forms [¥|Assets

Include Archived

Search Text:

Content 1D -

All the words
Any of the words
Ehrase

A ard
Cnntenl:ID.

Specifying additional search criteria

» Title. The title of the content. You can enter a partial word. For example,
entering Part yields the following results.
o Multi-Hospital Nurse Executive Participation
o Ektron Partners and Customers

You can enter more than one word or phrase as long as they are in the correct
sequence. The Search Text field also searches content title.

« Comments. The content’s comments, which can be inserted via the Comment
tab.

NOTE: If you enter multiple terms into the Comments field, they must be in
the order in which they appear in the content's comments.

- Date Created. The file's creation date. You can enter a single date or a range of
dates. The search returns content with that creation date that satisfy the other
criteria.

» Date Modified. The last date when the file was modified. You can enter a single
date or a range of dates. The search returns items with that edit date that satisfy
the other criteria.

» Last Editor’s Last Name. The last name (surname) of the user who most
recently changed the content. This is taken from the Last Name field on the
User Information screen. The search returns items last edited by that user that
satisfy the other criteria.
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« Status. The content status. See also: Content statuses on page 624

NOTE: Search results display only the most recently-published version.
Also,content that has never been approved does not appear.

Managing the search crawl

Crawling is the process of preparing index files for searching. When Ektron content is
added, deleted, or updated, a crawl makes that content available (or no longer
available) to the search. In general, Ektron manages the crawl automatically—you do
not need to do anything.

This section explains the automatic crawl: what starts one, how to monitor its status,
and so on. In addition, if your search has a problem, you can run a manual crawl to
troubleshoot it.

Full vs. incremental crawls
Microsoft Search Server 2010 supports 2 types of crawls.

» Full. occurs immediately after events that significantly change data structure

« Incremental. occurs after incremental crawl interval passes for less significant
events that still require a crawl
A full crawl registers searchable Ektron properties with the search provider and

ensures that search results reflect the latest information for all Ektron content. An
example of a full-crawl triggering event is the registration of a new site.

Many other Ektron events trigger an incremental crawl, which is run when the
specified time interval passes. See: Setting the incremental crawl interval below.
Examples of incremental-crawl triggering events are the creation of new content and
the editing of existing content.

If you are using eSync, a sync can trigger a full or incremental crawl, depending on
the data being synched and the profile selected.

Setting the incremental crawl interval

Starting crawls manually

You should not need to start a crawl. Ektron initiates crawls as necessary. You would
typically begin a manual crawl for troubleshooting purposes.

PREREQUISITE

You are a member of the Administrators group or assigned to the Search-
Admin role.

» To start an incremental crawl immediately, go to Workarea > Settings >
Configuration > Search > Status. Click Request Incremental Crawl.

© 0 -

Request an Incremental Crawl
LrseTrrare
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» To start a full crawl immediately, go to Workarea > Settings >
Configuration > Search > Status. Click Request Full Crawl.

Conts
Request a Full Craw!

| |2 artr=rreme

Improving search performance with crawl filters

When you set up the connection to Microsoft Search Server, you determine the types
of content to be crawled using the following screen.

Crawl Filters

ktron st e

required

[l HTML

[ Documerts
[l Products
= Forums

= Commurity Members

Inistal|Ehield l < Back ” et » ] Cancel

If your crawl is taking too long, consider removing content types, especially those
you do not use. To update the crawled content types, use the Search Configuration
Screen's Site Registration panel > Advanced Options > Crawl Filters fields.
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"'w Ektron Search Configuration =

crawl.

SMACDONALD1 / CMS400Devel = +” This site has been registered.

Further changes can be saved by registering your site again.
Site Registration CMS Database: SMACDONALD1 | CMS400Developer
Crawl Management
Site ID: 1
Database: CM3400Developer

Database Server: SMACDOMALDL
Site URL: http://SMACDONALD1/CMS400Developer
Version: 8.5.0.256

CMS Database Connection String:
Zzarch Server must connect to your CMS site's database in order to crawl its content. Please
werify that the connection string that appears below is valid.

server=SMACDONALD1 ;database=CMS400Developer; Integrated Security=TRUE; user=;pwd=;

Crawl Interval:
Your CM5 site checks to see if content or related CM5 objects were added or updated within
the interval configured below. If any changes occurred, a crawl is performed.

Interval: | 300 ssconds

Search Server Credentials:

Your CM= site must authenticate with Search Server when submitting a query. Pleass enter
the credentials for 2 Windows ussr with access to your Search Server indexes.

Domain: I

Usemname: I Administrator

Password:

Crawl Filters:

The performance of your Search Server will vary in relation to how much content must be
indexed. You can reduce the size of your indexes as well as the time required to crawl your
site by limiting the CMS data that gets indexed.

™ HTML ¥ Documents ™ Products
[V Forums v Community Members [l Community Conten
Obragy Items

* NOTE: Metadata and tags are crawled regardless of the crawl filter settings.
Also, changes to other Ektron data objects result in the appropriate crawl,
regardless of these settings. See also: Full vs. incremental crawls on
page 368.

Monitoring crawls

The Data Directory stores a log of information about each crawl. The Search
Configuration screen's Crawl Tracing field lets you determine the amount of detail
you want the log to collect.

The following errors may appear in the crawl log.

» Error. <url_path_to_asset>: The filtering was stopped because of a user action,
such as stopping the crawl

« Problem. An asset is referenced in the Ektron database, but the physical file
was deleted from the file system.

The following screens also let you monitor and manage crawls.
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« Search Status screen in the Workarea. See also: Monitoring Microsoft Search
Server 2010 from the Workarea on page 374

Search Status

D @ G

Status ltem Walue Description

Content Source Name ekiron1WS10652CM34000eveloper  The index associated with your site.

Query Credentials  Administrator The YWindows user authorized to communicate with the query service.
Crawl Request Pending Mo Indicates whether or notthe site has a request for a crawl to submit.

Current Action |dle The indexing activity that is currently in progress.

Pending Action MNone The indexing activity that will execute upon completion ofthe current activity.

Crawl Start Time  5/2i2011 2:02:36 PM The starttime of the most recent crawl.

Crawl End Time 5/2/2011 2:05:16 PM The end time ofthe most recent crawl.

Crawl Duration 00:02:40 The duration of the most recent crawdl.
Crawl Interval 00:05:00 Indicates how often the site will submit crawl requests.

» Search Configuration Screen's Crawl Management panel
Crawl Management

Wiew the indexing details and manage the crawl schedules for the selected content source.

Content Source: ektroniZMACDONALDICMSAI0Developer

Status:  Idle

Began: 1/14/2011 1:10:46 PM
Ended: 1/14/2011 1:12:00 PM
Durstion:  00:01:14

The following table compares the screens.

Workarea's Search Status

Options Search Configuration Screen
screen

On server that hosts Search
Server: Windows Start > All
Programs > Ektron >

CMS400vxxx> Utilities >
Workarea > Settings > Con- Search Config

How to access figuration > Search > ' _ _
Status If you're using Windows 8 or

2012, press the Windows key (

E)/Q then enter Search
Config. Right click and choose
Run as Administrator.
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Workarea's Search Status
screen

Search Configuration Screen

View crawl
information

search server
content source name
query credentials

if there is a pending
request to begin
incremental search

current and next
scheduled search
action See also:
Monitoring Microsoft
Search Server 2010
from the Workarea on
page 374

most recent start and
end times

duration

(last if no crawl currently
running; current if crawl
currently running)

interval See also:
Setting the incremental
crawl interval on

On Site Registration panel

» Crawl Interval See also:
Setting the incremental
crawl interval on page 368

« Crawl Filters
* Crawl Tracing Level

On Crawl Management panel

e content source name

» crawl status (same as
Current Action on Search
Status screen)

e most recent start and end
times

e duration

page 368
o crawl filters
Start full crawl \/ Not available
Start incre- 7 _
mental crawl Y’/ Not available
Site Registration panel >
oot C I Int | field
incremental View only rawl Interval fie

crawl interval

See also: Setting the
incremental crawl interval on
page 368
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Workarea's Search Status

Options
screen

Search Configuration Screen

Set the type of "'/

data that is View only Site Registration panel >

searched Advanced Options > Crawl
Filters

Troubleshooting crawl errors

The following information lists errors that may appears during a crawl, and how to
resolve them. Errors appear in Microsoft Search Server 2010's administration portal.
They do not appear in Ektron.

Condition. What happens if a crawl is running when a new one is scheduled to start?

» If a crawl request is issued while a crawl is running, the new crawl! will start only
after the current crawl completes.

» A pending full crawl starts before any pending incremental crawls.

Problem. A content block based on a Smart Form has a blank content_html field. An
error occurs: Exception from HRESULT: OxCOOCEE2D

Solution. Remove the field or insert content into it.

Problem. The crawl is taking a long time, your website has over 1 gigabyte of
assets, and over 100 PDFs.

Solutions

« Install Foxit PDF Filter
Install Foxit PDF filter from Foxit® PDF IFilter - Server

After installing, update the registry:

[HKEYiLOCALiMACHINE\SOFTWARE\Microsoft\Office Server\14.0
\Search\Setup\Filters\.pdf]

"Extension"=".pdf"

"FileTypeBucket"=dword:00000001
"MimeTypes"="application/pdf"

[HKEYiLOCALiMACHINE\SOFTWARE\Microsoft\Office Server\14.0
\Search\Setup\ContentIndexCommon\Filters\Extension\ .pdf]
@="{987£8d1a-26e6-4554-b007-6b20e2680632}"

See also: Index and Search PDF Files in SharePoint Server 2010

o Use the Filters Screen

The Crawl Filters screen lets you decide which file types are crawled. You can
exclude non-critical file types to speed up the crawl. See also: Using Microsoft
Search Server features on page 335
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Monitoring Microsoft Search Server 2010 from the
Workarea

Use the Search Status screen to monitor information about search crawls. You can
also launch an incremental or full crawl from the screen. See also: Managing the
search craw/ on page 368

PREREQUISITE

You are a member of the Administrators group or assigned to the Search
Admin role.

1. Choose Workarea > Settings > Configuration > Search > Status. The
Search Status screen appears.

Search Status

D © = ®

Status ltern Walue Description

Content Source Name  ektron1\WS10652CMS4000eveloper  The index associated with your site.

Query Credentials  Administrator The Windows user authorized to communicate with the query service.
Crawl Request Pending Mo Indicates whether or notthe site has a request for a crawl to submit.

Current Action |dle The indexing activity that is currently in progress.

Pending Action MNone The indexing activity that will execute upon completion ofthe current activity,

Crawl Start Time 5272011 2:02:36 PM The starttime ofthe most recent crawl.

Crawl End Time  5/2/2011 2:05:16 PM The end time ofthe most recent crawl.

Crawl Duration 00:02:40 The duration of the most recent crawl.
Crawl Interval 00:05:00 Indicates how often the site will submit crawl requests.

» Search server. The Search Server instance that hosts your search index.

» Content source name. The Search Server content source that identifies
your website.

* Query credentials. The Windows user authorized to communicate with the
query service.

 Incremental Crawl Request Pending. Yes appears if there is a pending
request to begin an incremental crawl. See also: Using Microsoft Search
Server features on page 335. Otherwise, No.

» Current and Next scheduled search action. at any time, there may be
an action that will start when the current one completes. There is never
more than one.

o Idle. Search Server is taking no action.

°© None. (appears for Next Action only) Nothing is scheduled to occur
when the current action completes.

o Incremental Crawl. Search Server is crawling content that changed
since the last crawl. See also: Full vs. incremental crawls on page 368

o Full Crawl (Property Discovery). Search Server is crawling Ektron
content, looking for new searchable properties.

o Full Crawl. Search Server is crawling all content.

° Property Mapping. Search Server is mapping searchable properties
that were found.
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+ Most recent start and end times. When the most recent crawl began

and ended.

« Duration (last if no crawl currently running; current if crawl currently
running). If last, the length of time (in seconds) required to complete the
most recent crawl. If current, the length of time (in seconds) since the
current crawl began. Click the Refresh button () to get the latest

information.

» incremental crawl interval. See also: Setting the incremental crawl

interval on page 368

» crawl filters. See Managing the search crawl/ on page 368.

2. If you want to launch a crawl from the toolbar:

« click ({7)) to launch an incremental crawl (note black color)

« click ({#)) to launch a full crawl (note blue color)

Reporting search activity

EktronSearchStatistics logs

IMPORTANT: EktronSearchStatistics Logs are not available for the Solr search

provider.

This log shows submission of the query statistics. It is updated only after a site visitor
inserts a search term, clicks the search button, and clicks a result. To access the log,
sign on to the Search Server machine > EktronSearchSite Web root > click

EktronSearchStatistics folder.

PID:7284 TID:7056 MTID: 2012-04-03T14:55:15
Verbose Publishing Search Statistics : Begin
PID:7284 TID:7056 MTID: 2012-04-03T14:55:1
Verbose QueryContext.Create: Creating QueryContext /
PID:7284 TID:7056 MTID: 2012-04-03T14:55:15
Verbose QueryContext.Create: Created QueryContext /
PID:7284 TID:7056 MTID: 2012-04-03T14:55:15

Verbose QueryServiceInfoProcessor.GetSearchApp for
QuerySSA:Search Service Application

PID:7284 TID:7056 MTID: 2012-04-03T14:55:15

Verbose QueryServicelInfoProcessor.GetSearchAppProxy
for QuerySSA:Search Service Application

PID:7284 TID:7056 MTID: 2012-04-03T14:55:15
Verbose MSStatsRecorderProxy.Record: Recording
PID:7284 TID:7056 MTID: 2012-04-03T14:55:15

Verbose MSSearchStatsHelper.SubmitStatistics:
Beginning statistics recording to SharePoint!
PID:7284 TID:7056 MTID: 2012-04-03T14:55:15

Verbose MSSearchStatsHelper.FetchClicksToRegisterValue:

Will be using 2 click(s) to complete
statistics recording to SharePoint!
PID:7284 TID:7056 MTID: 2012-04-03T14:55:15
Verbose MSSearchStatsHelper.SubmitStatistics:
Ending statistics recording to SharePoint!
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PID:7284 TID:7056 MTID: 2012-04-03T14:55:15
Verbose MSStatsRecorderProxy.Record: Recorded!
PID:7284 TID:7056 MTID: 2012-04-03T14:55:15

Verbose Publishing Search Statistics
Ends with Status SUCCESSFUL: O

EktronQuerySuggestion logs

IMPORTANT: EktronQuerySuggestion Logs are not available for the Solr search
provider.

This log shows the number of entries for the query prefix. In the following example,
the user entered ‘samp’ and Autosuggest found one entry (sample). To access the
log, sigh on to the Search Server machine, find EktronSearchSite Web root, and click
EktronQuerySuggestion folder.

PID:7900 TID:5168 MTID: 2012-04-04T08:51:18
Verbose QueryContext.Create: Creating QueryContext /
PID:7900 TID:5168 MTID: 2012-04-04T08:51:18
Verbose QueryContext.Create: Created QueryContext /
PID:7900 TID:5168 MTID: 2012-04-04T08:51:18
Verbose QueryServiceInfoProcessor.GetSearchApp for
QuerySSA:Search Service Application
PID:7900 TID:5168 MTID: 2012-04-04T08:51:18
Verbose QueryServicelInfoProcessor.GetSearchAppProxy for
QuerySSA:Search Service Application
PID:7900 TID:5168 MTID: 2012-04-04T08:51:18
Verbose SPQuerySuggestionReporter.GetQuerySuggestions:
Q:[samp] Profile:[]

PID:7900 TID:5168 MTID: 2012-04-04T08:51:18

Verbose SPQuerySuggestionReporter.GetQuerySuggestions:
Response for Q:[samp] : [1]

PID:7900 TID:5168 MTID: 2012-04-04T08:51:18

Verbose SPQuerySuggestionFeed.QuerySuggestionForProfileFeed:
completed feed request: Q:samp Culture:en-US

Using a search phrase report

The Search Phrase Report displays terms that were entered into a Search field within
a selected range of dates. You can use it to discover terms being submitted to the
search.

The report is gathered from the query text of keyword-based queries. The queries
include those submitted through the search field of search server controls, the
keyword search API, and the Workarea’s Search Published tab.
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Search Phrase Repors

PRINT REFORT Language: | English (U.5.) = I L2

Minimum Count: |4
Start Date: [Nong] i Y
End Date: [Nong] e Y
Get Result

You can narrow down the search by selecting any combination of these criteria.

» language—the language of the search page (either Workarea or website search).
The user performing the search can choose a language before inserting the
search text. If he does not explicitly choose a language, the search uses the
default one. This report shows results from all languages or one that you select.

* a minimum number of occurrences of the word or phrase to return. For example,
you only want words or phrases searched for 10 times or more during the last
month.

» range of dates when searches were conducted

After entering search criteria, click Get Result.

The search results show the number of times each word or phrase that satisfies the
selection criteria appears. They are arranged in this order.
» words or phrases with the most occurrences appear first

« if several words or phrases have the same number of occurrences, they are
arranged alphabetically

NOTE: Search terms are added to the Search Phrase Report according to rules
explained in Specifying the frequency of writing to the database on page 492.

Also, terms entered into the website or Workarea search are surrounded by
parentheses (). Terms entered into the Advanced Workarea search have no
parentheses. The Microsoft search engine uses this syntax to find content.

Troubleshooting Microsoft search

Problem. You publish a Visio® document but the search cannot find it.

Solution 1. Make sure the Visio iFilter is installed. See Installing the Visio IFilter on
page 346.
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Solution 2. Does the content have a non-standard alias extension? Aliases that use
standard extensions are not a problem. However, you can create custom alias
extensions. See also: Creating user-friendly URLs with aliasing on page 1293. If you
do, that content is searchable only if you add the custom extension to Search
Server's extension list. From the Search Server Administration page, click File types
> New File Type, and add the custom extension. Then, run a full crawl to index
these pages.

Solution 3. Is the content stored in a Smart Form field whose type is content?
Search does not support Smart Form fields with an Advanced type of Content
(instead of Attribute or Element). Smart Form fields that need to be indexed must
have a type of Attribute or Element.

Problem. SearchConfigUI.exe crashes while building search indexes and catalogs
Solution.
1. Make sure the metaconfig.doc file exists in the siteroot/uploadedfiles

directory. If it does not, ask Ektron Supportto send you a new file.

2. If anyone uploaded Visio documents to your server, make sure the iFilter is
installed. See Installing the Visio IFilter on page 346.

Installing and Setting up Microsoft
Search Server 2013 or 2016

This section explains how to install Microsoft Search Server 2013 or 2016. After
installing it, follow Configuring Ektron to work with Microsoft Search Server 2013 or
2016 on page 416 to configure the search provider. To learn how to use the search,
read Using Microsoft Search Server features on page 335.

» Installing active directory domain services below

» Installing SQL Server 2012 R2 on page 388

» Installing and troubleshooting online prerequisites issues for SharePoint 2013 on
page 402

» Installing SharePoint 2013 on page 405

» Configuring Ektron to work with Microsoft Search Server 2013 or 2016 on
page 416

Installing active directory domain services

1. In Server Manager, open the Dashboard and click the Add roles and features
links from the right panel.
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= Server Manager

B Local Server
W& All Servers

¥§ File and Storage Services P

WHAT'S NEW

LEARN MORE

ROLES AND SERVER GROUPS

Roles: Servergroups: 1 | Servers tota
Services
@ Manageability @ Manageability @ Manageability
Events Events Events
Performance Services Services
BPA results Performance Performance
BPA results BPA results

=

2. The Add Roles and Features Wizard appears. Check the Skip this page by
Default box.

= Add Roles and Features Wizard =le -

DESTIMNATION SERVER

Before you begin Suparbastarind

Before You Begin This wizard helps you install roles, role services, or features. You determine which roles, role services, or

features to install based on the computing needs of your organization, such as sharing documents, or
hosting a website.

To remove roles, role services, or features:
Start the Remove Roles and Features Wizard

Befare you continue, verify that the following tasks have been completed:

* The Administrator account has a strong password
* Metwork settings, such as static IP addresses, are configured
* The most current security updates from Windows Update are installed

If you must verify that any of the preceding prerequisites have been completed, close the wizard,
complete the steps, and then run the wizard again.

To continue, click Mext.

Skip this page by default

3. You are asked to select an installation type. Click Role-based or feature-
based Installation.

Ektron Reference I 379




Setting up search for your website

[ Add Roles and Features Wizard =i -

Qg.|r_~./—;— '_m;t- __-—_\t‘m N tvp DESTINATION SERVER
SCICUL e a o a_a'll } e SuperMasterMind

Select the installation type. You can install roles and features on a running physical computer or virtual
machine, or en an offline virtual hard disk (VHD).

@ Role-based or feature-based installation
Configure a single server by adding roles, role services, and features.

) Remote Desktop Services installation
Install required role services for Virtual Desktop Infrastructure (VD) to create a virtual machine-based
or session-based desktop deployment.

| < Previous | | MNext » | nsta Cancel

4. You are asked to select a destination server from the server pool.

[ Add Roles and Features Wizard == -

DESTINATION SERVER

i ial iDi’] Sei\/’el' SuperMasterMind

Select a server or a virtual hard disk on which to install roles and features.

(®) Select a server from the server pool
() Select a virtual hard disk

Server Pool

Filter: |

MName Address Operating System

SuperMasterMind 192.168.75.131 Microsoft Windows Server 2012 R2 Datacenter

1 Computer(s) found

This page shows servers that are running Windows Server 2012, and that have been added by using the
Add Servers command in Server Manager. Offline servers and newly-added servers from which data
collection is still incomplete are not shown.

| < Previous | | Mext > | nsta Cancel

5. On the Select Server screen, select the role Active Directory Domain

Services. Next, you are prompted to install prerequisites. Check the Include
management tools (if applicable) box and click the Add Features button.
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il

Add Roles and Features Wizard

Add features that are required for Active Directory

Domain Services?

You cannot install Active Directory Domain Services unless the
following role services or features are also installed.

[Tools] Group Pelicy Management

4 Remote Server Administration Tools

4 Role Administration Teols
4  AD DS and AD LDS Tecls
Active Directery module for Windows PowerShell
4 AD DS Tools

[Tools] Active Directory Administrative Center

[Tocls] AD DS Snap-Ins and Command-Line Tools

Include management tocls (if applicable)

Add Features

Cancel

6. You have installed all the prerequisites for Active Directory. Select additional
Roles and Features if required.
Add Roles and Features Wizard

Confirmation

Features

[BB.NET Framework 3.5 Feature

Select one or more features to install on the selected server.

.NET Framewark 4.5 Features (2 of 7 installed)

O Background Intelligent Transfer Service (BITS)

[] BitLocker Drive Encryption
[ BitLocker Netwark Unlock
[] BranchCache

[ Client for NFS

[] Data Center Bridging

[] Direct Play

[] Enhanced Storage

[ Failover Clustering

Group Policy Management
[ 1S Hostable Web Core

[ Ink and Handwriting Services

i

_I:I-

DESTINATION SERVER
SuperMasteriing

Description

MET Framework 3.5 combines the
power cf the .NET Framework 2.0
APls with new technologies for
building applications that offer
appealing user interfaces, protect
your customers' personal identity
information, enable seamless and
secure communication, and provide
the ability to model a range of
business processes.

< Previous | | Next >

nstal Cancel
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7. The following screen has information about how Active Directory Domain
Services will be installed.

[ Add Roles and Features Wizard = | = -

—~ DP T S,—. Vil el =T DESTINATION SERVER
9 _'}." Lomall ervices SuperiazterMing

Active Directory Domain Services (AD DS) stores information about users, computers, and other devices
on the network. AD DS helps administrators securely manage this information and facilitates resource
sharing and collaboration between users. AD DS is also required for directory-enabled applications
such as Microsoft Exchange Server and for other Windows Server technologies such as Group Policy.

Things to note:

To help ensure that users can still log on to the network in the case of a server cutage, install a
minimum of two domain controllers for a domain.

Confirmation

AD DS requires a DNS server to be installed on the network. If you do not have a DNS server
installed, you will be prompted to install the DNS Server role on this machine.

Installing AD DS will also install the DFS Namespaces, DFS Replication, and File Replication services
which are required by AD DS,

| < Previous | | Hext > | nsta

8. On the next screen, Click Restart the destination server automatically if

required and click the Install button.

[ Add Roles and Features Wizard = | = -

C: «]C Saal ,-ﬁH A <_,.|,.. B i DESTIMATION SERVER
Lontirm Installaton selecuons SuperiasterMing

To install the following roles, role services, or features on selected server, click Install.

[] Restart the destination server automatically if required

Optional features (such as administration tools) might be displayed on this page because they have

been selected automatically. If you do not want to install these optional features, click Previous to clear
their check boxes.

AD DS Active Directory Domain Services
Group Policy Management
Remate Server Administration Tools
Role Administration Tools
AD DS and AD LDS Teools
Active Directory module for Windows PowerShell
AD DS Taols
Active Directory Administrative Center

AD DS Snap-Ins and Command-Line Tools

Install | | Cancel
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Add Roles and Features Wizard X |

If a restart is required, this server restarts automatically, without
additicnal notifications. Do you want to allow automatic restarts?

Yes Mo

9. The Installation process begins. It takes several minutes to complete.
=

Add Roles and Features Wizard = IR

I +- | et e % DESTINATION SERVER
nsia 'at-Oﬂ s._al \_a’gl ess SuperiasterMind

Wiew installation progress

o Starting installation

Active Directory Domain Services
Group Policy Management

Remote Server Administration Tools

Role Administration Tools
Results

AD DS and AD LDS Tools

Active Directory module for Windows PowerShell
AD DS Tools

Active Directory Administrative Center

AD D5 Snap-Ins and Command-Line Tools

You can close this wizard without interrupting running tasks. View task progress or open this
page again by clicking Notifications in the command bar, and then Task Details.

Export configuration settings

10. Once the Active Directory Domain Service is installed, you see the installation

results. Click Promote this server to a domain controller to launch the
Active Directory Domain Services configuration wizard.

IMPORTANT: Do not close the screen yet.
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= Add Roles and Features Wizard =0 -

Installation oro i DESTINATION SERWER
Insta dt on pi '-H.J'g ress SuperMasterMind

View installation progress

o Feature installation

Active Directory Domain Services ~
Additional steps are required to make this machine a domain controller,
Promote this server to a domain controller
Group Policy Management
Remote Server Administration Tools
Role Administration Tools E
AD DS and AD LDS Tools
Active Directory module for Windows PowerShell
AD DS Tools
Active Directory Administrative Center
AD DS Snap-Ins and Command-Line Tools W

You can close this wizard without interrupting running tasks. View task progress or open this
page again by clicking Notifications in the command bar, and then Task Details.

Export configuration settings

The Deployment Configuration screen appears. Select the Add new a Forest

button and provide a Root domain name in the text box.

= Active Directory Domain Services Configuration Wizard - | o [
[ e TARGET SERVER
p'ep O}" ment Lontl L )| c_'.t on SuperMasterMind

Deployment Configuration

Select the deployment operation

O Add a domain contraller to an existing domain
(O Add a new domain to an existing forest

@ Add 3 new forest

Specify the domain information for this operation

Supply the credentials to perform this operation

<No credentials provided =

More about deployment configurations

Previous MNext > Cancel

The Domain Controller Options screen appears. Enter a password of your choice
in the Password and Confirm password fields. Keep default values for other

settings.
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Dom

LA

& £
Tl
dalfn |

Diomain Controller Options

DS Opt

Additional Options

Active Directory Domain Services Configuration Wizard

Controller Options

Select functional level of the new forest and root domain

[= [ |

TARGET SERVER
SuperMasterMind

Forest functional level: | Windows Server 2012 R2

|v|

Domain functional level: | Windows Server 2012 R2

|v|

Specify domain controller capabilities

Domain Name Systern (DMNS) server

Type the Directory Services Restore Mode (DSRM) password
Password:

Confirm password: sssssssssse

More about domain controller options

| < Previous | | Mext » |

nsta Cancel

13. A warning appears on the DNS Option screen. You don’t need to do anything.

B

DNS Options

Active Directory Domain Services Configuration Wizard

[= L= |

TARGET SERVER
SuperMasterMind

| i, A delegation for this DNS server cannot be created because the authoritative parent zone cannot be found... Show more x

nt Configuration

troller Cptions

Domain Con

DNS Options

Additional Cpticns

Specify DNS delegation options

More about DNS delegation

< Previous | | MNext =
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14. The Additional Options screen appears. Verify your NetBIOS domain name.

[ Active Directory Domain Services Configuration Wizard
Additional Options
Deployment Configuration : : : i
Verify the NetBIOS name assigned to the domain and change it if necessary
Domain Controller Cptions
DNS Options The NetBIOS domain name: MASTERMIND
NS Options
Additional Opticns
Paths
More about additicnal options
| < Previous | | Mext = |

_I:I-

TARGET SERVER
SuperMasterMind

sta Cancel

15. The Paths screen appears. Leave all settings as is.

=i Active Directory Domain Services Configuration Wizard

Paths

Deployment Configuration

Specify the location of the AD D5 database, log files, and 5YSVOL

troller Cptions

Database folder CA\Windows'\NTDS
Log files folder: C:\Windows\NTDS
SYSVOL folder: CA\Windows\SYSVOL

More about Active Dir

< Previous | | Mext »

BE |

TARGET SERVER
SuperMasterMind

IR

nsta Cancel
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16. The Review Options screen shows the selected wizard settings.

=] Active Directory Domain Services Configuration Wizard == -

R ! O OnS TARGET SERVER
eV -"’ =W D | SuperMasterMind

Deplovment Configuration Review your selections:

omain Controller Options
Create DN5 Delegation: No
DNS Options

Additional Cptions Database folder: C\Windows\NTDS

Paths Log file folder: CAWindows\NTDS
Review Cptions .

SYSVOL folder: C:\Windows\SYSVOL
Prerequisites Check

The DNS Server service will be configured on this computer.

This computer will be configured to use this DN5S server as its preferred DNS server,

The password of the new domain Administrator will be the same as the password of the local
Administrator of this computer,

These settings can be exported to a Windows PowerShell script to automate

additional installations

More about installation options

| < Previous | | Next = | nstal Cancel

17. The Prerequisites Check screen appears. This takes several minutes to complete.

When the test completes, click the Install button.

= Active Directory Domain Services Configuration Wizard = [ = -
P 3 - - (— h | TARGET SERVER
rel eqU|5|t95 -NECK SuperMasterMind
| Q All prerequisite checks passed successfully. Click ‘Install’ to begin installation. Show more »

Deployment Configuration
= = Prerequisites need to be validated before Active Directory Domain Services is installed on this
Domain Controller Options computer
DNS Options Rerun prerequisites check

Additional Cptions
A View results

named "Allow cryptography algerithms compatible with Windows NT 40 that pre'vents A

weaker cryptography algorithms when establishing security channel sessions. |

Prerequist

For more information about this setting, see Knowledge Base article 942564 (hitp://
go.microsoft.com/fwlink/?Linkld=104751).
This computer has at least one physical network adapter that does not have static IP
address(es) assigned to its IP Properties. if both IPv4 and IPv6 are enabled for a network
adapter, both IPv4 and IPv6 static IP addresses should be assigned to both IPvd and

IPv6 Properties of the physical network adapter. Such static IP address(es) assignment
should be done to all the physical network adapters for reliable Domain Name System

(DNS}) operation. V

1, If you click Install, the server automatically reboots at the end of the promotion operation.

Mare about prerequisites

< Previous Mext = | Install | | Cancel |

18. You reached last screen of the Active Directory Domain Services Configuration

Wizard. This screens shows the installation progress. When the installation is
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completed, your server restarts automatically.

= Active Directory Domain Services Configuration Wizard = =]
Installatio TARGET SERVER
Installation SuperMasterMind
Progress
Starting
~ View detailed operation results
1
Installation

Mare about installation options

19. After restart, you should be able to able to log into the domain using Domain
credentials, for example, Domain\UserName.

20. You can use the Active Directory Users and Computers administrator tool to
create users and groups.

File Action View Help
diz BE TaE7a%

=] tory Users and Com|| Name Type

Description
b [ Saved Queries 3 mastermind.... Domain
4 3 mastermind.com

| Saved Queries Folder to store your fave...
| Builtin

b

i [ Computers

I 2. Domain Controllers

I | ForeignSecurityPrincipaly
b ] Managed Service Accour
[ Users

21. Verify domain details by browsing the Users folder in Left panel.

Installing SQL Server 2012 R2

1. Browse the directory of the system where Microsoft SQL Server 2012 setup files
reside.
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2. Right click Setup.exe files and run as administrator.

1033_EMU_LP
boxstub_sql
PCUSOURCE
redist
FESOUFCES
Streaminsight
Teools
xbd

ik | autorun

|Z| Medialnfo

IAH cetun
cet Open

@) sql By | Run as administrator

3. The Splash screen keeps you waiting until SQL Server installation Center screen

appears.

Flease wait while Microsoft SQL Server 2012 Service Pack 1 Setup processes the current operation.

SQL Server 2012

4. The SQL Server installation Center screen appears.

=
“al

Planning
Installation
Maintenance
Tools
Resources

Advanced

Options

'_;-2_\ Microsoft”
~ SQL Server2012

SAL Server Installation Center \;E-

Hardware and Software Requirements

View the hardware and software requirements.

Security Documentation

View the security documentation.

Online Release Motes

View the latest information about the release.

How to Get SCL Server Data Tools

SOL Server Data Tools provides an integrated environment for database developers to
carry out all their database design work for any 5L Server platform.

System Configuration Checker

Launch a tool to check for conditions that prevent a successful SQL Server installation.

Install Upgrade Advisor

Upgrade Advisor analyzes any 5QL Server 2008 R2, 5L Server 2008 or SGL Server 2005
components that are installed and identifies issues to fix either before or after you
upgrade to SOL Server 2012,

Online Installation Help

Launch the online installation documentation.

How to Get Started with SOL Server 2012 Failover Clustering
Read instructions on how to get started with 5QL Server 2012 failover clustering.

How to Get Started with a PowerPivet for SharePoint Standalone Server Installation

Read instructions on how to install PowerPivot for SharePoint in the fewest possible
steps on a new SharePoint 2010 server.
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5. From left panel, click Installation. Installation options appear.

o

Planning

SQL Server Installation Center I;Ii-

- Mew SCL Server stand-alone installation or add features to an existing installation

Launch a wizard to install SGL Server 2012 in a non-clustered environment or to add

Installati
e features to an existing SQL Server 2012 instance,

Maintenance
Mew SOL Server failowver cluster installation

Tools

Launch a wizard to install a single-node 5QL Server 2012 failover cluster.
Resources
Advanced

Launch a wizard te add a node to an existing 50L Server 2012 failover cluster.
Options

Upgrade from SQL Server 2003, SOL Server 2008 or SOL Server 2008 R2
Launch a wizard te upgrade SQL Server 2003, SQL Server 2008 or SOL Server 2008 R2 to

. t'f Add node te a 5CL Server failover cluster
Al

SQL Server 2012,

"B Microsoft:

Z. SQLServer2012

6. Click New SQL Server stand-alone installation or add features to an existing

installation link. A splash screen keeps you waiting until the Microsoft SQL Server

2012 Service Pack 1 setup process completes.

i~ SQL Server Installation Center

==

Planning
Installation
Maintenance
Tools
Resources

Advanced

Options

ation or adc

SCL Server stand-alone inst

Me
h Launch a wizard to install SQOL Server 2012 in a nen-clustered environment or to add
features to an existing SQL Server 2012 instance.

eatures to an existing installation

Mew SCL 5

nstallation

failover clu

-4

Launch a wizard to install 2 single-node SQL Server 2012 failover cluster.

.5 Add node to a SOL Server failover cluster
LN

FU8 Launch awizard to add a node to an existing SOL Server 2012 failover cluster,

SOL Server 2012 rver 2008 R2 to

Please wait while Microsoft SQL Server 2012 Service Pack 1 Setup processes the current operation

#~ SQL Server2012
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7.

Installing SQL Server 2012 R2

On the Setup Support Rules screen, the Installer checks for any issues that

occurred during installation.
b SQOL Server 2012 Setup

_I:I-

Setup Support Rules

Setup Support Rules identify problems that might occur when you install SQL Server Setup support files. Failures must be
corrected before Setup can continue,

Setup Support Rules

Operation completed. Passed: 8. Failed 0. Warning 0. Skipped 0.

Show details >>

View detailed report

8. Inthe Product Key screen, provide a valid license Key. If you are installing the
free version, select Specify a free edition.

License Terms
Product Updates
Install Setup Files

b SAL Server 2012 Setup
Product Key
Specify the edition of SQL Server 2012 to install.
Product Key Validate this instance of SOL Server 2012 by entering the 25-character key from the Microsoft ~

el

certificate of authenticity or product packaging. You can also specify a free edition of SQL Server, such
as Evaluation or Express. Evaluation has the largest set of SQL Server features, as documented in SQL
Server Books Online, and is activated with a 180-day expiration. To upgrade from one edition to
another, run the Editicn Upgrade Wizard.

(O Specify a free edition:

Evaluation

(®) Enter the product key:

< Back Mext = | | Cancel
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9. The License Terms screen appears. Read the terms carefully and check the
Accept the license terms option if you are happy with them

5 SQL Server 2012 Setup |;|£-

License Terms

To install SOL Server 2012, you must accept the Microsoft Software License Terms.

Product Key 'WHICH VARY FROM COUNTRY TO COUNTRY. ~
Lis Te
shees el FOR AUSTRALIA ONLY. References to "Limited Warranty” are references to the express
Product Updates warranty provided by Microsoft. This warranty is given in addition to other rights and remedies
Install Setup Files you may have under law, including your rights and remedies in accordance with the statutory
guarantees under the Australian Consumer Law.

If the Australian Consumer Law applies to your purchase, the following applies to you: Our
goods come with guaranteeks that cannot be excluded under the Australian Consumer Law. You
are entitled to a replacement or refund for a major failure and compensation for any other
reasonably foreseeable loss or damage. You are also entitled to have the goods repaired or
replaced if the goods fail to be of acceptable quality and the failure does not amount to a major
failure.

b
L)
Copy Print

| accept the license terms.

Send feature usage data to Microsoft. Feature usage data includes information about your hardware
configuration and how you use SQL Server and its components.

See the Microsoft SQL Server 2012 Privacy Statement for more information.

| < Back | | Mext > | | Cancel |

10. The Product Updates screen appears. You are notified of hot fixes or updates for
SQL Server 2012 relevant to this installation.

o) SQL Server 2012 Setup = [ = -

Product Updates

Always install the |atest updates to enhance your SQL Server security and performance.

Product Key
Include SQL Server product updates
License Terms

Product Updates Name Size (MB) Meore Information
SQOL Server 2012 5P1 GDR Produc... | 145 KB 2793634

Install Setup Files
SOL Server 2012 SP1 GDR Setup .. |26 KB 2793634

2 updates (171 MB) found online.
The Setup updates (26 MB) will be installed when you click Mext.

Read cur privacy statement online

Learn more about SQL Server product updates

< Back | | Mext = | | Cancel
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11.

12.

Installing SQL Server 2012 R2

On the Install Setup Files screen, the Setup files are downloaded. Click Install.

5 SQL Server 2012 Setup \;‘i-

Install Setup Files

SQL Server Setup will now be installed. If an update for SQL Server Setup is found and specified to be included, the
update will also be installed.

L I

License Terms
Downloading the Setup files: 1 MB of 26 MB downloaded (1 %

Product Updates

Install Setup Files Task Status
Scan for product updates Completed
Download Setup files In Progress
Extract Setup files Mot started
Install Setup files Mot started

< Back Install

The Setup Support Rules screen appears, identifying installation issues.
i SQL Server 2012 Setup |- [=

Setup Support Rules

Setup Support Rules identify problems that might occur when you install SOL Server Setup support files. Failures must be
corrected before Setup can continue,

Setup Support Rules Operation completed. Passed: 6. Failed 0. Warning 1. Skipped 0.

Feature Selection

Installation Rules Hide details <<

Disk Space Requirements View detailed report

Error Reporting
Installation Cenfiguration Rules Rule Status
Ready to Install @ Fusion Active Template Library (ATL) Passzed
Installation Progress @ Previous releases of SOL Server 2008 Business Intelligence Devel... | Passed
Complete @ Mo 5x5 install with 5OL Server "Denali" CTPD Passed
@ Consistency validation for SOL Server registry keys Passed
A\ | Computer domain controller Warning
@ Microsoft MET Application Security Passed
(2 | Windows Firewall Passed
< Back Mext > | | Cancel | | Help
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13. On Setup Role screen, select SQL Server Feature Installation.

o SQL Server 2012 Setup [= | o [
Setup Role
Click the SQL Server Feature Installation option to individually select which feature components to install, or click a
feature role to install a specific configuration.
Setup Support Rules (®) SOL Server Feature Installation
Setup Role Install SOL Server Database Engine Services, Analysis Services, Reporting Services, Integration Services,
Feature Selection and other features,
Installation Rules (O SOL Server PowerPivot for SharePoint

Disk Space Requirements
Error Reporting
Installation Configuration Rules

Ready to Install

Install PowerPivot for SharePoint on a new or existing SharePoint server to support PowerPivot data
access in the farm, Optionally, add the SQL Server relational database engine to use as the new farm's
database server,

Installation Progress (O All Features With Defaults

Complete

Install all features using default values for the service accounts.

< Back | | MNext > | | Cancel | | Help

+ Instances Features

o

[}

[}

Database Engine Services
Full-Text and Semantic Extractions for Search
Analysis Services

« Shared Features

o
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Reporting Services — SharePoint

Reporting Services Add-in for SharePoint Products
SQL Server Data Tools

Management Tools - Basic

Management Tools - Complete




Feature Selection

SQL Server 2012 Setup

Select the Enterprise features to install.

Setup Support Rules

Setup Role

Feature Selection

Installation Rules

Instance Configuration

Disk Space Requirements
Server Configuration

Database Engine Configuration
Analysis Services Configuration
Reporting Services Configuration
Error Reporting

Installation Cenfiguration Rules
Ready to Install

Installation Progress

Complete

Features:

<

Installing SQL Server 2012 R2

Feature description:

Instance Features ~

Database Engine Services
[[] 50L Server Replication
Full-Text and Semantic Extractions for Searg
[[] Data Quality Services =
Analysis Services
[] Reporting Services - Native

Shared Features

Reporting Services - SharePoint

Reporting Services Add-in for SharePoint Prody
[[] Data Quality Client

SQL Server Data Tools

[[] Client Tools Connectivity

[ Integration Services

[] Client Tools Backwards Compatibility v
m >

The configuration and operation of each
instance feature of a 5OL Server instance is
isolated from other SOL Server instances.
SOL Server instances can operate side-by-
side on the same computer.

Prerequisites for selected features:

Already installed: ~
-Microsoft MET Framework 4.0

... Windows PowerShell 2.0
To be installed from media:
. Microsoft Visual Studio 2010 Shell
i Microsoft Visual Studic Tools for Applicati v
< m >

Select All | | Unselect All

Shared feature directory:

Shared feature directory (x86): |C:\Program Files (x86)\Microsoft SQL Server',

|C:\Program Files\Microsoft SOL Servert,

H

=

| < Back | |

MNext > | | Cancel | | Help |

and got stuck.

=
.

Installation Rules

Setup is running rules to determine if the installation process will be blocked. For more information, click Help.

Setup Support Rules

Setup Role

Feature Selection

Installation Rules

Instance Configuration

Disk Space Requirements
Server Configuration

Database Engine Configuration
Analysis Services Configuration
Reporting Services Configuration
Error Reporting

Installation Configuration Rules
Ready to Install

Installation Progress

Complete

Operation completed. Passed: 4. Failed 0. Waming 0. Skipped 0.

SQL Server 2012 Setup

Show details >=

View detailed report

14. The Installation Rules screen indicates if the Installation process had problems

_I:I-

| < Back | |

Mext > | | Cancel | | Help |

15. The Instance Configuration screen prompts you to choose the default SQL
Server Instance or create a new Named Instance. Also, you can change the
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Instance directory on Windows Server 2012 R2.

g
Had

Instance Configuration

SQL Server 2012 Setup

Specify the name and instance ID for the instance of S0OL Server. Instance ID becomes part of the installation path.

Setup Support Rules

Setup Role

Feature Selection

Installation Rules

Instance Configuration

Disk Space Requirements
Server Configuration

Database Engine Configuration
Analysis Services Configuration
Reporting Services Configuration
Error Reporting

Installation Configuration Rules
Ready to Install

Installation Progress

Complete

(®) Default instance

() Mamed instance:

Instance ID:

Instance root directory:

SQL Server directory:

Analysis Services directory:

Installed instances:

Instance Name

MS5QLSERVER

|MSSQLSERVER

|C:\Program Files\Microsoft SOL Servert,

C\Program Files\Microsoft SQL Server\MS50L11.M55QLSERVER
C\Program Files\Microsoft SQL Server\M5AS11.M55QLSERVER

Instance ID Features Edition Version

| < Back | | Mext > | | Cancel | |

=
Al

SQL Server 2012 Setup

Disk Space Requirements

Review the disk space summary for the SQL Server features you selected.

Setup Support Rules

Setup Role

Feature Selection

Installation Rules

Instance Configuration

Disk Space Requirements
Server Configuration

Database Engine Configuration
Analysis Services Configuration
Reporting Services Configuration
Error Reporting

Installation Cenfiguration Rules
Ready to Install

Installation Progress

Complete

Disk Usage Summary:

—--@ Drive C: 6845 MB required, 54827 MB available
| Systemn Drive (C:\): 4148 MB required
Shared Install Directory (C:\Program Files\Microsoft SOL Server'): 1043 ME required
Instance Directory (C\Program Files\Microsoft SOL Server\): 1652 ME required

16. The Disk Space Requirements screen displays the space required for installation.
If your Windows Server 2012 R2 has enough space, click Next to continue.

BE |

< Back | | Mext > | | Cancel | |

Help
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perform the following actions.
a. Change Startup Type for the SQL Server Agent to Automatic.

b. Change the Account Name for the SQL Server Database Engine to NT

Installing SQL Server 2012 R2

17. On the Server Configuration screen, click the Service Accounts tab and

c. Change the Account Name for the SQL Server Analysis Services to NT
o SQL Server 2012 Setup = || = -
Server Configuration
Specify the service accounts and collation configuration.
Setup Support Rules Service Accounts | Collation
Setup Role
EeatiisSaiiang Microsoft recommends that you use a separate account for each SOL Server service,
Installation Rules Service Account Name Password Startup Type
Instance Configuration SQL Server Agent NT Service\SOLSERVERA... Manual v
Disk Space Requirements SQOL Server Database Engine NT Service\MS50LSE.. v Automatic  |v
Server Configuration SOL Server Analysis Services MASTd NT Service'M550LSERVER Louu Automatic W
Database Engine Configuration SOL Full-text Filter Daemen Launc... | NT Service\MSSCLFDLa... Manual
Analysis Services Configuration SQOL Server Browser NT AUTHORITY\LOCAL ... Disabled u
Reporting Services Configuration
Error Reporting
Installation Configuration Rules
Ready to Install
Installation Progress
Complete
| < Back | | MNext > | | Cancel | | Help |

18. In the next screen, go to the Server configuration tab and select the Mixed
Mode (SQL Server authentication and Windows authentication) option.
Also, add the current logged-in user as a System Administrator Account for this
SQL Server Instance.
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vl SQOL Server 2012 Setup

Database Engine Configuration

Specify Database Engine authentication security mode, administrators and data directories.

Setup Support Rules

Setup Role

Feature Selection

Installation Rules

Instance Configuration

Disk Space Requirements

Server Configuration

Database Engine Configuration
Analysis Services Configuration
Reporting Services Configuration
Error Reporting

Installation Configuration Rules
Ready to Install

Installation Progress

Complete

[ se tories | FILESTREAM |

Specify the authentication mode and administrators for the Database Engine.

Authentication Mode

_) Windows authentication mode

® Mixed Mode (SOL Server authentication and Windows authentication)

Specify the password for the SQL Server system administrator (sa) account.

Enter password: |"0"""u

Confirm password: |"""0"u

Specify SOL Server administrators

(Vg R ——— |

SOL Server administrators
have unrestricted access
to the Database Engine.

Add Current User || Add... || Remove |

| < Back | | MNext > | | Cancel | | Help

as a System Administrator for Analysis Services

19. On the Analysis Services Configuration screen, select the current logged-in user

el SQOL Server 2012 Setup

Analysis Services Configuration

Specify Analysis Services server modes, administrators, and data directories.

(==

Setup Support Rules

Setup Role

Feature Selection

Installation Rules

Instance Configuration

Disk Space Requirements

Server Configuration

Database Engine Configuration
Analysis Services Configuration
Reporting Services Configuration
Error Reporting

Installation Configuration Rules
Ready to Install

Installation Progress

Complete

- N |
Server Configuration !_Data Directories |

Server Mode:
® Multidimensional and Data Mining Mode

() Tabular Mode

Specify which users have administrative permissicns for Analysis Services,

| m _ Analysis Services

administrators have
unrestricted access to
Analysis Services.

Add Current User || Add... || Remove |

| < Back | | MNext > | | Cancel | | Help
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20. On the Reporting Services Configuration screen, select the Install Only button.

G SQL Server 2012 Setup [= e[|

Reporting Services Configuration

Specify the Reporting Services configuration mode.

Setup Support Rules Reporting Services Native Mode

Setup Role

Feature Selection 5 : i T i
Installs and configures the report s

Installation Rules setup completes.

/er in native mode. The report server is operational after

Instance Configuration

Disk Space Requirements Installs the report server files. After installation, use Reporting Services Configuration Manager

Server Configuration to configure the report server for native mode.

DO Uniglianon Reporting Services SharePoint Integrated Mode

Analysis Services Configuration

Reporting Services Configura... skl

Installs the report server files. After installation use SharePoint Central Administraticn to

Error Reportin 5 £ = 5 : SR

_p 3 : ] complete the configuration. Verify the SQL Server Reporting Services service is started and
Installation Configuration Rules create at least one SQL Server Reporting Services service application. For more information,
Ready to Install click Help.

Installation Progress

Complete

| < Back | | MNext > | | Cancel | | Help |

21. On the Installation Configuration Rules screen, review issues that occurred

during installation.

bl SQL Server 2012 Setup (=[x

Installation Configuration Rules

Setup is running rules to determine if the installation process will be blocked. For more information, click Help.

Setup Support Rules Operation completed. Passed: 5. Failed 0. Warning 0. Skipped 0.

Feature Selection

Installation Rules Show details >>

Instance Configuration View detailed report

Disk Space Requirements

Server Configuration

Database Engine Configuration
Analysis Services Configuration
Reporting Services Configuration
Error Reporting

Installation Configuration Rules
Ready to Install

Installation Progress

Complete

< Back | | MNext > | | Cancel | | Help
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22. On the Ready to Install screen, review all Feature details that you wanted to
install.

o SQL Server 2012 Setup = || = -

Ready to Install

Verify the SQL Server 2012 features to be installed.

Setup Support Rules Ready to install SQL Server 2012:
Setup Role -y "
Feature Selection | - Edition: Enterprise
Installation Rules - Action: Install (Product Update) =
Instance Configuration | T Pirerequ|5|te.s
: : —|- Already installed:
T Sreta e i S -Microsoft NET Framework 4.0
Server Configuration L. Windows PowerShell 2.0
Database Engine Configuration | =I- To be installed from media:
Analysis Services Configuration - Microsoft Visual Studio 2010 Shell
Renothing Service Conf fond] 1o Microsoft Visual Studio Tools for Applications 3.0
eporting Services Configuration
P g ; 9 —J- Windows feature(s) to be turned on:
Error Reporting .. Microsoft [NET Framework 3.5
Installation Configuration Rules | —|- General Configuration
Ready to Install | = Features
Installation Progress -Database Engine SENfces .
- Full-Text and Semantic Extractions for Search
Complete - .
- Analysis Services
Rennrtinea Sanricar - SharaDnaint e

| < m bl

Cenfiguration file path:

C\Program Files\Microsoft 5OL Servert 1100\ 5etup Bootstrap'Logh20141001_145338\ConfigurationFile.ini |

| < Back | | Install | | Cancel | | Help |

23. On the Installation Progress screen, monitor the download status of required
software and the status of installation.

P SQL Server 2012 Setup = || = -

Installation Progress

Setup Support Rules

Setup Role

Feature Selection Downloading the Setup files: 122 ME of 145 MB downloaded (84 %)
Installation Rules

Instance Configuration

Disk Space Requirements

Server Configuration

Database Engine Configuration
Analysis Services Configuration
Reporting Services Configuration
Error Reporting

Installation Cenfiguration Rules
Ready to Install

Installation Progress

Complete

Next = Cancel | | Help
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24. The Complete screen displays the status of features you selected to install. Close
the screen and restart Windows Server 2012 R2.

w5 SQL Server 2012 Setup EEEN

Complete

Your SQL Server 2012 installation completed successfully with product updates.

EEtupnppOlERCES Information about the Setup operation or possible next steps:

Setup Role
: Feature Status ~
Feature Selection
: < Management Tools - Complete Succeeded -
etalltnnEiiEs @ManagementTools- Basic Succeeded B
Instance Configuration () SOL Server Data Tools Succeeded
Disk Space Requirements @Database Engine Services Succeeded
Server Configuration @Full-Text and Semantic Extractions for Search Succeeded
(4 Analysis Services Succeeded v

Database Engine Configuration
Analysis Services Configuration

Reporting Services Configuration Details:

Error Reporting Viewing Product Documentation for SQAL Server ~
Installation Configuration Rules
Only the components that you use to view and manage the documentation for SQL Server have
been installed. By default. the Help Viewer component uses the online library. After installing
Installation Progress SQL Semer, you can use the Help Library Manager component to download documentation to
Complete your local computer. For more information, see Use Microsoft Books Online for SQL Server
zhttp://go. microsoft. com/fwlink/?L inkID=224683=.

Ready to Install

Summary log file has been saved to the following location:

C\Program Files\Microsoft SQL Server',11045Setup Bootstrap'Log\20141001 145338
‘Summary SuperMasterhMind 20141001 145338t

| Close | | Help |

25. After restarting Windows Server 2012 R2, you should be able to login in to your
SQL Server Instance.

“E.;} Micrasoft:
2 SQLServer2012

Server type: | Database Engine

Server name: I

Authentication: I‘Mndows Authentication

[ Connect H Cancel H Help H Optionsg =3 |

26. After completing the installation, configure the Named Pipes protocol for SQL
Server 2012. To do this, browse the following path using SQL Server
Configuration Manager:

SQL Server Configuration Manager > SQL Server Network
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Configuration > Protocols for MSSQLSERVER. Locate the Named Piped
protocol in the screen 's right panel and enable.

Installing and troubleshooting online prerequisites issues for
SharePoint 2013

Preliminary steps

NOTE: Before installing prerequisites, follow these steps to ignore an issue that
appears when installing.

1. Update Windows to the latest package.

2. Onthe Windows server, open Server Manager > Configure this local server
> IE Enhanced Security Configuration. Turn this setting off.

3. Add the following features with a Powershell command:
Add-WindowsFeature NET-HTTP-Activation,NET-Non-HTTP-Activ,NET-WCF-
Pipe-Activation45,NET-WCF-HTTP-Activation45,Web-Server,Web-
WebServer,Web-Common-Http, Web-Static-Content, Web-Default-Doc,Web-Dir-
Browsing,Web-Http-Errors,Web-App-Dev,Web-Asp-Net, Web-Asp-Net45,Web-
Net-Ext,Web-Net-Ext45,Web-ISAPI-Ext,Web-ISAPI-Filter, Web-Health,Web-
Http-Logging,Web-Log-Libraries,Web-Request-Monitor, Web-Http-Tracing, Web-
Security, Web-Basic-Auth,Web-Windows-Auth, Web-Filtering, Web-Digest-
Auth,Web-Performance,Web-Stat-Compression, Web-Dyn-Compression,Web-
Mgmt-Tools,Web-Mgmt-Console, Web-Mgmt-Compat, Web-Metabase, WAS, WAS-
Process-Model, WAS-NET-Environment, WAS-Config-APIs,Web-Lgcy-
Scripting,Windows-Identity-Foundation,Xps-Viewer -verbose

4. If you get the error Application Server Role, Web Server (IIS) Role:
configuration error when running the prerequisite installer, follow these steps.
a. Open the MMC console.

b. Add the Group Policy Object snap-in.

c. In Local Computer Policy, go to Computer Configuration >
Administrative Templates and select System.

d. In system settings, scroll down the list and find Specify settings for
optional component installation and component repair.

e. Inthe top left corner, select Enabled and Contact Windows Update
directly to download repair content instead of Windows Server
Update Services (WSUS).

f. Click OK and close the MMC console.

g. Goto Windows/System32, duplicate servermanager.exe and rename it
servermanagercmd.exe.

h. If the SharePoint 2013 Preparation tool is stuck in configuring the
Application Server and the Web Server IIS roles, close the Server Manager
windows. The tool starts the other configurations.

5. If you get an error with the AppFabric, remove the PSModulePath entry in the
system environment variables.
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Beginning the installation

1. Go the directory that contains your installation files.
2. Select the Prerequisiteinstaller.exe file and Run as Administrator.

Beginning the installation

Name Date modified Type Size
ifs.en-us File folder
. Ihpsrv.en-us File folder

. osfserver.en-us
osrv.en-us
ppsma.en-us
pptserver.en-us

| prerequisiteinstallerfiles

File folder
File folder
File folder
File folder

File folder

search.en-us File folder

. setup File folder

. SMs.en-us Open File folder

| sps.en-us File folder

sqlemui.en-us TSUBteShOOT Eompatibility File folder

updates Bevte 4ad File folder

visioserver.en-us P File folder

wasn.en-us Restore previous versions File folder

. wdsnv.en-us File folder

Send to L

WS5.EN-US File folder

xlserver.en-us hiy . Filefolder
[ autorun Copy I 1CO File 2KB
%] autorun Create shertcut 1M Setup Information 1KB
|2 default Delete u HTA File 14 KB
 Key R A TXTFile 1KB
(&) maverio0l P Application extens... 210K
V5 prerequisiteinstalles Application 1,602 KB
._. e — VT vETe— o
] setun 12/14/2011 1:40PM  Windows Comma... 1KB

3. You are prompted with a User Account Control dialog. Click Yes.

4. The Microsoft SharePoint 2013 Products Preparation Tool screen appears. You
can see the complete list of prerequisite products for installation.
E3

Microsoft® SharePoint® 2013 Products Preparation Tool

Welcome to the Microsoft® SharePoint® 2013
Products Preparation Tool

The Microsoft® SharePoirt® 2013 Products Preparation Toal checks your computer far
required products and updates. t may connect to the intemet to download products from the
Microsaoft Download Center. The tool installs and configures the following products:

| Microsoft .NET Framework 4.5 ~
* Windows Management Framework 3.0

* Application Server Role, Web Server (11S) Role

+ Microsoft SQL Server 2008 R2 5P1 Native Client

* Windows ldentity Foundation (KES74405)

* Microsoft Sync Framework Runtime 1.0 SP1 (x64)

» Windows Server AppFabric

* Microsoft Idertity Exdtensions

+ Microsoft Information Protection and Control Client

* Microsoft WCF Data Services 5.0

* Cumulative Update Package 1 for Microsoft AppFabric 1.1 for Windows Server
(KB2671763) hd

Leam more about these prerequisites

MNext > || Cancel |

5. The License Terms for software products screen appears. Read the license terms
carefully and check the box to accept the license terms.
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6. Prerequisite Installer enables the Application Server Role on your server. Then,
you are asked to restart the server.
Microsoft® SharePoint® 2013 Products Preparation Tool -

Your system needs to restart to continue. Press
Finish to restart your system.

* Mcrosoft MET Framawaork 4.5: was aleady ingalled no action taken)

+ Windows Management Frameworc 3.0; was already ingaled ino actiontacen)
+ Applcation Server Rale, Web Server (115) Role: requires restart of the computer to
complete instaling

+ Mcrsoft SCL Server 2008 B2 SP1 Mative Client: Instzllation skipped

+ Mcrosoft Sync Framework Rurtime w10 5P1 §:64): Instalation skipped

+ Windows Server AppFabnc: Instalaton skipped

+ Mcrosoft Identiy Exdersicons: Installation skipped

+ Mcrosoft Information Protection and Control Client: Installation skipped

+ Mcroseft WCF Data Services 5.0: Installaion s«ipped

+ Cumulative Update Package 1for Mcrosoft ApoFabric 1.1 for Windows Server
(KB2E71763): Instalation skipped

Bawiew the lagfile

= Back | Fimigh | | Canesl |

7. After you restart the server, the Prerequisite Installer continues the installation.

Microsoft® SharePoint® 2013 Products Preparation Tool -

Microsoft® SharePoint® 2013 Products Preparstion Tool

Newy Installing Prerequisies. .

Corfiguring Application Server Role, Web Server (15) Role

Started 3:55:23 PM, unning for 0:00:06

it > Cancel

1]
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8. The Prerequisite Installer configures the following components on your server.
» Application Server Role, Web Server (IIS) Role

» Windows Identity Foundation (Windows6.1-KB974405-x64.msu)

» Microsoft Sync Framework Runtime v 1.0 SP1 (Synchronization.msi)

» Windows Server App Fabric (WindowsServerAppFabricSetup_x64.exe)
» Microsoft Identity Extensions (MicrosoftldentityExtensions-64.msi)

» Microsoft Information Protection and Control Client

» Microsoft WCF Data Services 5.0 (WcfDataServices.exe)

» Cumulative Update Packagel for Microsoft App Fabric 1.1 for Windows
Server (AppFabricl.1-RTM-KB2671763-x64-ENU.exe)

9. Once all components are configured and installed, a screen asks you restart the
server. Click Finish.

Microsoft & SharePoint® 2013 Products Preparation Toal -

Your system needs to restart to continue. Press
Finish to restart your system.

+ Microsoft MET Framework 4.5: was already installed ino action taken)

+ Winodows Management Framewaor 3.0: was already installed (no action taken)

+ Application Server Role, Web Server (115) Role: configured successfully

+ Microsoft SQL Server 2008 R2 5P 1 Native Client: equivalent products already installed
{no action taken)

+ Microzoft Sync Framework: Runtime v1.0 SP1 (c6d) was already installed {no action
taken)

+ Windows Server AppFabric: installed successfully

+ Microsoft Identity Edensions: installed successfully

* Microsoft Information Protection and Control Client: installed successfully

+ Microsoft WCF Data Services 5.0: installed successfully

+» Cumulative Update Package 1 for Microsoft AppFabric 1.1 for Windows Server
(KB2671763): installed successfully

| Finish | | Cancel

All SharePoint 2013 prerequisites will be installed.

Installing SharePoint 2013
Prerequisites

» Avalid SharePoint 2013 Server product key.

NOTE: SharePoint Foundation 2013 is not compatible with Ektron.

» A domain user added to the administrators group of the search machine with
DBCreator permissions on the SQL server. (For example, Domain/SP_Admin.)
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1. Log into Windows Server 2012 R2 as a SharePoint Administrator (SP_Admin)

user.

Setting up search for your website

Other user

sp_admin

.00..00..00|

Signinto: .-

2. Go to the directory that contains the SharePoint 2013 Installation files.
3. Select the setup.exe file and Run as Administrator.

Mame

ifs.en-us

Ihpsre.en-us

osfserver.en-us

OsMV.EN-US

ppsma.en-us

pptserver.en-us

prerequisiteinstallerfiles
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17 PM

Open

wd B Run as administrater

WE

xlze

ﬂ aut

[Z] rea B
] set| @)
|%| set

I:E setlp

|| splash

Troubleshoot compatibility

Pin to Start

Restore previous versions
Send to

Cut

Copy

Create shortcut

Delete

Rename

Properties

|%| swrsetup.dll
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Installing SharePoint 2013

4. You see with User Account Control Window. Click Yes.
5. The Enter your product Key screen appears. Enter a valid SharePoint 2013

Server product key.

s Microsoft SharePoint Server 2013

| Enter your Product Key

Need to find your Product Key?

Your Product Key is 25 characters and is typically found in your product
packaging. If you cannot find your Product Key, click the “Learn more about
Product Keys and see examples” link.

Learn more about Product Keys and see examples

|
2]

6. The Read the Microsoft Software License Terms screen appears. Read carefully
and check the I accept the terms of this agreement box.

7. On the Choose a file location page, accept the default settings and click

Install Now.

g Microsoft SharePoint Server 2013

Choose a file location

'.___>.4J
| ==

}C:'\,Program Files'\Microsoft Office Servers

If you intend to use this computer as a search server, the search index files will be
stored on the local hard drive, These files can be very large, so ensure that there is
sufficient free space on the selected drive. To change where Microsoft SharePoint
Server 2013 will store its search index files, click Browse, and then select the location.

Ch\Program Files\Microsoft Office Servers15.00\Data

Microsoft SharePoint Server 2013 will be installed on your computer, To install this
product in a different location, click Browse, and then select the location,

Browse...

Erowse..

Install Mow

8. A screen informs you that it is preparing files for Installation of SharePoint 2013.
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9. An Installation Progress screen appears. It might take some time to complete.
g Microsoft SharePoint Server 2013 *

@J Installation Progress

Finalizing installation. This may take a few minutes.

10. When the installation completes, a Run Configuration Wizard appears. Check the
Run the SharePoint Products Configuration Wizard now box. Click the
Close button.
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11. The Welcome to SharePoint Products screen appears.

SharePoint Products Configuration Wizard I;‘i-

Welcome to SharePoint Products

Inorderto configure SharePoint Products, you will require the following information:

= Name of database server and database where server farm configuration data will be stored

m Username and password forthe database access account that will administer the senver farm

Click Next to continue or Cancel to exit the wizard. To run the wizard again, click on the Start Menu shaortcut.

|

| Mext = H Cancel ‘

12. During Configuration, you are prompted to restart the services. Click Yes to
continue.
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SharePoint Products Configuration Wizard -8 X

Welcome to SharePoint Products

In orderto configure SharePoint Products, you will require the following infarmation:

m MName of database server and database where server farm configuration data will be stored

m |Jpoenomaan Aeomemime A fmrbbo Aobmbam e e s kbbb gl s A i it b s e e e Eon

SharePoint Products Configuration Wizard =

The following services may have to be started or reset during

! v, configuration:
Internet Information Services
SharePoint Administration Service
SharePoint Timer Service
Choose yes to restart the services if required and continue with the
configuration wizard or ne to exit the configuration wizard.
Click M rtcut.
Yes | ‘ Mo
‘ Mext = ‘ | Cancel

13. Onthe Connect to a server farm screen, click the Create a new server
farm button.
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SharePoint Products Configuration Wizard \;‘i-

Connect to a server farm

Aserverfarmis a collection of two or more computers that share configuration data. Do youwantto
connectto an existing server farm?

) Connectto an existing serverfarm

(®) Create a new server farm

| < Back H Next = || Cancel |

14. On the next screen, complete the fields below to complete the configuration.
+ Database server. Instance name of your SQL Server 2012 R2

- Database Name. Database of the SQL Server
» Username. Domain user (SP_Farm)
» Password. Your choice
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SharePoint Products Configuration Wizard |;|i-

Specify Configuration Database Settings

All serversinaserverfarm must share a configuration database. Typethe databaseserverand database
name. If the database does not exist, it will be created. To reuse an existing database, the database must be
empty. Foradditional informationregarding database server security configuration and nebwork access
pleaseseeshslp.

Datobase serve E— |

Database name: |5harePoint_Conﬁg |

Specify Database Access Account

Select an existing Windows account that this machine will always useto connect to the configuration
database. If yourconfiguration databaseis hosted on another server, youmust specify a domain account,

Typetheusernameintheform DOMAIN\User_Name and passwordforthe account.

Password: |...oo-o-o-o |

‘ < Back || Mext > H Cancel ‘

15. On the Specify Farm Security Settings screen, to provide a password to secure

the configuration data.
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SharePoint Products Configuration Wizard \;li-

Specify Farm Security Settings

Flease enter a new passphrase forthe SharePoint Products farm. This passphraseis used to secure farm
configuration data and is required for each serverthatjoins the farm. The passphrase can be changed after
thefarmis configured.

Passphrase: || |

Confirm passphrase: | |

16. On the following screen, set up the port number and security settings for your
site.
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SharePoint Products Configuration Wizard \;li-

Configure SharePoint Central Administration Web Application

A SharePoint Central Administration Web Application allows youto manage configuration settings for a server
farm. The first server added to a serverfarm must host this web application. To specify a port numberforthe
web application hosted on this machine, check the boxbelow and type a number between 1 and 65535, If
you do not specify a port number, a random one will be chosen,

Specify port number: | 3010

Configure Security Settings

Kerberos is the recommended security configuration to usewith Integrated Windows authentication. Kerberos
requires spedal configuration by the domain administrator. NTLM authentication will work with amy
application pool account and the default domain configuration. Show me more information.

Choose an authentication provider for this Web Application.

®) NTLM
() Megotiate (Kerberos)

‘ < Back || Mext = H Cancel ‘

17. On the Completing the SharePoint Products Configuration Wizard screen, click
Next.

SharePoint Products Configuration Wizard =l -

Completing the SharePoint Products Configuration Wizard

The following configuration settings will be applied:

= Caonfiguration Database Server _-
= Configuration Database Name
= Hostthe Central Administration Web Ap plication
= Central Administration URL
= Authentication provider

Click Nextto apply configuration setfings.

[ <ok |[ text> ][ oo |

18. When the configuration completes, you see the Successful message. Click
Finish.
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SharePoint Praducts Configuration Wizard == =

Configuration Successful

Thefollowing configuration settings were successfully applied:

= Configuration Database Server

!

= Configuration Database Name [SharePoint_Config

= Hostthe Central Administration Web Appliction [yes
= Central Administration URL Ihttp:/, 10/
» Authentication provider

ClickFinishto dosethis wizard and launch the SharePoint Central Administrationwebsite to continue
configuring yeur SharePointinstallation. The users may be prompted by theirweb browser fortheusername
inthe form DOMAIN\User_Name and password to access the site. At that prompt, enterthe credentials that
youusedtalogento this computer. Add this siteto the list of trusted sites when prompted.

19. You should be able to configure your site through a browser. If you want to take
part in the Microsoft Improvement program, select an option here.

SharePoint

Welcome ¢

Help Make SharePoint Better

Central Administration i p make sharePcint better?

Sign up for the Customer Experience Improvement Program and automatically
upload error reports to Microsoft

O Yes, 1 am willing to participate (Recommended).

How do you want ta
gurat

This wizard will help with th

O No, | don't wish to participate.
You can launch this wizard§

More Information

myse!

ade and Migration

General Application

settings

Configuration Wizards

20. The welcome page of the SharePoint Farm configuration appears. Click the Start
the Wizard button.

SharePoint I o

Qomre T
Welcome o

How do you want to configure your SharePoint farm?

YVes, walk me through the configuration of my farm
this wizard.

Start the Wizard
This wizard will help with the iitial configuraticn of your SharePoint farm. You can select the services to use in this farm and create your first site. using

System Settings

You can launch this wizard again from the Configuration Wizards page in the Central Administration site
Monitoring

Backup and Restore
No, | will configure everything myseff Cancel
Security

Upgrade and Migration

General Application
Settings

21. On the Services screen, configure a new Service Account to operate SharePoint.

NOTE: The SP_FARM user should be a domain user that was added to the
administrators group of the search machine, otherwise it will not let you add

it. Instead of setting up a new user you can click Use existing managed
account.
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SharePoint

Services o

Next Cancel

System O Use existing managed account

o]

@ Create new managed account

Monitor

User name
| B
o

Passw

Access Services 2010
Allows viewing, editing, and interacting with Access
Services 2010 databases in a browser.

Access Services
Allows viewing, editing, and interacting with Access
Services databases in a browser.

App Management Service
Allows you to add SharePoint Apps from the
SharePoint Store or the App Catalog.

Business Data Connectivity Service
Enabling this service provides the SharePoint farm with

22. A progress screen appears, saying Working on it.

23. When your service account is created, create a site collection in SharePoint
2013. Enter a site name of your choice.

SharePoint niGR——-  X 2

Qo

- Create Site Collection o

Central Administeation

- Cancel
Application

Management

b Application

t  web appicaton, weo applicaton: | -

To create a new web applic

System Settings

Monitoring

tion 5o to Nevw Web Application page.
Backup and Restore 9 PPl 9

Security Title 2nd Description -

Upgrade and Migration Title:

n for your new site. The ttle wil be displayed

General Application Sharepointsite
Settings Description:
Apps
Configuration Wizards
Web Site Address
URL

name and URL path to create a new site, or choose to

< speciic path P N

To add a new URL Path go to the Define Managed Paths page.

24. A success message appears.
25. You should see your SharePoint 2013 site.

SharePoint

Newsfeed  SkyDrive  Sites  [RSIVCCCURTNE o B4

BROWSE  PAGE

O sure Yyrouow LZsme 4 o

SharePointSite # EDITLINKS. Search this site pel
- SharePointSite

Home Get started with your site  removeTHis

vl | &)

Documents

Site Contents

# EDITLINKS O

Working on a Add lists, libraries, and
deadline? other apps. What's your style? Your site, Your brand.

Share your site.

Newsfeed Documents
Starta conversation @ new document or drag files here

v O Name

It's pretty quiet here. Invite more people to the site, or start a conversation. ) Autospinstaler

Configuring Ektron to work with Microsoft Search
Server 2013 or 2016

Prerequisites
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Prerequisites

* Both servers can browse to each other across the network.

» On your Ektron server
o Set SQL Security to SQL Server and Windows Authentication mode.
o Create a SQL user login with the sysadmin role. Microsoft Search Server
2013 or 2016 uses that login to access the Ektron database.
o Enable the TCP/IP for SQL server. Open SQL Server Configuration Manager
> SQL Server Network Configuration > Protocols for MSSQLSERVER >
Enable all 3 items. Restart the server.
» On your Microsoft Search Server 2013 or 2016 server
° QObtain the username and password of a user with Windows administrator
privileges.
1. Install or upgrade Ektron on its server, using the normal procedure. On the
Search Provider screen, choose Microsoft Search Server 2013 or 2016.
2. On Ektron server, copy the folder c:\Program
Files\Ektron\CMS400versionnumber\Utilities\SearchServer.

3. On the Microsoft Search Server 2013 or 2016 server, paste that folder and run
the file EktronSearchConfiguration.exe.

4. The following screen appears.

EktronSearchConfiguration - Installshield Wizard

Ektron Search Installation

Id like to install the Ekkron files,

ktron :

’ < Back ” —

Select the folder to which you want to install the Search Server files. Ektron
recommends using the default folder. Click Next.

5. The following screen appears. Enter the domain, username, and password of a
user with Windows Administrator privileges on the server you will use for
Microsoft Search Server 2013. Click Next.
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EktronSearchConfiguration - InstallShield Wizard

Search Administrator Credentials

ktron

Inistallshie]d ’ < Back ” Hext » ] Cancel

6. Enter the path where you want to locate the Ektron Querying Services website.
Click Next.

EktronSearchConfiguration - InstallShield Wizard E3

Website location

Plzase enter the path ant the Ektr : ko be located.

ktron

Erowse. ..

InstalEhiEld l < Back ” i

7. Enter the port number you want to use with the Ektron Querying Services
website. Click Next.
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EktronSearchConfiguration - InstallShield Wizard E

Ektron website port number

o

et the port number you want ko use with the

=ktron

[ < Back l ’ ek = ] Cancel

8. Click Yes for using Microsoft Search Server as your search provider.

Question |
| Are wou using Microsoft Search Server as waour search provider?
If wau are using Microsoft FAST Search for SharePaink, click Mo’
Yes Mo |

9. The following message appears, instructing you what to do next.

EktronSearchConfiguration - Installshield Wizard | x| |

Please run the Ektron Search Configuration Utiliky o connect your
site to your search provider,

Moke: The Ekkron Search Configuration utility can be Found in the
Following lacation: [InstallDir Jiklibes),
SearchServer\Ektron, Cms, Search, Config, UL exe

10. Open the Search Configuration screen, available from c:\Program Files
(x86) \Ektron\

CMS400versionnumber

\Utilities\SearchServer\Ektron.Cms.Search.Config.UI.exe.
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11. Enter the CMS Server Machine Name and SharePoint Administrator URL. Click

Next.

Setting up search for your website

E('5'6'/@-10[). net
CMS Databases:

I Site Registration

Crawl Management

 Ektron Search Configuration P =]

“w Ektron Search Configuration [x]

Step 1: Connection Information

Please enter the connection details for your CMS server and SharePoint Central
Administration server.

CMS Server Maching Name: ||

| What is the CMS Server Machine Name?

Enter the machine name of the server hosting the CMS site(s) you intend
to configure. A list of the sites available for configuration will be retrieved
for you to chooss from.

SharePoint Administration URL:

# | What is the SharePaint Administration URL?

Enter the URL identifying the SharePoint Central Administration portal
intended to support your CMS site(s).

To find the URL, run the SharePoint Central Administration utility from the
Start Menu as an administrator. The host and port number that appsar in
the address bar represent the URL required above.

Format:
http:/{[host-name]:[port-number]

Wersion: 9.3.0.075

—
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12. Click Next.

EiEktI‘DI‘I Search Configuration

Step 2: Search Service Applications

Please select the service applications relevant to your CM5 site,

SharePoint Administration URL: http:/ MWIN-I4QULHMLIOED: 47932

Provider Type: Search Server
Content Service Application: [Seard1 Service Application - |
Query Service Application: [Seard'l Service Application - |

# | What are service applications?

& ==arch service application encapsulates the various components
necessary to index and guery a search data store.

Depending on your deployment, there may be one sarvice application
supporting both content and query or there may be different service
applications supporting each of thess functions.

[Back|[Next|[Exit|

Version: 9.3.0.07%
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13. The following screen appears.
l

E(."_"Blg__i,nt_}['_)[:) net Site Registration

Content sources for your CMS site must be registered with the search provider (Microsoft Search Server [
FAST). A content source is a sat of options specifying the typs of content to crawl, when to perform that
crawl, and how desp to craml.

CMS Databases:

vnlabvma0 / CMS400Minvma0 ¥ 3 This site has not yet been registered or requires re-registration.

You can register your site by entering the data requested below.

I Site Registration CMS Database: vrlabymad / CMS400Minvma0
Site ID: 2
Database: CMS400MinvmB0

Database Server: wnlabvm80
Site URL: hitp://WVNLABVMB0
ersion: 9.3.0.0755P1

CMS Database Connection String:

The indexing components must connect to your CMS site's database in order to crawl its
content.

Note: The connection string is not displsyed here for security reasons, I you do not provics
3 connaction string, either the one from the web.config of your site or the one from an
evisting registration (i any) will be used|

If you provide & connection string, i must be accessibie from the server hosting the search
proviger.

Crawl Interval:

Your CM3 site checks to see if content or related CMS objects were added or updated within
the interval configured below. If any changes occurred, a crawl is performed.

Interval: I 300 saconds

Credentials:

Your CM3 site must authenticate with the search provider when submitting a query. Please
enter the credentials for a Windows user with access to your search provider's indexes.

Domain: I WIN-T4QULHM10ED

Username: I Administrator

Password: £

+ | Advanced Options...

Register Site

a. Inthe CMS Databases drop-down, choose the database you installed.

b. In CMS Database Connection String section, enter the connection string

of your Ektron site. It must be accessible from the server hosting the search
provider.

c. In Credentials section, enter domain, username and password of a
Windows user can access to your search provider’s indexes.

d. Click Register Site.
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Working with Microsoft FAST
search

Microsoft FAST Search provides the following advantages:

» Profile ranking. Forces topics to the top of search results. See Managing rank
profiles on page 447

» Faceted searching. See Using faceted search on page 443
« Documentation promotion. See Add, remove and display document
promotions for a keyword by using Windows PowerShell (FAST Search Server
2010 for SharePoint) and Add document promotions.
o Supported for CMS content
o Entirely configured within SharePoint/FAST
° No explicit API or templated control support required
» High degree of relevant results/Similar Results. See Improving Relevance
for FAST Search Server 2010 for SharePointand Find Similar (FAST Search
Server 2010 for SharePoint)
o Supported for CMS content

° No configuration required

o Support exists within the API and templated controls to add this to search
criteria.

This chapter explains how to set up Microsoft FAST Search, and how to use its
features.

Setting up a Microsoft FAST search

PREREQUISITE

You purchased and deployed Microsoft FAST Search Server 2010 and
SharePoint Server 2010. See also: Licensing Q&A: Determining Your
Licensing Needs, Product Licensing Search

Configuring Ektron to work with Microsoft FAST Search Server 2010 and SharePoint
Server 2010 involves the following major tasks.

e Part 1: Install SharePoint 2010 and Microsoft FAST Search Server 2010 on the
next page

e Part 2: Set up Microsoft FAST Search Server 2010 for SharePoint 2010 Search on
the next page

e Part 3: Enable querying from SharePoint to Microsoft FAST Search Server 2010
on page 433

» Part 4: Enable indexing of additional formats on page 434
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e Part 5: Verify that Microsoft FAST Search Server 2010 can communicate with
SharePoint 2010 on page 435

e Part 6: Set up Ektron to work with Microsoft FAST Search Server 2010 on
page 437

e Part 7: Make FAST SharePoint’s query search application on page 440
After you complete the tasks...

» the FAST service is configured to crawl the Ektron site.
» Ektron events that affect content trigger a FAST crawl.

» Ektron templated search controls can execute FAST queries to retrieve search
results.

Part 1: Install SharePoint 2010 and Microsoft FAST Search
Server 2010

1. Install SharePoint 2010 and Microsoft FAST Search Server 2010, each on its own
server, on the same domain. Please refer to Microsoft's installation
documentation for details.

NOTE: When installing Microsoft FAST Search Server 2010, you are
prompted to enter a certificate password. Note this password, because you
need it in Part 2c: Set up SSL-enabled communication on page 428.

2. Create 2 domain user accounts: one for Microsoft FAST Search Server 2010 and
one for SharePoint 2010.

3. Add the SharePoint site administrator to the Microsoft FAST Search Server 2010
administrators group (located on the Microsoft FAST Search Server 2010
server).

Part 2: Set up Microsoft FAST Search Server 2010 for
SharePoint 2010 Search

You need to create 2 Search Service Applications.

 FAST Search Connector. for crawling content.

 FAST Search Query. for accepting search terms, querying the database, and
returning results.

In this section, you complete these tasks.

e Part 2a: Create a collection for the content source below

e Part 2b: Create a FAST search connector service application for crawling content
on the facing page

e Part 2c: Set up SSL-enabled communication on page 428
e Part 2d: Create a search service application for querying on page 429

Part 2a: Create a collection for the content source
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Part 2b: Create a FAST search connector service

Before creating the FAST Search Connector, create a collection for the Ektron content
source. The collection lets you clear only Ektron content from the index. To learn
more, see Manage content collections (FAST Search Server 2010 for SharePoint).

1. On the Microsoft FAST Search Server 2010 server, go to Start > All Programs.

If you're using Windows 8 or 2012, go to
C:\ProgramData\Microsoft\Windows\Start Menu\Programs\.

2. Right click Microsoft FAST Search Server 2010 for SharePoint and click
Run as Administrator. A PowerShell window for managing Microsoft FAST
Search Server 2010 appears.

= Administrator: Microsoft FAST Search Server 2010 for SharePoint

FE C:»FASTSearch hin* New-FASTSearchContentCollection —Mame ektroncms —Pipeline

"O0fficeld (webcluster>"

: ektroncms

: 2@11-11-A1T13:55:=18
: 2@11-11-A1T13:55:18
: @

: Officel4 <{webcluster)

3. Enter the following command:
New-FastSearchContentCollection —-Name ektroncms —-Pipeline
"Officeld (webcluster)”

NOTE:

* The Name is the new collection nhame.

* Surround the Pipeline name in quotes (as shown above).
* Surround webcluster with curly brackets ().

* See also: New-FASTSearchContentCollection

Part 2b: Create a FAST search connector service application for crawling
content

1. Open SharePoint 2010 Central Administration home page.
2. Under Application Management, click Manage Service Applications.

3. Onthe Manage Service Applications page, click New > Search Service
Application.
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Site Actions =

=1

MNew | Connect Delete Manage Adm

L

Browse Service

Access Services

Business Data Connectivity Service
Excel Services Application

Managed Metadata Service
PerformancePoint Service Application

PowerPoint Service Application

Search Service Application

eleeerpeel

Secure Store Semvice

ﬁ1 llcar Drafila Canvira Arnnliratinn

4. Complete the screen.
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Part 2b: Create a FAST search connector service

Specify the properties Far this Search Service Application. The settings you specify here can be changed later using the pre

Manage Service Applications page.
& new Search 3ervice Application will hawe an initial fbopology with all components on one application server and all databas:

server, The topology of this application can be changed later using the Modify Topology link located on the Farm Search Ad

Name
Prowide a unique name For this Service Application,

FAST Service Application

If wou are deploving a FAST Search Service Application, select the
type of application to enable additional properties,

Learn more about FAST Search Service Application properties,

Search Service Account

This is the Windows Service account For the SharePoint Server Search
Service, This setking affects all Search Service Applications in the
fFarm. ¥ou can change this account fram the Service Accounts page
under Security seckion in Central Administration,

Application Pool for Search Admin Web Service

Choose the Application Pool ko use For this Service Application. This
defines the account and credentials that will be used by this web
SErVICE,

‘fou can choose an existing application pool or create a new one,

Content Distributors

Provide the location of the content distributors in the Format
FODM: port, Use semicolons(;) to separake multiple entries.

Content Collection Name

Provide the name of the content collection which will hold content
crawled by this connector,

Service Application name

FASTContentConnector

 Mone
¥ FAST Search Connector
 FAST Search Query

Search Service Aocount

EKSEARCH\ekspservice =]
Reqgister new managed account

' Use existing application pool

I EKTFASTContent=34

{* Create new application pool
Application pool name

[FasTContentssa

Select a security account For this application pool

" Predefined
|Network Service;l

{* Configurable

| EKSEARCHYeksp =
Reqgister new managed accounk

Content Diskributors

ektsqa20.fsqa.ektron.com:13391

Conkent Collection Marne

|ektrnncms|

« Name. Enter a unique name for this application.
» Fast Service Application. Select Fast Search Connector.

» Search Service Account. Click Register new managed account to
create a new account for this search service.

» Application Pool for Search Admin Web Service. Select Create new
application pool and enter a name. Under Select a security account,
select Configurable and select the account under which the SharePoint
search service is running. You created this account in Part 1: Install
SharePoint 2010 and Microsoft FAST Search Server 2010 on page 424.

Ektron Reference I 427



Setting up search for your website

» Content Distributors. On the Microsoft FAST Search Server 2010 server,
open the $FASTSEARCH%\Install Info.txt file. Copy the value of Content
Distributors (for GUI SSA creation) to this field.

FASTSearch: Installation Details

Query Service Location HTTP (default):
http://ektsga20.fsga.ektron.com:13287

Query Service Location HTTPS:
https://ektsqa20.fsga.ektron.com:13286

Administration Service Location HTTP (default):
http://ektsga20.fsga.ektron.com:13257

Administration Service Location HTTPS:
https://ektsqa20.fsga.ektron.com:1325

8Resource Store Location:
http://ektsqga20.fsga.ektron.com:13255

Account for Administration Service:
fsga\fsuser

Content Distributors (for PowerShell SSA creation):
ektsga20.fsga.ektron.com:13391

Content Distributors (for GUI SSA creation):
ektsga20.fsga.ektron.com:13391

Default Content Collection Name: sp

NOTE: Keep the Install Info.txt file open—you need itin Part 2d:
Create a search service application for querying on the facing page.

» Content Collection Name. Enter the name you entered for the Name
parameter in Part 2a: Create a collection for the content source on
page 424.

Part 2c: Set up SSL-enabled communication

To authorize SSL communication between SharePoint 2010 and Microsoft FAST
Search Server 2010: Source: Create and set up the Content Search Service
Application (FAST Search Server 2010 for SharePoint)

PREREQUISITE

You need the password you supplied when setting up Microsoft FAST
Search Server 2010.

Log on to the Microsoft FAST Search Server 2010 server.

Open \FASTSearch\installer\scripts.

Copy securefastsearchconnector.ps1 to any folder on the SharePoint server.
Open \FASTSearch\data\data security\cert.

i
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Part 2d: Create a search service application for

5. Copy FASTSearchCert.pfx to any folder on the SharePoint server.
6. Log onto the SharePoint server.

7. Open a Microsoft SharePoint 2010 Management Shell using Start >All
Programs > Microsoft SharePoint 2010 Products.If you're using Windows

8 or 2012, press the Windows key (E) /Q then enter Microsoft SharePoint
2010 Products

8. Right click SharePoint 2010 Management Shell and click Run as
Administrator.

9. Go to the directory to which you copied the securefastsearchconnector.ps1 script
in Step 3.

10. Run the script, replacing parameters with your environment's values. For
example:

.\SecureFASTSearchConnector.psl
—certPath "path of the certificate\FASTSearchCert.pfx"
—ssaName "name of your content SSA"
-username “domain\username”

Replace the following parameter values:

» certPath. The folder path to which you copied the certificate in Step 5.

» ssaName. The Name you assigned to your FAST Search Connector service
application in Part 2b: Create a FAST search connector service application
for crawling content on page 425.

» username. The domain and username under which the SharePoint 2010
service runs. You set up this account in Part 1: Install SharePoint 2010 and
Microsoft FAST Search Server 2010 on page 424.

11. When prompted to enter a certificate password, enter the password you supplied
when you ran the post-setup configuration of Microsoft FAST Search Server
2010.

Part 2d: Create a search service application for querying

(Source: Create and set up the Query Search Service Application (FAST Search
Server 2010 for SharePoint))

1. Open the SharePoint 2010 Central Administration home page.
2. Under Application Management, click Manage Service Applications.
3. Onthe Manage Service Applications page, click New > Search Service
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Application.

site Actions ~ @l Browse Service

=

MNew | Connect Delete blanage Adm
x

Arcess Services

Business Data Connectivity Service
Excel Services Application

Managed Metadata Service
PerformancePoint Service Application

PowerPoint Service Application

Search Service Application

Secure Store Semvice

cefrlerprp el

Ilrar Drafila Canvira Annlicratinn
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4. Complete the screen.

Name
Provide a unique name for this Service Application.

FAST Service Application

If vou are deploving a FAST Search Service Application, select the

type af application ko enable additional properties,

Learn more about FAST Search Service Application properties,

Search Serrice Account
This is the Windows Service account For the SharePaink Server

Search Service, This setting affects all Search Service Applications
in the Farm, ¥ou can change this account from the Service Accounts

page under Security section in Central Adminiskration,

Application Pool for Search Admin Web Service

Choose the Application Poal to use For this Service Application. This

defines the account and credentials that will be used by this web
service.

‘fou can choose an existing application poal or create a new one,

Application Pool for Search Query and Site Settings Web

Service

Choose the Application Poal to use For this Service Application. This

defines the account and credentials that will be used by this wah
service.

‘fou can choose an existing application poal or create a new one,

Query Service Location

Pravide the location of the query service in the Format
prokacal:fFQDMN:port. Use semicolons{;) ko separate multiple
entrigs,

Administration Service Location

Prowide the location of the administration service in the format
prokacal:IFQDMN: port.,

Resource Store Location

Prowide the location of the resource store in the Format
prokacal:IFQDMN: port.,

Account for Administration Service

Prowide the account which will be used to authenticate to the
administr ation service,

Part 2d: Create a search service application for

Service Application name

EktQuery

Oy Mone

(O)FAST Search Conneckor

@FasT Search Qusry —  Be sure to select
"] Fast Search Query!

Search Service Accounk

EKSEARCH\ekspservice w
Reqgister new managed account

(O Use existing application pool

() Create new application poal
Application pool name

EktQueryadmin

Select a security account Far this application poal
() Predefined

(® Configurable
EKSEARCH\eksp w
Reqgister new managed account

(T3 Use existing application paal

(®) Create new application poal
Application pool name

EktQuerySettings
Select a security account For this application poal
() Predefined

(&) Configurable
EKSEARCHYeksp L'
Reqgister new managed account

Query Service Location

Administration Service Location

Resource Store Location

Account For Administration Service

EkSearch\ERTFast

« Name. Enter a unique name for this application.
+ Fast Service Application. Select Fast Search Query.

» Search Service Account. Click Register new managed account to

create a new account for this search service.

» Application Pool for Search Admin Web Service. Select Create new
application pool and enter a name, such as EktQueryAdmin. Under Select
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a security account, select Configurable and select the account under
which the SharePoint search service is running. The application pool must
run in the context of a FAST Search administrator.

» Application Pool for Search Query and Site Settings Web Service.
Select Create new application pool and enter a name, such as
EktQuerySettings. Under Select a security account, select Configurable
and select the account under which the SharePoint search service is
running.The application pool must run in the context of a FAST Search
administrator.

Query Service Location. Open the $FASTSEARCH%\Install Info.txt file
to obtain the value for this field. Use the HTTPS value if you want to use
secure communications between the SharePoint 2011 and Microsoft FAST
Search Server 2010 servers.

FASTSearch: Installation Details

Query Service Location HTTP (default):
http://ektsga20.fsga.ektron.com:13287

Query Service Location HTTPS:
https://ektsqga20.fsga.ektron.com:13286

Administration Service Location HTTP (default):
http://ektsga20.fsga.ektron.com:13257

Administration Service Location HTTPS:
https://ektsqa20.fsga.ektron.com:13258

Resource Store Location:
http://ektsga20.fsga.ektron.com:13255

Account for Administration Service:
fsga\fsuser

« Administration Service Location. Obtain the value for this field from

$FASTSEARCH%\Install Info.txt. (See example above.) Use the HTTPS
value if you want to use secure communications between the SharePoint
2011 and Microsoft FAST Search Server 2010 servers.

Resource Store Location. Obtain the value for this field from
$FASTSEARCH%\Install Info.txt. (See example above.)

» Account for Administration Service. specify a domain account for a user

who is a member of the FAST Search Administrators group on the Microsoft
FAST Search Server 2010 server.

5. You see a confirmation that a new Query Search service application is created.
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Part 3: Enable querying from SharePoint to

Part 3: Enable querying from SharePoint to Microsoft FAST
Search Server 2010

Part 3 describes how to transfer a Microsoft FAST Search Server 2010 STS certificate
(MOSS_STS) from SharePoint Server 2010 to FAST servers. This certificate enables
SharePoint query servers to provide security-trimmed queries. See also: Enable
queries from Microsoft SharePoint Server (FAST Search Server 2010 for SharePoint)

PREREQUISITE

You will need a SharePoint Server 2010 directory that is accessible to
Microsoft FAST Search Server 2010 servers.

3. At the Windows PowerShell command prompt, enter the following commands.

$SstsCert = (Get-SPSecurityTokenServiceConfig)
.LocalloginProvider.SigningCertificate
SstsCert.Export ("cert") | Set-Content -encoding byte MOSS STS.cer

4. The Moss STS.cer file is created in the directory in which you run the
commands.

5. Copy MOsSs STs.cer to a directory accessible to the Microsoft FAST Search
Server 2010 server(s).

6. Import the SharePoint STS certificate to each Microsoft FAST Search Server
2010 server. To do that:
a. On the Microsoft FAST Search Server 2010 server, click Start >All
Programs > Microsoft FAST Search Server 2010 for SharePoint.
b. Right click Microsoft FAST Search Server 2010 for SharePoint and
select Run as administrator.

c. Atthe Windows PowerShell command prompt, browse to
<FASTSearchFolder>\installer\scripts\, where <FASTSearchFolder>
is the path to the Microsoft FAST Search Server 2010 folder. For example,
C:\FASTSearch\installer\scripts\.

d. Enter the following command:

.\InstallSTSCertificateForClaims.psl
—-certPath <"full path of MOSS STS certificate">

Where full path of MOSS STS certificate is the path to the location to
which you copied the MOSS_STS.cer file in Step 5.

7. Repeat steps 6a through 6d for all query servers (if you have more than one).
8. Within the PowerShell window, check the status of FAST services by entering the
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following command: nctristatus. The results should look something like this.

Administrator: Microsoft FAST Search Server 2010 for SharePoint

PS C:“FASTSearch~hin> cd C:“FASTSearch~installersscripts

PS C:~FASTSearch~installersscripts? .SInstallS8TSCertificateForClaims.psl —certPa
th C:~MO55_STS.cer

PS C:~FASTSearch~installersscripts>

PS C:“FASTSearchninstallerscripts> nctrl status

Connecting to Mode Controller at localhost:13268..

Issuing ’status’ reguest to Mode Controller..

Status for node : EKTFS545P

FAST Search : C:NFASTSE™1
Disk status : 32% used — 182.63 GB free — 47.27 GB used - 147.98 GBE total

Process MName Status

browserengine Running

configserver Running

contentdistributor Running

crauvler Running

fdmuworker Running

indexer Running

indexingdispatcher Running

nameservice Running

procserver_1 Running

procserver_2 Running

~ procserver_3 Running

Document Processor procserver_4 Running
QRProxy Service qrpProxy Running
QRServer qrseprver Running
SAM Admin samadmin Running
SAM Worker samworker Running
RIS Search search-1 Running
Automatic spellcheck tuning spelltuner Running
sprel Running

topfdispatch Running

walinkstorerreceiver Running

walookupdbB Running

llebAnalyzer webanalyzer Running

PS C:~FASTSearch~installersscripts?> _

Part 4. Enable indexing of additional formats

Advanced Filter Pack is a Microsoft FAST Search Server 2010 feature that enables
text and metadata extraction from several hundred file formats (such as PDF),
complementing the document formats supported by the Microsoft Filter Pack.

PREREQUISITE

Install 1 of the following PDF filters on the Microsoft FAST Search Server

2010 server:

« Foxit PDF filter (Foxit® PDF IFilter - Server—recommended if you will

index a large number of PDF files)

» Adobe 64-bit PDF iFilter (installed on Ektron server Cc:\Program
Files (x86)\Ektron\CMS400vxx\Utilities\iFilterPack)

Go to the [FASTSEARCH] folder (represented by the environment variable

%FASTSEARCH%).

Move to the installer\scripts folder using this command: cd
.\installer\scripts.

Insert the command .\AdvancedFilterPack.psl —-enable.
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10.

Part 5: Verify that Microsoft FAST Search Server

When you see Are you sure you want to continue, enter.

a Administrator: SharePoint 2010 Management Shell

ASTSearch> cd .“installersscripts

earchuvinstallersscripts> _“AdvancedFilterPack_psl —enable

: You are about teo enable text and metadata extraction support for
hundred additional file formats. Please see the product documentation
for details ahout which file formats are enahled by default and which ones are

enabled hy the Advanced Filter Pack. For security reasons, it is recommended to
only enahle these additional filters if vyou have content wusing these file
formats.

Are you sure you want to continue (y/ni>: ¥

Advanced Filter Pack is successfully enabled.

PS5 C:=~FASTSearch~installer scripts> _

Open the file $FASTSEARCH%\etc\config
data\DocumentProcessor\formatdetector\user converter rules.xml.

Enable PDF format detection by adding <ext name=".pdf"
mimetype="application/pdf" />and <mime type="application/pdf">PDF
Document</mime> as show in the following example:

<ConverterRules>

<IFilter>

<trust>

<!-- A list of extensions that bypasses the builtin format detection.
Any extension that is not supported out-of-the-box, need to be
added here along with the mimetype if you have installed an IFilter
for that type and want to use it. A mime element should also be
added to the MimeMapping element with a human-friendly description
of the type.
<ext name=".xxx" mimetype="application/xxx" />
<ext name=".yyy" mimetype="image/yyy" /> -->
<ext name=".pdf" mimetype="application/pdf" />

</trust>

</IFilter>

<MimeMapping>

<!-- A mapping between mime types and the description of them.

<mime type="application/xxx">XXX Document</mime>

<mime type="application/postscript">YYY Image</mime> -->
<mime type="application/pdf">PDF Document</mime>

</MimeMapping>

</ConverterRules>

IMPORTANT: Back this file up in a safe location, so that you can re-enter
these changes if you later need to apply a FAST service pack, patch, or hotfix.

Stop the FAST service by going to Windows Services, find FAST Search for
SharePoint, and click Stop.
Restart the Microsoft FAST Search Server 2010 server.

Part 5: Verify that Microsoft FAST Search Server 2010 can
communicate with SharePoint 2010

1.

On the SharePoint 2010 Central Administration Screen, go to Application
Management>Create Site Collections. The Create Site Collection screen

appears.
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Central Administration » Create Site Collection

Use this page to create a new top-level Web site

Web Application
Select a web appiication.

Title and Description
Type a titie and description for your new site. The title wil be displayed on each page in the site.

Web Site Address
Specify the URL name and URL path to create a new site, or choose to create a site at a spadific
path.

To add a new URL Path go to the Define Managed Paths page.

Template Selection

A site template determines what lists and features will be available on your new site, Select a site
template based on the descriptions of each template and how you intend to use the new site.
Many aspects of 2 site can be customized after creation. However, the site template cannot be
changed once the site is created.

Primary Site Collection Administrator

Spedify the administrator for this site colection. Only one user login can be provided; security
groups are not supparted.

Secondary Site Collection Administrator

Optionally spedify a secondary site collection administrator. Only one user login can be provided;
security aroups are not supported.

Quota Template
Select a predefined quota template to limit resources used for this site collection.

To add a new quota template, go to the Manage Quota Templates page.

Setting up search for your website

[ oK ] ( Cancel

Web Application: | http://spvm1/ -

Title:
FastSearchTestSite

Description:

FastSearchlesisite

URL:
http://spvm1 /sites/ ~ FastSearchTestSite

Select a template:

Collaboration MeetmglentErprlsElPuhh;hmg Custom

Document Center
Records Center

Business Intelligence Center
Enterprise Search Center
My Site Host

FAST Search Center

A site for delivering the FAST search experience. The welcome page indudes
a search box with two tabs: one for general searches, and another for
searches for information about people. You can add and customize tabs to
focus on other search scopes or reslt types.

User name:

‘ Sharspeintlser; ‘ & w

User name:

| o

Select 3 quota template:
No Quota -
Storage limit:

Mumber of invited users:

Enter a Title, Description, and URL, assigning any name.

In the Template Selection area, click the Enterprise tab then select FAST
Search Center.
In the User name field, enter the name of the SharePoint user you created in
Part 1: Install SharePoint 2010 and Microsoft FAST Search Server 2010 on
page 424.
Click OK to create a site collection.
On the SharePoint 2010 server, create a new folder and share it with the
Microsoft FAST Search Server 2010 user that you created in Part 1: Install
SharePoint 2010 and Microsoft FAST Search Server 2010 on page 424.
On the folder's Security tab, grant the Microsoft FAST Search Server 2010 user
full control.
Drag and drop a few text files into that folder. If you enabled PDF support (as
explained in Part 4: Enable indexing of additional formats on page 434), drop
some PDFs.
Create a Content Source for the folder. To do this:
a. On the SharePoint 2010 Central Administration screen, click Manage
service applications.
b. Click the Ektron content service application you created in Part 2b: Create a
FAST search connector service application for crawling content on page 425.
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Part 6: Set up Ektron to work with Microsoft FAST

c. On the Search Administration screen, under Crawling, click Content
Sources.

EKSEARCHadministrator

rar m
Ad tration

Crawling
Crawl| Rules

Crawl Log

Server Name Mappings
Host Distribution Rules
File Types

Index Reset

Crawler Impact Rules

Reports

Adrinistration Reparts

* Indicates a required Field
Name

Trpe a name to describe this content source.

Content Source Type

Select what type of content will be crawled.

Note: This cannot be changed after this content source is created because other settings depend on it

Start Addresses
Trpe the URLs from which the search system should start crawling,

This includes contents of & file share, such as documents and other files,

Crawl Settings
Specify the behavior for crawling this type of content,

hoose which folders to inchude in the crawl,

Crawl Schedules

Select the crawl schedules for this content source.

Content Source Priority

Select what the prioricy of this corkent source should be, The Crawl system wil pricritize the processing of 'High! prierity content sources
aver Hormal' priority content sources

Stark Full Crawl

d. On the New Content Source screen:
° Enter a Name.

o For Content Source Type, select File Shares.
o For Start Addresses, enter the folder that you created in Step 6.

o For Crawl Settings, select Crawl the folder and all subfolders of
each start address.

o Check the Start full crawl of this content source box.
o Click OK.

10.

Hame: *
TestCantentSource

Select the type of content to be cramled:

) SharePaint Sites

O Web Sites

@ File Shares

© Exchange Public Folders
O Line of Business Data
© Custarn Repository

Type start addresses below (one per line): *
NspymiTest

Examples:
iserveridirectory, or
filei//server/directory

Select crawling behavior far all start addresses in this content
source:

@ Crawl the falder and all subfolders of each start address
© Cnly crawl the folder of each start address

Select the schedule that this should be a part of!

Full Crawl
None
Create schedule

Incremental Crawl
None
Create schedule

Select the priority for this content source:
Priority| Mormal »

[ start full orawl of this content source

Verify that the search works by navigating to the FAST search site and searching

for content in the test folder you indexed. If correct results are returned,
Microsoft FAST Search Server 2010 is configured correctly. If not, or if you see
errors in the Crawl Log, there is a configuration issue with your setup.

Part 6: Set up Ektron to work with Microsoft FAST Search

Server 2010

Install Ektron, setting it up for your environment. When prompted to select a search
provider, choose Microsoft FAST Search Server 2010. When prompted to connect the
site to a Microsoft Search Server 2010 instance, click No. Complete the Ektron
installation. See also: Installing Ektron on page 9

In this section, you complete these additional tasks.

e Part 6a: Set up the Ektron search connection on the SharePoint server on the

next page
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e Part 6b: Set credentials for the Ektron search server service below
e Part 6¢c: Run the Ektron search configuration utility on the facing page

Part 6a: Set up the Ektron search connection on the SharePoint server

EktronSearchConfiguration.exe enables communications between your site and
the FAST search service.

1. From the Ektron server, copy the following file to any folder on the SharePoint
server.

$SystemDrive%$\Program Files (x86)\Ektron\Utilities\SearchServer
\EktronSearchConfiguration.exe

2. From the SharePoint folder, run the file.

Part 6b: Set credentials for the Ektron search server service

1. On the SharePoint server, open the Windows Services control panel.

2. Right click Ektron Search Server Service.

3. Click Properties.

4. Select the Log On tab.
Marmne : Description Status Startup Typ
+: Cryptographic Services Provides four manag... Started Autormatic
v DCOM Server Process Launcher The DCOMLAUMNCH ...  Started Autornatic
v Desktop Window Manager Session Manager  Provides Desktop Wi...  Started Autormatic
+: DHCP Client Registers and update... Started Autormatic
+: Diagnostic Policy Service The Diagnostic Polic...  Started Autormatic
+: Diagnostic Service Host The Diagnostic Servi...  Started Manual
+: Diagnostic System Host The Diagnostic Syste... Manual
o Disk Defragmenter Provides Disk Defrag... Manual
o Distributed Link Tracking Client Maintains links betw...  Started Autormatic
o Distributed Transaction Coerdinator Coordinates transact...  Started Autornatic
v DMS Client The DM5 Client servi...  Started Autornatic
+: Ektron CMS5 File HelperService Used for file copy to ... Started Autormatic
+: Ektron Diagnostics Service This service is for Ekt...  Started Autormatic
o Ektron Motification Service This service is for Ekt...  Started Autornatic

*#4Eltron Search Server Service This service is for Ekt...  Started

L . . f e ———

- Ektron Windows Services piiron Search Server Service Properties (Local Computer) =
" Extensible Authentication|| | General | Log On | Recoveny I Dependencies|
o Fax

. ) ) Log on as:
+ Function Discovery Prowv

1 Local System account
Allow service to interact with desktop

+: Function Discovery Reso

= Groun Policw Client

Browse. ..

EESSWDl'd: SERERRRRRRRRREN

Confirm password: I IT T T T T I T I Y]

5. Select This account.
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Part 6¢: Run the Ektron search configuration utility

6. Enter the credentials of the user under whom the SharePoint Server Search
service runs. You created this user in Part 1: Install SharePoint 2010 and
Microsoft FAST Search Server 2010 on page 424.

7. Click OK.
8. Restart the Ektron Search Server Service.

Part 6¢: Run the Ektron search configuration utility

1. Log on to the SharePoint server.
2. Click the Windows Start menu > All Programs > Ektron >
CMS400vreleasenumber > Utilities > Search Config. If you're using

Windows 8 or 2012, press the Windows key (E)/Q then enter Search
Config. The Step 1 configuration screen appears.

W Ektron Search Configuration [i_vj-,

Step 1: Connection Information
Please enter the connection details for your CM3 server and SharePoint
Central Administration server,

M5 Server Machine Name: EKTENGH

* | 'What 1s the CMS Server Machine Mame?

SharePoint Administration URL: http:.-"_e’EK—I'ENEEl:'_EE-’-l

* | What is the SharePoint Administration URL?

| Next || Eat |

3. Enter the Ektron server name.

4. Enter the SharePoint Administration URL. See also: Logging into Ektron's Search
Configuration screen on page 312.

5. Click Next. The Step 2 configuration screen appears.
F_ Ektron Search Configuration [ivj-]

Step 2: Search Service Applicaticns

Please select the service applications relevant to your CMS site.

Content Service Application [SEarch Service Application - |

Query Service Application: ["’.Search Service Application i T |

v | What are service applications?

| Back || Next || Eit |
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. At the Content Service Application field, select the application you created in

Part 2b: Create a FAST search connector service application for crawling content
on page 425.

. At the Query Service Application field, select the application you created in

Part 2d: Create a search service application for querying on page 429.

. Click Next. The Ektron Search Configuration screen appears. For

documentation, see Updating the site registration panel on page 316.

. When you complete the screen, click Register Site. Progress appearsin a

window.

1/14/2011 11:41:34 AM: Creating content source.

1/14/2011 11:41:3% AM: Content source created.

1/14/2011 11:41:39 AM: Performing initial site crawd.

1/14/2011 11:41:42 AM: Site reaistration completed successfully.

| dose |

During this process, the FAST search index is populated with your data, and the
schema is modified to include your site’s searchable properties. This process can
be lengthy when registering a site for the first time. You can monitor these
activities in the Workarea.

Part 7. Make FAST SharePoint’s query search application

In this section, you complete these tasks.

e Part 7a: Update web.config with query service application below
e Part 7b: Set FAST search query as default search service application below

Part 7a: Update web.config with query service application

1.

(O8]

On the SharePoint server, go to $CommonProgramFiles%\Microsoft
Shared\Web Server Extensions\14\ISAPI\EktronWebService.

. Open the web.config file.
. Find the following entry: <add key="QuerySSA" value="FAST Query SSA" />
. Replace the value property with the name of the Query Service application you

entered in Part 2d: Create a search service application for querying on page 429.

To continue that example, the line would look like this: <add key="QuerySSA"
value="EktQuery" />

. Restart the Ektron search site application pool. See also: Start or Stop an

Application Pool (IIS 7).

Part 7b: Set FAST search query as default search service application
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Managing FAST administrative tasks

1. Open the SharePoint 2010 Central Administration Page.

2. Go to Application Management >Service Applications > Configure
service application associations.

Sike Actions ~ gl Erowse

&, SﬁgrePointzolo Central Administration » Application Management

Central
Adrministration

Systermn Settings
Monitoring

Backup and Restore
Security

Upgrade and Migration

General Application
Settings

Configuration Wizards

IE=

-.‘?'_E_?'_ |

LS

Web Applications

Manage web applications | Configure alternate access mappings

Site Collections

Create site collections | Delete a site collection | Confirm site use and deletion | Specify quota ternplates
Configure quotas and lacks | Change site collection administratars | Wiew all site collections

Configure self-service site creation

Service Applications
Manage service applications | |Configure service application associations | Manage services on server

Databases
Manage content databases | Specify the default database server | Configure the data retrieval service

3. Under Web Application, click SharePoint-80. The Configure Service
Application screen appears.

If EKTQUERYSSA is the default, exit the screen. Otherwise, click the Edit the

following group of connections pulldown and choose [custom]. The screen
refreshes and the check boxes are active.

Configure wpplication

ations

Edit the following group of connections: | default

MNarme

Acocess Services

Application Registry Service
Business Data Connectivity Service
Excel Services Application
Managed Metadata Service

PerformancePoint Service Application

EkTOuerySsa [default]

SPz0l0ZearchService

Secure Store Service

State Service

Access Services Web Service Applicat
Application Registry Proxy

Business Data Connectivity Service &
Excel Services Application Web Servic
Managed Metadata Service Connectior
PerformancePoint Service Application
Search Service Application Proxy
Search Service Application Proxy
Secure Store Service Application Prox

State Service Proxy

5. Check EKTQUERYSSA[default] then click OK.

Managing FAST administrative tasks

The following topics explain how to perform administrative tasks that are unique to
Microsoft FAST Search Server 2010. The following list shows other search-related
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functions that apply to all Microsoft search providers (including Microsoft FAST
Search Server 2010).

Basic versus advanced website search on page 336
Formulating search queries on page 339

Using Autosuggest on page 340

The "Did you mean?" feature on page 345

Managing searchability of Ektron content on page 346
Managing search results on page 347

Using synonym sets on page 348

Providing suggested results on page 350

Using advanced search in the Workarea on page 364
Reporting search activity on page 375

Making the title property sortable

By default, the Title property is not sortable. To change it so that it is sortable, follow
these steps.

1.
2.

Log into the Fast Central Administrator console.

Choose Manage Service App > Query Service Application > Fast Search
Administrator > Managed Properties.

Find the Title Managed Property.
Edit it and check the Sort property box.

IQ?Ektl)uerv: Edit Managed Propetty - Title - Windows Internet Explorer

—
@ v =| hittp:/iekksqav20: 5432 1) _admin/search/AddManagedProperty, ast ,Dj 1| X EkbQuery: Edit Managed Pro... X

Site Actions *

P — R py— =l
administration - . .
Type a name and description for this property. Title
FAST Search Des on:
ad trat
minsEELen [The title of the document B

]

Tyee Type:

Select the type of information you want o store in this Text B

property.For txt type proparties you can enable stemming and

select static or dynamic summary. [© Enable stemming

Enable stemming if you wanta query far ane of the possble

of award to also match properties that contain 2 different

form of the word.

Use dynamic summary for large tect fields whera only matching

sactions should be displayad in the ssarch result summary.

Mappings to Crawled Properties

A list of crawled properties mapped to this managed property is € Include values from all cravded properties mapped.

shown. Ta use a crawled property in the search system, map it to

amanaged property. A managed property can getavalue froma & Include va e erh he er spe

crawled proparty based an the arder specified by using the Mave

Up and Mave Down buttons or fram all the crawled properties Crawled properties mapped to this managed property —

mapped.
Mailis(Tex -
Office:2(Text) Move Up |
Officer2(Text]
title (Text) Move Down |
rss.title(Text)
sitemap.title(Text) Add Mapping |
subject(Text)
urnischemas.microsoft.com :fulltextque ryi [ |
ows_Title(Text) d

Sort Praperty

. ’ ; F

Indicates whether this property will ba sortable o not. Note that Sort property

this increases memory consumption.
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IMPORTANT: When used to sort, the Title property follows an ASCII sort pattern.
As a result, titles that begin with a capital letter precede ones that begin with a
lower case letter. For example:

Better Business Bureau

Tiramisu recipe

american foreign policy

See also:

 Enable a managed property as sort option by using Windows PowerShell

 Make a managed property sort option available in the web front-end by using the
graphical user interface

Using faceted search

Facets are content properties that allow site visitors to filter search results. For
example, your site lists job postings. So, your results page offers a Region facet,
which visitors use to select jobs in specific regions.

Search for jobs

Region
O East (10)
O Mid-Atlantic (8)
O Midwest (13)
O South (4)
O West (26)

Faceted search has these limitations:

» If the metadata definition type is integer or date, facet categories only appear if
a metadata value is assigned to 2 or more content items. For example, if the
South region was assigned to only one content item's metadata, South would
not appear on the facets list. However, the content would be returned in search
results.

» If the same metadata value is applied to all content, no facet categories appear.
To continue the above example, if all content to which the Regions metadata
definition may be applied have South for their value, no facets list appears.

» The refiner count may be inaccurate if you are using duplicate removal. For more
information, see Refiner count is wrong when using duplicate removal.

This section explains how to implement faceted searching using Ektron and Microsoft
FAST Search Server 2010.

Creating facets

1. Create searchable Ektron metadata definitions. See also: Creating and deploying
a Search tag definition on page 759.

IMPORTANT: Carefully plan capitalization, spelling, spacing, and so on of
metadata definitions for Faceted Search. Minor inconsistencies can result in
duplicate entries.
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Search for jobs

O east (3] |
(100

O east (3)
O East (10)

2. Apply metadata values to appropriate content.

3. Run a full crawl. The metadata become managed properties within Microsoft
FAST Search Server 2010.

4. Update search server controls to look for the metadata/managed property. They
appear as selectors on your search results page.

Wiew Content "Systems Engineser*

&|[eom | @ X $H e =

Froperties Content Sumrmary Metadata

Search Data

MapAddress:

MapLatitude:

MapLongitide: Engineering job Search
MapDate:  [njgpe] Advanced Search *
[reoi: e ] e

Region:  south d )
—* ] - and display it as a selector
- = O east (8) " onthe search results screen.
o O south 4y == | Check the box to filter results

Apply metadata to by the metadata.

content...

Svstems Engineer
hitp://ektsqala/Company/Careers/Engineering/Systems-Engmeer/ 1/11/2012 6:13:00 PM

Junior-Level IT Project Manager
hitp:/ektsqala/Company/Careers/Engineering/Junior-Level-1T-Project-Manager/ 1/11/2012 6:11:56 PM

Creating a faceted search
1. Create a metadata definition in the Workarea. See Working with Metadata on
page 755. This example uses a text metadata definition called region.

2. Apply the new metadata definition to a folder. See Assigning metadata to a
folder on page 764.

3. Within that folder, apply the new metadata definition to appropriate content. See
Adding metadata to content on page 766.

4. Sign on to Microsoft FAST Search Server 2010.

5. Go to Search Central Administrator > Manage Service Applications >
click the query content source > Fast Search Administration >
Managed Properties.

6. Inthe Search field, enter emt followed by the metadata definition you created
in Step 1. To continue the example, enter emtregion.
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NOTE: You enter emt because this is a text-style metadata definition. Use
these prefixes for other styles.

Microsoft FAST Search Server 2010 prefixes for Ektron metadata definition
styles:

» Text, select from list, multiple selections. emt

+ Integer and number. emi

+ Boolean. emb

« Date. emd

 Double. emf

» If the content is an XML Smart Form, use these prefixes instead:
o Text, select from list, multiple selections. est

o Integer and number. esi
°© Boolean. esb
o Date. esd
°© Double. esf
7. Click the metadata definition/managed property.

Central Administration » EKTFASTQuerySSA; Managed Properties

il A Crawled properties are automatically extracted from crawled content, Users can perform gu

Sﬁ‘éreP0|nt'20]_0 managed properties, Use this page to create and modify managed properties and map craw

) properties to managed properties, Changes to properties will take effect after docurnents ar
reprocessed or after the next full crawl,

Adrninistration

Seamd CemirisrEn Search for managed property names: | emtregion Search
Farm Search ] =
Adrministration =i Add Managed Property  Crawled Property Categories 4] Refresh

FAST Search

Adrninistration Property Mamet Type Sort Property Query Property  Refiner Property  Mappings to Cr

emtreqgion Text “es Tes Mo Region(Text)

8. Scroll down to Refiner Property.

Ektron Reference I 445




Setting up search for your website

9. Check it and the Deep Refiner box.

Sort Property

Indicates whether this property will be sortable or St nraner
T ] - Sort property
not, Mote that this increases memory consumption.

Query Property

With query field enabled, the managed property can Query property
be induded in gquery operators and filkers. Mote that T !
thiz increases the index size,

Refiner Property

A refiner categorizes the top (typically top 100) Refiner properh
documents in the search result into refiner groups. A

deep refiner is based on all documents in the search

result, Mote that deep refiners increase memory

usage in search and indexina.

Full-text Index Mapping ) )
Full-text index mapping:
Full-text index mapping defines the rank priority of the

properties. Properties can be mapped to different N priority mapping (0) «

10. Complete Steps 1 through 9 for all metadata definitions that you want to add.
11. Run a full crawl. See Using Microsoft Search Server features on page 335.
12. To enable a search server control to display a metadata selector, modify the

SearchController control using a <Refiners> tag as shown. The tag references
the managed property name, emtregion in our example.

<ektron:SiteSearchController ID="controller" runat="server">

<Refiners>
<ektron:Refiner Name="emtregion"/>

</Refiners>

</ektron:SiteSearchController>

<ektronUI:Pager runat="server" ResultsPerPage="50"
PageableControlID="controller" >

</ektronUI:Pager>

Here are sample search results. If you check a box next to a region, the page
refreshes and displays only content to which that metadata property is applied.
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Engineering Search

Advanced Search ~
e emiregion

o [east(s
o [scuth (4)

Svstems Engineer
hitp:ffektsqala/Company/CareersEngmeering/Systerms-Engineer 1/11/2012 6:13.00 P14

Junior-Level IT Project Manager
hitp:fiektsqala/Company/CareersEngmeerngTunior-Level-TT-Project-Ianagers 1/11/2012 £:11:56 P

Managing rank profiles

Microsoft FAST Search Server 2010 lets you adjust the rank of search results,
enabling you to control which content appears near the top. This feature is
sometimes called "Advanced Sorting." You typically use the Rank Profile feature
when site visitors are not getting expected search results. For example, your manage
a university website and, when people enter Admissions, the Admissions
department page is not among the top search results. To fix that, use a Rank Profile
to force certain search results to the top.

See also: Tune relevance factors (FAST Search Server 2010 for SharePoint), Manage
rank profiles (FAST Search Server 2010 for SharePoint), Ranking and Sorting (FAST
Search Server 2010 for SharePoint).

Increasing the search rank of a content item
Here is an overview of how to increase the search rank for selected content.

1. Create a metadata definition to define searchable properties.

2. Apply metadata values to selected content. When the content is crawled, the
metadata values become managed properties in Microsoft FAST Search Server
2010.

3. Use Microsoft FAST Search Server 2010 to create a Rank Profile. While defining
the profile, you

 list the metadata values/managed properties
» modify the search rank of the managed properties, which in turn, modify the
rank of content to which they are applied

4. Update a search server control or the API to use the rank in the search results
algorithm.

Part 1: Create metadata definitions

To increase a content item's search rank, first create searchable Ektron metadata
definitions. They contain the content attribute by which site visitors will search. Then,
apply those metadata definitions to relevant folders and content.

NOTE: The process of creating and applying metadata is abbreviated here. For
full details, see Creating and deploying a Search tag definition on page 759.
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To continue the above example, create a searchable metadata definition named
Departments, of the type Select from a List. Add Admissions to the list of values.
Then, apply that metadata to all folders that contain relevant content.

View Metadata Definition "Departments”®

£ eDm | M @
Hame: Departments
10 130
Type: Searchable Property

Editable:  Yes

Publicly Viewable: Yes

Style: Selectfrom a list
Separator:
List of Values: Admissions,Academics: Student Life;News, 0 ffices
Default:

Next, find Ektron content that describes your Admissions department. Edit that
content, click the Metadata tab, and apply the Admissions metadata to the content.
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Edit Content in Folder "Departments”™

€| pusush | @) 4 [=

@

Title: Admissions
Content Summary Metadata Alias

Search Data

MapAddress:

Default current character

Manl stitido:

After creating searchable type
metadata and applying it to
folders, use the content's
Metadata tab to apply the
metadata value to content.

) e L one

admissions

academics
Tags student life

news
[ 2 Default |~ ..

Part 2: Create a rank profile

The Microsoft FAST Search Server 2010 type and metadata value name
you use to increase the search rank. To continue the above example, use

emtadmissions. For a list of types, see Using faceted search on
page 443.
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NOTE: For more information on Index schema cmdlets, see Index schema
cmdlets (FAST Search Server 2010 for SharePoint).

To create a Rank Profile:

3. Create and enter a name for the Rank Profile.
New-FASTSearchMetadataRankProfile

-name (your profile name)

4. Define the Microsoft FAST Search Server 2010 type and name of the metadata
value used to increase search rank.

Smp = Get-FASTSearchMetadataManagedProperty
-Name (your managed property)
5. Set a variable to your profile. This is typically the same as the name you entered
in Step 3.
Srp = Get-FASTSearchMetadataRankProfile
-name (your profile name)
6. Add a managed property boost to your profile. The $smp command has 2
parameters:
» string,int. the Microsoft FAST Search Server 2010 type and name of
metadata value whose search rank you want to increase

+ boost number. a relative value by which you want to increase the profile's

search rank. See also: Change the managed property field boost weight by
using Windows PowerShell

Srp.CreateManagedPropertyBoostComponent (Smp,
"<string/integer managed property value>,<boost number>)”)

Replace values within angle brackets (< >) with actual values.

7. Update your profile
Srp.Update ()

Here’s an example:

New-FASTSearchMetadataRankProfile -name departments

Smp = Get-FASTSearchMetadataManagedProperty -Name emtadmissions
Srp = Get-FASTSearchMetadataRankProfile -name departments
Srp.CreateManagedPropertyBoostComponent (Smp, "admissions,20000")
Srp.Update ()

Part 3: Incorporate the rank profile into the search result display

This section explains how to use a Rank Profile to modify search results, using either
the SiteSearchInputView server control or the API.

1. Add the rank to a Search server control:

Modify all SiteSearchInputView server controls that you want the ranking to
modify. See also: Using the Search Server Controls. To achieve that, use
<SortProperties> tags. Inside the tags, set these parameters.
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Removing a boost

» DisplayName. Enter any unique name to identify this profile.
« RanklId. Your profile name that you created on the FAST server.

<ektron:SiteSearchInputView ID="SiteSearchInputViewl"
runat="server" ControllerID="SiteSearchControllerl">
<SortProperties>
<ektron:RankSearchProperty DisplayName="Custom Relevance"
RankId="departments" />
</SortProperties>
</ektron:SiteSearchInputView>

2. Add the rank using the API:

The following illustrates how to modify search results via the Rank Profile using
the API.

criteria.OrderBy = new List<OrderData> ()
{ new OrderData (new RankPropertyExpression ("rank profile name"),
OrderDirection.Ascending) };

For example:

criteria.OrderBy = new List<OrderData> ()
{ new OrderData (new RankPropertyExpression ("departments"),
OrderDirection.Ascending) };

Removing a boost

1. Set a variable to the profile. Use the same profile name that you used in Part 1:
Install SharePoint 2010 and Microsoft FAST Search Server 2010 on page 424.

Srp = Get-FASTSearchMetadataRankProfile -name (your profile name)

2. Setto a variable the Microsoft FAST Search Server 2010 type and name of the
metadata value used to increase search rank.
Smp = Get-FASTSearchMetadataManagedProperty
—-name Name (your managed property)

3. Set a variable for the boost you want to delete.
The $ .Boostvalue command has 2 parameters: string,int and boost
number. Use the same values you used when creating the Rank Profile. See
Part 1: Install SharePoint 2010 and Microsoft FAST Search Server 2010 on
page 424.

Sboostl = $rp.GetManagedPropertyBoosts ()
| Where-Object{$ .BoostValue -like '* (string/int), (boost number) *'}

4. Delete the boost.
Sboostl.Delete ()

5. Update your profile.
Srp.Update ()

Here’s an example:

Srp
Smp = Get-FASTSearchMetadataManagedProperty -name emtadmissions
Sboostl = $rp.GetManagedPropertyBoosts ()

| Where-Object{$ .BoostValue -like '*admissions,20000*'}

Get-FASTSearchMetadataRankProfile -name departments

Ektron Reference I 451




Setting up search for your website

Sboostl.Delete ()
Srp.Update ()

Viewing all boosts

Run this query: $rp.GetManagedPropertyBoosts ()

Troubleshooting boosts

 Problem. The boost does not affect search results

» Solution. Verify that the FreshnessResolution is set to second. See also:
Change the freshness resolution and weight by using Windows PowerShell

Troubleshooting FAST

Problem. Documents are not being indexed.

Solution. Provide full control rights on the $FASTSEARCH%\bin and
$FASTSEARCH%\ tmp folders for the user running Microsoft FAST Search Server 2010

More information. Crawling and processing Office documents with FAST for
Sharepoint 2010 results in document conversion errors in the crawl log
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Ektron Digital Experience
Hub release notes

Ektron's Digital Experience Hub (DXH) adds seamless integrations with
Pardot, Eloqua and Silverpop marketing systems to its extensive library
of out-of-the-box data connectors. Ektron connectors provide bi-
directional data integration between Ektron’s core Content Management
System (CMS) and leading enterprise systems for CRM, marketing
automation, social media, web analytics, and enterprise content
management.
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Connectors

DXH has the following connectors that let you export data collected on your website
and map data to targeted content to provide content that matches their interests,
thereby placing your site information in the context of your users.

» Eloqua

+ ExactTarget
» Pardot

» Silverpop

Using connector information in targeted content

See Connecting Visitors with Targeted Content in the Ektron Reference.

ExactTarget and Pardot connectors can provide data criteria to the Targeted Content
widget, which lets you provide content that matches their interests. For example,
search keywords used to find your site might determine the best offer to show a
prospect. Or, site members might explicitly state their interests by adding to their
user profile or filling out a form or survey.

Targeted Content

Click the + or bution to define the condition.

ExactTarget ExactTarget.Subscriber »
Pardot Pardot.Prospect 3
Search Engine 3
Referring URL...

URL parameter...

Cookie. ..

Device configuration. ..
BreakpointConfig

Logged in...

User is in group...

Usar is in commumnity...

User Properties

Date and Time

User Regional Info

Facebook Info

Submitted Form Data. .

Otherwise. .

Cancel Save
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Using connector information to create a persona

Using connector information to create a persona

See Creating Personalized Web Experiences with Personas in the Ektron Reference.

You can use connector information to create persona criteria.

web.config Persona
* PM site path
« DxH path Management

PM installation

prompts for
DxH path

Register DxH
connections
with Ektron

PM retrieves
attributes
from DxH’s
external apps

Register external
apps with DxH

Enterprise Apps
* FElogqua *  Microsoft
* ExactTarget Dynamics CRM
* HubSpot * Pardot
* Marketo * Salesforce
* Silverpop

What's fixed in DXH?

e 73612. You could map hidden fields on an Ektron form to a CRM form.
» 73726. DXH generated an error in the log pointing to SharePoint.
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Web traffic from mobile devices is accelerating. Making your website available to
mobile users is not enough. Your website must deliver the same, consistent level of
experience to your mobile visitors as you do for those who visit your website on their
desktop to ensure that your consumers are accessing information, products, and
services from your website.

Mobile applications require different, more compact navigational aids, and content
must fit into a smaller footprint. Mobile websites need "tap to call" options to take
advantage of cellular technology, a robust search, flexible menus, and quick access
to content. Tables and figures may need to be adjusted or reconfigured to avoid
unnecessary "pinching" and scrolling.

Developing a multi-channel website design

When you design and develop your website, you want to reach as many people as
possible. People are using a wide variety of devices to access the Web.

758 x 1024

Smart Phones Tablets Metbooks Desk tops

When you evaluate your website, or where you want it to be, consider the following
website strategies:

 Foundational. Educate your users about your purpose and products with little
interactivity. Enable business users to publish content using content editing and
management, approval chains, and publishing. Reduce site maintenance for IT
and increase the number of visits to your website.

» Tactical. Facilitate content reuse, user-generated content, categorization, and
page assembly. Create Smart Forms, taxonomies, online communities.
Synchronizemultiple sites. Develop pages, templates, surveys and polls, blogs,
search, commenting and threaded discussions.

» Strategic. Embrace multi-channel delivery and support a richer customer
experience with eCommerce, multi-channel, multi-site, multi-language, and
video.

« Engagement. Continually analyze and customize the customer experience with
personas, create touch-centric interaction for mobile devices, integrate with
marketing automation, use multivariate testing, geolocation, device orientation,
and activity streamsto target content for what is relevant and meaningful to your
site visitor. Customer Relationship Management systems can personalize the
Web experience to drive revenue, deliver better business results, increase your
brand awareness, and create customer loyalty.
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Separate mobile site design

Consider the following approaches to design.

« Separate Mobile Site Design

» Separate Mobile Template Design

» Responsive Web Design

» Responsive Web Design and Server Side Components (RESS)

Separate mobile site design

If you have an existing website that you do not want to redesign, you can separate
the content into 2 site architectures: 1 for desktop computers and 1 for mobile
devices. You can target your content specifically for mobile devices, avoiding the
complexity of developing device-conditional style sheets and manipulating existing
content.

However, you will have to maintain 2 sites and ensure that they are synchronized
(where applicable). You have to set up device recognition so that mobile device
requests for your website are routed to your mobile (m-dot) site instead.

Also, having 2 sites can impact your SEO ranking negatively if content is found on
both sites.

Separate mobile template design

Separate templates, optimized for mobile, get rendered whenever somebody visits
your site from a mobile device. This approach lets you define a unique mobile
experience, without affecting the desktop experience, and create a mobile
experience without having to undergo a complete website redesign. Loading of pages
is more streamlined when you use separate templates instead of the responsive
design approach because only the mobile content gets retrieved from the server;
responsive sites often have extra content that is then hidden by CSS rules based
upon the current device.

However, you must maintain more than 1 set of templates (for mobile and desktop
experiences). Also, the server must detect whether a visitor is using a mobile device
before rendering a mobile template, so a list of devices must be kept up-to-date.
Fortunately, Ektron is able to keep the device list up to date for you. See Updating
the Wireless Universal Resource File on page 481.

Responsive Web Design

You should consider a Responsive Web Design (RWD) when you have a high degree
of overlap between the site visitor experience and content on many devices.

Responsive design provides an optimal viewing experience for devices of any size by
adapting the layout of your pages with CSS3 media queries. The elements on your
pages (including any images) must use relative units (percentages or ems) for sizing
instead of fixed dimensions (pixels). This enables your site to expand and contract to
the viewing size of any device.
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Responsive designh has a single code base, where other approaches require the use of
separate mobile-specific templates to display your pages to mobile devices. While
you may identify which of your content is "canonical" in a Separate mobile site design
on the previous page, the singular architecture and repository of a responsive design
means that you have one authoritative source for SEO leading to higher rankings by
search engines. (Multiple websites can dilute your ranking.) It also lets your site
visitors use a consistent set of URLs without the issue of directing to the WWW or m
(dot) site.

Many traditional websites require a complete redesign and implementation to change
to a responsive site. Additionally, a complete redesign may require added time and
effort to ensure that the user experience is mobile-friendly. You must weigh the costs
of a redesign to gain the benefits of a single code base (long-term maintenance
savings, SEO improvements, and so on).

Another issue to consider before creating a responsive website is that entire pages
are loaded. If you have a lot of content on a page, it can impact the user experience.
By contrast, if your site uses separate mobile templates, you can decide if some of
that content should be loaded on certain types of devices.

Using responsive frameworks with PageBuilder on page 1001 shows how to work
responsive Web design into your PageBuilder pages.

Responsive Web Design and Server Side

Components

Responsive Web Design + Server Side Components (RESS) has the flexibility of
responsive design while providing the granularity of device detection to deliver
device-specific components.

Ektron supports the use of RESS by providing tools to display content and assets
based on groups of devices, which can be added to your responsive pages. Of course,
this responsive aspect means that your site needs to be redesigned, but once
redesigned, these tools can provide the best of both approaches.

Using responsive frameworks with PageBuilder on page 1001 shows how to work
responsive Web design into your PageBuilder pages.

Using mobile templates

A template is a customized Web page format comprised of objects such as content
blocks, list controls, menus, rotating banners, a search object, and videos. How you
assemble the objects affects the user experience. Because of the smaller display size,
templates for mobile devices may have a single column to eliminate horizontal
scrolling, pinching, and zooming. You decide what is practical for each device by
creating different templates instead of creating different content. Objects may have
to be omitted or replaced with mobile-friendly objects. The following image shows
PageBuilder templates for desktop and mobile devices. Note that the mobile template
does not include content object 3. See Developing wireframe templates on page 1007
for information about creating PageBuilder wireframe templates.
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Setting up a mobile template

column_layout.aspx mobile_column_layout.aspx

You should use the same dropzone IDs for both the mobile and desktop templates.
Content does not display if a mobile template contains a dropzone ID that the
corresponding desktop template does not have.

Ektron can detect specific characteristics of a mobile device, such as the differences
between the Android Droid X and Droid 2. These characteristics help you determine
how to render the user experience. For example, one device may support Flash
technology and another may not.

In any case, you want to ensure that your content on a mobile device is elastic,
meaning that it can scale to the various sizes of displays. Use percentages instead of
hard-coded pixel sizes for the mobile template. If you set PageBuilder dropzone
width to 100%, the normal flow of the objects in the mobile browser cause them to
stack from the top to the bottom.

Setting up a mobile template

1. In the site root/web.config file, set ek_EnableDeviceDetection to True.

<add key="ek EnableDeviceDetection" value="true">

2. Identify a template for which you want to create a mobile version, using the
Workarea > Settings > Configuration > Template Configuration screen.
Click any template to see its folder location relative to your site root.

Ektron Reference | 461




AW

Ul

Y] smart Phones fOnTrekd account.ph.sma@

Creating a mobile-driven Web experience

Update Template

4 || UPDATE TEMPLATE ]

Template File: /OnTrek! account.pb.aspx

Template Name:
Template Description:
[l Page Builder Wireframe

Device Configurations
[C] Smart Phones fonTrek!

[C] Generic Mobile fonTrek!

daa

. Open Windows Explorer and locate that template in the site root folder.

. Copy and save a mobile version of the template under a suitable name, for
example, account .pb.smartphone.aspx.

. Adapt the template for mobile use by changing column styles, removing
unwanted navigation, images, headers, footers, adding components that help
mobile users, and so on.

. Create device groups. Assign to each one any mobile devices that use the

template you created. See also: Grouping mobile devices on page 466.

Return to the Template Configuration screen and click the template you

identified in Step 2.

. Check every mobile Device Group for which you created a mobile template

version. Then, for every checked configuration, click the ellipsis button (J ) to
its right, go to and select the mobile template you created in Step 6.

Update Template

€ || UPDATE TEMPLATE 7]

Template File: fOnTreki account.pb.aspx
Template Name:

Template Description:
[ Page Builder Wireframe

Device
Configurafic

| Generic Mobile  fOnTrek

11

Now, if a mobile device user accesses a page which uses that template, the
mobile-enhanced template displays the content.

» To test mobile templates, preview your content within them. See Previewing
content in a mobile template on the facing page.
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Previewing content in a mobile template

» Ektron uses the Wireless Universal Resource File (WURFL) file to obtain
wireless device information. To learn how to view, update, and customize
this file, see Updating the Wireless Universal Resource File on page 481.

» To conditionalize Smart Form content based on user device, see Specifying
device-specific content with Smart Forms on page 465.

» To use a mobile site visitor's geographic location to deliver relevant content,
see Using Geographic data from a mobile device on page 479.

Previewing content in a mobile template

You can preview content in mobile template to ensure the content fits within the
screen resolution.

Previewing mobile content from a PageBuilder page

Ektron multi-channel preview lets you ensure that your page is optimized for devices
of every size. You can browse your entire site using any preview device.

If you have the toolbar enabled...

PREREQUISITE

Previewing virtual mobile devices requires an HTML5 CSS3-compliant
browser. You must also enable the toolbar, for any template you want to
use it, by checking the boxes in the Enable Toolbar column at
Workarea > Settings > Configuration > Template Configuration.

1. D Click Preview on the toolbar to show your page on a variety of simulated
devices (portrait and landscape views). A bar appears with devices that simulate
your Web page on those devices. For information about setting these devices,
see Adding a group by device model on page 470.

Generic Tablets

2. Click on the device on which you want to preview the web page. For example,
choose Apple® iPhone® 4s. The Web page appears in the simulated device. You
can select portrait or landscape view.
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BB /@ Logout / Workarels

Products Services

Globalize Your Business
Strategy

With OnTrek, you can customize your business
solution to meet the needs of your clients, no matter

where they are located. You can deploy rich,

interactive solutions today that are scalable for

tomormom

If you have the toolbar disabled (or do not have an HTML5 CSS3-compliant
browser)...

1. Log into your Ektron website.

2. Go to PageBuilder page that you want to view as a mobile device user would.

3. From the PageBuilder menu, click View > Device Preview. A dialog box
appears.

FILE m PROPERTIES HELP

Properties

Warkarea
Analtics

-ﬂwﬂ_ Advance t¢

Take control of vour
users, build an onlin

innovative, new tool

Choose the breakpoint you want to preview from the drop down menu. The page
displays in the dialog box.
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Previewing mobile content within the editor

Select a break point to preview | Smart Phones |E|

W4E0px H:480px

Products Services

Empower your clients

OnTrek empowers vour clients by providing an
intuitive way of managing vour business needs. With
our affordable solutions, yvour clients can successfully
meet all of their business objectives. OnTrek enables
your business and your clients to be positioned for

SUCCESS5.

Learn More »

Lorem ipsum dolor sit amet, consectetur adipiscing ¢ PMews

elit. Mam viverra hendrerit turpis, sed egestas nulla ¢ Events

~ 1

4 il

Previewing mobile content within the editor
1. Edit contentin the editor.

2. Click Preview (. "1).

3. Select a model from the Device Configuration drop-down and click Preview.
The content displays in the selected template.

Specifying device-specific content with Smart Forms

You can set up Smart Form configurations to recognize a user's device and, based on
that information, display appropriate content. For example, if a user is not using a
Smart Phone, show a complex display with rich graphics. If a user is using a Smart
Phone, create a simpler presentation of the same fields without graphics. To learn
about this capability, see Inserting a conditional section on page 828.

You can also desighate some or all of an HTML form's postback message to be
conditional upon a user's device. So, for example, the postback message for Smart
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Phone users can be much shorter than the message for users who are not using a
mobile device. To learn more about this, see Specifying conditional text in the
postback message on page 805.

Grouping mobile devices

You can accommodate a variety of mobile devices by grouping characteristics, such
as display size. You can group devices for standard presentation and add refinements
for specific devices. For example, a device configuration may consist of a Smart
Phones group (Apple iPhone®, Samsung Galaxy Note™ II, Motorola® Droid RAZR
MAXX HD, and so on) and a Tablets group (Apple iPad®, Google Nexus™ 10,
Microsoft® Surface™, and so on).

With Ektron, you can group devices by breakpoint, model or operating system. A
breakpoint is a screen width at which media queries make changes to the layout and
switch from one image file to another.

For example, you can set a breakpoint of 480 pixels-wide and call the group "Smart
Phones," and set another breakpoint of 1024 pixels-wide and call the group
"Tablets." If an image is loaded at 720 pixels-wide, the image is allowed on devices in
the "Tablets" group. (You may have alternate images to display for the "Smart
Phones" group. See Applying adaptive image resizing on page 472 for information
about optimizing images for device groups.)

Grouping by model gives you more control over specifications, but it is quicker to
group by operating system. You may want to first group by breakpoint, then by
operating system, then only define models that do not work properly under an
operating system configuration.

To determine which mobile devices to add to your device configurations, review your
Analytics reporting to see which mobile devices are browsing your site. To see the
Browser and OS report:

1. In the Workarea, select Reports > Traffic Analytics > Visitors > Browser
Capabilities > Browsers and OS.

2. Modify the time period and rank if needed. For more information, see Analyzing
websites on page 483.
The following example shows that Android and iPhone mobile devices have browsed

pages. You can create templates and device configurations to improve the experience
of these visitors.

Browser and 05 Hone Visits -4 Visits | Browser and OS contribution to fotal:  Visits -
B Internet Explorer / Windows

17.14% 11.72%
M Firefox / Windows o

6.92%
W Chrome / Windows B

Safari/ Macintosh

N W =

Firefox lllaciotosh -

Safari/ Android ‘\\/
Safari/ iPhone \\/‘

8. Chrome /' Macintesh

9. Opera / Windows

10. Opera ini/ (not set)
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Adding a group by breakpoint

Ektron provides 2 default groups by breakpoint (Smart Phones, and Tablets). When
you set up breakpoints, images that are subsequently uploaded are created in each
of the breakpoint sizes for use on devices that fit the breakpoint criteria. See also:
Applying adaptive image resizing on page 472.

1. Workarea > Settings > Configuration > Mobile Settings > View All
Device Groups.

2. Click New Group.
3. Click Group by Breakpoint.

4. Click Create Group. The Group Device by Breakpoint screen appears. The
Smart Phones group has a breakpoint of 480 pixels. The graphics to the right of
the groups show the devices that fit your criteria. The check boxes under the
device images lets you select the devices that you want to show as options on
the Device Preview screen of the toolbar. See Editor toolbar options on
page 554.

NOTE: You can specify new breakpoint values for an existing group on this
screen and click Save.
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Group Devices by Breakpoint

€| SAVE @

Device groupings work with templates and images to help the system display the content you've designed for
certain device experiences. Lsing the size you enter, the system determines what devices will use templates
and images assigned to this size grouping. You may also select what device images you'd like to use when
CMS authors want to view content within a simulated device.

© Add Breakpoint

Images available for preview @

Smart Phones 0 <480

'%' Ex: Lumia 200, iPhone® 45, Galaxy 3@ 1,
Galaxy Mote™ |, Focus® 2, Droid RAZR MAXK HD,
BlackBerry® Curve™ 9320

pixels @

Generic Lumia iPhone®

Smart Phones 800 45

IT‘“'ETS 481 <1024 | pixels @
]
@  ExiPad®

Generic iPad®

Tablets

5. If a Wireless Universal Resource File (WURFL) update is available, click Update.
For more information about WURFL, see Updating the Wireless Universal
Resource File on page 481.

6. Click Add Breakpoint to create a new breakpoint group. The Add New Device
Group dialog box appears.
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Adding a group by operating system

Add New Device Group ®
Add New Device Group By Breakpoint
Mame:*
Small Phones

Breakpoint Width-*|360 : pixels

Create Group Cancel

7. Enter the name of this breakpoint group. For example, Small Phones.
Enter the breakpoint width for the group. For example, 360.

9. Click Create Group. The Group Device by Breakpoint screen re-appears with
device images next to the new breakpoint group.

Group Devices by Breakpoint i

€| SAVE | @

@®

Device groupings work with templates and images to help the system display the content you've designed for certain device
experiences. Using the size you enter, the system determines what devices will use templates and images assigned to this
size grouping. You may also select what device images you'd like to use when CMS authors want to view content within a

simulated device.

© Add Breakpoint

Images available for preview @

m

Small Phones
':'E' Ex: Lumia 900, iPhone® 43, Focus® 2, BlackBerry® Curve™
9320

0<[360 |pixels @

Small Lumia iPhone®

Phones 500 45

Smart Phones

b Ex: Galaxy 5@ |ll, Galaxy Mote™ II, Droid RAZR MAXX HD

361<l4g0 | pixels @
1

Smart D Galaxy D Galaxy

Phones s& I MNote™ ||

10. Click Save to create the new group. The new group appears in the Groups By
Breakpoint (Default) section of the View All Device Groups screen.

Adding a group by operating system
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1. Workarea > Settings > Configuration > Mobile Settings > View All
Device Groups.

2. Click New Group.
. Click Group by Operating System (0S).
4. Click Create Group. The Group Device by OS screen appears.

(O8]

NOTE: If your Wireless Universal Resource File (WURFL) is out of date, a
notice appears on the screen. Click Update to update the device information.
For more information about WURFL, see Updating the Wireless Universal
Resource File on page 481.

Group Device By OS

£|| savE @

= AWireless Universal Resouce File (WURFL) update is avaliable. Would you like to update device information? | Update

WURFL device information was last updated on 5/20/2013 3:21:26 AM.

Name*:

Dimensions for preview: @
Width: 320 pixels Height: 430

- -

- < pixels

Available Device 05
E Android
E] Bada0S
E| Hiptop 0%
E iPhone 05
E LinuxSmartphone 05
E MeeGo
E MTK/Nucleus OS
B Pamos
E RexQualcomm 05
B RIMOS
E RiN Tablet 03
| Symbian 03
] web0s
| windows CE
] windows Mobile 0S
] windows Phone 0%
] windows RT

Enter the name of this OS group.
Check the boxes next to the available operating systems you want in this group.
You can specify new dimensions for preview, or accept the default values.

Click Save to create the new group. The new group appears in the Groups By
Device Configuration section of the View All Device Groups screen.

® N WU

Adding a group by device model

When adding individual devices to a configuration, group devices that share
characteristics, such as Flash support and screen resolution. Since you will assign the
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configuration to a mobile template, make sure that all devices support the template's
functionality.

1.

W

Workarea > Settings > Configuration > Mobile Settings > View All
Device Groups.

. Click New Group.

Click Group by Device Model.
Click Create Group. The Group Device by Model screen appears.

NOTE: If your Wireless Universal Resource File (WURFL) is out of date, a
notice appears on the screen. Click Update to update the device information.
For more information about WURFL, see Updating the Wireless Universal
Resource File on page 481.

Group Device By Model

€| SAVE | @
WURFL device information was last updated on 5/20/2013 8:08:33 AM.
Name*:
Dimensions for preview: @
Search by Model Y Width: 320 < pixels Height: 480 < npixels
Available Device and Models Selected for Group

@ search results will display here.

Enter the name of this Model group. For example, My Favorite Phones.
Enter a model name in the search box of a device that you want to add. For
example, enter Blackberry or iPhone and press Enter.

Select the devices you want in the model group by checking the boxes. If you
want to choose models from Blackberry AND iPhone AND Razr, first select
your device and models from one, then enter another into the search box and
select the others. Your selections appear on the right side of the screen.
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€ | SAVE | @
WURFL device information was last updated on 5/20/2013 8:08:33 AM.
Hame®: My Favorite Phones
Dimensions for preview: @
Razr Y Width: 320 - pixels  Height: 480 o pixels
Available Device and Models Selected for Group
=[] [§ Motorola Manufacture Model

/| Droid Razr @ | RIM BlackBerry 9320
Droid Razr 4G @ RIM BlackBerry 9330
Droid Razr HD @ | RIM BlackBerry 9380
DROID RAZR M 4G LTE @ RIK BlackBerry 9500 £
MOTORAZR @ | Apple iPhone
MOTORAZR 2 @ | Motorola RAZR D3
MOTORAZR VAN @ Motorala RAZR VG
MOTORAZR VOx & | Motorola RAZR V8

7| RAZR D3 @ | Motorola Droid Razr
RAZR Showing 1to 8 of 8 entries
RAZR M 4G LTE
RAZR \ XT885
RAZR V3cC
RAZR V3
RAZR V3m
RAZR \V3x
RAZR VW 3ux
RAZR V3o iZar

v | RAZR VE il

8. You can specify new dimensions for preview, or accept the default values.

9. Click Save to create the new group. The new group appears in the Groups By
Device Configuration section of the View All Device Groups screen.

Deleting a device group

1. Workarea >Settings > Configuration > Mobile Settings > View All
Device Groups.

2. Click Delete (). A confirmation dialog box appears.
3. Click Delete.

Applying adaptive image resizing

Adaptive Image Resizing resizes images and helps you implement a caching strategy
to enhance a user's mobile experience on your site. It includes the following features:
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« Criteria to determine which images get resized

» A user-defined set of resolutions—Ektron renders the image in a device-
appropriate resolution

» Adirect access mode that lets a developer set an image to a predefined
resolution

PREREQUISITE

To enable Adaptive Image Resizing settings, set ek__
EnableDeviceDetection to True in siteroot/web.config.

<add key="ek EnableDeviceDetection" value="true" />

Some visitors to your website will be on devices that have less-than-optimal
bandwidth due to their geographic location, their network, or device limitations. As a
result, the website loads slower for the mobile visitor than for the desktop visitor. By
optimizing your images for device sizes, you minimize these limitations.

Simply shrinking an image to fit a smaller device may result in an unsatisfactory
image. To ensure that your mobile visitors receive the best experience, Ektron’s
Mobile Image Selector lets content authors replace the image (with a satisfactory
substitute) that gets displayed for visitors on mobile devices of certain sizes. For
example, the following images show a "Times Square" article example on a Smart
Phone. Authors can swap out the desktop image for an image that renders well on
smaller devices; the shrunken image on the left gets replaced by the image on the
right.

——

SAMSUNG

New Year's Eve Ball Drop in
Times Square

New Year's Eve Ball Drop in
Times Square

Adaptive Image Resizing lets every visitor receive the image that is most appropriate
based on their device. For example, Smart Phones may receive an image that’s been
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scaled down to a lower resolution and 480-pixels wide, while the “"Desktop” version of
the image might be high resolution and 1200-pixels wide.

Image resolution ultimately defines the amount of detail an image holds. If an
original image is 1024 x 1024 pixels, there is a significant loss of detail when looking
at a scaled-down 24 x 24 thumbnail image. However, a 24 x 24 thumbnail image has
a much smaller physical size in KB, which means that it downloads much faster.

IMPORTANT: A delay in loading a page by only 1 second can dramatically impact
your conversion rate and deliver a poor customer experience.

If you view a 1024-pixel-wide image on a 320-pixel-wide screen, you cannot see the
detail. Downsizing the image to 320 pixels reduces the physical size significantly with
no loss of image detail. Similarly, you also can crop a section of the 1024-pixel-wide
image to a 320-pixel-wide section with all of its detail.

You want to balance image quality with file size because every millisecond of load-
time makes a difference to the experience (and tolerance) of your site visitors.

When you add an image to the Ektron CMS, Ektron creates copies of the image in the
sizes specified in the image breakpoint groups, up to the width of the original image.

Upload to CMS Ektron library asset

Image
Breakpoint
Manager
Transcoding
Images

For example, if you set up 4 image breakpoints at 320, 476, 620 and 768 pixels wide,
when you upload an 1024 x 1600 image called MonalLisa. jpg, the CMS creates 4
additional images as follows:

e Original image. /uploadedimages/Monalisa.jpg Monalisa.jpg

» 320 breakpoint. /uploadedimages/320W MonalLisa.jpg

» 476 breakpoint. /uploadedimages/476W Monalisa.jpg

» 620 breakpoint. /uploadedimages/620W Monalisa.jpg

» 768 breakpoint. /uploadedimages/768W Monalisa.jpg

If a 400-pixel-wide device calls the Mona Lisa image, the device gets the 476-pixel
image scaled to fit the (400-pixel device) container. However, even though you can
force an 1024 x 1600 image to fit into a container, creating a smaller image
drastically reduces the physical size of the image file by several factors of kilobytes
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that are transferred, significantly speeding up page-load time. Delays in page loading
can mean a loss in customer conversions and deliver a poor customer experience.

When you specify both width and height breakpoints, a device uses the larger of the
breakpoints to scale the image while keeping the aspect ratio of the image. For
example, if the height is 400 and the width is 600, the width is used to determine the
scale and the aspect ratio is kept.

NOTE: Adaptive images and responsive images are similar: adaptive images are
affected by the server while responsive images depend on the client to display

correctly. For information about responsive image selection when you are editing
your Web page, see Editing images on page 570 in Editing in Ektron on page 553.

Enabling adaptive images for breakpoints

If you have mobile devices grouped by breakpoints, you must enable groups to
create adaptive images when images are uploaded to the library or as assets. Go to
Workarea > Settings > Configuration > Mobile Settings > Adaptive Image
Settings. The Adaptive Image Settings screen appears. The following example
shows the Small Phones group that was added in Adding a group by breakpoint on
page 467.

Adaptive Image Settings

SAVE | @

Breakpoint Settings Advanced Settings
Enable Adaptive Images for the following Breakpoints © Add Breakpoint

Small Phones Create Adaptive Images for images added to these areas

¥| Library (~/uploadedimages
¥|DMS (~iassets

Smart Phones

Tablets

When you check a box next to a breakpoint group, the screen expands to let you
specify maximum width and height for the breakpoint images, and lets you add a file
label as a prefix to the image filename. In the following example, uploading Mona
Lisa.jpg generates sSM Mona Lisa.jpg for the Small Phones group, sP Mona
Lisa.jpg for the Smart Phones group, and the TB Mona Lisa.jpg for the Tablets
group.

Ektron Reference I 475



Checking boxes for Library and DMS enables adaptive image generation when
images are uploaded into these locations.

The Advanced Setting tab of the Adaptive Image Setting screen lets do the following:

e Image Settings

SAVE | @

Breakpoint Settings Advanced Settings

Enable Adaptive Images for the following Breakpaoints

Small Phones
Images will scale if either of the following dimensions are exceeded:

maximum image width-* 360 = pixels
maximum image height: 360 5 pixels

File Label=™ |SM

Smart Phones

Images wil scale if either of the following dimensions are exceeded:

maximum image width:* 480 5 pixels
maximum image height: 480 5 pixels
File Label=* |SP
¥ Tablets

Images wil scale if either of the following dimensions are exceeded:

-

maximum image width:* 1024 5 pixels
maximum image height: 1024 5 pixels

File Label* TH|

Creating a mobile-driven Web experience

© Add Breakpoint
Create Adaptive Images for images added to these areas

¥ Library ~
#IDMS (-

Adaptive Image Settings

476 |

Breakpoint Settings

SAVE | @

Advanced Settings

Minimum File Size

Specify the minimum file size that an image must meet in order to be resized

Minimum Image Size Threshold a0 5 KB

Caching

Setting Level 1 Caching stores the file name, size, and resolution for each of your images.

How many image files would you like to store in the Level 1 cache?

¥l Also cache image file @

How many image files would you like to store in the Level 2 cache?

¢ Clear Cache

-

5000 5 images

-

600 5 images

Specify the maximum image size for resized images to be cached. Images greater than this size wil not be cached.

Maximum Image Size Threshold 256 KB

4

Direct Access Query String

A Direct Access Query string allows developers to explicity request a specific version of an image. Ex: /im.

Direct Access Query String Key: |targetTypelD
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» Specify minimum file size that an image is before it will get resized. The default
minimum is 80 KB—smaller files are not resized.

» Specify caching levels 1 and 2. Use caching to avoid expensive query storage.
You should approximate the number of image files in the image folders.

To clear both Level 1 and Level 2 cache, click Clear Cache.

o Level 1 caching stores only a filename, file size, and resolution.
o Level 2 caching stores the file's content as a byte array.

BEST PRACTICE

Use the following formula to calculate memory usage for Level 2
caching:

Level2CacheltemThresholdKB * Level2CacheSize = total memory used

For example: 256KB*500=128000KB=128MB of maximum memory
used by Level 2 caching.

How adaptive image caching works

1. A user on a mobile device accesses an Ektron Web page that uses Adaptive
Image Resizing.
2. Forevery image file request, Ektron looks for it in Level 1 cache to
determine if the image size exceeds the threshold.
« If the cached item is found, the cached file information is used.

» Ifthe cached item is not found, Ektron queries the storage device for
the file information and caches it.

3. Forevery qualified image request, if level 2 caching is enabled, Ektron
searched Level 2 cache for the target file. If the file is found, the cached byte
array is sent to the user's device. If the file is not found, Ektron sends the
image from storage and caches the byte array (if the size does not exceed
the defined limits).

» The Direct Access Query String Key (targetTypeID) is for developers who want
to ignore a user's device and choose a specific version of an image. The
targetTypeID string is appended after the question mark (?) on a URL. You can
change targetTypeID to another string in this field.

Using responsive images with the editor

When you insert an image from the library into content then click the image to select
it, the Inspector's Advanced tab shows all breakpoints and their corresponding
images.

You can replace an image by clicking Change and selecting another image from the
library.
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Inspector

D FIGLIRE IMG
BHighlight Tags On Click

Advanced

H'Eesponﬁwehnugeﬁekximn

B Position & Wra pping

When responsive images are inserted into the editor, the editor produces
HTML similar to the following code to determine which images should be displayed for
each breakpoint.

<figure class="ektron-responsive-imageset"
title="Mona Lisa"
data-ektron-image-src="/uploadedImages/Content/About/
Mona Lisa.jpg?targetTypeld=Tablets"
data-media="/uploadedImages/Content/About/
FP Mona Lisa.png?targetTypelD=FeaturePhone"
data-media316="/uploadedImages/Content/About/
SM Mona lisa.jpg?targetTypeID=Smartphone"
data-media768="/uploadedImages/Content/About/
Mona Lisa.jpg?targetTypeID=Tablets">
<img src="/uploadedImages/Content/About/
Mona Lisa.jpg?targetTypeID=Tablets" alt="Mona Lisa" />
</figure>
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Creating image copies in a specified resolution

For information about the editor, see Editing in Ektron on page 553.

Creating image copies in a specified resolution

After you enable device detection in web.config, Ektron automatically creates
versions of the image in specified sizes for a matching breakpoint when a visitor
views an image.

<add key="ek EnableDeviceDetection" value="true" />

A new image filename consists of ImageResConfig TypeID original file
name.extension. For example, if the original image filename is mytest.png, and itis
resized to specifications set in the LowRes ImageResConfig element, the new
filename is LowRes mytest.png.

If a mobile visitor views an image that was in Ektron before device detection was
turned on, the image may be resized at that time. Ektron creates resized image
versions in the same folder as the original image.

If you later view the image on any device with the same resolution range, the saved
version is displayed. This practice enhances the performance of your mobile website.
However, creating additional image versions also increases the number of files and
storage space needed.

BEST PRACTICE

When planning an implementation of Adaptive Image Resizing, consider
your future space requirements.

Using Geographic data from a mobile device

If your site visitor is on a mobile device, the geographic location of your site visitor
becomes very important information. For example, if a mobile visitor is accessing
your site, you can display nearby stores and special promotions. To create a
geographically aware Web experience with Ektron, follow these steps.

1. Create content with MapLatitude and MapLongitude geo-location metadata. This
metadata is automatically added when you publish content with a street and city
address in the MapAddress field.
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View Content "Pizza Top™

|| eom | @ W 2 =] « ik & E a View: English (US) w Add: -selectlsngusge

Properties Content Summary Alias Comment Tasks

Search Data

MapAddress:

MapLatitude: 42 539428

MapLongitude: 71 671208

MapDate: [Mone]

2. Place the Map server control in a mobile device template.

3. Because of the size of a mobile device, you may want to rearrange the content
list, map image, and search components provided by the Map server control. To
do this, change the standard map EKML file. See Ektron Markup Language and
the sample file [siteroot] /workarea/template/map/map.ekml.

To learn more about using geolocation, see the Map server control.

After finishing the previous steps, use your mobile device (if it has GPS capability) to
browse to the template that contains the map; it shows your location at the center of
the map. For other mobile devices, the center of the map is the Latitude and
Longitude coordinates set by the Map server control. Content locations appear as
map pins, and the content list is sorted by distance from the current location (with
GPS) or map center.
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Updating the Wireless Universal Resource File
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Updating the Wireless Universal Resource File

NOTE: The commercial license between Ektron Inc. and ScientiaMobile, Inc., the
owner of WURFL, expired on April 3rd, 2016. You have the following options:
« Disable the WURFL data repository in your deployment so that you are not
using WURFL in an unlicensed manner.
« Contact Scientiamobile, Inc. to obtain a license directly. ScientiaMobile, Inc.
has provided a guide to transitioning.
» Replace the WURFL data repository with the 51 Degrees(TM) Lite library by
51Degrees.mobi, which is licensed under an Mozilla Public License open-
source license agreement.

When a device requests information from a Web server, HTTP headers are passed to
the server along with the image URL. The HTTP headers contain information that
identifies the type of device that is doing the request. Because new mobile devices
are being created every day, it is important for your website to detect these devices
when they are available and present the appropriate experience to visitors who use
these devices when they visit your site.

Each time a user clicks on the View All Device Groups folder, Ektron determines
whether more recent device information is available.

1. Go to Workarea > Settings > Configuration > Mobile Settings > View All
Device Groups. If your WURFL file is not up-to-date, you are given the
opportunity to update it.
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View All Device Groups

NEW GROUP | &)

Device groups work with templates and images to help the system display the content you've designed for
certain experiences. For example, if you've designed a template for users viewing your site an any mabile
phone thatis less than 480 pixels wide (whether landscape or portrait), vou can create a group that only
shows that template when that screen size or smaller is detected. If your template is intended for specific
types of mobile phones, you can create a group forthose exact phones.

s A Wireless Universal Resouce File (WURFL) update is avaliable. Would you like to update device

information? | Update

m

WURFL device information was |ast updated on 4/28/2013 2:23:10 AM.

Groups By Device Configuration

Group ID Grouped By Device Group Name Group Info Associated with
0 Default Generic Maobile Generic Maobile Device 0 Templates

Showing 1to 1 of 1 entries

2. Click Update.
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Ektron has 2 types of analytics.

« Ektron Business Analytics. uses Ektron server controls to track activity, store
the information in the database, and report on that information. See Running
Ektron business analytics on page 488.

« Ektron Traffic Analytics. uses an outside service provider, such as Google
Analytics to monitor all aspects of Web traffic to your site and report on that
information. See Running Ektron traffic analytics on page 509.

You can also run analytics from other providers documented in this chapter.

Viewing page-level analytics data

After you enable analytics tracking, your provider retains data on every visited page
(thatis, a unique URL) such as http://developer.ektron.com/articles.aspx OF
http://developer.ektron.com/template.aspx?id=6572. Data is tracked when the
quicklink is used, as well as any alias assigned to the content. See also: Creating
user-friendly URLs with aliasing on page 1293

You can view any page’s analytics data from the following locations.

» Viewing page-level analytics from the site below
» Viewing page-level analytics from a PageBuilder page on the facing page
» Viewing page-level analytics from the Workarea on page 486

Viewing page-level analytics from the site

Any authorized user can view analytics for a page on your website by following these
steps.

1. Log into the website.

2. Go to the page whose analytics data you wish to view.

3. Hover the cursor over the Website Content menu.
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Viewing page-level analytics from a PageBuilder

4. Choose View Page Activity. The SEO page’s Traffic tab appears.

URL: |http:/ fdev.ektron.com/articles.aspx?id=9212
SEO Google WicC Alexa Images Text Meta E
Analytics Provider | Google % | Start Date: [1/30/2011 End Date: [3/1/2011 &
. . Metrics
Display == | Pageviews A Time on Page ~ being
10 graphed

This page was viewed 28 times.

& visit this page | Analyzing

N 28 pageviews (1.27/day)
Metrics
AN\ A 24 Unique Views (1.09/day) | tracked by
Analytics
Mo /A 00:01:42  Time on Page provider

AAAMA 60.00% Bounce Rate

A NA 42.86% 2 Exit

The Traffic tab of the SEO control graphs the analytics data of any 2 search criteria.
There are data under the graph for the 5 visit criteria tracked by the analytics
provider.

» Pageviews. humber of pageviews for this page over the selected date range

» Unique pageviews. number of unique visitors to this page over the selected
date range

» Average time on page. how long a visitor spent on the page. It is calculated
by subtracting the initial view time for this page from the initial view time of the
subsequent page. So, this metric does not apply to exit pages.

+ Bounce rate. the percentage of single-page visits (that is, visits in which the
visitor exited your site from the entrance page)

» 9 Exit. the percentage of site exits that occurred from this page
You can change the date range, analytics provider, and either search criterion
(Pageviews and Time on Page in the example above).

You can also replace the URL with a different one, and view the page being analyzed
(by clicking Visit this page in the green bar).

Viewing page-level analytics from a PageBuilder page

Any authorized user can view analytics for a PageBuilder page by following these
steps.

NOTE: You cannot drag and drop the Analytics widget onto a PageBuilder page.

1. Open the PageBuilder menu. See also: Creating Web pages with PageBuilder on
page 991
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2. From the menu, choose View > Analytics. The SEO page’s Traffic tab
appears.

Viewing page-level analytics from the Workarea

The Workarea provides 2 page-level views of analytics data.
» The View Content History screen compares analytics data for any 2 published
versions
» The Analytics toolbar button displays the SEO page’s Traffic tab.
To view a content item’s analytics data from the Workarea:

1. Go to the folder containing the content whose analytics data you want to view.
2. Click the content item.

3. To compare analytics data between any 2 published versions, click History(L)).
See also: Comparing versions of content on page 645

To view analytics for the currently published version, click Analytics (5). When
you do, you see the Traffic tab of the SEO page.

On the View Content History screen, blue and orange radio buttons appear next to
each published version of content.

View Content History

& || COMPARE ANALYTICS | @)

a Lasi La
@ =P o T La Ti -

O 3.0 & 11/16/2011 2:53 PM Sample Content Blod

21 11/M18/2011 2:53 PM Sample Content Blodk
(o|®) 2.0 & 11/7/2011 11:04 AM Sample Content Blodk

1.1 11772011 11:04 AM Sample Content Blodk
(ol o) 1.0 B 10/21/2010 3:52 AM Sample Content Blodk  Administrator

0.1 10/21/2010 2:52 AM Sample Content Blodk Administrator

To compare analytics data, click the appropriately-colored radio button next to each
version, then click Compare (l#l). The Compare screen for the 2 versions appears.
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URL filtering

Display |Pageviews v i Site http://smacdenald1 % | Analylics Provider| Google |+ & URL Filtering  [All URLs Allowed i
700 Display pulldown URL Filtering
dropdown
50
July 15 July 22
Start Date: | 7/15/2009 End Date: | 7/25/2009 & 2iee/z00na /542009 &
A2 T\ 15751 Pageviews (1,431.91day) NS 20,578 Pageviews (1,870.73/day)
A\ 11505 Unigue Views (1,045.91/day) N 14784 Unigue Views (1,344.00/day)
/""" 00:02:24 Time on Page N\ 00:02:23 Time on Page
/7T 50.89% Bounce Rate ~——""—  58.12% Bounce Rate
/7T a166% % Bt N 40.74% % Exit

You can change the date range for each content version. You can also:

» Use the Display pull-down to graph any visit data.

» Click the URL Filtering tab to select the URLs being displayed. See also: URL
filtering below

» Select a different site
» Select a different analytics provider

* Use the Segments button (L&&).

URL filtering

Any content item can be viewed via several URLs, such as

 its quicklink. See also: Adding a quicklink to content on page 686
* manual alias
« automatic alias See also: Creating user-friendly URLs with aliasing on page 1293

NOTE: While Regex-based aliases affect Analytics data, they do not appear on the
URL Filtering tab.

The URL Filtering tab of the Compare Analytics screen lets you analyze the data by
each identifier. So, for example, you can drill down to view only the data collected
when site visitors accessed a page by typing its manual alias into the browser.

LRL Filtering  [AlllJRLs Allowed -

Limit results to the following LIRLS:

L] rdynamic.aspx?ekiim=1053
O fhohs_Pollaspx

Add Al Remoaove All

Viewing site-level analytics data
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You can view analytical data for any site via the Analytics Report widget and several
reports. See also: Creating and using widgets on page 1171

d!';[.
AnshyticsReport

You can drag and drop the Analytics Report widget onto the Smart Desktop. When
you do, you initially see the Direct Traffic report for the past 7 days.

You can click Edit (Ei) to change the display using any of the following options.

Analytics Report Ed
Analytics Provider| Google | Analytics Provider
Overview Report data Summary ¥
Display
Last 7 Days |Time interval | = oy | dev ektron.com-Google
| Cancel | | Save | Site

There are 3 time interval choices:

» last 7 days (the default)
e last 30 days
» last 90 days

Running Ektron business analytics

The Business Analytics feature lets you track statistics about visits to your website.
You can use it to determine the following kinds of information:

» how often your content was viewed

« how many site visitors viewed for first time, and how many returned

» the most popular referral pages (that is, the Web page from which visitors
clicked to arrive on your site)

Several options for selecting a date range let you compare activity across different
weeks, months, and years.

By default, the Business Analytics feature is disabled in the web.config file. To
enable it, set the value of the ek _enableClassicAnalytics property to true. If you
set this property to true and later change it to false, statistical data remains within
Ektron, but no additional data is collected.

<add key="ek enableClassicAnalytics" value="true" />
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For every template view, business analytics captures the following statistical
information:

url. the visited page

content_id. the ID of the visited content. Captured by the Analytics server
control. Tracking clicks by file type on page 526

visitor_id. a unique GUID that identifies a visitor
hit_date. date and time when a page view occurred
referring_url. the URL a user was viewing before jumping to the visited page

visit_type. zero (0) indicates new visitor, 1 indicates returning visitor, 2
indicates all other views. After a user logs on, the first page hit tracks the visit as
zero (0) (if the user is new) or 1 (if the user previously visited the page). From
then on, 2 is logged for that user.

In addition to writing Business Analytics data to the database, you can write it to the
IIS log. To do this, enable the appendToIISLog element in the web.config file. Note
that if you set appendToIISLog to true, some Business Analytics data is only written
to the IIS log and does not appear in the Workarea.

Analyzing site statistics

The following table shows analytic statistics available for each level of the site.

Type of Statistical Information

Template- Content-
Level Level

Views of Any Template

Visitors: New and Return

Pie Chart of New vs. Return Visitor

Pie Chart of Views/Visitors Ratio

Bar Graph of Views/Visitors Ratio

RN ENEEN
RN IENE N

Visited Pages

Visited Content Blocks

URLSs from which Site Visitors
Accessed Ektron

NSNS ININ N NS
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Site statistics view

The Site Statistics view offers an overview of tracked activity within the selected date
range. You see actual data for the

number of views

number of visitors

ratio of visitors per view

number of new and returning visitors

ratio of new to return visitors

See also: Tracking site visitors on page 492.

The following image shows pie charts of the ratio of views to visitors and new vs.
return visitors.

Content Analytics

2

Quick View: [Day] Week] [Maonth] [vear]
Jump To:  [Previous Week] [Mext Week] [Today]

StartDate: | Tyacday, April 27, 2010 = B

EndDate: | Tyggday, May 04, 2010 B 5B

FHun Custom Range

Total Views 1344
Total Visitors 36
Views fVisitor 37.33
New Visitors 19
Returning Visitors 25
ViewsfVisitor MNew vs. Returning Yisitors
« Total s [ew
wiEws Yisitars
e« Total s Returning
Yisitors Yisitors
Content view

The Content View shows the most frequently-accessed content on your website.
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Templates view

Content Analytics

L2
Ouick View:  [Day] [Week] [Month] [vear]
Jump To: [Previous Week] [Mext Weelk] [Today]

StartDate: | Tyugsday, April 27, 2010 = &

EndDate:  Tygseay, May 04, 2010 =

Run Custom Range I

Content
Site Statistics Site Activity Templates Referrers
Content Title ContentID) Visitors Wi
Build Health: Want To Prevent Or Cure Cancer? az 1 13
The Diet f Cancer Link 29 1 3
[=TaTal-1d a0 1 L]

Click any content item to view:

» Content Statistics. Statistics for that content item only
» Content Activity. Relative activity for that content item only

« Audit Content. All users who viewed the selected content; to the right of each
user are the date and time when content was viewed

NOTE: Only users who viewed content after logging in appear on the list. Site
visitors who do not log in affect statistics but are not tracked on this report.

Templates view

The Templates View shows all viewed templates on your website, with the most
frequently-accessed ones on top.

By default, the templates at the top have the highest number of unique visitors. You
can change the sort by clicking any column header. For example, to sort templates by
the number of views, click Views.

Content Analytics

LI
Cuick View: [Day] [Week] [Month] [vear]
Jump To: [FPrevious Week] [Mext Week] [Today]

Start Datel | Tugsday, April 27, 2010 = [

EndDate: | Tuzzday, May 04, 2010 = =

Run Custom Range I

Template Statistics

Site Statistics Site Activity Content Referrers

Template Visitors View
fcms400demofdefault. aspx =l 63
JCMS4000ermoforum.asps 3 28
[CMS400Demo/search.aspx 2 33
fCMS400Demo/services.aspx 2 z
e Annharmn fwalllhacs alarkc achw 1 =

You can click any template to view
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 Template Statistics. Statistics for that template only
+ Template Activity. Relative activity for that template only

+ Content in Template. If a content item was specified for the template in the
Content Analytic server control, this view show statistics for the template. You
can click the template to view Template Level activity.

Referrers view

The Referrers View shows domains from which your site was most frequently
accessed.

Content Analytics

)
Quick View: [Day] [Week] [Month] [Year]
Jump To:  [Previous Week] [Mext Week] [Today]

Start Date: Tuesday, April 27, 2010 = 5

End Date:  yazday, May 04, 2010 = B

Run Custom Range

Referring Domains

Page
http:ff192,168.0.203/CM54000emo/work area,/explorer/main. html
httr:u f,-’192 168.0.203/CMS4000emot orkareaflibrary .asps?

nnnnnnnn 1AM 220 s mbimm = fms] e TRA P DA —E 1 Do memm A —11

Tracking site visitors

The Business Analytics feature provides information about visits made by new versus
returning visitors. To capture this data, the feature asks this question whenever a
page is visited: is the user logged in as either a membership or regular user?

» If yes, capture the user ID with the statistical data
» If no, place a cookie on the visitor’s computer

The next time the user visits that page, the feature checks the visit history for the
user ID, or for a cookie. If either is found, the visit is considered a return.

The same user visit may be considered new on one view but not on another. For
example, someone visits on January 30 (Monday) then again February 2 (Thursday).
On the monthly statistics, that visitor is new, but on the weekly statistics, the
February 2 hit would be a return visit (his second this week).

Now consider a second visitor, who browses to your site on the first and 20th of the
month. These visits appear on weekly statistics as 2 new visits, but on the monthly
statistics, only the first visit would show up on that month's tally of new visitors. The
second visit would add to the return visitor statistics.

Specifying the frequency of writing to the database
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Using Quick View options

After you set up the Business Analytics feature, your database is subject to a
continuous barrage of write activity, generated by visits to your site. To optimize
your database’s performance, you can hold visit activity in application server
memory until a predetermined amount of data is collected. When collected, it is
moved in one packet to the database. So, the database is “hit” much less frequently.

Specify the amount of data saved in memory prior to being written to the database
using these web.config file elements.
* recordsBeforeWrite. the number of unique template visits

e timeBeforeWrite. the number of seconds since the last time a database write
occurred

When either element reaches the value set in web.config, all records stored in
memory are written to the database. That event resets both elements to zero (0).
When you first view statistical data, the default date range is today (one day).

If you view statistics for different date ranges, when you return to the screen, the last
selected date range is the default selection. You can change it if needed.

Using Quick View options
Use Quick View options to view analytics for any of these time periods.

» one day

* Oone week

e one month

e oneyear
When you click Quick View [week], [month] or [year], the current end date is
used as the last day of the range. Here are some examples.

» Week. If end date is today, begin date is one week earlier than today

» Month. If end date is today, begin date is one month earlier than today

» Year. If end date is today, begin date is one year earlier than today

Using Jump To options

Use Jump To options to view statistics for a time period before and after the current
date range. The time period is determined by the Quick View increment. For
example, if the Quick View option is Day, you can jump to the previous day, the
following day, or today.

Regardless of the Quick View increment, you can always view statistics for today.

Viewing business analytic reports

The Business Analytics reports let you drill down from the entire site to individual
templates to individual content items.

PREREQUISITE
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In your site's web.config file, the ek _enableClassicAnalytics settingis
set to true.

NOTE: The Most Popular and Trends widgets also report on Business Analytics
data. See Most popular widget below and Trends widget on page 497.

To access Business Analytics Reports:
Either

1. Browse to a content item for which Business Analytics data is being captured.
2. Right click the mouse.

3. Choose View Template Activity to see Business Analytics data for the current
content item (to learn more about data captured for one content item, see
Content view on page 490).

4. Choose View Site Analytics to view Business Analytics data for the entire site.
or
« From the Ektron Workarea, choose Reports > Business Analytics to view

analytic data for the entire website. The following reports are available.
« Sijte statistics view on page 490

» Content view on page 490
» Templates view on page 491
» Referrers view on page 492

Most popular widget

o

The Most Popular widget reports on these categories of content on your website. By
default, every Most Popular widget tab shows up to 5 results.

» Most Viewed

» Most Emailed

* Most Commented

« Highest Rated

You can place the Most Popular widget onto any PageBuilder page. See also: Creating
Web pages with PageBuilder on page 991.

NOTE: You cannot place more than one Most Popular widget on a PageBuilder
page. Also, you can hide up to 3 tabs if desired.

The Most Popular widget references content events, which are Ektron events that are
tracked when used with various server controls. Here are 2 examples of a content
event:
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» for the Most Viewed tab, the content was viewed and tracked by the Analytics
Tracker server control. See also: Analytics Tracker.

» for the Most Emailed tab, the content was emailed from the Social Bar server
control.

The Most Popular widget displays content items that meet these criteria.

» the content is tracked by a server control

« content events occurred within the date range set in widget properties. The
default value is 7 days, but you can change it if desired.

» the content is assigned to a selected folder or taxonomy. By default, the widget
has no folder or taxonomy restrictions. But the properties screen lets you restrict
results by folder or taxonomy.

» the content is among the highest-rated content items for that tab.

For example, if the Most Viewed tab shows the top 5 content items (the default
setting), content that has not been viewed as frequently as the top 5 does not
appear. Consider the following example.

Number of Times Content

Content ID Viewed within Date
Range
30 87
259 82
316 78
12 78
658 67
243 62

In this example, content ID 243 does not appear on the Most Popular widget
because it is sixth in viewing rank frequency.

Each time a content item is used with one of the following server controls, its count
for that day is incremented by 1.

» Analytics Tracker. Most Viewed tab—A site visitor browses to a page that is
tracked by the Analytics Tracker server control. The control lets you determine
which content is counted when the page is viewed.

» SocialBar. Most Emailed tab—A community group member browses to a page
that hosts the Social Bar server control, and emails a content item to a friend.
(The SocialBar server control must be associated with content.)
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» MessageBoard. Most Commented tab—A Community Group member browses a
page that hosts the Message Board server control and comments on a content
item on that board. (The MessageBoard server control must be associated with
content.)

» ContentReview. Highest Rated tab—A site visitor browses to page that hosts the
Content Review server control, and uses the control to rate a content item.

Next to each content item is a count. The count indicates the number of times a
content event occurred for that content within the specified time frame.

Most Viewed Most Emailed Most Commented Highest Rated

Sample Content Blocl«@

About Us (6)

Business Practices (6)

About Us - Index (6)

Where did you hear about Ektron Medical? (6)

[5 T S FURN N R

The date range can affect the count. For example, if a content item was viewed once
a day for the past 10 days but the date range is set to 7 days, the countis 7. To
change this maximum:

1. Open sitercot/widgets/mostpopular.ascx.cs.

2. Find the following line: private int PageSize = 5;.

3. Change the number at the end of the line to the maximum results to display.

NOTE: This setting affects all tabs and instances of the Most Popular widget.

A logged in user can change properties that determine what appears on the Most
Viewed tab. To do so, click Edit (l<).

» Tab text. The text that appears on this tab. In the above example, the left tab's
text is the default Most Viewed.

» Visible. Determines if the tab you are editing appears on the widget. At least
one tab must appear. Checked is the default.
« Number of days to report. The number of days for which to display the data.
The defaultis 7.
° The current day is not counted, since it is incomplete. So if you enter 1, you
see information for all of yesterday and today.

° The date calculation is based on the clock on the website's server.

NOTE: You can change this to any number you wish. However, the
widget can only show data for days for which data is stored in your
database.

» Report. Determines information that appears when a tab is clicked.
° Tab 1. Most Viewed

° Tab 2. Most Emailed
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Trends widget

° Tab 3. Most Commented
°© Tab 4. Highest Rated
» Filter By. You can restrict the content appears on this widget by selecting a
folder (default) or a taxonomy.

Filter by Mo filter is selected,

Folder % '

While selecting a folder/taxonomy category, you can include all
folders/categories under the selected one. To remove this restriction later, click

Delete (+%).

Trends widget
bl
dl';

By default, the Trends widget shows the Most Viewed content on your website. You
can edit the widget's properties so that it displays any of the following categories of
content instead.

» Most Emailed

* Most Commented

» Highest Rated
The Trends widget is a subset of the Business Analytics, so you should be familiar
with that section before reading this. It explains topics such as how Ektron
determines which content appears for each category. You can place the Trends

widget on any PageBuilder page. See also: Developing wireframe templates on
page 1007.

A logged in user can change properties that determine the appearance of the Trends
widget. To do so, click Edit (l«]). The Trends widget screen appears.
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Trends Widget %X
Repaort Type: Maost Viewed b
Mumber of days to report: 7
QOrder Direction: sort Descending ¥
Maximum number of items: R
Filter by: No filter is selected

Folder b @

« Report Type. Report types are:
o Most Viewed (default)

° Most Emailed
° Most Commented
o Highest Rated

« Number of days to report. The number of days for which to display the data.
The defaultis 7.
° The current day is not counted, since it is incomplete. So if you enter 1, you
see information for all of yesterday and today.

° The date calculation is based on the clock on the website's server.

NOTE: You can change to any number you wish. However, the widget only
shows data for days for which data is stored in your database.

» Order Direction. The direction in which search results are sorted. The default is
Descending.
o Ascending. Alphabetical results from A to Z; numeric values low to high;
dates from oldest to most recent

o Descending. Alphabetical results from Z to A; numeric values high to low;
dates from most recent to oldest

« Maximum Number of Items. Enter the maximum number of content items
that may appear on the Trends widget. The default is 5. The Ektron database
maintains a count (number of hits) for each content item, for each date. When
you select a number of days, the Trends widget displays the content with the
most hits during that date range, up to the number you set in this field.

» Filter By. You can filter which content appears on this widget by selecting a
folder or a taxonomy.
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Filter by: Mo filter is selected.

Folder % '\

o) Gua)  [Toom

While selecting a folder/taxonomy category, you have the option to include all
folders/categories under the selected one. If you later want to remove this

restriction, click Delete (#%)

Business analytics API

The Business Analytics API's namespace is
Ektron.Cms.Framework.Analytics.BusinessAnalytics and consists of several
static methods arranged into 2 groups:

* those that save events to the database
» those that retrieve the event data from the database for use in reports

NOTE: The demonstration code in this section uses C# syntax.

Saving event data

The following illustration depicts saving event data to the database.
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Event)

API
EvertLogger(Ektron.Cms framework Analytics Businesz Analvtics)
CreatesnalyticzEventr)
Lol
Dbjectfau:tu:lry.Gemnalf.-'tin:sEverdSelrvic:e(j
BLL
l[&nakticsEventzervice
(Ektron.CMZ= Framewoaork Analvtics Businessanalytics)
CreatesnalyticzEventr)
Loar)

DAL
[EILISiI'IESS.-':'-.I'|E||ﬂiESEVEFﬂPFDViIﬂEF(EHFDH LS BuzineszObjects Analytics Providers)
Loal)

Buzinesz&nalyticsEventDal
[Ektron CMS BusineszObjectz . Analytics InternalSupport DALY

Logi)
v

Database

To save events, use the static class EventLogger, which exposes the following
methods.

e IAnalyticsEventData CreateAnalyticsEventData ()

e void Log(IAnalyticsEventData eventObject)

e void Log(string eventName)

e void Log(string eventName, string xml)

e void Log(string eventName, string xml, int count)

The following image shows the EventLogger class.
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Xml { get: set; } : string

As long as an event (myEvent) has been registered in the system, you can store an
event like this:

using Ektron.Cms.Framework.Analytics.BusinessAnalytics;

EventLogger.Log (“myEvent”) ;

This code saves the event data with default values. As shown, the Log method has
several overloaded versions. Each provides a different amount of control over the
information saved to the database. The following list shows the Log method's
parameters.

« eventName (String). A name that uniquely identifies the event. This name
must be registered and enabled in the database for it to be recorded.

« XML (String). This parameter is purely for customization. By default, its value is
null. The API stack passes the string to the database, where the appropriate
stored procedure can use it. For example, it can store additional values that are
not part of the current event-object

« count (Integer). Allows increments other than the default value of one. For
example, you may want a specific event to increment the event counter by 5.
In addition to the parameters listed above, you can set other values by referencing

the event object that carries the information to the database. A call to
CreateAnalyticsEventData returns this object, and can be used as follows:

IAnalyticsEventData eventObject = CreateAnalyticsEventData () ;

Through the interface TAnalyticsEventData, the object provides the following
additional parameters, which allow more control over what information is saved with
the event.

» Objectld (Long). For a content related event, Objectld should be set to a
Content ID.

 Languageld (Integer). The content object's Language ID. If that is not
available, the current request's Language ID.

» Siteld (Long). The current request's Site ID

NOTE: A value of -1 means this value has not been set, and will be updated
appropriately at a lower level.
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» UserlId (Long). The current request's User ID (if logged in)
« VisitorId (String). The current request's Visitor ID (if not logged in)
+ EventDate (DateTime). Defaults to current date and time

Retrieving event data
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This illustration depicts retrieving that data into reports.
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Use the static class EventReporter to retrieve events stored in the database. This
class exposes the following methods.
e IList<string> GetReportNamelList ()
e TAnalyticsQueryRequest CreateQueryRequest ()
e IContentQueryRequest CreateContentQueryRequest ()
e IList<IAnalyticsEventItem> GetList (IAnalyticsQueryRequest
queryRequest)
e IList<IContentEventItem> GetList (IContentQueryRequest
queryRequest)

e void UpdateReportData (String eventName, DateTime eventDate)

The EventReporter classes are illustrated as follows.
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GetReportNamel.ist method

Use the GetReportNameList method to obtain a list of recognized (e.g., registered)
report names. You can extend this list by adding custom event types and their
corresponding stored procedure handlers.

For example, to obtain a list of the allowed report names, use the following code.

using Ektron.Cms.Framework.Analytics.BusinessAnalytics;

IList<String> names = EventReporter.GetReportNamelList () ;

CreateQueryRequest method

Use the CreateQueryRequest method to specify an event data report of the base-
level type. The method returns an object that implements the interface
IAnalyticsQueryRequest, which has the following parameters.

ReportName (String). Uniquely specifies the report, which is registered and
corresponds to one or more stored procedures which, when run, generate the
requested data.

Siteld (Long). The Site ID of the data being returned.
Userld (Long). The User ID of the data being returned.

EventStartDate (DateTime). If desired, use to determine the earliest date for
which report data is returned. By default, data from the earliest date is returned.

EventEndDate (DateTime). If desired, use to determine the latest date for
which report data is returned. By default, data through the most recent date is
returned.

PagingInfo (Ektron.Cms.PageingInfo). Page size and number let you display a
small portion of the report at a time. By setting page size and number, the report
data is reduced, and performance will improve. Conversely, performance
degrades as page size (RecordsPerPage) increases, especially if the amount of
stored data is large. This type has the following fields:

° CurrentPage

o EndRow
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o RecordsPerPage
o StartRow

o TotalPages

o TotalRecords

» OrderByDirection (EKEnumeration.OrderByDirection). Descending or
Ascending

« XML (String). This parameter is purely for customization. By default, its value is
null. While saving event data, the API stack passes the string to the database,
where the appropriate stored procedure can use it. For example, it can store
additional values that are not part of the current event-object. Within the
CreateQueryRequest method, this parameter can returns that string.

CreateContentQueryRequest method

Use the CreateContentQueryRequest method to specify a report of event data that
is related to content. It returns an object that implements the interface
IContentQueryRequest which, in addition to those provided by interface
IAnalyticsQueryRequest (see CreateQueryRequest method on the previous page)
has the following parameters.

NOTE: You can use either the FolderID or the TaxonomyID parameter but not
both. Also, you can only use the IncludeChild parameter related to the selected
parent parameter.

 Languageld (ID). The Language ID of the content that the report returns.

» FolderId (Long). The folder of the content being returned. All content in the
folder is returned. It defaults to that of the current HTTP request.

« IncludeChildFolders (Boolean). Determines whether the report includes
children of the folder specified in the FolderID parameter.

« Taxonomyld (Long). The taxonomy category of the content being returned. All
content to which the category is applied the folder is returned. It defaults to that
of the current HTTP request.

» IncludeChildTaxonomy (Boolean). Determines whether the report includes
children of the folder specified in the FolderID parameter.

GetList method
There are 2 versions of the GetList method.

One version takes an TAnalyticsQueryRequest object, and returns a list of objects
that implement IanalyticsEventItem. That version has the following parameters.

» ID (Long). The object Id s supplied when the related events were saved.
« XML (String). This parameter is purely for customization. By default, its value is
null.

While saving event data, the API stack passes the string to the database, where
the appropriate stored procedure can use it. It can store additional values that
are not part of the current event-object.
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The other version of the GetList method takes an IContentQueryRequest object
and returns a list of objects that implement the interface 1ContentEventItem. That
provides the following parameters in addition to those of IAnalyticsEventItem
(shown above).

 Languageld (Integer). The Language ID of the content that the report returns.
* Quicklink (String). The object's URL.

» Title (String). Determines whether the report includes children of the folder
specified in the Folder1D parameter.

» Teaser (String). The content summary.
» Status (String). The content's status. See also: Content statuses on page 624
» FolderID (Long). The FolderID of the content being reported.

» Count (Integer). The count of the object being reported. For example, if you are
retrieving the most frequently emailed content item, the count is the number of
times it was emailed. The count and average values may be used individually or
together, depending on the report. For example, the rating report returns both
the average (rating) and the count (the number of ratings), while the
commented report uses only the count.

« Average (Decimal). The a numerical value divided by the count. For example,
when Ektron calculates average content rating, it divides the total number of
rating points (on a scale of 1 thru 10) by the number of votes.

UpdateReportData method

This method tells the database that an event's details should update that event's
aggregated data. This method is only required if the database does not automatically
do this, such as when the corresponding bit is disabled for that an type in the
database. Disabling the corresponding bit generally improves performance,
especially if the event logging rate is high. But, if you disable the corresponding bit,
you must call this update method if you want the report to show current data.

The UpdateReportData method takes the following parameters.

+ eventName (String). The event whose data will be updated.

+ eventDate (DateTime). The date of the event's occurrence. For example, if you
pass 1/1/2009, one row in the aggregate table is updated. If the row does not
exist, it gets created. If you do not pass an event date, this method updates the
aggregate table with summary info for that event for all dates. For example, if
today is February 1, the system has been in use since the beginning of the year,
and you pass NULL for the date, 32 table rows are updated (31 days in January
plus 2/1).

Disabling the saving or reading of events
You can disable the saving or reading of all events or of individual events.

It is useful to disable events when you want to minimize database traffic. To disable
all events:
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1. Open siteroot/web.config.
2. Set the following parameters to false.

<!-- Enable saving business-analytics events to the database

(at API level) --—>

<add key="ek enableBusinessAnalyticsEventStorage" value="false"/>
<!-- Enable querying the database for business-analytics events

(at API level) -->

<add key="ek enableBusinessAnalyticsEventReports" value="false"/>

NOTE: These settings are set to enabled (true) by default.

You can also enable or disable individual events in the database itself, but this does
require a call to travel through the full stack.

Using a custom provider

Providers that read and write event data are located under the service level. Default
providers pass calls through to standard Ektron database-access-level code, which
reads and writes from the database. You can modify this behavior to almost any
conceivable alternative. For example, you can

» save data to an alternate database on an alternate machine.
» call Web services to handle reads and writes.

« filter the data and/or requests.

» process information on its way to or from the database.

The SDK contains sample providers, as well as full source code for Ektron-supplied
providers. You can use this material as a basis for writing custom providers, which is
the preferred technique for customizing the behavior of the Business Analytics API
stack and subsystem.

The default providers for saving and reading event data (respectively) are
EktronEventProvider.cs and EktronQueryProvider.cs. Example custom-provider
source code has the following names for saving and reading event data
(respectively): DemoEventProvider.cs and DemoQueryProvider.cs. For the default
providers, the siteroot/web.config file must contain the following, inside
<configuration><configSections>.

<section name="businessAnalyticsQueryProvider"
type="Ektron.Cms.Analytics.Providers
.BusinessAnalyticsQueryProviderConfiguration,
Ektron.Cms.BusinessObjects"
allowDefinition="MachineToApplication"
restartOnExternalChanges="true"/>
<section name="businessAnalyticsEventProvider"
type="Ektron.Cms.Analytics.Providers
.BusinessAnalyticsEventProviderConfiguration,
Ektron.Cms.BusinessObjects"
allowDefinition="MachineToApplication"
restartOnExternalChanges="true"/>

Additionally, the following must exist inside the <configuration> tags.
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<businessAnalyticsQueryProvider
defaultProvider="EktronBusinessAnalyticsQueryProvider">
<providers>
<add name="EktronBusinessAnalyticsQueryProvider"
type="Ektron.Cms.Analytics.Providers.EktronQueryProvider,
Ektron.Cms.BusinessObjects"/>
</providers>
</businessAnalyticsQueryProvider>
<businessAnalyticsEventProvider
defaultProvider="EktronBusinessAnalyticsEventProvider">
<providers>
<add name="EktronBusinessAnalyticsEventProvider"
type="Ektron.Cms.Analytics.Providers.EktronEventProvider,
Ektron.Cms.BusinessObjects"/>
</providers>
</businessAnalyticsEventProvider

Creating custom providers
To override the default Ektron provider with a custom provider:

1. Create a new solution with a project named CustomProviders.

2. Add the following references to the project.
» Ektron.Cms.BusinessObjects.dll

e Ektron.Cms.Common.dll
» Ektron.Cms.ObjectFactory.dll

3. Add files bemoEventProvider.cs and DemoQueryProvider.cs (
SDK).

4. Build.

Ul

6. Update web.config by modifying the <configuration> section
add demo providers to the Business Analytics providers.

<businessAnalyticsQueryProvider
defaultProvider="DemoQueryProvider">
<providers>
<add name="EktronBusinessAnalyticsQueryProvider"
type="Ektron.Cms.Analytics.Providers.EktronQueryProvider,
Ektron.Cms.BusinessObjects"/>
<add name="DemoQueryProvider"
type="Ektron.Cms.Analytics.Providers.DemoQueryProvider,
CustomProviders"/>
</providers>
</businessAnalyticsQueryProvider>
<businessAnalyticsEventProvider
defaultProvider="DemoEventProvider">
<providers>
<add name="EktronBusinessAnalyticsEventProvider"
type="Ektron.Cms.Analytics.Providers.EktronEventProvider,
Ektron.Cms.BusinessObjects"/>
<add name="DemoEventProvider"
type="Ektron.Cms.Analytics.Providers.DemoEventProvider,
CustomProviders"/>
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</providers>
</businessAnalyticsEventProvider>

Running Ektron traffic analytics

To access a fully-developed, Web traffic analytics provider model, go to Workarea
> Reports > Traffic Analytics.

By linking to best-of-breed analytics software, such as Google, Webtrends, and
SiteCatalyst, your website’s information is integrated into Ektron's Workarea, and
you can view analytics from other Web Analytics providers.

IMPORTANT: No data is stored in Ektron; Ektron retrieves the analytics on
demand from Web Analytics providers.

By analyzing the user traffic coming to and interacting with your site, you can better
understand key elements of your Web presence. Traditional Web analytics packages
help you understand where your traffic is coming from, when traffic is occurring
(including high and low points), and which pages users are interacting with. But this
information is often isolated from Web content and, so, lacks the context needed to
take advantage of it.

You can place the Analytics Reports widget on your dashboard, so that you have
instant access. Also, the software is integrated into the content history, making your
traffic analytics more relevant because you can view what modifications were made,
when, and how they impacted traffic to that page. You can react immediately,
restoring content that performed better or changing current content to better reflect
your goals.

Customer reporting, segmentation, and legacy data are easier to access, and Ektron
becomes the central hub for all of your website’s information, bringing it together so
that it is no longer siloed. Having all information in one place puts it in context,
making it easier to draw conclusions needed to optimize your Web presence.

» To view Web traffic analytics, you must have an Ektron Professional or
Enterprise License.

» Only the following users can view the Web Analytics data.
o Administrators group members

o Administrators group members

Ektron’s Workarea provides customized reporting, reflecting exactly the information
you care about. The data can analyzed in many ways, such as:

» number of visits per day

e browser usage

« visitor location

 visitor language

« top content

» referring sites
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When you set up Web Traffic Analytics, the Analytics Provider monitors every site
visit. In the Workarea, you can view this data from many perspectives.
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When you view Analytics data in the
Workarea, it is pulled from the provider.

Mo Analytics data is stored in the CMS.

Running Google Analytics

Google Analytics is an enterprise-class solution that gives you rich insights into your
website traffic and marketing effectiveness. Powerful, flexible, and easy-to-use
features let you see and analyze traffic data in an entirely new way. Google Web
Analytics prepare you to write better-targeted ads, strengthen your marketing
initiatives, and create higher converting websites. Its main features are:

» Advertising ROI. Measure the success of your display, search, new media, and
offline advertising efforts.

» Cross Channel and Multimedia Tracking. Compare your site usage metrics
with industry averages and track Flash, video, and social networking sites and
applications.

» Visualizing Data. Uncover trends, patterns, and key comparisons with funnel
visualization, motion charts, mapping, and more.

» Customized Reporting. Create reports, dashboards, and segments that make
the most sense for your business.

« Sharing and Communicating. Administration controls and email reports let
you share data across your organization.

+ Google Integration and Reliability. Google Web Analytics complements a
suite of related products, all running on the same world-renowned infrastructure
that powers Google.

For more information, see the Google Analytics home page, Configuring your Ektron
Site for Google Analytics.
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Deciding which Google Analytics version to use

BEST PRACTICE

See also the following recorded demonstration: Configuring Google
Analytics - Ektron Developer Office Hours; and Configuring your Ektron
Site for Google Analytics.

Deciding which Google Analytics version to use

Ektron supports Google Analytics versions 2.4 and 3.0. To compare versions, see
Migration Guide: Moving from v2.3 APIs to v2.4 & v3.0> Differences between
v2.4 and v3.0.

You may use both versions. If you enable both, the Ektron Workarea displays a drop-
down for choosing a provider. Data is the same for both providers if you use the same
Google analytics profiles.

IMPORTANT: If you will use Google’s Core Reporting API v3.0, Ektron supports
the ClientLogin and OAUTH 2.0 authentication. If you will use Google’s Core
Reporting API v2.4, Ektron only supports ClientLogin authentication.

Setting up Google Analytics

This section explains how to set up Google analytics. After you complete these steps,
Google begins tracking your entire website. Alternatively, you can track individual
site pages (see Tracking a single page on page 526), or clicks by file type (see
Tracking clicks by file type on page 526).

PREREQUISITE

If you want to use OAuth2.0 authentication, follow the steps in Setting up
the OAuth2.0 authorization protocol for Google Analytics 3.0 on page 517
before beginning this procedure.

WARNING! Enabling the tracking code may cause a significant increase in CPU
usage.

1. Create a Gmail account (http://mail.google.com).

2. Sign up for Google Web Analytics (www.google.com/analytics/). When setting
up a Google Web Analytics profile for your site, you are assigned a profile ID and
a User Account. You need those to complete Step 8.

3. Open this Google Analytics help page: Migration Guide: Moving from v2.3 APIs
tov2.4 & v3.0.

4. Under "Create a Project in the Google APIs Console," follow steps 1 through 4.
On the API Access screen, under Simple API Access, click the Create new
Browser key button. Copy the new browser key. This will be your API key in
Step 8.

5. Onthe server that hosts Ektron, go to C:\Program Files
(x86) \Ektron\CMS400vxx\Utilities\EncryptEmailPassword.exe.

6. Use that utility to encrypt the Gmail username and password that you obtained
in Step 1. Enter the full user name, including @gmail. com.
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7. Openyour siteroot/web.config file and find the AnalyticsDataProvider tag.
If you enable versions 2.4 and 3.0, edit the GoogleV3.0 and GoogleV2.4 tags.

<AnalyticsDataProvider defaultProvider="Google">
<providers>
<add name="GoogleV3.0"

type="Ektron.Cms.Analytics.Providers.GoogleAnalyticsProviderv3,
Ektron.Cms.BusinessObjects"
EmailAddress=""
KeyFilePassword=""
KeyFilePath="/Key/privateKey/XxxXxXxXxx.pl2"
Username=""
Password=""
ProfileId=""
SiteURL=""
UserAccount=""
Endpoint="https://www.googleapis.com/analytics/v3/data/"
ApiKey=""
CacheInterval="0"

GoogleAnalyticsTrackingCodePath="Analytics\template\googletrackingcode.ascx"
Version="3.0" />

<add name="GoogleV2.4"
type="Ektron.Cms.Analytics.Providers.GoogleAnalyticsProvider,
Ektron.Cms.BusinessObjects"

Username=""
Password=""
ProfileId=""
SiteURL=""
UserAccount=""
Endpoint="https://www.googleapis.com/analytics/v2.4/"
ApiKey=""
CacheInterval="0"

GoogleAnalyticsTrackingCodePath="Analytics\template\googletrackingcode.ascx"
Version="2.4" />

</providers>
</BAnalyticsDataProvider>

NOTE: If your web.config has several analytics providers and you want to
disable tracking for any of them, delete the value of the
GoogleAnalyticsTrackingCodePath property.

8. Complete each tag’s properties.
 name. The free text name of the site being tracked and the Google version.
You should use the site name followed by provider name and version. For
example, www.ektron.com-Google V3.0. When Workarea users view site-
level displays of Web Analytics data, they choose the site from a drop-down.
If you change the name, you must also change the <AnalyticsDataProvider
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S = 7/2/2009

defaultProvider element to match the name.
synergy.ektron.com-Google

synergy.ektron. com-Google
dev.ektron.com-Google

New vs. Returning

869 visits from 2 visitor types

NOTE: The following three fields are only used if you are using OAuth 2.0
authentication.

« EmailAddress. Enter the service account email address that you used to
register your site in the Google Console. For example:
111111111111 @developer.gserviceaccount.com.

» KeyFilePassword. Appears in the Download dialog that appears while
registering your site in the Google Console.

» KeyFilePath. Enter the path to the privatekey file that you downloaded and
saved while registering your site in the Google Console.

» Username. The Gmail username you encrypted in Step 6.
» Password. The Gmail password you encrypted in Step 6.

» ProfileID. The Google Analytics Profile ID you obtained in Step 2. Another
way to find your ProfileID is
a. Log into https://www.google.com/analytics/.

b. Click Admin.

GO 8[@ Ana E,J’EVCS g @0mailcom  Sefings by Account

Analytics now includes Change History, a log of account changes. Learn more
Dec 21, 2013 - Jan 20, :

Mode | = i Sncwﬁ |

Avg. Visit Bounce Rate Go

Visits Nuration Conversion F

c. Inthe View column, select the account that you want to track. If you
do not see the account, create it.
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d. Inthe View column, under View Settings, locate the View ID.

LI LI E H LT s

8.6 Ektron Web Help

8.6 Ektron Web Help w

View Settings
n View Settings

User Management
Goals
Content Grouping
Filters

Channel Grouping

Reporting View Settings
PERSONAL TOOLS & ASSETS
Basic Settings

Segments View ID

» SiteURL. Enter the current server's fully-qualified domain name. For
instance, if your site’s URL is http://hostname.domain.com, the SiteURL
value should be hostname.domain.com. Careful! Omit the leading http://
Or https://.

Annntatinne

NOTE: In an eSync environment, set the ProfileID to the analytics
account you wish to view. The SiteURL, however, should be the fully-
qualified domain name of the current server.

For example, if you want to view production site analytics from your
staging URL, set SiteURL to the staging server's fully qualified domain
name, while ProfileID and Account ID point to your production server.

» UserAccount. The Google Analytics SiteURL you obtained.

NOTE: On your Google Analytics Settings page, the UA-xxxxxx-x string
next to your site domain is the Google UserAccount.

That string also appears on the Admin > Property> Property
Settings page.
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%]

8.6 Ektron Web Help

8.6 Ektron Web Help ~

Property Settings
Universal Analytics Upgrade

ﬁ Property Settings
User Management
Tracking Info
Remarketing

Custom Definitions

Property Settings
Data Import
Basic Settings

Social Settings Tracking ID
A-33193949-

Property name

NOTE: To track multiple providers or sites:
1. Copy the <providers> tag.

2. Paste it under the existing tag and above
</AnalyticsDataProvider>.

3. Modify the elements.

» API key. Insert the API key that you created in Step 4.

9. Within the web.config's <analyticsSettings> tagsis a suppressBeacon
element that lets you track or suppress the tracking of users on your website.
Many site administrators do not want to track user behavior in Traffic Analytics
reports, as it corrupts the data. (This setting does not apply to Business
Analytics.) See also: Analyzing websites on page 483. Possible values for this

element are
* None. Track all users, including authenticated membership and Ektron

users.
» Members. Track unauthenticated and logged-in Ektron users only. Do not
track membership users.
e Authors. Track unauthenticated and logged-in membership users only. Do
not track Ektron users.
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» All. Track unauthenticated users only. Do not track membership and Ektron
users.

10. Within the siteroot\web.configfile, find the ek AutoInsertBeaconScript.

Change its value to true.

11. Save web.config.

IMPORTANT: No server control is needed to track Web Analytics. After you
enable Web Analytics in the web.config file, the following JavaScript is
automatically added to each PageBuilder page and any site page that contains
an Ektron server control.

<%Q@ Control Language="C#"
AutoEventWireup="true"
CodeFile="googletrackingcode.ascx.cs"
Inherits="Analytics Template GoogleTrackingCode"
EnableTheming="false" EnableViewState="false" %>
<!-- Start Google Code —-->
<script type="text/javascript">
var _gaq = _gaq || []:
_gaqg.push ([' setAccount', '<asp:literal id="GoogleUserAccount"
runat="server"/>'1]);
_gaqg.push ([' trackPageview']);
<asp:literal runat="server" id="variables"/>
(function ()
{ var ga = document.createElement ('script');
ga.type = 'text/javascript';
ga.async = true;
ga.src = ('https:' == document.location.protocol ? 'https://ssl'
'http://www') + '.google-analytics.com/ga.js';
s.parentNode.insertBefore (ga, s);
var s = document.getElementsByTagName ('script') [0];
}
) ()7
/* Start Track Event binding Code */
//
// extracted from
// http://runtingsproper.blogspot.com/
// 2009/12/how-to-automatically-track-events-with.html
//
// un-comment the following if you want Google Analytics to track your pdf
// download links on the website.
//$ (document) .ready (function () {
// TrackEventsForClicks () ;
//Y);
//
//function TrackEventsForClicks ()
/74
// TrackEventByFileExtension (".pdf");
//
// add your file extension here
//}
//
//function TrackEventByFileExtension (FileExtension)
/7 A

// $("alhref$='" + FileExtension + "']").click(function ()
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/71

// var fileURL = $(this).attr ("href");

// _gaq.push([' trackPageview', fileURL]);
/7 Y);

//}

/* End Track Event Binding Code */
</script> <!-- End Google Code —-->

Setting up the OAuth2.0 authorization protocol for Google
Analytics 3.0

OAuth2.0, the next evolution of the OAuth protocol, lets you provide authorization
flows for Web applications, desktop applications, mobile phones, and so on. Google
APIs use OAuth 2.0 for authentication and authorization. Google has implemented an
OAuth2.0 for access to its resources from third-party applications, such as Ektron.
It's secured, so that the client need not share user credentials with third party
applications. See also: http://oauth.net/2/,
https://developers.google.com/accounts/docs/OAuth?2

Follow these steps to implement the OAuth2.0 authorization protocol for Google
Analytics 3.0.

1. Createa Gmail account. If you already created an gmail account to complete
Step 1 of Setting up Google Analytics on page 511, enter that email address.

2. Sign up for Google Web Analytics (www.google.com/analytics/). When setting
up a Google Web Analytics profile for your site, you are assigned a profile ID and
a User Account. You need those to complete Step 15.

3. Open a browser and go to https://code.google.com/apis/console.
4. Click Create project.
5. Inthe left panel, click Services.
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6. Turn on Analytics API. Agree to terms of service.

— - R
Google apis
Ektron Google Analytics ¥ | Ajl(64) Active (1) Inactive (63) Google Cloud Platform
Overview -
All services
Services Select senvices for the project.
Team Service Status
APl Access = |
(7] OFF
Reports ® Ad Exchange Buyer API | OFF |
Quotas % Ad Exchange Seller API @ [forr)
% Admin SDK @ [([Torr)
% AdSense Host API L7 Request acce
*, AdSense Management APl @ [Tlor]
o4 Analytics API @ EN

7. Inthe left panel, click API Access.
8. Click the button Create an OAuth 2.0 client ID.

Ektron Google Analytics v

APl Access
Overview To prevent abuse, Google places limits on APl requests. Using a valid OAuth token
Services back to your project.

Team

API Access

Reports OAwth 2.0 allows users to share specific data with you (for example @

Authorized APl Access

contact lists) while keeping their usernames, passwords, and other
information private. A single project may contain up to 20 client IDs
Learn more

Quotas

Create an QAuth 2.0 client 1D...

9. A pop-up window opens. Register your site information. In the Home Page URL
field, enter your website address. Click Next.

10. The Create Client ID screen appears. Choose Service Account and click Create
client ID.
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11.

12.

13.

14.
15.

16.

17.
18.

19.

Setting up the OAuth2.0 authorization protocol for

The following screen appears. Click Download private key. Close the window.

Public-Private Key Pair Generated

Your private key's password is notasecret. You must present this password to
use the key.

There is only one copy of this key. You are responsible for downloading it and

storing it securely.
Download private key

A key file is downloaded. Keep it in a secure directory. The file contains a private
key that is unique per user. You need this information to complete Step 8 of
Setting up Google Analytics on page 511.

The next screen displays your Client ID, email address and public key
fingerprints. You need this email address to set up OAUTH in the web.config
section (in Step 20).

Log into https://www.google.com/analytics/.
Click Admin.

GO 8[6 Analytics oo @omailcom  Seffings My Account
) viic

All Accounts

Analytics now includes Change History, a log of account changes. Leamn more

Dec 21,2013 -Jan 20, :

Mode | = i Shc'.'.'ﬁ |

Avg. Visit
Duration

Go

Visits Bounce Rate .
Conversion F

In the Account column, select the account that you want to track. If you do not
see the account, create it.

In the Property column, click User Management.

Under Add permissions for, add the GA service email address generated in
Step 13. Forexample: 111111111194Qdeveloper.gserviceaccount.com.

Open your site’s siteroot/web.config file and find the
AnalyticsDataProvider tag. If you enable version 3.0, edit the GoogleV3.0
tags.
<AnalyticsDataProvider defaultProvider="Google">
<providers>
<add name="GoogleV3.0"
type="Ektron.Cms.Analytics.Providers.GoogleAnalyticsProviderv3,
Ektron.Cms.BusinessObjects"

EmailAddress="" <!-- address comes from Step 13 -->
KeyFilePassword="" <!-- Password is "notasecret" as shown in Step 11 -->
KeyFilePath="/Key/privateKey/xxxxxxxxx.pl2" <!-- Replace sample path with

actual path -->
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Username="" Password="" ProfileId=""
SiteURL="" UserAccount=""
Endpoint="https://www.googleapis.com/analytics/v3/data/"
ApiKey="" CachelInterval="0"
GoogleAnalyticsTrackingCodePath="Analytics\template\googletrackingcode.ascx"
Version="3.0" />
</providers>
</BAnalyticsDataProvider>

NOTE: If your web.config has several analytics providers and you want to
disable analytic tracking for any of them, delete the value of the
GoogleAnalyticsTrackingCodePath property.

NOTE: To track multiple providers or sites:

1. Copy the <providers> tag.

2. Paste it under the existing tag and above </AnalyticsDataProvider>.
3. Modify the elements.

20. Complete each tag’s properties.

+« name. The free text name of the site being tracked and the Google version.
You should use the site name followed by provider name and version. For
example, www.ektron.com-Google V3.0. When Workarea users view site-
level displays of Web Analytics data, they choose the site from a drop-down.
If you change the name, you must also change the <AnalyticsDataProvider
defaultProvider element to match the name.

o 7/2/2008

synergy.ektron. com-Google
dewv.ektron.com-Google

New vs. Returning

869 visits from 2 visitor types

 EmailAddress. OAUTH2.0 only—Enter the service account email address
that you used to register your site in the Google console. This address was
created in Step 13 above.
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APl Access

To prevent abuse, Google places limits on API requests. Using a valid OAuth token or AP| key

Authorized APl Access
OAuth 2.0 allows users to share specific data with you (for example, contact lists) while keepil
contain up to 20 client IDs. Learn more

Branding information

The following information is shown to users whenever you request access to their private data.

Product name: BareBones Site

Google account:

Home page URL: www.barebonesnh. com

Edit branding information...

Service account

Use senice accounts to call Google APls on behalf of your application instead of an end-user
Client 1D: D000, apps. googleusercontent . com
mail address: @developer.gserviceac@

Public key fingerprints:

— Dele

KeyFilePassword. OAUTH2.0 only—Was displayed in the Download dialog
that appears while registering your site in the Google Console (step 10
above).

KeyFilePath. OAUTH2.0 only—Enter the path to the privatekey file that
you downloaded and saved while registering your site in the Google Console
(step 10 above).

Username. non-OAUTH2.0 only—The Gmail username you obtained in
Step 1.

Password. non-OAUTH2.0 only—The Gmail password you obtained in Step
1.

ProfileID. The Google Analytics Profile ID you obtained in Step 2.
Another way to get your Profile ID:
a. Log into https://www.google.com/analytics/.

b. Click Admin.

[ O Sle Analvtics @amail.com  Settings My Account
VLIS

a All Accounts

Analytics now includes Change History, a log of account changes. Learn more

Dec 21, 2013 -Jan 20, :

Mode | = E Sncwﬁ |

Avg. Visit Bounce Rate Go

Visits Nuration Conversion F
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c. Inthe View column, select the account that you want to track. If you
do not see the account, create it.

d. Inthe View column, under View Settings, locate the View ID.

- Catinne

sration :» Reporting View Setings

8.6 Ektron Web Help

8.6 Ektron Web Help =

View Settings
i View Settings

User Management
oals
Content Grouping
Filters

Channel Grouping

Reporting View Settings
PERSOHAL TOOLS & ASSETS
Basic Settings

Segments View ID

» SiteURL. Your site root name. For example, you could set up one
<providers> tag for the developer.ektron.com site, and another for the
synergy.ektron.com Site. The SiteURL needs to match the development
site URL when you test in your development environment. For example, if
the site path is http://MyDevMachine/default.aspx, the SiteURL is
MyDevMachine. If there is no match, the Google beacon is not inserted onto
your page.

» UserAccount. The Google Analytics SiteURL you obtained.

Annntatinne

NOTE: On your Google Analytics Settings page, the UA-xxxxxx-x string
next to your site domain is the Google user account.

That string also appears on the Admin > Property> Property
Settings page.
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%]

8.6 Ektron Web Help

8.6 Ektron Web Help ~

Property Settings
Universal Analytics Upgrade

ﬁ Property Settings
User Management
Tracking Info
Remarketing

Custom Definitions

Property Settings
Data Import

Basic Settings
Social Settings Tracking ID

A-33193948-

Property name

« API key. non-OAUTH2.0 only—Insert the API key that was displayed in
Step 12.
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APl Access

To prevent abuse, Google places limits on AP requests. Using a valid OAuth token or AP key allows:

Authorized APl Access
OAuth 2.0 allows users to share specific data with you (for example, contact lists) while keeping thei
contain up to 20 client IDs. Learn more

Branding information
The following information is shown to users whenever you request access to their private data.
Product name: BareBones Site

Google account: oot LTl

Home page URL: www . barebonesnh. con

Edit branding information...

Service account

Use service accounts to call Google APls on behalf of your application instead of an end-user. Learn
Client 1D: .apps.googleusercontent . com
Email address: Bdeveloper.gserviceaccount.com
Public key fingerprints: : — Delete

Create another client ID...

Simple API Access
Use APl keys to identify your project when you do not need to access user data. Learn more

Key for browser apps (with refersrs)
Pl key: : N ——

Rafarare- Anwv refarar Allreed

21. Within the web.config's <analyticsSettings>tagsis a suppressBeacon
element that lets you track or suppress the tracking of users on your website.
Many site administrators do not want to track user behavior in Traffic Analytics
reports, as it corrupts the data. (This setting does not apply to Business
Analytics.) See also: Analyzing websites on page 483. Here are the possible
values for this element.

» None. Track all users, including authenticated membership and Ektron
users.

» Members. Track unauthenticated and logged-in Ektron users only. Do not
track membership users.

e Authors. Track unauthenticated and logged-in membership users only. Do
not track Ektron users.

» All. Track unauthenticated users only. Do not track membership and Ektron
users.
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Setting up the OAuth2.0 authorization protocol for

Within the web.config's <appSettings>tagsisanek
AutoInsertBeaconScript element that either tracks or suppresses tracking
activity on your website. Change its value to true.

Save web.config.

IMPORTANT: No server control is needed to track Web Analytics. After you
enable Web Analytics in the web.config file, the following JavaScript is
automatically added to each PageBuilder page and any site page that
contains an Ektron server control.

<%@ Control Language="C#"
AutoEventWireup="true"
CodeFile="googletrackingcode.ascx.cs"
Inherits="Analytics Template GoogleTrackingCode"
EnableTheming="false" EnableViewState="false" %>
<!-- Start Google Code -->
<script type="text/javascript">
var gag = gaq || [];
_gaqg.push ([' setAccount', '<asp:literal id="GoogleUserAccount"
runat="server"/>']);
_gaqg.push ([' trackPageview']);
<asp:literal runat="server" id="variables"/>
(function ()
{ var ga = document.createElement ('script');
ga.type = 'text/javascript';
ga.async = true;
ga.src = ('https:' == document.location.protocol ? 'https://ssl'
'http://www') + '.google-analytics.com/ga.js';
s.parentNode.insertBefore (ga, s);
var s = document.getElementsByTagName ('script') [0];
}
) ()i
/* Start Track Event binding Code */
//
// extracted from
// http://runtingsproper.blogspot.com/
// 2009/12/how-to-automatically-track-events-with.html
//
// un-comment the following if you want Google Analytics to track your pdf
// download links on the website.
//$ (document) .ready (function () {
// TrackEventsForClicks () ;
//Y);
//
//function TrackEventsForClicks ()
/71
// TrackEventByFileExtension (".pdf");
//
// add your file extension here
e
//
//function TrackEventByFileExtension (FileExtension)
/7 A
// $("alhref$='" + FileExtension + "']").click (function ()

/74
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// var fileURL = $(this).attr ("href");

// _gaq.push([' trackPageview', fileURL]);
/7 Y);

//}

/* End Track Event Binding Code */
</script> <!-- End Google Code —-->

Tracking a single page

As an alternative to tracking your entire site, you can track individual .aspx pages. To
do that, follow these steps on every page you wish to track.

PREREQUISITE

il

8.
9.

You completed all steps in Setting up Google Analytics on page 511.

Open the siteroot/web.config file.

Find the ek AutoInsertBeaconScript tag.
Setits value to false.

Save web.config.

NOTE: The previous steps disable the tracking code on your website.

Open Visual Studio.

. Open the .aspx page to which you want to apply the tracking code.
. In the Solution Explorer tree, go to

Workarea/Analytics/template/googletrackingcode.ascx.
Drag and drop that user control onto the page.
Assign EktronAnalyticsTrackingCode as the ID of the control.

Tracking clicks by file type

To track the number of times that files on your site (for example, PDFs) are accessed,
follow these steps.

PREREQUISITE

Nouhkwhe

You completed all steps in Setting up Google Analytics on page 511.

Open the siteroot/web.config file.

Find the ek AutoInsertBeaconScript tag.

Setits value to true.

Save web.config.

Open Visual Studio.

Open the .aspx page to which you want to apply the tracking code.

In the Solution Explorer tree, go to
Workarea/Analytics/template/googletrackingcode.ascx.
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8. Uncomment the following code.

/* Start Track Event binding Code */

//

// extracted from

// http://runtingsproper.blogspot.com

// /2009/12/how-to-automatically-track-events-with.html
//

// un-comment the following if you want Google Analytics to track your pdf
// download links on the website.

//$ (document) .ready (function () {

// TrackEventsForClicks() ;

/7Y

//

//function TrackEventsForClicks ()

/ /A

// add your file extension here

// TrackEventByFileExtension (".pdf");

//

//}

//

//function TrackEventByFileExtension (FileExtension)

/ /A

// $("alhref$='" + FileExtension + "']").click (function() {
// var fileURL = $(this).attr ("href");

// _gaq.push([' trackPageview', fileURL]);

/7 1Y)

//}

/* End Track Event Binding Code */

By default, the JavaScript tracks the opening of PDF files on your website. To add file
types, copy TrackEventByFileExtension (".pdf"); and paste it, and change the
file type as shown in the following example.

xfunction TrackEventsForClicks ()

{
TrackEventByFileExtension (".pdf") ;
TrackEventByFileExtension (".png") ;

Google site reports

You can access site-level Google Analytics reports from within the Workarea by
selecting Reports > Traffic Analytics > Google.

NOTE: The following text was adapted from Google Analytics Help Center. Check
that site for additional details on the reports.

Google sites reports show direct traffic on left side, top content on the right.
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Direct Traffic Top Content
Display "® | Visits 4 {unassigned) '+ 17 821 pages were viewed a total of 102,572 times
Avg
U B
2= om0 Page Pageviews i Time on ounce % Exit
250 20 Pageviews Rate
Page
& 7,572 6263 00:01:00 2475% 2320%
August 09 August 23 September 06 &g forum.aspx 5,897 3,688 00:00:57 22.98% 1059%
& Ikb_arficle.aspx?id=5382 4750 4382 00:04:42 91.50% 90.67%
NNV 7956 visits (248.94i0y) @& fforum.aspx?g=topics&f=a0 3,891 1308 000224 27.85% 1272%
Faan e 416 Pagesivisit & fforum.aspx?g=search 2,182 1,128 00:01:28 41.18% 18.70%
5 /support.aspx 2,167 1694 00:01:27 3463% 32.16%
[V 00:05:115 | Time on Site s
& /cms400releasenotes aspx 1,269 4,080 00:03:08 80.68% 64.30%
\Ammrmr y -
f | |GER RS @ fforum.aspx?g=topics&f=a8 1,236 544 000213 33.83% 13.35%

Search reports show terms used by site visitors to find content on your site. Note that
this data is not retrieved from Google Analytics. Instead, it is retrieved from Ektron’s
site search.

The following sections describe Google’s site-level reports.

Visitors

This report shows the number of new and returning visitors who came to your site
and how extensively they interacted with your content. This traffic overview lets you
view aspects of visit quality (i.e. average pageviews, time on site, bounce rate) and
visit characteristics (i.e. first time visitors, returning visits).

Locations

32,639 visits came from 151 countries/territories

CountryTerritory Visits FagesiVisit Avg. Time on Site %% Mew Visits Bounce Rate
United States 18,786 3.86 00:04:51 44 34% 50.45%
India 2,505 222 00:02:53 59.38% 68.78%
United Kingdom 1,960 2.88 00:03:30 59.29% 60.20%
Canada 1,810 3.43 00:04:07 54.59% 54.36%
Australia 568 229 00:02:12 73.59% 58.66%
Germany 347 1.35 00:00:52 91.93% 84.15%
Metherlands 329 1.72 00:01:41 83.50% 80.55%

» Locations. Countries of your site visitors.

 New vs. Returning. The number of visitors to your site who are new or
returning.

A high number of new visitors suggests that you are successful at driving traffic
to your site, while a high number of return visitors suggests that the site content
is engaging enough to keep visitors coming back. You can see how frequently
visitors return and how many times they return in ‘Recency’ report and the
‘Loyalty report’, both under ‘New vs. Returning’ in the Visitors section.

» Languages. Uses the language provided by the HTTP Request for the browser to
determine site visitors’ language. Values are given in 2- or 4-character language
code (for example, en-br for British English).

This report captures the preferred language that visitors have configured on
their computers. Understanding who your visitors are is crucial to developing the

528 | Ektron 9.50




Visitor trending

right content and optimizing your marketing spend. Many times, geo-location is
not enough. Many countries have diverse populations speaking different
languages which present important market targeting opportunities.

User defined. If you modified the tracking code to provide a user-defined
segment, this field identifies that segment by the string you provide when
setting up a user-defined segment.

Visitor trending

25,247 Visits | 1147 36 Visits f Day

Wednesday, August 12, 2009 i e

Thursday, August 13, 2009 e R
Friday, August 14, 2009 e R

Saturday, August 15, 2009 I 1 oo (326)

Sunday, August 16, 2009 R, 1 .5 0% (405)

Monday, August 17, 2009 T 0o 1 52

Visits. The number of visits your site receives is the most basic measure of how
effectively you promote your site. Starting and stopping ads, changing your
keyword buys, viral marketing events, and search rank influence the number of
visits your site receives.

Absolute Unique Visitors. The number of unduplicated (counted only once)
visitors to your website over the specified time period. A Unique Visitor is
determined using cookies.

Pageviews. The total number of pages viewed on your site. It is a general
measure of how much your site is used. It is more useful as a basic indicator of
the traffic load on your site and server than as a marketing measure.

Average Pageviews. Average pageviews is one way of measuring visit quality.
A high Average Pageviews number suggests that visitors interact extensively
with your site. A high Average Pageviews results from:
o Appropriately targeted traffic (that is, visitors who are interested in what
your site offers)

o High quality content presented effectively
Conversely, a low average pageviews indicates that traffic coming to the site has

not been appropriately targeted to what the site offers or that the site does not
deliver what the visitor expected.

Time on Site. One way of measuring visit quality. If visitors spend a long time
visiting your site, they may be interacting with it extensively. However, Time on
site can be misleading because visitors often leave browser windows open when
they are not actually viewing or using your site.

Bounce Rate. The percentage of single-page visits (that is, visits in which the
person left your site from the entrance page).

Bounce rate is a measure of visit quality, and a high bounce rate generally
indicates that site entrance (landing) pages are not relevant to your visitors. You
can minimize Bounce Rates by tailoring landing pages to each keyword and ad

Ektron Reference I 529




Analyzing websites

that you run. Landing pages should provide the information and services that
were promised in the ad copy.

Browser capabilities

Optimizing your site for the appropriate technical capabilities helps make your site
more engaging and usable and can result in higher conversion rates and more sales.

Browsers

34 589 visits used 20 browsers

Browser Visits % Contribution to total
Internet Explarer 17,284 50.00%

Firefax 13,864 40.08%

Chrome 2024 5.85%

Safari 858 2.48%

Opera 429 1.24%

lMozilla 68 0.20%

Opera Mini 14 0.04%

Seallonkey g 0.03%

MMozilla Compatible Agent [ 0.02%

Kongueror 5 0.01% I Internet Explorer 50.00%
Yandex 1 0.01% e
Galeon 2 0.01% i 2.48%
Netscape 2 0.01% Opera 1.24%

 Browsers. The browsers that your visitors use.
» Operating Systems. The operating systems that your visitors use.

 Browsers and OS. The browser/operating system combinations that your
visitors use.

» Screen Colors. The number of screen colors your visitors use.

» Screen Resolutions. The screen resolutions that your visitors use.

» Flash Versions. The versions of Flash that your visitors have installed.
» JavaSupport. Whether Java is supported on your visitors' platforms.

Network properties

Network Location
25 242 visits came from 5,323 network locations

Metwark Location visits  Pagesivisit  Avg. Timeon Site % NewVisits  Bounce Rate
sprint 1,741 482 00:08:20 14.65% 39.86%
road runner holdeo lle 745 3.03 00:02:49 56.63% 56.29%
comecast cable communications inc. 456 2.35 00:02:45 T5.66% B7.54%
ekiran inc. 434 1.81 00:01:43 6.22% Ta.12%
yerizon internet services inc. 392 2.93 00:02:38 B8.11% 62.24%
internet service provider 338 283 00:03:43 59.23% T337T%
COX communications inc. 224 .10 000844 41 .96% 46.43%
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 Network Location. The internet service providers that your visitors use. This
report lets you track the internet service provider (ISP) domains to which the
user resolves.

The domain is determined by the internet service that owns the user's internet
protocol (IP) identifier.

 Hosthnames. Hosts from which people are visiting your site. Hostnames
sometimes provide insight into organizations that are interested in what you
offer.

» Connection Speeds. Connection speeds that your visitors are using.

Optimizing your site so that it loads quickly for most visitors can result in higher
conversion rates and more sales.

Traffic sources

This section provides an overview of the different kinds of sources that send traffic to
your site. The graph shows traffic trends; the pie-chart and tables show what is
driving the trends.

Direct Traffic

Display "™ | Visits & FTime on Site 1%

AL NS

NN Vv 7,820 Visits (236.97/day)
B Vaana's 396 Pagesiisit

| v 000514 Time on Site
A 4465%  Bounce Rate

» Direct Traffic. Visits from people who clicked a bookmark to come to your site
or who typed your site URL directly into their browser. Direct traffic can include
visitors recruited via offline (i.e. print, television) campaigns.

+ Referring Sites. Externals sites from which visitors linked to your site.

» SearchEngines. Visitors who clicked to your site from a search engine result
page.

« All TrafficSources. Visitors referred from search engines, sites, and tagged

links. The graph shows the overall trends while the table shows the specific
sources (i.e. search engines, sites, and tagged links) driving the trends.

» Keywords. Compares traffic from search keywords to overall traffic to your site.

« Campaigns. How people referred from your configured campaigns compare to
the “average” visitor to your site.

The graph shows overall trends, while the table lists each configured campaign.
Because all traffic in this report results from campaigns that you explicitly
control, you can use this information to add or delete campaigns, or to
determine the effectiveness of tests that you have set up using custom tags.

» Ad Versions. Compares your AdWords ads (and configured campaigns in which
you use the “content” tag) against each other.

This report shows you which ad copy (in AdWords ads or in configured
campaigns) is most effective. Ads with high clickthrough rates show that the
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copy is effective at getting the user to click, while high bounce rates, for
example, indicate a need for landing pages that are consistent with what the ad
promises.

Content

This report provides an overview of pageview volume and lists the pages (Top
Content) that were most responsible for driving pageviews. You can also reach some
useful reports that reveal how users interact with your site and statistics related to
how they found your site in the first place.

NOTE: Content reports include a link icon (';ﬂ) and a hyperlink. If you click the
link icon, you go to the page. If you click the hyperlink, you see a more detailed
Analytics report about that page.

Top Content

16,091 pages were viewed a total of 88 948 times

Fage Fageviews  Unigue Pageviews  Avd. Time on Page  Bounce Rate % Exit
& S 7,300 6,031 o110 26.98% 25.41%
& fforum.aspy 4,729 2887 00:00:59 2265% 10.91%
& Jkb_aticle aspx?id=5982 4,341 3,993 00:04:32 91.61%  H0.65%
G fforum asp?g=topics =80 33T 1,107 00z 29.51% 12.88%
& fsupportasp 2117 1,645 00:01:28 ITET% 34.10%
& forum.aspx?o=search 1,729 911 o001 43.86% 19.26%

» Top Content. The most commonly viewed pages on your site, and how they are

used.

The table lists all pages which were viewed on your site. A high bounce rate
indicates a landing page that should be redesigned or tailored to the specific ad
which links to it. A high 'Time on Page' may indicate content that is particularly
interesting to visitors. The significance of exits varies according to each page.
For example, it may be common for visitors to exit your site from a receipt or
“thank you” page because they have completed a conversion activity. In
contrast, a high number of exits from a non-goal page (from a funnel page, for
example) may indicate that the page is confusing or that it generates user
errors.

Content by Title. The most commonly viewed groups of pages on your site
(grouped by title), and how they are used. This report provides the same
information in the “Top Content” report, but aggregated by title tag value.

Top Landing Pages. Data on how effectively your landing pages entice visitors
to click further into your site. You can lower bounce rates by tailoring landing
pages to their associated ads and referral links and placing a clear call-to-action
on each landing page.

Top Exit Pages. Pages from which people exit your site.

The significance of an exit rate varies according to each page. For example, it
may be common for visitors to exit your site from a receipt or “thank you” page
because they have completed a conversion activity. In contrast, a large number
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of exits from a non-goal page (from a funnel page, for example) may indicate
that the page is confusing or that it generates user errors

Viewing Google segments

Google Analytics has an Advance Segments tool that lets you "slice and dice" your
Analytics data with great precision. Advanced segments let you choose what types of
visits you want to be considered when generating the data for a report." (source:
About Advanced Segments)

Google segments allow marketers using analytics reports to drill down to specific
classes, or segments, of site visitors, such as

e Users

» Sessions and visitors

« Members and authors
This section explains how to select and view segments within Ektron.

NOTE: While you can view custom segments within Ektron, you must create them
within Google Analytics.

1. Browse to a view of Analytics data. See also:
2. Click Segment (L),

SEQ Google W3cC Alexa Images Text Meta M

Analytics Provider | Google v | Start Date: |[1/29/2011 End Date: |2/28/2011 = ;,-Q“-

Display ™ | Pageviews o (unassigned] P
10 | Segment button on |
View Page Activity |

Screen |

v

1/23/20M1 2/28/20M o hittp: /7 smacdonaldl s =6

http://smacdonald1 Direct Traffic " Segment button on Traffic | http://smacdonald1 1

Analytics = Google =

: 4028 pages were views
Overview screen

Display ™ | Visits hd (unassign:

FPage
@& feurrenthwebhelp/Cover

& foms400hE02Mwebhelpl

& fenrrenthwebhelnilnstall:
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Compare Analytics for Sample Content Block

Display |Pageviews e 4;:-Site http://smacdonald1 » | Analytics Pn

i N
10

Segment button on

Compare Analytics
screen |
.
% Analytics Report k]
Analytics Provider | Google b
Civerview hd Summary ¥
Last 30 Days |+ . Segment button on Smart _;»-'u;“- Site | http-/fsmacdonald? v
Diesktop Analytics Report [
[ Cancel ] [ Save ] y

3. The Segments screen appears. Select up to 4 segments to display.

4. The screen refreshes and graphs each segment in a different color. In the
following example, new visitors are graphed in blue and returning visitors are
orange. Also, the screen breaks down data by each segment.

1/29/2011 0z2/28/2011 an http:/fsmacdonaldl s e

http://smacdonald1 Direct Traffic
Display | “isits v | Legend |

b

40

Returning Visitors
1/28/201 1 212/2011 2/26/2011
TN\ | Mew visitars 505 | Visits (16.29/dav) N
e — | LV
Returning Visitars e Data for selected
e Mew visitors 116 Page ~ Scgments
Returning Visitars 6.13 Pagesiisit

DNoa NN Mewvisitars 00:09:02 | Tirne on Site

Running Webtrends analytics

ey
A

hitp://smacdonald1 Top Col

2250 pages were viewed a tota
Visitors" segment

FPage
& fcurrentiwebhelpiCover logo.htrm

Mew Visitars

i
7 Returning Yisitors

& forns400kE020webhelp/Cover logc
Mew Visitors
Returning Yisitors

& Jcurrenthwebhelinstallationssyste
requirements hirn

Marketers today face a new set of challenges. With the explosion of new digital
channels such as social and mobile, it is even harder to understand customer
behaviors and optimize how to communicate with them. Both Webtrends Analytics
On Demand and On Premises deliver the industry’s most accurate picture of how
customers interact with your brand in the digital space.

Real-time data, intelligent alerts, and the ability to easily share information within
your organization means you empower your team to make smart and timely
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decisions based on solid data. You'll find new opportunities, ensure conversions are
on track and respond to needs faster than ever before.

Setting up Webtrends analytics

» Webtrends On Demand 2.1 and 3
* You have permission to edit files on the Ektron Web server.

To set up Webtrends Analytics to work with Ektron:

1. Create a Webtrends Account and create a tracking script.
a. Set up a Webtrends account: Webtrends Developer Network.

Webtrends sends you an account name, username, and password.
Log into Webtrends using this URL: Webtrends Developer Network Login.
Use your Webtrends account name, username, and password.

From that page, follow this menu path: Administration> Application
Settings > Data Sources.

f. Click New. A Data Source Wizard screen appears.

» Enter a name for the data you will retrieve.

» Select your server's time zone.

e Click Next.

» A summary of the information you entered appears along with a
Webtrends data collection server ID (DCSID) value.

» Click Save. The Data Sources screen reappears with your new data
source.

g. Copy your Data Source ID number (DCSID), indicated in the following
figure. You will use this number in the next step.

®© a0

Administration

[ Web Analysis = Data Sources
Reports & Profiles
[# Report Configuration I Search | Advanced

[# Report Designer Data Sources
[# Options -

[# Import/Export

=l Application Settings
[# User Management

User Notifications Managed SOC Account ' pesio y
Change History o S - L number
Account Login History Click to go to v
Data Sources | Build Tag screen |

Cptions ;I " -

e roTe

m Analytics Reports
ﬂ Administration

2. Build the Tracking Files. In this step, you tell Webtrends the type of data you
want to track. Webtrends then generates files that track that data.
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Open Webtrends' Tag Builder page: Webtrends Tag Builder

From the Data Sources screen, you can click Build Tag (Tracking Code).
Complete this page, which prompts you to identify which data Webtrends
should track.

Into the page's Webtrends data collection server ID (DCSID)field,
paste the number you copied in Step 1g above. For help completing the Tag
Builder page, click the information button in the top right corner.

Tag Builder Help 5

Required Settings

The site domain you want to track:

documentation.ektron.com [eg. example.com, example.co.uk)

Web server time zone
(GMT-05:00) Eastern Time (U5 & Cs v

WebTrends data collection server ID (DCSID}):

Data collection server . Enter DCSID number
&) Statsewebtrendslive.com (defaul for e =

O smantSource Data Collector location (ebTrends software customers)

Additional Options

Uplogd am existing tag configuration.

The Internet address ofthe WehTrends
server that collects your web data.

Event Tracking Visitor Tracking Data Mapping Diomain Filtering Tag Integration

Build Tag _Reget -

™, Build Tag button

e. Click the Build Tag button. Webtrends generates files you will use to track

usage statistics. The Summary and Confirmation screen appears.
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f. Click the Download tag button.

! Tag Builder — Webtrends® E -" barebonesband. com - Google Search

Ei'ag Builder

ﬂ Summary and Confirmatio

Your tag is ready for download. Please review the configuration.

Required Settings
4 9 File Name: (wektrends _KX¥¥¥H zip)

Required Setting=Site Domain:  documentation.ektron.com
Frimary Time Zone: (GMT-05:00) Eastern Time {US & Canada)
DCSID: des5jd1eg000000g8d40t1df_5k2p Javascript Folder Name:
Data Collection Server:  statse.webtrendslive.com Istripts!

desSjd1eg000000g8d4081di_Sk2p

B

j Download Tag button V4

g. Save the .zip file to your computer.

3. Copy Webtrends tracking files to Ektron. In this step, you replace the
Webtrends.html file in your Workarea folder with the one you downloaded, and
you replace the <div> tag in your Workarea's Wwebtrends.ascx file with the one
in the downloaded file of the same name.

a. Extract the .zip file you downloaded.

b. Open the folder that contains the extracted files.
c. Copy Webtrends.js.
d

Paste it into the site root\Workarea\Analytics\template folder. This
action replaces a file of the same name.

In the folder that contains the extracted files, open Webtrends.html.

f. Copy the following <div> tag.

<div><img alt="DCSIMG" id="DCSIMG" width="1" height="1"
src="http://statse.webtrendslive.com/dcs5jdleg000000g8d40txldf 5k2p
/njs.gif?dcsuri=/nojavascripté&amp;

®

WT.Jjs.No&amp; WT.tv9.3.0&amp; WT.dcssip=www.documentation.ektron.com"/>
</div>

g. Inthe site root\Workarea\Analytics\template folder, open
Webtrends.ascx.

h. Replace the <div> tag with the one you copied.

4. Update Ektron's web.config file. You must have permission to edit files on your
Ektron Web server.

a. Obtain a value for your web.config file's ProfileFileName property by
going to
https://ws.Webtrends.com/v2/ReportService/profiles/?format=xml.
(Authentication required.)

» In the User name field, enter your account name\username that
you obtained.
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» In the Password field, enter your password. A screen displays your
Webtrends profile as follows.

<?xml version="1.0" encoding="utf-8" ?> —
<list> —
<ProfileDefinition>
<string name="ID">ABCD1234</string>
<string name="name">MyAnalyticsAccountName</string>
<decimal name="AccountID">234567</decimal>
<decimal name="TimeZoneID">-500</decimal>
</ProfileDefinition>
</list>

You will use the string name value (highlighted in red),
ProfileFileName property.

b. Open your siteroot/web.config file

c. Find the tag beginning with <add name="Webtrends".

d. Replace the webtrends tag's properties.
« Name. The name displayed on the report. If you have several
accounts, you can use names like these.
o Webtrends. developer.ektron.com

o Webtrends. document.ektron.com
However, the value of this field for one analytics provider must match
the value of the <analyticsDataProvider defaultProvider> tag.
» Type. Do not change.

+ Username, Password.
1. GotocC:\Program Files (x86)\Ektron\CMS400vxx\
Utilities\EncryptEmailPassword.exe.

2. Encrypt the Webtrends username and password you obtained.
3. Enter the encrypted values into these properties.
» ProfileFileName. Enter the string name value you obtained.

» SiteURL. Enter the URL visitors use to access your site. For example,
www.example.com.

» UserAccount. Enter the account name you obtained.

+ Endpoint. The default endpoint value is
https://ws.Webtrends.com/v2/ReportService/. You only need to
update this value if you are not using the default Data Collection Server
on the Tag Builder page.

» Cache Interval. Use to cache the Analytics provider's data. Enter a
number in seconds. The maximum 86400. Caching improves the
performance of the traffic report page.

» AnalyticsTrackingCodePath. Do not change.

Displaying Webtrends site reports

You can access Webtrends analytics reports within the Workarea by selecting
Reports > Traffic Analytics > Webtrends.

538 | Ektron 9.50




Display options

Refer to the following WebTrends manual for information about specific reports:
Webtrends Administration User Guide> Chapter 32 : Webtrends Analytics Report

Library

Display options

Webtrends reports provide the following display options.

Data table

Search Engines: Keywords

Start Date: 10/30/2011

End Date: 11/29/2011 g

www.example.com Search Engines: Keywords

View: Data Table -

Search Engine

Google
Google UK

Google Product

Search

Google India

Google Canada

Bing

Google Australia

Yahoo

Google Germany

Google
Metherlands

Bar chart

Wisits

4454
8a7

759

732
629
503
418
141
109

107

Page
Views

22548
5087

4164

5269
3628
2963
2147
941
475

560

Avg Visit Duration
(Min)
2.86

274

3.09

324
313
2.80
293
283
1.61

2.60

Site www.exampie.com (g

3ingle Page View  Entry Page

Visits
19649
vz

405

368
271
200
183
52
70

50

Visits
3215
1858

1639

2288
1282
992
853
287
226

234
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Keywords

Start Date: 10/30/2011 =~ End Date: 11/2%2011 &

Site www exampie.com g

www.example.com Search Engines: Keywords

View: BarChart -

Search Engine Visits

Google

Google UK .
Google

Product

Search u
Gooagle India .
Google

Canada B
Bing I
Google

Australia |
Yahoo |

Heat map
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4454

aa7

759

732

629

503

418

141

Page Views
22548
5087
|
4164
[ |
5269
|
3628
[ |
2063
[ |
2147
|
941
|

Avg Visit

Duration (Min)

wI

2.86

274

3.09

324

3

2.80

293

283

Single Page
View Visits
1969
372
|
405
|
368
[ |
271
[ |
200
1
183
1
52

Entry Page
Visits

8215

1858

1639

2288

1282

992

853

287



Display options

Search Engines: Keywords

Start Date: 10/30/2011  End Date: 11/25/2011 b Site  www.example.com g

www.ektron.com Search Engines: Keywords

View: HeatMap -

I Visits Eiz?js ;:?HTSH Duration 3:;?;8 Page View Eir;tirt]; Page
Google 4 19649

Google UK 887 8087 372 1858
gz;r‘i': A 405 1639
Google India 732 5269 368 2288
Google Canada 629 3628 271 1282
Bing 503 2963 200 992
Google Australia 418 2147 183 853
Yahoo 141 941 52 287
Google Germany 109 475 1.61 70 226
Google

Nethgerlands 107 | 560 234
Gooagle France a0 382 1.21 50 154

Pie chart
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Search Engines: Keywords

Start Date: 10/30/2011  End Date: 11/29/2011 2 Site www.example.com &)

www.ektron.com Search Engines: Keywords

View: Pie Chart -

i . Page Avg VI,S” Confribution to total
Search Engine  Visits Duration -
Views ) Visits -
(Min)
Google 4454 22548 286

Google UK 887  b0a7 274 \'
Google Product 750 4164 3,09
Search

Google India 732 5269 3.24
Google Canada 629 3628 313

B Google 43.13%

Bing 503 2963 280 Google UK 8.59%

Google Google P..t E'mi'r.:'.-‘ 7.35%

Australia 418 2147 2.93 B Google India 7.09%

Google Canada 6.09%

Yahoo 141 941 233 B Rino 4 A7
From the pie chart, you can change the display to see percentages of the following
factors.

» Visits

» Page views
Average visit duration (minutes)
Single page view visits

Entry page visits

Running Adobe Analytics

Adobe Analytics® (formerly known as Omniture SiteCatalyst) provides marketers
with actionable, real-time intelligence about online strategies and marketing
initiatives. Adobe Analytics helps marketers quickly identify the most profitable paths
through their website, determine where visitors are navigating away from their site,
and identify critical success metrics for online marketing campaigns.

To set up and monitor Web traffic analytics using Adobe Analytics.

1. Log onto site and generate tracking code.
a. Contact Adobeand set up an account to use Adobe Analytics.

b. Use the information Adobe provides (URL, username, password, and so on)
to log in to Adobe Online Marketing Suite.
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Running Adobe Analytics

0 Adobe Online Marketing Suite Favorites Admin Community Help

ADOlBE OIE‘“JNE MARKETING SUITE Test Feed Suite e Bektre =
B Announcerments
-~
_ Actionablz
Maintenance Release SITECATALYST" Wieh Analylics
W will be performing s
maintenance update in SiteCatalyst ) ]
on 7 Apr 2011 beginning st 3:00 P Advanced Seomentation | pyeea\ER sEE SEARCHCENTER*
L5 Mourttain Standard Time. & Analysis oO — sl
oo ‘O
Product Release
Announcements
Mutti-Channel
March 17T 2011; See what hasz Analytics INSIGHT ;E [ﬂ GENESIS
changed in today's mairtenance e —_ - —_—
elect an
Carmrmunity Ad?bebprqdud
0 begin
Knowledge Base Gued Search or | gF ARCH&PROMOTE Iﬂ Ble|  TEST&TARS
Targeted Results
Training Videos
)
Docurnertation ) (? | 83
Measurs AUEENCE | GURVEY ® ——  RECOMMENDATIC
Sertiment

Click Admin > Admin Console > Code Manager.

dobe Online Marketing Suite Faworites Admin Community Help

Admin Conzole Acdmin Console Hor

DIISE'DNLINE MARKETING SUITE

SAIMT Classifications  Report Suites

nnouncements - Manage Campaigns Code Manager
-~
Data Sources COmpany
tenance Release
Exclud